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IMPORTANT: READ BEFORE INSTALLING SOFTWARE
nQuery Advisor License Agreement

This document sets forth the terms and conditions of the license and the limited warranty for nQuery Advisor,
hereinafter referred to as "nQuery". Proceeding with this installation constitutes your acceptance of this
license agreement with respect to all accompanying nQuery software received by you. If you do not accept
this agreement, you may cease the installation within 10 days of receipt of installation key and your money
will be refunded.

THIS LICENSE AGREEMENT is made and entered into by and between Statistical Solutions Limited, an Irish
registered company, hereinafter referred to as "LICENSOR", and you, hereinafter referred to as "LICENSEE".

WHEREAS, LICENSOR has ownership rights of nQuery ("SOFTWARE") and LICENSEE desires to obtain
from LICENSOR, and LICENSOR desires to grant to LICENSEE, a license to use the aforementioned nQuery.

NOW, THEREFORE, in consideration of the mutual covenants, conditions and terms hereinafter set forth,
and for other good and valuable consideration, the parties hereto hereby agree as follows:

I. GRANT

A. Subject to the provisions contained herein, LICENSOR grants to LICENSEE a non-exclusive, non-transferable
license for the use of SOFTWARE ("LICENSE") which shall not and will not be copied by the LICENSEE
and will not be passed by the LICENSEE to any other person or party, or will the whole or any part of it be
disclosed by the LICENSEE to any other or party.

B. Unless otherwise specifically agreed in writing by the LICENSOR, SOFTWARE may be used solely by
LICENSEE.

C. No title or ownership rights to SOFTWARE are transferred to LICENSEE by this Agreement.
Il. MAINTENANCE

A. LICENSOR agrees to provide maintenance for SOFTWARE for the duration of this Agreement.
B. MAINTENANCE includes the following services and materials.

1. Updates and improvements to SOFTWARE, as these become available.

2. Reasonable written or telephone consultations.

C. Maintenance will be provided only for the release of SOFTWARE which is current at the time maintenance
is required.

I1l. REGISTERED USE

A. LICENSEE agrees that it will maintain SOFTWARE (including any future forms of SOFTWARE provided
to LICENSEE) in confidence.

B. LICENSEE agrees not to knowingly provide, distribute or otherwise make available, in whole or in part
to those outside of LICENSEE'S site, SOFTWARE, or any derivative thereof, including without limitation
program listings and code.

IV. ACCEPTANCE AND PAYMENTS
A. All terms and conditions of this Agreement shall be binding upon purchase of LICENSE by LICENSEE.

B. LICENSEE, for and in consideration and as a condition of purchasing this LICENSE, hereby agrees to pay
over to LICENSOR an annual fee. The yearly fee in effect will become due unless LICENSEE has properly
exercised its right to terminate this Agreement pursuant to paragraph V.B. below.

V. TERM

A. This Agreement shall become effective upon purchase of LICENSE by LICENSEE and shall remain in effect
for an initial period of one (1) year, and thereafter shall be automatically renewed for successive periods of
one (1) year, unless terminated as provided in this Agreement.

B. LICENSEE or LICENSOR shall have the right to terminate this Agreement, at the end of any licensing
period upon written notice, which shall be given to the other party at least sixty (60) days prior to the
expiration of the yearly licensing period. In the event that notice of termination is not given by either party at



least 60 days prior to the expiration of the license period the Agreement shall be deemed effective for another
one year.

C. Either party shall have the right to terminate this Agreement at any time upon violation by the other party
of any of the provisions of this Agreement.

D. Upon termination, of this Agreement, LICENSEE shall destroy all installations of SOFTWARE, LICENSEE
shall promptly forward written notice to LICENSOR that all programs and materials containing SOFTWARE
have been destroyed and are no longer in use or usable by LICENSEE.

VI. WARRANTIES
A. LICENSOR warrants that it has the right to grant this License.

B. LIMITED WARRANTY AND REMEDY. Both parties hereto agreeing that this is not a consumer contract,
LICENSOR warrants that for sixty (60) days after purchase of LICENSE by the LICENSEE, SOFTWARE
shall reasonably perform in accordance with the accompanying documentation (manuals and computer aided
instructions). LICENSOR specifically DOES NOT warrant that SOFTWARE will operate uninterrupted or
error free.

LICENSEE'S SOLE AND EXCLUSIVE REMEDY for a failure of SOFTWARE to perform in accordance with
the accompanying documentation is for the LICENSEE to return SOFTWARE to LICENSOR in writing of
the non-performance within sixty (60) days of purchase of the media. LICENSOR'’S sole obligation within a
reasonable time after receiving notification of non-performance shall be, at LICENSOR'S option to:

1. correct demonstrable and significant program errors.
2. provide the LICENSEE with functionally equivalent software, or
3. provide or authorise a refund.

THE LICENSOR'S LIMITED WARRANTY SET FORTH ABOVE IS IN LIEU OF ANY OTHER WAR-
RANTIES. LICENSOR DISCLAIMS ANY IMPLIED WARRANTY INCLUDING, BUT NOT LIMITED TO
ANY IMPLIED WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE OR MERCHANTABILITY. LI-
CENSOR DISCLAIMS ALL OTHER WARRANTIES INCLUDING, BUT NOT LIMITED TO, THOSE MADE
BY DISTRIBUTORS OF LICENSOR'S SOFTWARE, BUT DOES ATTEMPT TO DISCLAIM OR EXCLUDE
LIABILITY FOR PERSONAL INJURIES WHERE THE LICENSOR HAS AN OBLIGATION FOR SAME UN-
DER LAW.

A. In no event shall LICENSOR become liable to LICENSEE, or any other party, for any loss or damages,
consequential or otherwise, including but not limited to time, money or goodwill arising from the use, opera-
tion or modification of SOFTWARE by LICENSEE. LICENSEE further agrees to indemnify, defend and hold
harmless, its agents or employees from and LICENSOR against all loss or expense resulting from liability of
any nature arising or resulting from the acts or omissions of LICENSEE, its employees or agents, in its use,
possession or operation of SOFTWARE.

B. If any of the provisions, or portion thereof, of this Agreement is invalid under any applicable statute of
law, they are to that extent to be deemed omitted. This Agreement shall constitute the entire agreement
between the parties hereto with respect to the subject matter hereof, and shall supersede all oral, promotional
or advertising presentations. This Agreement may not be modified except in writing signed by an authorised
representative of LICENSOR. The prevailing party in the legal action brought to construe the terms of or
enforce this Agreement shall be entitled to reasonable legal fees and costs. Under no circumstances shall this
Agreement or any of the rights granted to LICENSEE hereunder be sold, assigned or sub-licensed, voluntarily
or by operation of law, to any other person or entity, and any such purported sale, assigned or sublicenses
shall be void.

VII. This agreement shall be governed by the laws of Ireland and the parties agree to the exclusive jurisdiction
of the Irish Court.

VIIl. DATA PROTECTION

Each of the parties shall observe all of their respective obligations under all legislation and regulations relating
to the protection of personal data (including Regulation (EU) 2016/679) that arise in connection with this
Agreement. The parties acknowledge that LICENSEE will not be disclosing or transferring personal data to
LICENSOR and that LICENSOR will not be processing personal data on behalf of LICENSEE.



Contents

1 nQuery Basics 1
1.1 System Requirements . . . . . . . . ... ... 1
1.2 Help and Support . . . . . . . . . 1
1.3 Starting nQuery . . . . . ... 1
1.4 nQuery Start-up and Layout . . . . . . . .. ... .o 2
1.5 Opening a Design Table . . . . .. ... ... ... ... ... ..... 8
1.6 Design Table Layout . . . . . .. .. ... ... . . 12
1.7 Using nQuery Design Tables . . . . . .. .. .. ... .. ... ... .... 14
1.8 Design Table Tools . . . . . . . . .. .. . 22
1.9 Editing Plots . . . . . . . . . 31
2 Advanced nQuery Table Features 33
2.1 Manual Solver Activation . . . . . . . . . ... ... . 33
2.2 Errors and Warnings . . . . . . .. .. Lo Lo 37
2.3 Options Menu . . . . . . . . ... 40
2.4 Print and Report Options . . . . . . . . .. . . . ... ... o1
2.5 Other Topics . . . . . . . . 53
3 Advanced nQuery Assistants 58
3.1 Design Table Side-Tables . . . . . . . . .. ... .. .. ... ... ..... 58
3.2 Compute Standard Deviation Assistants . . . . . ... ... ... ..... 66
3.3 Data Entry Assistant . . . . . . ... 67
3.4 Cumulative Distribution Function Assistants . . . . . . . . . . ... .. .. 69
3.5 Survival Parameter Conversion Assistant . . . . . . . ... ... ... ... 70
3.6 Posterior Error Rate Calculator Assistant . . . . . . . . .. .. ... .. .. 70
4 nQuery Qualification Tools 72
4.1 Installation Qualification (IQ) Tool . . . . . . ... ... ... ... . ... 72
4.2 Operational Qualification (OQ) Tool . . . . .. ... ... ... ... ... 73
5 nQuery Updates and Licensing 44
5.1 Renewing a License . . . . . . . . . . ... 7
5.2 Activating an Add-on Module . . . . . ... ... L 7
5.3 Checking for Software Updates . . . . . . . .. ... ... ... ...... 78
6 nQuery Randomization Lists 80
6.1 Randomization Algorithms . . . . . . . . . . . ... 80
6.2 nQuery Randomization Lists Demonstration . . . . . . .. ... ... ... 86

7 Group Sequential Design (Spending Function, Haybittle-Peto, Wang-Tsiatis,
Unified Family, Custom Boundaries Tables) 142
7.1 Introduction . . . . . . . .. 142



Contents

7.2  Group Sequential Design Theory . . . . . . . . ... ... ... .. ..., 143
7.3 Group Sequential Design Table User Interface . . . . . ... .. .. .. .. 168
8 Group Sequential Design Simulation Tool 243
8.1 Group Sequential Design Simulation Overview . . . . . . . . .. ... ... 243
8.2 Opening Group Sequential Design Simulation Tool . . . . . ... ... .. 244
8.3 Group Sequential Design Simulation Tool Layout . . . . . ... .. .. .. 250
8.4 Group Sequential Design Simulation Input Steps . . . . . . . .. ... ... 253
8.5  Group Sequential Design Simulation Outputs . . . . . ... ... .. ... 277
8.6 Saving/Loading Group Sequential Design Simulation Files . . . .. .. .. 298
8.7 Group Sequential Design Simulation Technical Background . . . . . . .. 299
9 Group Sequential Designs (Lan-DeMets Spending Function Only Tables),
Interim Monitoring & Unblinded Sample Size Re-estimation 318
9.1 Introduction . . . . . . . . . ... 318
9.2 Group Sequential Test Design . . . . . .. ... .. ... .. ... ..... 319
9.3 Interim Monitoring and Unblinded Sample Size Re-estimation . . . . . . . 329
10 Multiple Comparisons Procedure - Modelling (MCP-Mod) 348
10.1 Multiple Comparison Procedures and Modelling (MCP-Mod) Design . . . . 348
10.2 MCP-Mod Demonstration . . . . . . .. .. ... ... ... ... ..... 354
11 nQuery Predict 361
11.1 Trial Milestone Prediction . . . . . . . . .. . ... ... ... ....... 361
11.2 nQuery Predict Demonstration . . . . . .. .. .. ... ... ... 371

Bibliography 593

ii



1 nQuery Basics

This chapter provides a quick guide for how to access nQuery Advisor (referred to as
nQuery from hereon), an overview of nQuery’s various user interface elements, a break-
down of nQuery’s core features and a tutorial on how to conduct a basic sample size
determination or power analysis. nQuery’s more advanced features are described in more
detail in subsequent chapters.

Note that nQuery installation is not covered in this tutorial. Installation guides will have
been provided to you with the application and are also available online in your nQuery
account or in the Knowledge Base at www.statsols.com.

1.1 System Requirements

The minimum system requirements for nQuery 9.4.1.0 are:
» Processor: Intel/AMD (x64-based)
RAM: 2GB
Memory: 1 GB
OS: Microsoft Windows 11, Windows 10 (v1607 or higher)
Other: Microsoft .NET 8

1.2 Help and Support

The easiest way to get statistical or technical support is to contact Statsols using your
nQuery Community User account (see subsection 1.4.1) or to use the Help Centre button
found in the bottom right of the nQuery application Home tab (see subsection 1.4.5).
The nQuery support centre can also be found at the following URL:

« info.statsols.com/help-center

The official nQuery website is www.statsols.com. You can find additional detail on
nQuery, contact information and access to resources such as worked examples and webinar
recordings at our website.

1.3 Starting nQuery

There are multiple ways to open the nQuery application.
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Firstly, nQuery can be opened by double-clicking on the nQuery desktop icon, if selected
during installation.

Secondly, enter nQuery into the Windows search field - the search feature is either directly
embedded in taskbar or within the Start menu depending on Windows OS version. Select
the nQuery application (app) when it appears in the search results.

Thirdly, you can find nQuery within the list of applications in the Start menu. Select
the Start menu in the lower-left. Scroll down to the N section in the alphabetised list of
apps and select the nQuery folder. Click on the nQuery under that folder. Select All
Apps if the full list of apps is not shown by default.

Alternatively, open the nQuery.Application.exe file from the nQuery installation folder.
By default nQuery will be installed in C:\ Program Files (x86)\Statistical Solutions Ltd\nQuery

1.4 nQuery Start-up and Layout

Once the user has launched nQuery, the application will appear as illustrated in Figure 1.1.
The five major elements in the application on start-up are the Home tab (1), the toolbar
(2), the menu bar (3), the tab menu (4) and the information bar (5). These are summarised
in the following section.

Q nQuery - [=] X
File Edit View Assistants Predict Plot Help 3

Em =EEBI6 X [~ gl - 2

Home x ‘+ 4 <

@ Home 1.1 D Recent Files 1.2

Create New Table Create Prediction

Open nQuery File ez Create Randomization List
andomize

&k Packages 1.3 2 Help & Support 1.4

Package E Manual
@ Online Help
& My Account
@} Getting Started
£ Contact Us

nQuery Advanced Expert
Query P 3 Create Support Ticket

Figure 1.1: nQuery on Start-up

1.4.1 Home Tab (1)

When you open nQuery, the software will open the “Home” tab. This window contains
options to open new tables or pre-existing nQuery files, open recent nQuery files, see
which nQuery modules are currently active and support options if you need further help
in using the software. The four quadrants (1.1 to 1.4 from top-left to bottom-right) in
the Home tab are described in more detail below.
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1.4.1.1 Home (1.1)

The Home quadrant (top-left) contains up to four buttons: Create a New Table, Open
an Existing Table, Create Randomization List, Create Prediction

Selecting the Create a New Table button will open the Select Table window where
you can open a new design table for sample size or power calculations. This window is
described in section 1.5

Selecting the Open nQuery File button will open the Open window where you can
open any pre-existing nQuery save file (.nqt, .nqp, .nqd, .nqrl, .nqgs) - the Open window
will be a Windows Explorer dialog.

Selecting the Create Randomization button will open a new Randomization List
tab. The Randomization List feature is described in detail in chapter 6.

Selecting the Create Prediction button will open the New Prediction window where
you can upload interim data files for milestone prediction. nQuery Predict is described in
detail in chapter 11. This option will only be shown if an nQuery Advanced Expert license
is active. Active packages are displayed in the Packages section (1.3 below). To purchase
additional packages, see www. statsols. com.

1.4.1.2 Recent Files (1.2)

The Recent File quadrant (top-right) will contain a list of all save files recently opened
in nQuery. To open a file, select the required file from this list and this save file will open
automatically. An example is provided in Figure 1.2.

“O Recent Files

i Case-Control Phase IV Study - Example 3.nqt
= G: » My Drive » Marketing Materials » Save Files

i Two Arm Cohort Study - Example 2b.nqt
5 G: » My Drive » Marketing Materials » Save Files

i One Arm Cohort Study - Example 2.nqt
5 G: » My Drive » Marketing Materials » Save Files

i One Arm Cohort Study - Example 1.nqt
= G: » My Drive » Marketing Materials » Save Files

Figure 1.2: Recent Files Example
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1.4.1.3 Packages (1.3)

The Packages quadrant (bottom-left) will contain a list of the nQuery packages which are
currently active under your current nQuery license. Packages which are active will have
a tick to the right of the package name. For details on nQuery packages and activating
them, see section 5.2. To purchase additional packages, see www. statsols. com.

The current packages in nQuery Advanced (largest areas covered in brackets) are:

nQuery Advanced (Fixed Term Trial Sample Size)
nQuery Advanced Plus (Bayesian Sample Size)
nQuery Advanced Pro (Adaptive Design)

nQuery Advanced Expert (Milestone Prediction)

1.4.1.4 Help & Support (1.4)

The Help & Support quadrant (bottom-right) contains a range of help, support and
troubleshooting options for nQuery. These options are as follows:

1.
2.

Manual: This will open the User Manual (this document)

Online Help: This will open the nQuery Knowledge Base website. This website
provides a comprehensive set of instructions for installation, using the software and
common troubleshooting issues with solutions.

. My Account: This will open the nQuery Account Administrator Portal. Your

nQuery account website will contain access to the relevant installers, activation
keys and installer guides.

Getting Started: This will open the “How to Use nQuery” website. This website
contains videos and instructions on all the basic elements of using nQuery for clinical
trial design.

Contact Us: This will open the “nQuery FAQ” website. This website will contain
answers to frequently asked questions (FAQs) about nQuery and provides an “Ask
a Question” facility where you can send a custom query to us online by filling out
the relevant form.

Create a Support Ticket: This will bring you the “Contact nQuery” website. This
page provides access to the multiple support channels available for different types
of query.

1.4.2 Toolbar (2)

The toolbar provides easy access to the most commonly used functions in nQuery. The
toolbar options can be split into five main categories: file options, print options, table
options, side-table options, plotting options and nQuery Predict options. The toolbar is
shown in detail in Figure 1.3.

Note that the nQuery Predict options (15 - 18) will be described further in chapter 11 but
will not be displayed unless an nQuery Advanced Expert license is active. Active packages
are shown in the Packages section of the Home tab.
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Figure 1.3: Toolbar

There are fourteen options in the menu bar. These are as follows:

1.

SR B

I T = S ot
Tl W N = O

16.

17.

18.

New Table (New): Open the Select Table screen

Open Existing Table (Open): Open nQuery table save files

Save Table (Save): Save the currently open nQuery table

Print: Print the currently open nQuery table

Print Preview: Open Print Preview of currently open nQuery table

Undo Action (Undo): Undo last action within currently open nQuery table
Redo Action (Redo): Redo last undone action with currently open nQuery table
Copy Table: Copy all contents of currently open nQuery table

Clear Table: Clear all entries from currently open nQuery table

Fill Right: Fill all entries to the right with the same selected cell value

. Compute Effect Size: Open the Effect Size side-table (if available)

. Compute Covariance Matrix: Open the Covariance Matrix side-table (if available)
. Plot Power vs Sample Size: Plot Power vs Sample plot for selected column(s)

. Plot User Selected Rows: Open custom plot dialog for selected column(s)

. Create New Prediction Workspace (New Prediction): Open new nQuery Predict

workspace. When selected a drop down with two options will be displayed:

a) Prediction with Subject-level Data: Open “New Prediction - Import Datasets”
dialog for uploading interim data

b) Prediction with Fixed Parameters: Open new nQuery Predict Workspace.

Specify the Simulation Parameters (Configure): Return to the Setup stage in the
current nQuery Predict workspace

Add a New Dataset to the Workspace (Add Dataset): Open Import Datasets dialog
to add new dataset to current nQuery Predict workspace

Remove the Selected Dataset from the Workspace (Remove Dataset): Remove the
selected Dataset in Data section from current nQuery Predict workspace.

These options will be explored in further detail later in this manual.

1.4.3 Menu Bar

There are six options on the menu bar: File, Edit, View, Assistants, Plot and Help.
These are shown in Figure 1.4.
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File Edit View Assistants Predict Plot Help

Figure 1.4: Menu Bar

The File menu enables the user to open new tables, existing files and provides access
to additional software options. This menu contains options to open the New design
table menu, Open an existing nQuery save file or save (Save, Save as) the currently
open design table. The most common save file format in nQuery for design tables is the
nqt format. Complex nQuery features use their own file formats - nQuery Predict (.nqp),
Randomization Lists (.nqrl), Group Sequential Simulation (.nqgs) and Data Entry (.nqd).
The File menu also includes options for printing (Print, Print Preview), a dropdown for
Recent Files, the nQuery Options menu and an option to Close nQuery.

The Edit menu enables the user to conduct common actions or changes within the current
nQuery design table. This menu contains options to Undo and Redo actions within the
current table, options to Copy Table or Clear Table for the entirety of the current design
table and an option to fill all right-ward columns with the same value(s) from the currently
selected column(s) using the Fill Right option.

The View menu enables the user to open and close specific nQuery user interface (UT) ele-
ments. The Home option will open or close the initial “Home” tab (subsubsection 1.4.1.1)
in nQuery. The other options enable the user to open or close the table Ul elements of the
Output statement, the Specify Multiple Factors tool, the Help panel and the Notes tool.
These table elements are described in section 1.8. Note all options other than Home are
initially unavailable (greyed out) until the user opens a design table. A currently open
element will have a tick on right-hand side of that option in the View menu.

The Assistants menu gives access to several useful tools that can help with a user’s
calculation. These include access to the Calculate Effect Size and Specify Covariance
Matriz side-tables (if available in the currently open design table tab), access to utilities
for deriving the Standard Deviation, access to cumulative Distribution Functions for mul-
tiple statistical distributions, a Data Entry tool, a Survival Parameter Converter tool, a
Bayesian Posterior Error calculator (note this requires nQuery Advanced Plus or higher
license), the Report feature, the Randomization Lists feature, the Group Sequential Design
Simulator (note this requires nQuery Advanced Pro or higher license) and a shortcut to
the native Windows Calculator (if available). These options are discussed in further detail
in subsequent chapters.

The Predict menu gives access to options to create a new nQuery Predict workspace
and to add or remove datasets in the currently open nQuery Predict workspace. New
Prediction will open a menu with two options: Prediction with Subject-level Data and
Prediction with Fized Parameters. Prediction with Subject-level Data opens the “New
Prediction - Import Datasets” dialog for uploading interim data. Prediction with Fixed
Parameters opens a new blank nQuery Predict Workspace. Add Dataset opens the Import
Datasets dialog to upload additional datasets to the current nQuery Predict workspace.
Remove Dataset removes a dataset selected from the Data field in the current nQuery
Predict workspace. Note that the Predict menu will not be displayed unless an nQuery
Advanced Expert license is active. For details on nQuery packages and activating them,
see section 5.2. To purchase additional packages, see www. statsols. com.

The Plot menu enables a user to generate plots in the current nQuery design table. Once
a table has been opened and a column(s) has been filled appropriately, the user can use
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this menu to create Power vs. Sample Size and Plot User Selected Rows plots. The
table-specific Survival vs Time (for piecewise survival tables such as STT3) and Multiple
Boundary (for Group Sequential (Lan-DeMets Only) tables such as MTT12) are also
available in this menu.

The Help menu gives access to the nQuery Manual (this document), utilities for license
management (Activate/Renew License, Enable Modules (i.e. higher license tiers)), an
option Check for Updates to the latest nQuery version, the Installation Qualification (1Q)
and Operational Qualification (OQ) tools and the About page containing the nQuery
version information and license agreement

For functions which have keyboard shortcuts, these are provided on the right-
hand side of that file menu option.

Below is a complete list of menu options:

File: New, Open, Save, Save As, Print, Print Preview, Recent (horizontal menu), Options,
Close

Edit: Undo, Redo, Fill Right, Copy Table, Clear Table
View: Home, Specify Multiple Factors, Output, Help, Notes

Assistants: Compute Effect Size, Compute Covariance Matrix, Standard Deviation, Data
Entry, Distribution Functions, Survival Parameter Converter, Posterior Error Rate
Calculator (nQuery Advanced Plus or higher), Report, Randomization Lists, Group
Sequential Design Simulator (nQuery Advanced Pro or higher), Windows Calculator

Predict: nQuery Advanced Ezxpert Only - New Prediction (Prediction with Subject-level
Data, Prediction with Fixed Parameters), Add Dataset, Remove Dataset

Plot: Power vs. Sample Size, User-Selected Rows, Survival vs Time plot (STT3/STT3u
tables only), Multiple Boundary (Group Sequential Design (Lan-DeMets Only)
tables only)

Help: nQuery Manual, Activate/Renew License, Enable Modules, Check for Updates,
Installation Qualification, Operational Qualification, About

1.4.4 Tab Menu

The tab menu provides an easy way to navigate between different currently open tables
within nQuery and quickly create fresh copies of open tables. It is shown in Figure 1.5
(note that we have opened some additional tables in nQuery for illustration purposes)

Home X | t-test for Two Means-" X | Prediction 1 x |+ v

Figure 1.5: Tab Menu

There are three main elements to the tab menu: the tabs, the fresh table shortcut and
the table navigation drop-down.
1. Tabs: Individual tabs for each table opened in the session and the “Home” tab. The

tab also has an “x” button on its right-hand side to close an individual tab. The
current open tab will be highlighted compared to the other tabs.
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2. Fresh Tab: If the Home tab is selected or no tabs are available, will open the “Select
Test” menu. If a nQuery table is selected, it will open a clean version of that table
in a new tab. If a nQuery Predict workspace is opened, it will open a copy of the
current workspace state in a new tab.

3. Tab Navigation Menu: If selected, will open a drop-down menu of all tabs currently
open in nQuery. When a tab is selected, this table is displayed in nQuery.

1.4.5 Information Bar

The information bar provides information on the currently opened table and the currently
selected cell in that table. It is shown in Figure 1.6 (note a specific cell was selected for
illustration purposes)

o Group Sequential Test of Two Means-1 ‘ Test Significance Level, c: 0.0250000000

1 2 3

Figure 1.6: Information Bar

There are three main elements to the information bar: the Help Centre, the Table Name
and current Cell Information

1. Help Centre: Selecting the information “i” symbol will open the online help centre
in the default browser. It provides links to guides, troubleshooting and to create a

support ticket
2. Table Name: Provides the name of the currently open table

3. Cell Information: Provides the name and the value (up to 10 decimal places) in the
currently selected table cell

1.5 Opening a Design Table

The next aspect of the interface that will be reviewed is the opening of a new design table.
A design table is the tool which is used to conduct clinical trial design calculations such
as for sample size and power. There are three ways in which the user can open a new
design table in nQuery:

1. Selecting New from the File menu

2. Selecting the New option from the menu bar E

3. Selecting the “+” symbol in the tab menu when the Home tab is open or no tabs
are open in nQuery.

When these options are selected, the Select Table window will open. This is shown in
Figure 1.7.
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Q Select Table - B "

Design Goals No. of Groups Analysis Methods
v'| Fixed v| Means One Group Inequality
Bayesian Proportions Paired Equivalence
Adaptive Survival Cross-over MNon-inferiority
Counts v| Two Intervals
1 Agreement =2
Regression Hierarchical
»  Two-sample t-test (Double-click for options) 2 .

MTT1  Wilcoxon (Mann-Whitney) Rank-Sum Test for Continuous Outcome

MTT2  Wilcoxon (Mann-Whitney) Rank-Sum Test for Ordered Categories

MTT2U Wilcoxon (Mann-Whitney) Rank-Sum Test for Ordered Categories and Unequal n's
MTT3  Two Sample Repeated Measures ANOVA with Greenhouse-Geisser Correction
MTT5  Repeated Measures for Two Means

MTTé  Test for Ratio of Two Incidence Rates using Negative Binomial Model

MTT7  Test for Difference of Two Incidence Rates using Normal Approximation

MATTO Tart far Datim AF Tun lncidamneca Datae vcina Daiceran Kdadal b

Type here to search all tests... 3 Clear Search

4 o Cancel
Figure 1.7: Select Table Window

The Select Table window consists of four main elements: the table selection menus (1),
the table selection window (2), the table search bar (3) and the OK/Cancel buttons (4).

In nQuery, there are two main ways to find a specific design table: the table selection
menus or the table search bar.

Table Selection Menus: The table selection menu consists of four radio button columns.
These are for the Design, the Goal, the No. of Groups and the Analysis Methods. A brief
description of these follows:

1. Design: Specify whether the study analysis will use a Fixed, Bayesian or Adaptive
design.

2. Goal: Specify the type of data which will be analysed in the study. Choose between
Means, Proportions, Survival, Counts, Agreement or Regression.

3. No. of Groups: Specify the number of groups which will be compared in the study.
Choose between One Group, Paired, Cross-over, Two, >2 (Greater than Two) or
Hierarchical

4. Analysis Type: Specify the type of analysis and hypothesis type which will be used
in the study. Choose between Inequality, Equivalence, Non-inferiority, Intervals
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By default no values are selected from the Table Selection Menus and the Table Selection
Window (2, see below) will display a list of every table ordered alphabetically by Table
Code to left of each design table name e.g. AOCO. As options are selected from the Table
Selection Menus, the list is filtered to include only those tables which fulfil that radio
button condition. Note tables can be shown for multiple options within a given radio
button column. The tables filtered for with each radio button are as follows:

In the Design menu, Fized will select all tables which assume a fixed term analysis i.e.
analysis only occurs once all subject follow-up data is available. Bayesian will select
all tables which either use Bayesian inference to improve power calculations or find the
sample size for a specific Bayesian analysis, test or interval. Adaptive will select all tables
which use an adaptive design i.e. where decisions or changes are made to the trial while
it is on-going based on interim data.

In the Goal menu, Means will select all tables related to continuous data (e.g. t-tests,
ANOVA) - this option also includes non-parametric (e.g. Wilcoxon Mann-Whitney U),
incidence rate/counts (e.g. Poisson) or variances (e.g. F-test) analysis options. Pro-
portions will select tables related to binary (e.g. Fisher’s Exact Test), categorical (e.g.
Chi-Squared Tests) and ordinal data (e.g. Proportional Odds Model) analysis. Survival
will select tables related to time-to-event/survival (e.g. Log-Rank Test, Cox Regression)
analysis. Counts will select tables related to counts or incidence rates (e.g. Poisson, Neg-
ative Binomial) analysis. Agreement will select tables related to agreement (e.g. Kappa),
correlation (e.g. Pearson Correlation) or diagnostic screening (e.g. sensitivity, ROC)
data analysis or testing. Regression will select tables related to regression analysis for
continuous (Linear), binary (Logistic), survival (Cox) and incidence rate (Poisson) data.

In the No. of Groups menu, One Group will select all tables where a single group will
be analyzed, most often against a reference parameter value. Paired will select all tables
which are appropriate for a paired analysis (e.g. paired t-test, McNemar test). Cross-over
will select all tables which use a cross-over design (e.g. 2x2 design). Two will select all
tables where two independent (parallel) groups are compared. >2 (Greater than Two) will
select all tables where more than two independent treatment groups are compared (e.g.
ANOVA). Hierarchical will select all tables which analyze hierarchical data structures
such as repeated measures, cluster randomized data or multi-center trials using methods
such as mixed models.

In the Analysis Methods menu, Inequality will select tables where the power for an
inequality (also commonly referred to as superiority) hypothesis test is of interest. Equi-
valence will select tables where the power of an equivalence hypothesis test is of interest
e.g. bioequivalence analyses. Non-inferiority will select tables where the power of an
non-inferiority hypothesis test is of interest - note this option will also include Superiority
by a Margin (also known as Supersuperiority) tables, many non-inferiority tables can also
be used for Superiority by a Margin analysis. Intervals will select tables where a specific
width of confidence or other statistical interval (Bayesian Credible, Prediction, Tolerance)
is targeted.

Table Selection Window: For a given set of table selection menu options or a specific
table search query, the table selection window will display all of the tables which are
consistent with the menu options or search query. For example, in Figure 1.7 the options
selected from the Table Selection Menu are Fixed > Means > Two Groups > Inequality
which corresponds to tables which use a fixed term analysis for the power of a test for a
two sample superiority hypothesis. Relevant options for this combination of menu options
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1.5 Opening a Design Table

include common tests such as Two Sample t-tests, Wilcoxon/Mann-Whitney Rank-Sum
(U) tests and Two Group Repeated Measure ANOVA tests.

To open a table, select the desired table from this Window and select OK in the bottom-
right of the window.

If the number of available tables for a given selection criteria is high, you can use the
scroll bar on the right-hand side to find tables further down the list for the given query.

Note that some types of statistical test have a large number of variants. These variants are
then contained within a sub-menu to reduce the number of options shown by default for
casier searchability. These sub-menus are indicated by a “P” symbol and the test prompt
“(Double-click for options)”. To open the sub-menu select the P symbol or double-click
the table name and the options will appear automatically below the sub-menu title. For
example, in Figure 1.7 the option of “Two-Sample t-test” is a sub-menu option. If we
select the P drop-down menu then the options will appear below the “Two-Sample t-
test” option. This is shown in Figure 1.8.

Q Select Table - B "

Design Goals No. of Groups Analysis Methods
| Fixed v| Means One Group v| Inequality
Bayesian Proportions Paired Equivalence
Adaptive Survival Cross-over MNon-inferiority
Counts v| Two Intervals
Agreement =2
Regression Hierarchical
4 Two-sample t-test (Double-click for options) ~
MTTO  t-test for Two Means
MTTOU t-test for Two Means with Unequal n's
MTT0Ou... Satterthwaite t-test for Two Means with Unequal Variances
MTTOu... Satterthwaite t-test for Two Means with Unequal Variances and Unequal n's
MTTOc... t-test for Fold Change of Two Log-Normal Means
MTTOc... t-test for Fold Change of Two Log-Mormal Means with Unequal n's
MTTOF... t-test for Fold Change with Fold Change Threshold
MTTOF... t-test for Fold Change with Fold Change Threshold and Unequal n's v
Type here to search all tables... Clear Search
OK Cancel

Figure 1.8: Select Table Drop-down

Table Search Bar: The table search bar allows the user to search for tables using a
given text search query. For example if a t-test analysis was being considered, entering

11
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“t-test” into this search bar field would show all of the potential t-test tables in nQuery.
The tables which match the query will be shown in the Table Selection Window. To open
the table, select the table in Table Selection Window and select “OK”. An example of this
is shown in Figure 1.9.

O Select Table - B n

MOEQ Non-Inferiority t-test for Paired Means

MOE1T Non-Inferiority t-test for One Mean

MOE2 Non-Inferiority t-test for One Log-Normal Mean

MOE3 Non-Inferiority t-test for Ratio of Paired Log-Normal Means
MOE4  Equivalence t-test for One Mean

MOES  Equivalence t-test for Paired Means

MOEE& Equivalence t-test for One Log-Normal Mean

MOE7 Equivalence t-test for Ratio of Paired Log-Normal Means
MOTO  t-test for One Mean

t-test ‘ Clear Search

Cancel

Figure 1.9: Table Search Query Example

Note that while a search query is active the Table Select Menu will be disabled (greyed
out). To re-activate the Table Select Menu, click the “Clear Search” button.

OK/Cancel Buttons: These buttons complete the table selection process. When the
desired table from the Table Selection Window is selected, click “OK” and that table will
be opened in nQuery. To close the Select Test Design and Goal window without opening
a table, select the “Cancel” button. Note that selecting the close window option in the
top-right is equivalent to selecting “Cancel”.

1.6 Design Table Layout

nQuery design tables have a large number of shared design elements. This section will
outline the default layout of an nQuery design table and a brief description of these
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elements and their usage. Many of these elements will be covered in more detail in future
chapters. The default layout of the One Way Analysis of Variance (ANOVA) table is
shown in Figure 1.10.

Q nQuery
File Edit View Assistants Predict Plot Help

o = 4 .
Emleag = il

Home X | One-Way Analysis of \  x | +

) 1 2 I 2 x
1 2 3 4 5 6 7 8 9 |[|HO
» | Test Significance Level, «
Number of Groups, 6~ 2,
Variance of Means, V Alphaiis the probability of rejecting the null hypothesis
3 of equal means when it is true (the probability of a Type
| error)

Test Significance Level, a

Power (%)

Sample Size per Group, n Suggestion: 6

Enter 0.05, a frequent standard.

Acceptable Entries:

1e-8sas0.2

Output 7 Help

@ One-Way Analysis of Variance (ANOVA)-1

Figure 1.10: One Way Analysis of Variance Design Table

When a design table is opened, there are seven major elements of interest:
1. Table Title: This is the full name of the design table for the currently open table

2. Design Parameter Row-Names: The names of the design parameters required
for the calculations in this design table.

3. Main Design Table: The table where the values of the design parameters will be
entered for a specific calculation.

4. Solver Drop-down Menu: The menu containing the names of the available solvers
in this design table and the “Run” button to manually activate solvers.

5. Output Window: The window containing the output statement summary for a
solver calculation.

6. Help Window: The window containing the help card for each design parameter
row.

7. Window Selection Tabs: Tabs to navigate between a window’s options. In the
Output window, we can select the Specify Multiple Factors Tool and in the Help
window, the Notes tool.

The usage of each of these elements will be explored in the next section using a tutorial
example from nQuery.
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1.7 Using nQuery Design Tables

1.7 Using nQuery Design Tables

1.7.1 Introduction

In this section, a basic example of using an nQuery design table is provided. A design
table is the tool which is used to conduct clinical trial design calculations such as for
sample size and power. The additional tools and options to assist in conducting a sample
size or power calculation in a design table are also illustrated.

For this example, the One-Way ANOVA table used in section 1.5 and section 1.6 will
continue to be used. This table is shown in Figure 1.11.

Q nQuery - X
File Edit View Assistants Predict Plot Help
Emlllelg =
Home X | One-Way Analysisof \ X | +

2 *x

1 2 3 4 5 6 7 8 9 L, ECES

Test Significance Level, a

Alphais the probability of rejecting the null hypothesis
of equal means when it is true (the probability of a Type

Sample Size per Group, n Suggestion

Enter 0.05, a frequent standard.

Acceptable Entries:

1e-8sas0.2

QOutput L

@ One-Way Analysis of Variance (ANOVA)-1

Figure 1.11: Clean One-Way ANOVA Table Example

In the main design table, each row corresponds to a design parameter which is set by the
user and each column corresponds to an individual design specification. nQuery allows
users to easily calculate the parameters of interest using multiple design specifications
using its intuitive spreadsheet format.

Main table inputs will be either Numeric Inputs (within the allowable range, see subsection 1.7.2
and subsection 2.2.1) or Dropdown Menus.

Numeric inputs will either be floating point double values (e.g. Variance of Means, V),
percentages (e.g. Power) or integers (e.g. Sample Size). Integer rows will automatically
prevent decimal values being inputted.

Dropdown Menus will consist of a list of options for that row. For example, a list of
possible tests for the current design scenario or a list of potential variance calculation
options. The list of options is viewable by selecting the downwards arrow button on the
left of the selected cell - this will open a drop down menu of all available options for that
row. The user can then select the required drop down option for that specific column. In
cases where the dropdown options are all numeric (e.g. 1 or 2 Sided?), the user can use
the drop down menu or enter the numeric input directly.
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1.7 Using nQuery Design Tables

For each row in the left-most column, the definition of that row parameter is given.
In this example, the first row corresponds to the Test Significance Level, o of the
proposed study design. For example, this could be set to 0.05, an common standard for
test significance. Additional detail for each row is provided in the Help window on the
right when that row is selected. See subsection 1.7.2 for details.

To conduct a solver calculation, the full set of mandatory input design parameters
must be filled in a column except for the desired solver value of interest. A solver is
the algorithm used to calculate a design parameter(s) of interest e.g. power, sample size,
given all required algorithm inputs have been provided.

Input-only Rows are rows which are only inputs into one or more of the design table
solvers. These rows will be white in nQuery. In most tables, all these rows are required for
solver activation. However, in some tables one or more of these rows will be optional. For
example in MGTO, the Variance of Means, V and Common Standard Deviation,
o are optional rows as the user can activate the power and sample size solvers directly
using the Effect Size row without these two parameters - these rows exist to calculate
the effect size more easily via an auto-calculation - see subsection 1.7.4.

Solver Rows are rows where nQuery can calculate the result for this row given all other
mandatory inputs have been provided. These rows will be yellow in nQuery. In MGTO,
these are the Power, Sample Size per Group and Effect Size design parameter rows.
Note that in most cases, the other solver rows must be filled to activate a given solver
e.g. the sample size solver requires inputs for the power and effect size.

Read-only Rows are rows which cannot be edited by the user. These rows will be grey
in nQuery. These are usually additional outputs from the solver or an auto-calculation
which are useful to the user.

In this table MGTO, the design parameters are the Test Significance Level, o (input),
the Number of Groups, G (input), the Variance of Means, V (input - optional), the
Common Standard Deviation, o (input - optional), the (standarized) Effect Size,
AZ? (solver), the Power (%) (solver) and the Sample Size per Group, n (solver).

1.7.2 Table Help

To find additional information or guidance on a specific design parameter, use the help
cards provided for that parameter. The help card is summary of currently selected rows
including it’s definition, allowable range and additional useful information and context.
If a specific table row is selected, the Help window on the right-hand side (by default)
will dynamically update to the relevant help card for that selected design parameter.

These help cards have four main potential sections: Main Text, Suggestion, Acceptable
Entries, Aid

Main Text section provides a definition of the parameter for the design.

Suggestion section provides advice on common values for the selected design parameter
or advice on how to derive a value from other potentially known parameters.

Acceptable Entries section provides the range of values which are allowed to be entered
into a given row.
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Aid section provides information on table assistants which can be used to derive this
cell value from other known information (e.g. an Assistants file menu option such as
Compute Effect Size side-table in MGTO - see subsection 1.7.4)

Note that an Aid and/or Suggestion section may not be included in all help cards.

In Figure 1.11, the help card for the test significance level is shown on the right-hand
side. This shows the definition of the significance level as the Type I error, the suggested
value of 0.05 and the acceptable entries of 1E-8 to 0.20.

In Figure 1.12, the help card for the Variance of Means row is shown. In this help card,
there is an example of an Aid section which refers to the usage of an Effect Size side-table
to derive the value for this parameter.

Help -0 %

] o H
K ® @ "

Variance of Means, V

The variance of the means, V, is the variance
of the individual group means, L. It is the
square of the standard deviation of the means.

Acceptable Entries:
= 0.0

Aid:

Once a value is given for Number of Groups,
G, use Compute Effect Size in the Assistants
menu, or select a cell in the Variance of
Means row, to compute the variance of means
using the individual level means. Once
opened, this table can be navigated to and
from using the tabs at the bottom of the
window.

Help

Figure 1.12: Variance of Means Help Card Example

If you want an overall summary for the table, select the Home icon at the top of the
Help window. This will provide a brief summary on how to use the table and provide the
References (academic articles, books, software) used for the design table solvers. The
Home Card for this table is shown in Figure 1.13.
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Help W

(=)

One-Way Analysis of
Variance (ANOVA)

Enter a value for alpha, a, the significance
level for the analysis of variance. Enter
the number of groups (G), the variance of
means, and the common standard
deviation (or the effect size). Enter either
required power or sample size and
nQuery will compute the other. Or enter
power and sample size and nQuery will
compute the detectable effect size.

References:

+« (O'Brien, R.G., Muller, K.E.
"Applied Analysis of Variance in
Behavioral Science" Marcel
Dekker, New York {1993) Chapter
8 pp. 297-344

Help

Figure 1.13: Home Card Example

1.7.3 Activating a Table Solver

To conduct a calculation of interest, we require the usage of a table solver. A solver is
the algorithm used to calculate a design parameter(s) of interest e.g. power, sample size,
given all required algorithm inputs have been provided.

Solver Rows are rows where nQuery can calculate the result for this row given all other
mandatory inputs have been provided. These rows will be yellow in nQuery. In MGTO,
these are the Power, Sample Size per Group and Effect Size design parameter rows.
Note that in most cases, the other solver rows must be filled to activate a given solver
e.g. the sample size solver requires inputs for the power and effect size.

The easiest and most common way to activate a specific solver is to fill in all of the other
mandatory design parameters in a table column except for the parameter of interest. This
will automatically select and calculate the remaining solver design parameter of interest.
Manual methods for selecting and activating solvers are discussed in section 2.1.

After the values for the design parameters which will be used in this study design is
decided, enter these into the relevant column. Each column in a design table corresponds
to an independent solver activation i.e. activity in column 1 has no effect on activity in
column 2.

In this example, assume a sample size calculation is requested and that values given in
Table 1.1 were used for the mandatory design parameters. This design corresponds to
a study which will use a one-way analysis of variance to test the null hypothesis that 3
independent group means are equal at the 0.05 significance level with 80% power, assuming
a “medium” effect size of 0.5 [Cohen, 1988].
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Table 1.1: Example Parameter Values

Parameter ‘ Value ‘
Test Significance Level | 0.05
Number of Groups 3
Effect Size 0.5
Power 80

Remember that the Variance of Means and Common Standard Deviation are optional
parameters and are thus not required for a solver to activate. These rows are provided
for user convenience to derive the (standardized) effect size.

When these values are entered into column one of the design table, the Sample Size per
Group row is automatically populated by the sample size solver algorithm due to it being
a solver row and all other mandatory parameters being specified. This is illustrated in
Figure 1.14

Q‘ nQuery - ] X

File Edit View Assistants Predict Plot Help

Emd®daocnEE5B I B il -
Home X | One-Way Analysis of \ % | + "
MGTO-1/ One-Way Analysis of Variance (ANOVA) * || Help 3 x
1 2 3 fi© 4
Test Significance Level, o 0.050 .
Number of Groups, G 5 Sample Size per Group, n
Variance of Means, V The sample size per group is the number of subjects or
Common Standard Deviation, o observations in each group needed for the specified
Effect Size, A* = V/a® 0.500 power; the larger the sample size, the higher the power

Power (%)
Sample Size per Group, n

to detect a specific alternative effect size.

-

Suggestion:
< > Enter the number of subjects you can afford to study and
Calculate sample size per group v m solve for power.
~TOC. x .
MGTOS * Acceptable Entries:
22
~
Group Mean
H1
2
3
Variance of means, V
W
MGT0S-1 Help

o One-Way Analysis of Variance (ANOVA)-1 | Power (%): 80.000000000

Figure 1.14: Example Solver Answer

In this example, the sample size per group required is 8. This corresponds to a total
sample size of 24 (8 x 3).

When a solver is activated the solver output (in this case the sample size per group in
column 1) will be the only cell still highlighted in yellow (Power and Effect Size are now
input-only white) and that the text of the solver answer will be highlighted in bold. Note
some tables will automatically update the power (or other parameters) to its exact value
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after a non-power solver is used - in these cases the solver will highlight the row of interest
and the power row which contains the exact power.

Any other solver can be activated initially in the same fashion - by inputting sample size
but not power to calculate the power for example. However, in this example the “Calculate
sample size per group” solver is now activated in column 1 and any subsequent change
to this column will only re-calculate the sample size unless this column is subsequently
fully cleared using the “Clear Table” option or “Clear” from the right-click context menu
while that column is highlighted. For more detail on how to manually select and change
solvers, see section 2.1.

This very basic example illustrates the ability of nQuery to easily and quickly find the
appropriate sample size for your study.

1.7.4 Effect Size Side-table and Auto-Calculations

Let’s expand upon this example by using the optional elements and effect size side table
to derive the sample size for a study design where the user can take advantage of the
additional information they have available to find better estimates for the required design
parameter of the Effect Size.

For this example, assume that the common (within-group) standard deviation is assumed
to be equal to 1.1. Assume that the expected group means are also known and are equal
to the values in Table 1.2.

Table 1.2: Tutorial Group Means Example

’ Group # \ Mean Value ‘

1 1.1
2 2.3
3 3.0

To use these group mean values to derive the Variance in Means, use the Compute
Effect Size side-table.

Side-tables are additional tables which allow the user to calculate design table (we will
also refer to as “main table”) inputs from commonly available existing information. Note
that some design tables may have multiple side-tables and that some solvers may use
side-table inputs directly - see section 3.1 for details.

To open this particular side-table, the Number of Groups, G row must be specified in that
column. Once the number of groups is specified in a column, the Compute Effect Size
options will become active in the Assistants menu and menu bar to open the side-table
for the selected column(s).

However, the easiest way to open the side-table in a column is to select the derived
row in that column (i.e. Variance of Means, V here in MGTO0) and the side-table will
automatically open below the main design table (i.e. in the same window as “Output”).

Once the side-table is open, enter the group means into the relevant rows.
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This will activate the Calculate button in the top-left of the side-table window. Select
“Calculate” and this will show the calculated value of ~0.616 in the Variance of Means
row in the side-table.

This activates the Transfer button. Selecting “Transfer” will transfer the value for the
Variance of Means to the relevant row for the current side-table’s column of the main
table. This is shown in column two in Figure 1.15.

Q. nQuery - ] X
Eile Edit View Assistants Predict Plot Help
_ —L — .
Emd®dunnEZRE il
Home X | One-Way Analysisof \ X | + v
MGTO- e-Way Analysis of Variance (ANOVA Help L e
1 2 3 LGRS y
Test Significance Level, 0.050 .
Number of Groups, G B 3 Variance of Means, V
¥ | Variance of Means, V 0.616 The variance of the means, V, is the variance of the
Common Standard Deviation, o individual group means, . It is the sguare of the
Effect Size, A* = V/o® 0500 standard deviation of the means.
Power (%) 80
Sample Size per Group, n B Acceptable Entries:
>0.0
<
o - BIR
Once a value is given for Number of Groups, G, use
MGTOS-2 o )
= Compute Effect Size in the Assistants menu, or select a
Z C 1 Transf al . .
% QI L URLE R | S @D cell in the Variance of Means row, to compute the
Group Mean variance of means using the individual level means.
1 1.100 Once opened, this table can be navigated to and from
2 2.300 using the tabs at the bottom of the window.
3 3.000
*  Variance of means, V e D816 ]
v
MGT0S-2 Help

o One-Way Analysis of Variance (ANOVA)-1 | Variance of Means, V

Figure 1.15: Side Table Example

Note that some side-tables tables will only have a Transfer button - in these side-tables
the required outputs will be calculated automatically for the user in the side-table once
it the side-table is filled appropriately. In other tables there will be neither a Calculate or
Transfer button - in these cases the side-table will automatically calculate and transfer
the required outputs to the main table when the side-table is filled appropriately.

Now enter the Common Standard Deviation value of 1.1 into the relevant main table
row. In this table, the effect size can be derived from the variance in means and the
common standard deviation and thus when these are both specified the effect size will
automatically update to derived value for the values set for those two parameters. In this
example, this equals approximately 0.509. This is shown in Figure 1.16.
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Q nQuery - a X
File Edit View Assistants Predict Plot Help
i 1} 2= s
EmdedacnEGHE gl
Home X | One-Way Analysis of X |+ 7
MGTO-1 / One-Way Analysis of Variance (ANOVA) 2 || Help ¥ x
1 2 3 feo 4
Test Significance Level, a 0.050 . 2
Number of Groups, G 3 3 EffeCt SIZe, A
Variance of Means, V 0616 The effect size is the variance of the means divided by
Common Standard Deviation, o 1.100 the within-group variance (square of the standard
» | Effect Size, A* = V/o® 0.500 P0s09 deviation). The effect size is an index of the separation
Power (%) 80 expected among the observed means.
Sample Size per Group, n 8
Suggestion:
< > Enter a value observed in similar studies.
v IEEXE
Acceptable Entries:
MGTOS-2 X
>0.0
& Compute 'T'H,Transfer & Clear
~
Group Mean
1 1.100
2 2.300
3 3.000
¥ | Variance of means, V 0.616
A4
MGT0S-2 Help

ne-Way Analysis of Variance F fect Size, A = : 0.
@ One-Way Analysis of Vari (ANOVA)-1 Effect Size, A* = V/o: 0.508723600

Figure 1.16: Effect Size Auto-Calculation Example

Note that entering two out of three of these parameters (Variance of Means, Common
Standard Deviation, Effect Size) will always return the third value. Changing any one of
these design parameters after all three are specified will cause one of the other paramet-
ers to change to ensure consistency (e.g. updating the Variance of Means or Common
Standard Deviation would cause the Effect Size row to update).

To complete the example, enter the same significance level (0.05) and power (80) as per
the previous example. This will give the same sample size per group of 8.

1.7.5 Saving and Opening nQuery Files

nQuery design tables can be saved in the nQuery specific file format named .nqt. This
file format allows users to save their work and then share it with other nQuery users or
use this file again in future sessions. The save file will retain the main design table and
any side-tables, output statements, plots and notes generated at the time of saving.

To save an nQuery file, the user can use the Save or Save as options from the File menu

or by using the Save option EI icon in the tool bar.

If the design table has not been saved before or the user selects the Save as option then
the Save menu will appear - see Figure 1.17. Select the desired folder and edit the default
save name in the File Name field if desired. Select Save to save the file.

If the currently open design table has been saved before then selecting the Save option
will automatically overwrite that file with the current updated state of the design table.
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) save As >
«— v ‘& » ThisPC > Documents > Example v (&) O Search Example
Organise = New folder = v 0
= This PC ~ Name - Date modified Type Size

¥ 3D Objects
I Desktop

Mo items match your search.

= Documents
¥ Downloads
J” Music

| Pictures

E Videos

%9 Windows (C)
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File name: | One-Way Analysis of Variance (ANOVA])-1 w

Save as type: |nQuery Files (*.ngt;*.ngp;*.nqd) ~

» Hide Folders Cancel

Figure 1.17: Save Window

To open an nQuery file, the user can select the Open option from the File menu or by

using the Open option = icon in the tool bar.

This will open the Open menu. Select the folder which contains the previously saved .nqt
file and select the file. Select Open to open the file in nQuery. You can also open an
nQuery (.nqt) file by double-clicking the file directly e.g. in Windows Explorer. This will
either open the save file in the last used open nQuery instance or open an instance of
nQuery and open the file in this new nQuery instance.

1.8 Design Table Tools

nQuery features a number of additional tools to help users understand and summarise their
calculations. The tools which will be covered in this section are the Qutput statement,
the Notes tool, the Specify Multiple Factors tool and the Plots options.

1.8.1 Output Statement

The Output statement provides a verbal summary of the results given in a column after
a solver has been activated. This statement can be used as a template for the sample size
justification given in a study protocol, academic paper or similar document.

The output statement is shown by default in the window below the main design table
in nQuery. In this example, due to the usage of the effect size side-table, that window
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1.8 Design Table Tools

currently shows the effect size side table for column two of the main table instead of the
output statement.

To return to the Output statement in this bottom panel, select the “Output” tab on the
left of the tab bar at the bottom of the lower window. The output statement for the

column two calculation will be shown below the main table as per Figure 1.18.

Q- nQuery - ] X
Eile Edit View Assistants Predict Plot Help
- 1) (=—-! L~ .
ESES®duncGEHEB bt 1 il
Home X | One-Way Analysisof \ % | + =
MGTO-1/ One-Way Analysis of Variance (ANOVA * || Help R
1 2 3 fi © p
Test Significance Level, o 0.050 0.050 .
Number of Groups, G 5 5 Sample Size per Group, n
Variance of Means, V 0616 The sample size per group is the number of subjects or
Common Standard Deviation, o 1.100 observations in each group needed for the specified
Effect Size, A® = V/o* 0.500 0.509 power; the larger the sample size, the higher the power
Power (%) 80 80 to detect a specific alternative effect size.
¥ | Sample Size per Group, n 8 8
Suggestion:
= L Enter the number of subjects you can afford to study and
Calculate sample size per group v m solve for power.
Output * X 1 Acceptable Entries:

z2
When the sample size in each of the 3 groups is 8, a one-way analysis of variance will
have 80% power to detect at the 5% level a difference in means characterized by a

variance of means, V, of 0.616, assuming that the common standard deviation is 1.1.

_ove

Qutput Help

o One-Way Analysis of Variance (ANOVA)-1 | Power (%): 80.000000000

Figure 1.18: Output Statement Tutorial Example

The output statement contains multiple convenience functions to extract or edit this
statement within nQuery from either the shortcut icons in the bottom-right of the Output
panel or from the right-click context menu.

To Print the output statement select the Print button (1st icon - printer) in the bottom-
right of the output statement window or use the Print or Print Preview options from the
right-click context menu. Note the Print icon button will open the Print Preview window
not the Print window directly.

To Copy the output statement to the clipboard, use the Copy All button (2nd icon - 2
stacked pages) in the bottom-right of the output statement window or from the right-click
context menu to copy the entire output statement. Alternatively, use the Copy option in
the right-click context menu to copy the currently selected text (e.g. via click and drag).
Note that the Copy context menu option will default to Copy All if no text is selected.

To Edit the output statement, select the Edit button (3rd icon - pencil on paper) in the
bottom-right of the output statement window or from the the right-click context menu.
When finished editing, select the Stop Editing button (3rd icon - tick box) to return the
output statement to read-only status.

23



1.8 Design Table Tools

To Transfer the output statement, select Add to Notes from the right-click context menu.
The Notes tool allows a given output statement to be saved to prevent it being overwritten
if a solver calculation is re-run in the same column. The notes tool also provides additional
editing tools (see subsection 1.8.2) that may be of interest.

Note that where a table has optional design parameter rows, the output statement will
change depending on whether the optional elements have been fully specified in the se-
lected column. For example, the output statement in the column 1 example the output
statement does not contain references to the unspecified optional elements (Variance of
means, Common Standard Deviation) and instead only mentions the mandatory Effect
Size design parameter - see Figure 1.19

When the sample size in each of the 3 groups is 8, 2 one-way analysis of variance will
have 80% power to detect at the 0.05 level an effect size of 0.5.

Output

Figure 1.19: No Optional Elements Output Example

1.8.2 Notes Tool

The Notes tool is a word processor facility integrated into nQuery which allows users to
write and save notes about their calculations directly into their nQuery save file.

By default, it is found in the window to the right of the main table. To open the Notes
tool, select the “Notes” option from the bottom of the Help window in the tab bar. This
Notes Tool window can be seen on the right-hand side of Figure 1.20.
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1.8 Design Table Tools

Q nQuery -
File Edit View Assistants Plot Help
R e
EmEdedmET =
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» | Common Standard Deviation, o 1.100 Links
Effect Size, A” = V/o” 0.500 0509 Parsgraph
Power (%) 80,000 80.000 Styles
Sample Size per Group, n 8 8 Ed‘itmg
< >

Calculate sample size per group v I ] A columns

‘When the sample size in each of the 3 groups is 8, a one-way analysis of variance will have 80% power to detect at
the 0.05 level an effect size of 0.5.

Output Notes

@ One Way Analysis of Variance (ANOVA)-1 | Common Standard Deviation, o

Figure 1.20: Notes Tool Example

At the top of the Notes tool, the toolbar will contain a drop-down for the font and text
size and buttons for the style (bold, italics, underline), copy, cut, paste, paste special,
print and a Symbols menu. The arrow on the right-hand side of the toolbar gives access
to a large variety of advanced tools for formatting, tables, images and other options.
Right-clicking within the editor will open a context menu containing the Edit tools (copy,
cut, paste), indent options, font and paragraph menus, bookmark and hyperlink options.

subsection 1.8.1 shows that Output Statements can be transferred to the Notes tool using
the “Add to Notes” option from the right-click context menu within the Output tab. This
will be automatically placed below any material already in the Notes tab at that point in
time.

1.8.3 Specify Multiple Factors Tool

The Specify Multiple Factors tool provides a method to quickly enter multiple values
for design parameters and to generate all combinations if more than one design parameter
is varied simultaneously.

The Specify Multiple Factors tool is found by default in the window below the main table.
To open the Specify Multiple Factors tool, select the “Specify Multiple Factors” option
from the bottom of the Output/Side-table window in the tab bar. This Specify Multiple
Factors Tool window can be seen on the bottom of Figure 1.21.
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Figure 1.21: Specify Multiple Factors Tool Example

The Specify Multiple Factors tool allows a maximum of eight values per design parameter.

In this example, the Test Significance Level will be evaluated at 0.05, 0.025 and 0.001
and the number of groups will be evaluated at 3 and 4. The Variance in Means,
Common Standard Deviation and Power will be fixed at 0.5, 1 and 80 respectively.

This will calculate the empty Sample Size per Group row automatically via the sample
size solver algorithm for all 6 scenarios (3 x 2 x 1 x 1 x 1) specified by these inputs. Note
that the Effect Size row is also left empty since it will be calculated from the Variance
of Means and Common Standard Deviation transferred into the main table via an auto-
calculation (i.e. formula given in the Effect Size rowname).

To clear the inputs from the Specify Multiple Factors tool and reset the tool, select the
Clear button on the right of the window.

To transfer these inputs into the main table by selecting the Fill button on the right-hand
side of the window. The results for this set of inputs is shown in Figure 1.22.
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Figure 1.22: Specify Multiple Factors Output Example

If the number of column combinations exceeds the number of columns open in the table,
the table will automatically create additional columns up to the maximum number of
columns. If the number of column combinations exceeds the allowed maximum number
of columns then a warning will be given and only the first number of combinations equal
to the maximum number of columns will be shown. The maximum number of columns is
configurable in Options menu - see section 2.3.

For rows which contain a dropdown menu (e.g. 1 or 2 Sided Test?), a drop down menu
will exist for all cells for that row in the Specify Multiple Factors tool. By default, all
cells will have the same drop down option selected but the user can manually select other
drop down options as per the main table. If there are duplicate cells in that row of the
Specify Multiple Factors tool, the duplicates will be ignored.

1.8.4 Plot Power vs Sample Size

The Power vs Sample Size plot provides a quick visual overview of the relationship
between power and sample size over a reasonable range of power while fixing the other
elements in calculation.

The Power vs. Sample Size plot can be activated in two ways: using the Plot menu drop-
down option Plot Power vs Sample Size or using the tool bar Plot Power vs Sample Size

",
button Ii . Note that both of these options will be inactive for a selected column until
that column contains inputs for at least all of the mandatory design parameters except for
the power and sample size. After selecting the desired Power vs Sample Size plot option,
the plot will appear in a separate windown in the nQuery application foreground.

If you want to compare visually across multiple (appropriately filled) columns, select
cells in all of the desired columns and select the plot options as above. A plot will be
generated where all columns’s results will be displayed simultaneously. The Ctrl+Left
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1.8 Design Table Tools

Click (to select multiple individual cells) or Shift+Left Click (to select a range of cells)
shortcuts may assist in selecting multiple columns in nQuery.

An example of an individual and multiple column versions of the Power vs Sample Size plot
are shown in Figure 1.23. In this example, the plots are for the six columns generated
from the Specify Multiple Factors example above, with the individual plot being from
column 1.

Q nQuery - X

-8 x

Power vs Sample Size / Column 1 x x

Power vs Sample Size Power vs Sample Size

100 100

% P

/

%)

N

Power (%)
Power (

-
§55555

40

6 9 12 15 10 20

Sample Size Sample Size

Figure 1.23: Power vs Sample Size Example

Highlighting a point in the plot will display the exact values for the X-axis and Y-axis
value selected for each column - this can be seen in the multiple columns example on the
right.

Right-clicking on the plot will open a context menu which provides options to Print, open
a Print Preview, Save the plot as an image file and options to edit the plot (seesection 1.9).
These options are also available from the Edit... menu in the top-left of the plot window.

1.8.5 Plot User Selected Rows

The Plot User Selected Rows plot provides a customisable tool to visually assess
the relationship between any of the continuous/integer design parameters and any of the
available solvers given all unselected design parameters are fixed.

The Plot User Selected Rows menu can be activated in two ways: using the Plot menu
drop-down option Plot User Selected Rows or using the tool bar Plot User Selected Row

button — . Both of these options will be inactive until a column is filled sufficiently for
at least one valid custom plot to be available.

After a column is filled appropriately, select the Plot menu or menu bar option and this
will open the Select X-axis, Y-axis window. This menu is shown in Figure 1.24.
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Select X-axis, Y-axis

H-awis and Y-axis varables

K-axis: | Sample Size per Group, n ™

Y-axis: | Effect Size, A® = /& w

¥-awis range and step size
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Max value: 200 (&

Step size: 10 |
OK Cancel

Figure 1.24: “Select X-axis, Y-axis” Plot User Selected Rows Menu Example

The X-axis drop-down will contain the full list of design parameters which are of either
a continuous or integer type which would have an effect on the solver algorithm output.

The Y-axis drop-down will contain the list of the all the solvers available in the table.
This table allows us to create a combination of any of these two lists to create a custom
plot to assess the relationship between the select X and Y axis options.

When an X-axis option is selected, the user can specify the range over which that design
parameter will be varied in the plot by specifying a minimum value and maximum value
for this range by using the Min value and Max value options. The Step Size input is
then used to specify the size/increment that will the X-axis parameter will increase by to
reach the maximum from the minimum value. Default values will be given for the Max
value, Min value and Step size for each X-axis option in a given table.

The number of steps can be found by dividing the range by the step size (round down if
answer is a non-integer) i.e. (Max value - Min value)/(Step Size)

For example with the Sample Size per Group as the X-axis selection and a Min value of
2, a Max value of 200 and a Step Size of 10 the plotted values for the selected Y-axis
solver (Effect Size or Power) along the X-axis will be 2, 12, 22 ... 172, 182, 192. Note
where Step Size leads to an “overhang” the first value above Max Value will be ignored
e.g. 202 would not be plotted in this example.

Note the OK button will be disabled if any of the inputs are inconsistent (e.g. Max
Value < Min Value), the Min Value or Max Value are inconsistent with X-axis
option’s Acceptable Entries or if the Step Size would lead to too few (<5) or too many
(>1000) points on the plot.

However, it is still possible for a solver to generate an error for one or more of the specified
X-axis values - in this case these points will be automatically be removed from the plot.
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1.8 Design Table Tools

Where all points generate an error the plot will be empty except for an explanatory error
at the top of the plot window.

If you want to compare visually across multiple (appropriately filled) columns, select
cells in all of the desired columns and select the plot options as above. A plot will be
generated where all columns’s results will be displayed simultaneously. The Ctrl+4Left
Click (to select multiple individual cells) or Shift+Left Click (to select a range of cells)
shortcuts may assist in selecting multiple columns in nQuery.

An example of an individual and multiple column versions of the Plot User Selected Rows
plot are shown in Figure 1.25.

In this example, the plots are for the six columns generated from the Specify Multiple
Factors MGTO example above. The individual column plot is for column 1 where the
X-axis option was the Test Significance Level, using the default 0.01 to 0.2 by 0.0095
X-axis range, and Y-axis option was the Effect Size. The multiple columns plot is for the
six column where the X-axis option was the Sample Size per Group, with a custom range
of 5 to 30 by 1 X-axis range, and Y-axis option was Effect Size.
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User-Selected Rows / Column 1 x x
Effect Size, A% = V/o? vs. Test Significance Level, a Effect Size, A? = V/o® vs. Sample Size per Group, n
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— 16: 0.260
— 16:0480
16: 0.182
16:0.218
— 16:0.386

Effect Size, A* = V/a®
Effect Size, A* = V/o®
|

e
§55555
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0 005 0.1 0.15 02 10 20 30

Test Significance Level, a Sample Size per Group, n

Figure 1.25: Plot User Selected Rows Example

Highlighting a point in the plot will display the exact values for the X-axis and Y-axis
value selected for each column - this can be seen in the multiple columns example on the
right.

Right-clicking on the plot will open a context menu which provides options to Print, open
a Print Preview, Save the plot as an image file and options to edit the plot (seesection 1.9).
These options are also available from the Edit... menu in the top-left of the plot window.
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1.9 Editing Plots

nQuery provides options to edit the default Power vs N and User Selected rows plots. To
edit these plots, select the “Edit...” button from the top-left corner of the plot or use
the dropdown context menus available when right-clicking on the plot.

In the edit menu, there will be options for Print, Print Preview and Save As which allow
the printing and saving of the current plot. There are the following options for editing a
plot

1. Titles (Edit Table and Axis Titles)
2. Series (Edit Series names and colors)
3. Gridlines (Add and Edit Gridlines)
4. Legend (Add and Edit Legend)

1.9.1 Titles Options

The Titles menu contains options for the three main table titles: the Chart Title (above
plot), the X-axis Title (below plot), the Y-axis Title (left of plot). Each of these titles
has the same three options for editing:

1. Hide/Show Title: Hide or show selected title in plot
2. Rename: Rename title in separate Rename Title dialog window.

3. Font: Edit Font, Size, Style (Bold, Italics) and Text Color (“More Colors” for
custom colors) in separate Update Title Font dialog window

1.9.2 Series Options

The Series menu contains options for updating the x-axis range and editing the color and
name of each series (i.e. selected column) in the plot. If a single series is in the current
plot, the following three options will be available:

1. Update X-axis range: Edit range of x-axis displayed in plot in separate Update
X-axis Range dialog window - contains same Min Value, Max Value and Step Size
options as per Plot User Selected rows

2. Marker Style: Edit range of x-axis displayed in plot in separate Update X-axis
Range dialog window - contains same Min Value, Max Value and Step Size options
as per Plot User Selected rows

3. Marker Size: Edit range of x-axis displayed in plot in separate Update X-axis
Range dialog window - contains same Min Value, Max Value and Step Size options
as per Plot User Selected rows

4. Rename: Rename series in separate Rename Series dialog window. This will
update the series name shown in the plot Legend (if displayed). By default the
series name will be set to Column 1, Column 2 etc. The user can manually change
the column title in both the design table and the displayed series name here by
double-clicking the column title number at the top of that column and editing the
column title manually.
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5. Color: Change the color used for series (column) in Select Series Color dialog
window. Select an existing color or generate a custom color by selecting the More
colors option. By default, nQuery uses a grayscale color scheme.

If more than two series (columns) are selected in the current plot, this menu will have
the same Update X-axis range option but then separate dropdown options with the
names of all the input series in the current plot. If you select a specific series dropdown,
the Rename and Color options will be available for that specific series which will work
as above.

1.9.3 Gridlines Options

The Gridlines menu contains options to add and remove gridlines for the X and Y axes.
This menu contains the following options:

1. Hide/Show X-axis gridlines: Hide or show X-axis gridlines depending if shown
at present

2. Hide/Show Y-axis gridlines: Hide or show Y-axis gridlines depending if shown
at present

These main gridlines will be in-line with the tick marks for the relevant axis with four
equally spaced minor gridlines between each main gridline.

1.9.4 Legend Options

The Legend menu contains options to add and remove the legend and to edit the hori-
zontal and vertical position of the legend. This menu contains the following options:

1. Hide/Show Legend: Hide or show legend depending if shown at present

2. Horizontal Position: Selecting this will open a sub-menu for legend locations.
This menu gives five options to place the legend: Left inside, Left outside, Center,
Right inside, Right outside. Select the desired option to change the position

3. Vertical Position: Selecting this will open a sub-menu for legend locations. This
menu gives five options to place the legend: Top inside, Top outside, Center, Bottom
inside, Bottom outside. Select the desired option to change the position

Inside/QOutside refer to whether the legend should be included in the plot area itself
(inside) or placed outside the plot area (outside). Note that changing the line colors and
legend series names is done using the Series options described above. Series names can
also be edited using the column name feature by double-clicking the column title in the
main table before creating a plot.
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2 Advanced nQuery Table Features

2.1 Manual Solver Activation

In nQuery, the easiest way to generate a result is to use the auto-activation of a solver.
An example of auto-activation is given in subsection 1.7.3. In short, a solver will auto-
matically activate if all the mandatory elements in a design table are filled except for a
solver row - solver rows are yellow in the design table.

However, in certain cases, a user may wish to fix a column to use a specific solver regardless
of user inputs or change the solver being used in an already completed column. Both of
these are covered in the following section and will make use of the Solver Drop-down
Menu and Run button referenced in Figure 1.10.

2.1.1 Manually Fixing a Column Solver

To fix the solver which will be used in a given column, open a design table and select the
column or columns which will have their solver fixed.

To do this, select a cell or cells in the column(s) of interest or select the full column(s) by
selecting the column title(s). This can be achieved by clicking and dragging for multiple
cells or by holding down Ctrl (individual cells/columns) or Shift (range of cells/columns)
while selecting cells or columns.

After the cell(s) or column(s) are selected, the solver can be fixed by selecting a specific
option from the Solver Drop-down menu. These options are illustrated for the One Sample
Chi-Square Test in Figure 2.1.
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Q. nQuery - a
File Edit View Assistants Predict Plot Help
. = . Lo . . .
Emwl e Q! BEE S X W[k
| Home x ‘ One-Way Analysis of \ X ‘ Chi Square Test for O % ‘ o
POTQ-1/ Chi Square Test for One Proportion Help ¥

(I T R

¥ | Test Significance Level, a
1 or 2 Sided Test? 2 2
Null Hypothesis Proportion, m,

Alternative Proportion, T,
Power (%)
Sample Size, n

Calculate power

Calculate sample size

o Chi Square Test for One Proportion-1 ‘ Test Significance Level, a

[e NN Specify Multiple Factors

ftee
Test Significance Level,
a

Alpha is the probability of rejecting
the null hypothesis that the
proportion equals the specified
value when it is true (the
probability of a Type | error).

Suggestion:

Enter 0.05, a frequent standard

Acceptable Entries:
0.00110 0.20

Figure 2.1: Solver Drop-down Menu Example

The One Sample Chi-Square test has two solvers available: Calculate power and Cal-

culate sample size.

In this example, the power solver will be fixed for the first three columns of the table by
selecting the “Calculate power” option from the solver drop-down while the first three

columns are highlighted as in Figure 2.1.

As the solver is fixed for these three columns, entering the design parameters in a column
which would activate the power solver will calculate the appropriate power for those
design parameters. However, entering parameter values which would activate the sample

size solver does not generate any solver output. This is illustrated in Figure 2.2.
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Figure 2.2: Solver Manual Activation Example

In this example, the first column has successfully generated the power but in the second
column the values generate no result even though this column would generate the sample
size if it was in its default initial state i.e. where solver dropdown was empty.

In every table the first option in the solver drop-down is a “blank” option. If this option is
selected, the selected column(s) will reset to auto-selecting a solver as per subsection 1.7.3.

2.1.2 Changing a Filled Column’s Solver

After a solver is activated and generates a solver output result (either automatically or
manually) in a column, the user may be interested in changing the solver being used in
that column. There are two main methods to achieve this: Reset the column or Select an
alternative solver

2.1.2.1 Reset Column
To reset a column, there are three main methods: Clear Table, Clear Column, Blank
Solver Option

1. Clear Table: Selecting Clear Table from the Edit menu or the menu bar will reset
all columns to their default state where any solver can be automatically or manually
activated.
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2.1 Manual Solver Activation

2. Clear Column: Highlighting a column(s) by selecting the column title or all the
cells in a column and then selecting “Clear” from the right-click context menu will
return the column to its default state

3. Blank Solver Option: Selecting a column and selecting the first “blank” option
from the Solver Drop-down menu will reset the column to its default state

Unlike the Clear options, the Blank Solver option can be used on a partially filled or
a fully filled column. If a column if fully filled and the blank option is selected, a new
calculation can be activated by changing a value in the affected column(s) or by selecting
the “Run” button to the right of the solver drop-down menu. The first calculation in the
solver drop down list will be selected by default if the column is completely full and either
the Run button is used or a subsequent edit it made to activate the solver.

2.1.2.2 Select Alternative Solver

To select an alternative solver select the column(s) or interest, open the Solver Drop-down
menu and select the solver which is desired. After an alternative solver is selected, it will
be activated if a cell is changed in the affected column(s) or by using the Run button
to the right of the solver drop-down menu. Selecting the sample size solver and using the
Run button is illustrated in Figure 2.3.

Q- nQuery - m} X

File Edit View Assistants Predict Plot Help

EndadunnEE e 71 gl -
Home X | One-Way Analysis of X | Chi Square TestforOn % | + B3
POTO-1/ Chi Square Test for One Proportion ® || Help T X
Power Sample Size 3 4 5 fe 4
Test Significance Level, a 0.050 0.050
1 or 2 Sided Test? 2 2 2 2 2 NU" HypOtheSiS
» | Null Hypothesis Proportion, T, 0.500 0.500 Proportion, TTe
Alternative Proportion, m, 0.600 0.600
Power (%) 81.23 20 The expected proportion under the
Sample Size, n 200 194 null hypothesis is denoted by TTo.
Suggestion:
< ’ Use values observed in similar
Calculate sample size e m published studies or in pilot
studies.
| Calculate power r X

Calculate sample size .
Acceptable Entries:

A one group ¥? test with a 5% two-sided significance level will have 80% power to detect the difference Any value between 0 and 1 that is
between the Null hypothesis proportion, mg, of 0.5 and the Alternative proportion, 1y, of 0.6 when the sample
size is 194. not equal to .
20
Output Help

@ Chi Square Test for One Proportion-1 ‘ Null Hypothesis Proportion, Ti,: 0.500000000

Figure 2.3: Manual Solver Change Example
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2.2 Errors and Warnings

nQuery provides a number of errors and warnings to prevent incorrect values being entered
or when a solver cannot find a legitimate answer. There are three primary types of errors
and warnings in nQuery: Out of Range errors, Solver errors, Solver Warnings.

2.2.1 Out of Range Errors

Out of range errors occur when a value is entered into a design table or side-table cell
which is outside the acceptable entries for that cell. The acceptable entries for a given
cell can be found in the Help card for that cell (see subsection 1.7.2).

This error will typically occur due to incorrect direct user input but note that out of range
errors can occur due to table auto-calculations.

For example, the auto-calculation for the Effect Size row in MOTO - One Sample t-
test can be outside the acceptable entries of 0.1 to 40 when derived from the optional
element values of the Null Hypothesis Mean, Alternative Hypothesis Mean and
Standard Deviation.

Note these errors will also be generated in side-tables. A common scenario in side-tables
is where there are read-only auto-calculated cells which contain the sum of the write-
able elements of the side-tables (e.g. POT2 - Chi-Square Test for Proportions in
Multiple Categories).

When an out or range error occurs, a red @ symbol will appear on the left-hand side of
the affected cell. Placing the mouse over the cell will provide a tooltip which gives a brief
summary of the allowable values in the cell. An example of this is shown in Figure 2.4.

MOTO-1/ One Group t-test That a Mean Equals User-Specified Value r
1 2 3 4
Test Significance Level, o 0.050
1 or 2 sided 2 2 2 2
MNull Hypothesis Mean, o 0.000 0.000
Alternative Hypothesis Mean, pa 1.000 40,000
Standard Deviation, o (] -1.000 0.500
b | Effect Size, & = |pa - puo|/o Q 50,000
Power (%)

. & must be greater than 0 and less than or equal to 40
Sample Size, n =

< >

Figure 2.4: Out of Range Error Example

While an out of range error is present in a design table column, no solver activation can
occur in that column. In a side-table, an out of range error will prevent the side-table
from being able to Compute or Transfer values.
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2.2.2 Solver Errors

Solver errors occur when a solver cannot find a solution for the given inputs. This is
most common when the design parameter inputs were too extreme (e.g. leading to the
solver algorithm outputting an infinity or NA) or when the solver reached a numerical
limit (e.g. too wide array search leading to memory overflow). These errors indicate that
either there is no correct result for the design parameters provided or that the correct
solver result was too extreme to be found by nQuery’s solver algorithm. (e.g. <1E-10)

When a solver error occurs, the affected cell will be highlighted in red. If you hover the
mouse over the affected cell, a brief description of the error will be given.

An example is given in Figure 2.5 where the population size is too low causing there to
be no legitimate output for the Lgamma function due to there being no value for the
adjusted sample size which would achieve 80% power.

MOTOF-1/ One Group t-test That a Mean Equals User-Specified Value with Finite Popula... *

1 2 3 4

Test Significance Level, « 0.050

1 or 2 Sided 2 2 2 2

MNull Hypothesis Mean, p, 1.000

Alternative Hypothesis Mean, pa 2.000

Standard Deviation, o 1.000

Effect Size, & = |pa - o/ 1.000

Power (%) 80.00%

Population Size, N 3

Adjusted Sample Size, n, | Lgamma did not return a number. Increase population size or effect size |

< >

Calculate required sample size for given power o m All columns

Figure 2.5: Solver Error Example

2.2.3 Solver Warnings

Solver warnings occur when a solver result is given but there are issues which would cause
concern over the veracity of the result given. The two major categories of solver warnings
are Rounding Warnings and Assumption Warnings.

1. Rounding Warnings: These occur if the solver output was rounded due to being
too extreme originally.

2. Assumption Warnings: These occur if an underlying assumption of study design
is not met by the current design parameters.

Examples of rounding warnings include nQuery rounding the sample size up to two when
it was below two and rounding the power down to 99% when it was greater than 99%.

Examples of assumption warnings include the minimum cell count being too low for chi-
square tests and the normal approximation not holding when the population size and
sample size are too similar when the finite population adjustment is being used.
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When a solver warning occurs, the background is clear and the solver answer value is
red. Unlike Solver Errors, Solver Warnings do not prevent the user from generating a
solver result but they do provide additional context to prevent over-interpretation of a
questionable sample size or power calculation.

This is illustrated in Figure 2.6 where column one has a “Calculate power” solver warning
for the minimum cell count being low and the column two has a “Calculate power” solver
warning that the power was rounded down to 99% due to being “unrealistically” high.
As per the errors above, the specific warning is viewable by placing your cursor over the
affected cell(s).

POTOF-1/ One Group Test on Proportion Adjusted for Finite Population 1

1 2 3 4
Test Significance Level, o 0.050 0.050
1 or 2 Sided Test? 2 2 2 2
Mull Hypothesis Proportion, T, 0.010 0.500
Alternative Proportion, 0.020 0.600
Power (%) 95.73% 99.00%
Population Size, N 100 1000

k| mg a5
£ >

Calculate power A m All columns

Figure 2.6: Solver Warning Example

2.2.4 Application Logging

When nQuery opens a table or encounters an error, these are logged automatically by
nQuery. If you want to track errors in the application or asked to provide additional
information to the nQuery Technical Support Team then these logs can be useful. An
example is given in Figure 2.7.

File Edit Format View Help

ﬁﬂl?—ﬂs—lﬁ 89:25:58.4012| INFO| nQuery .Desktop . ViewModels. TestViewModel| Created new test MIT12 / GroupSequentialTestOfTwoMeans =
20817-88-15 89:26:16.9788| ERROR | nQuery .Desktop.Rules.TestRuleEngine|Exception thrown when executing validation rule Validate power

2017-88-15 ©9:26:208.4691| ERROR | nQuery .Desktop.Rules.TestRuleEngine|Exception thrown when executing validation rule Validate group 1 standard deviat
2017-88-15 ©9:26:208.4861| ERROR | nQuery .Desktop.Rules.TestRuleEngine|Exception thrown when executing validation rule Validate group 2 standard deviat
2017-88-15 ©9:26:20.4861| ERROR | nQuery.Desktop.Rules.TestRuleEngine|Exception thrown when executing validation rule Validate effect size

2017-88-15 ©9:26:208.4861| ERROR | nQuery.Desktop.Rules.TestRuleEngine|Exception thrown when executing validation rule Validate sample size 1

2017-88-15 ©9:26:20.4861| ERROR | nQuery.Desktop.Rules.TestRuleEngine|Exception thrown when executing validation rule Validate sample size 2

2017-88-15 ©9:26:20.4861| ERROR | nQuery.Desktop.Rules.TestRuleEngine|Exception thrown when executing validation rule Validate Cost Per Sample
2017-88-15 ©9:26:22.1832| ERROR | nQuery .Desktop.Rules.TestRuleEngine|Exception thrown when executing validation rule Validate group 2 standard deviat
2017-88-15 ©9:26:22.1832| ERROR | nQuery .Desktop.Rules.TestRuleEngine|Exception thrown when executing validation rule Validate effect size

2017-88-15 ©9:26:23.7423| ERROR | nQuery .Desktop.Rules.TestRuleEngine|Exception thrown when executing validation rule Validate sample size 1

2017-88-15 ©9:26:23.7423| ERROR | nQuery.Desktop.Rules.TestRuleEngine|Exception thrown when executing validation rule Validate sample size 2

2017-88-15 ©9:26:23.7423| ERROR |nQuery.Desktop.Rules.TestRuleEngine|Exception thrown when executing validation rule Validate Cost Per Sample
2017-88-15 108:47:35.6658| INFO|nQuery .Desktop.ViewModels.TestViewModel |Created new test PTT4 / ProportionsMantelHaenszelCochranTestOfOR1linSstrata
2017-88-15 11:08:28.7026| ERROR | nQuery .Desktop.Controls.AboutViewModel|Failed to read license agreement file ©
< >

Figure 2.7: nQuery Log Example

By default, these logs are saved in “C:/Users/<Username>/AppData/Roaming/nQuery/Logs”
- where <Username> is the name of the Windows account associated with the nQuery
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installation. The save location for the Log can be changed in the Options menu (see
section 2.3).

2.3 Options Menu

The Options menu gives the user the ability to change a number of nQuery features to
reflect a users preferences for the software.

The Options menu can be opened by selected Options item from the File menu in the
top-left of the nQuery software.

2.3.1 Application-Wide Options

The application-wide options are shown in Figure 2.8 with their default settings.

40



2.3 Options Menu

F |

Options
General
Auto-calculation On [ |
Initial number of columns 20
Minimum number of columns 8
Maximum number of columns 100
MNumber of decimal places (for percentage val... 2
MNumber of decimal places (other floating-poi... 3
Default Table Save/Load Folder ChUsers\Ronan\Documents
Open Most Recent Folder? On [ |
Output View
Font family Segoe Ul Semilight
Font size 11
MNumber of decimal places (for percentage val... 2
Number of decimal places (other floating-poi... 3
Printing
MNumber of decimal places (for percentage val... 2
Number of decimal places (other floating-poi... 3
Automatic Updates
Auto-update On [ |
Logging
Logging On [ |
Log level Info
Log files folder Ch\Users\Ronan\AppData\Roaming\nQueny\Logs

Cancel

W

Figure 2.8: Application Options Menu

There are three main categories of application-wide settings. These are named and de-
scribed below:

1.

General Settings: Determine number of columns shown in design tables, num-
ber of decimals shown in design table cells and save/load folder default locations.

Following fields available:

a) Auto-calculation: Toggle whether solvers are activated automatically if column
is filled appropriately. If disabled, solvers are only activated via the Run button

- Default: On

b) Initial number of columns: Set the number of columns included in a design
table when opened initially - Default: 20

¢) Minimum number of columns: Set the minimum number of columns in a
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design table. Resets to this value if the number of Specify Multiple Factors
combinations is less than this value - Default: 8

d) Maximum number of columns: Set the maximum number of columns in
a design table. Resets to this value if the number of Specify Multiple Factors
combinations is more than this value - Default: 100

e) Number of decimal places (for percentages): Set number of decimals
displayed for percentage rows in tables e.g. power - Default: 2

f) Number of decimal places (other floating-point values): Set number of
decimals displayed for all non-percentage rows in tables e.g. means, propor-
tions, effect size - Default: 3

g) Default Table Save/Load Folder: Default folder shown in Save/Open win-
dows in nQuery - Default: C:\Users|<Username>\Documents

h) Open Most Recent Folder?: Toggle for whether to show folder most re-
cently used to save or open an nQuery table file (.nqt) - Default: On

2. Output View: Determine fonts and number of decimals shown in Output state-
ments. Following fields available:

a) Font Family: Select the font family used in the Output window text - Default:
Segoe UI Semilight

b) Font Size: Select the font size used in the Output window text - Default: 11

c¢) Number of decimal places (for percentages): Set number of decimals
displayed for percentage rows in output statement e.g. power - Default: 2

d) Number of decimal places (other floating-point values): Set number of
decimals displayed for all non-percentage rows in output statement e.g. means,
proportions, effect size - Default: 3

3. Printing: Determine number of decimals shown in Print Preview. Following fields
available:

a) Number of decimal places (for percentages): Set number of decimals
displayed for percentage rows in print preview e.g. power - Default: 2

b) Number of decimal places (other floating-point values): Set number of
decimals displayed for all non-percentage rows in output statement e.g. means,
proportions, effect size - Default: 3

4. Automatic Updates: Determine if software should automatically alert user if
software update is available. Following field available:

a) Auto-update: Select if software should prompt user to install update if avail-
able on software start-up - Default: On

5. Logging: Determine if nQuery log should be generated, which information to log
and location to save log files. Following fields available:

a) Logging: Toggle whether logging occurs - Default: On

b) Log Level: Change the level of event logged by nQuery. Options are Trace,
Debug, Info, Warning, Error - Default: Info

¢) Log Files Folder: Specify file location where log file is saved Default: C:\Users|<Username:
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2.3 Options Menu

2.3.2 Chart (Plotting) Options

This section contains options to edit all default options for plots. The plot options are
discussed in details in section 1.9 and are editable within each plot individually.

These options are shown in Figure 2.9 with their default settings.
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4 Chart

Legend Visible

Off

Multiple Column Legend Visible On

Legend Border Color

Legend Horizontal Position

Legend Vertical Position
Title Visible

Title Font

Title Color

Title Font Size

Title Bold

Title Italic

Subtitle Visible
Subtitle Font

Subtitle Color

Subtitle Font Size
Subtitle Bold

Subtitle Italic

X-Axis Title Visible
X-Axis Title Font
X-Axis Title Color
X-Axis Font Size
X-Axis Bold

X-Axis Italic

Y-Axis Title Visible
Y-Auis Title Font
Y-Axis Title Color
Y-Axis Font Size
Y-Axis Bold

Y-Axis ltalic

X-Axis Gridlines Visible
Y-Axis Gridlines Visible
Marker Style

Marker size

Series Palette

#0OFFFFFF
RightOutside
Center

On
Segoe Ul
B Elack
21

Off

Off

On
Segoe Ul
| #FFAQAQA9
16

Off

Off

On
Segoe Ul
B clack
16

Off

Off

On
Segoe Ul
B Elack
16

Off

Off

Off

Off

Circle
b

Grayscale

Figure 2.9: Plot Options
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The options for Chart (plotting) are as follows:

1.
2.

13.

14.

15.
16.
17.
18.
19.

20.

Legend Visible: Toggle if legend is shown for single column plots. - Default: Off

Multiple Column Legend Visible: Toggle if legend is shown for multiple column
plots. Default: On

. Legend Border Color: Select color of legend border - either hex number of color

name will be displayed. Selecting this option will open the color picker interface,
select More Colors to manually select color - Default: #00FFFFFF (Transparent
White)

. Legend Horizontal Position: Combination of horizontal location of legend (Left,

Right, Center) and if legend is inside or outside of plot frame (Outside, Inside) -
Default: Right Outside

. Legend Vertical Position: Combination of vertical location of legend (Top, Bot-

tom, Center) and if legend is inside or outside of plot frame (Outside, Inside) -
Default: Center

. Title Visible: Toggle if main plot title is shown. Default: On

Title Font: Select font for main plot title. The dropdown will preview each font
style. Default: Segoe UI

. Title Color: Select color of main plot title - either hex number of color name will

be displayed. Selecting this option will open the color picker interface, select More
Colors to manually select color - Default: Black

. Title Font Size: Select size of font for main plot title. Default: 21
10.
11.
12.

Title Bold: Toggle if main plot title font is bolded. Default: Off
Title Italic Toggle if main plot title font is italicized. Default: Off

Subtitle Visible: Toggle if main plot subtitle is shown. Subtitles (title text which
appears below main plot title) are primarily used in nQuery Predict plots. Default:
On

Subtitle Font: Select font for main plot subtitle. The dropdown will preview each
font style. Default: Segoe UI

Subtitle Color: Select color of main plot subtitle - either hex number of color
name will be displayed. Selecting this option will open the color picker interface,
select More Colors to manually select color - Default: Grey (#FFA9A9AY)

Subtitle Font Size: Select size of font for main plot subtitle. Default: 16
Subtitle Bold: Toggle if main plot subtitle font is bolded. Default: Off
Subtitle Italic Toggle if main plot subtitle font is italicized. Default: Off
X-axis Title Visible: Toggle if X-axis plot title is shown. Default: On

X-axis Title Font: Select font for X-axis plot title. The dropdown will preview
each font style. Default: Segoe Ul

X-axis Title Color: Select color of X-axis plot title - either hex number of color
name will be displayed. Selecting this option will open the color picker interface,
select More Colors to manually select color - Default: Black
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21.
22.
23.
24.
25.

26.

27.

28.

29.
30.

31.

32.

33.
34.

X-axis Title Font Size: Select size of font for X-axis plot title. Default: 16
X-axis Title Bold: Toggle if X-axis plot title font is bolded. Default: Off
X-axis Title Italic Toggle if X-axis plot title font is italicized. Default: Off
Y-axis Title Visible: Toggle if Y-axis plot title is shown. Default: On

Y-axis Title Font: Select font for Y-axis plot title. The dropdown will preview
each font style. Default: Segoe Ul

Y-axis Title Color: Select color of Y-axis plot title - either hex number of color
name will be displayed. Selecting this option will open the color picker interface,
select More Colors to manually select color - Default: Black

Y-axis Title Font Size: Select size of font for Y-axis plot title. Default: 16
Y-axis Title Bold: Toggle if Y-axis plot title font is bolded. Default: Off
Y-axis Title Italic Toggle if Y-axis plot title font is italicized. Default: Off

X-axis Gridlines Visible: Toggle if X-axis gridlines are displayed. These are
major and minor gridlines. Default: Off

Y-axis Gridlines Visible: Toggle if Y-axis gridlines are displayed. These are
major and minor gridlines. Default: Off

Marker Style: Select shape for markers for points charted in plot. Select from
Hidden, Circle, Cross, Polygon, Ring, Square, Star, Triangle. Default: Circle

Marker Size: Select size for markers for points charted in plot. Default: 6

Series Palatte: Select color palette used for color(s) of lines and markers in plots.

See https://docs.devexpress.com/WPF/400728/common-concepts/themes/palettes#

predefined-palettes for details on the available palettes Default: Grayscale

2.3.3 nQuery Predict Options (nQuery Advanced Expert only)

This section contains the options for nQuery Predict. These options are shown in Figure 2.10
with their default settings. More detail on nQuery Predict can be found in chapter 11.
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¥

Options X
Predict -
Use File Import Wizard Off .
Use First Row For Column Headers On .

CSV Delimiter Character(s)
Maximum number of simulations 100000
Maximum number of rows in gene... 20000

Mumber of decimals in wizard inpu... 4

Default Predict Import Folder ChUsers\Ronan\Documents

Open Most Recent Folder? On ||

Reports font family Segoe Ul Semilight

Reports header font size 14

Reports table font size 9 =
oK Cancel

Figure 2.10: nQuery Predict Options

The options for nQuery Predict are as follows:

1.

Use File Import Wizard: Toggle if nQuery Predict should use “advanced” file
import wizard. The advanced file import wizard will provide option to specify
whether to use the first row for column headers and csv delimiter character at file
import. The “simple” file import wizard used when this option is off will assume
those options equal the values specified here in the Options menu Default: Off

. Use First Row for Column Headers: Toggle if first row of imported datasets

should be assigned as the column headers Default: On

CSV Delimiter Character(s): Enter delimiter between entries in imported CSV
files Default: , (Comma)

Maximum Number of Simulations: Maximum number of simulations allowed
in nQuery Predict workspace. Note this option will also apply to the spreadsheet
outputs of the Randomization List and Group Sequential Design Simulator tools.
Default: 100000

. Maximum Number of Rows in Generated Reports: Maximum number of

rows displayed in generated spreadsheet reports. nQuery Predict will generate up
to this amount of rows in the report, the remaining rows, if any, will not be included.
Note this option will also apply to the spreadsheet outputs of the Randomization
List and Group Sequential Design Simulator tools. Default: 20000
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10.

11.

. Number of decimals in wizard input fields: Number of decimal places dis-

played in nQuery Predict numeric input fields Default: /

Default Predict Import Folder: Default folder displayed when importing data-
sets Default: C:\Users|<UserName>\Documents

Open Most Recent Folder?: Open most recently used folder in nQuery Predict
workspace when importing datasets Default: On

. Reports Font Family: Font used in nQuery Predict Reports Default: Segoe UI

Semilight

Reports Header Font Size: Font size of headers in nQuery Predict Reports
Default: 14

Reports Table Font Size: Font size of values in tables within nQuery Predict
Reports Default: 9

2.3.4 Randomization List Options

This section contains the options for Randomization List tool, see chapter 6. These
options are shown in Figure 2.11 with their default settings. Note that these settings also
apply to the Group Sequential Report feature in the GSTX series of tables.

F |

Options X

Randomization Lists -

Mumber of decimals in wizard inp... 4

Reports font family Segoe Ul Semilight

Reports header font size 14

Reports table font size 9 -
OK Cancel

Figure 2.11: Randomization List Options

The options for the Randomization List are as follows:

1.

Number of decimals in wizard input fields: Number of decimal places dis-
played in numeric input fields Default: 4

. Reports Font Family: Font used in Reports Default: Seqoe Ul Semilight
. Reports Header Font Size: Font size of headers in Reports Default: 1/

Reports Table Font Size: Font size of values in tables within Reports Default: 9
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2.3.5 Group Sequential Report Options (nQuery Advanced Pro only)

This section contains the options for the Group Sequential Report in the GST series of
group sequential tables - chapter 7 covers the GST series of tables, subsection 7.3.4 covers
the Group Sequential Report specifically. These options are shown in Figure 2.12 with
their default settings

Options X

0=
O—

4 Group Sequential Design Report

Reports font family Segoe Ul Semilight

Reports header font size 14

Reports table font size g -
OK Cancel

Figure 2.12: Group Sequential Report Options

The options for the Group Sequential Design Simulator are as follows:

1. Reports Font Family: Font used in Group Sequential Report Default: Segoe UI
Semilight

2. Reports Header Font Size: Font size of headers in Group Sequential Report
Default: 14

3. Reports Table Font Size: Font size of values in tables within Group Sequential
Report Default: 9

2.3.6 Group Sequential Simulation Options (nQuery Advanced Pro
only)

This section contains the options for Group Sequential Simulation tool. This tool is
available from the GSTX series of group sequential tables or from the Group Sequential
Design Simulation option from the Assistants file menu. These options are shown in
Figure 2.13 with their default settings.

More detail on Group Sequential Design and the Group Sequential Design Simulator, can
be found in chapter 8 and chapter 7.
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Options X

4 Group Sequential Design Simulator

Mumber of decimals in wizard inp... 4

Reports font family Segoe Ul Semilight

Reports header font size 14

Reports table font size g -
OK Cancel

Figure 2.13: Group Sequential Design Simulator Options

The options for the Group Sequential Design Simulator are as follows:

1. Number of decimals in wizard input fields: Number of decimal places dis-
played in Group Sequential Design Simulator numeric input fields Default: 4

2. Reports Font Family: Font used in Group Sequential Design Simulator Reports
Default: Segoe UI Semilight

3. Reports Header Font Size: Font size of headers in Group Sequential Design
Simulator Reports Default: 14

4. Reports Table Font Size: Font size of values in tables within Group Sequential
Design Simulator Reports Default: 9

2.3.7 Per-Table Options

Some of the General Settings options can be changed on a per design table basis.

To achieve this, select the arrow to the left of Tables under the Per-Table Configura-
tion Settings field found at the end of the Options menu window. Then select the arrow
to the right of table code name of interest. An example of this is shown in Figure 2.14
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4 Per-Table Configuration Settings
4 Tables Test Tables
4 0] MOTO

Auto-calculation [
Initial number of columns
Minimum number of colu...
Maxirmum number of colu...
Mumber of decimal place...

Mumber of decimal place...

Figure 2.14: Per-Table Options Menu Example

The user can then edit the Auto-calculation, Initial number of columns, minimum number
of columns, maximum number of columns, Number of decimal places (percentages) and
Number of decimal places (double) as per the General Settings fields described above.
Unless manually edited, the same settings and defaults for a specific design table are used
as per General Settings i.e. General Setting used if leave that field empty.

2.4 Print and Report Options

nQuery provides printing options for the design tables and other table outputs.

2.4.1 Print Table

To Print the contents of the table, select either the Print option under the File menu or
from the tool bar. This will display the default Windows print screen where you can edit
the printer used, the printer preferences, the pages printed and number of copies printed.

2.4.1.1 Print Preview
To have nQuery generate a Print Preview, select either Print Preview option under the

File menu or from the tool bar. This will display a Print Preview screen with an example
shown in Figure 2.15.
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B8 Print Preview - 0
=H HSse&=ls > 1@ Q-

N

Wilcoxon/Mann-Whitney Rank-Sum Test (ordered ncuel’y
categories) *

I 3 S N R
Test Significance Level, a 0.05

1 or 2 sided test? 2 2 2 2 2

Number of Categories, k 3

Side Table Name MTT25-1

Pl = PX<Y) 06

Power (%) 74.569

Figure 2.15: Print Preview Example

The toolbar at the top of the Print Preview screen gives options to open, save, search,
print, quick print, adjust settings, page up, page down, first page, last page, zoom, zoom
in, zoom out, export, send or watermark. A hand tool is also available from the right-click
context menu.

2.4.2 Other Print Options

Print options are available for the following table outputs: Plots, Output Statement.
To print plots, use the Print option in the right-click context menu used within a plot.

To print the output statement, use the Print button in the bottom-right of the Output
window or in the right-click context menu.

2.4.3 Report

nQuery provides a report function which allows users to summarise the results for specific
design table column in a print-ready format.

To open a report for a specific column, select that column by clicking the column name
bar above the column. Then right-click the column and select the Report option at the
bottom of the context menu or select Report from the Assistants file menu. This will
open a column report which will include a summary of the design parameter values in
that column and the output statement for that column if a solver is active.

The report will be opened in a Print Preview style window and has the same options
and functionality described in subsubsection 2.4.1.1. An example of report is shown in
Figure 2.16.
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B8 Print Preview - 0
Gl e Ly \ \ \ Ly i L
2 L = M . ™ . .
=H DS e&=ls ARX-@ a2
Two Sample Student's t-test (equal variances) n(: uel’y

Test Significance Level, o 005
1or2Sided
Group 1 Mean. .
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Figure 2.16: Report Example

2.5 Other Topics

2.5.1 Design Table Context Menu and Shortcuts

Within an nQuery design table when a cell or cells is selected, right-clicking will open a
context menu for those cells. In nQuery when a cell or multiple cells are selected, the
context menu will contain options for Copy, Cut, Paste, Select All, Fill Right, Clear and
Copy Table.

Many shortcuts for standard Windows commands (e.g. Ctrl+C for Copy, Ctrl4+V for
Paste) are used in nQuery. These shortcuts are displayed to the right of the name within
the file menus and context menus where appropriate.

If a full column is selected either by dragging over all the cells in a column or by clicking
the column title bar, selecting Clear will reset the solver in the column. It also opens a
Report option which is described in subsection 2.4.3.

To select multiple entries in a design table, select a cell and then hold down the Shift
key (to select all cells between the first and second selected cells) or Ctrl key (to select
multiple individual cells) and select another cell.

2.5.2 Design Table Drop-downs
In some nQuery design tables, a row is a drop-down menu rather than a numeric input.

To select a value from this drop-down, select the relevant cell and click the downwards
arrow on the right-hand side of the cell. This will display the full set of options available
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for that row. The help card will provide a description of the solver drop-down options,
their meaning and usually a Suggestion for this option.

Where all options for a drop down are numeric, the numeric input can be inputted directly.
One example of this class of drop-down menu is for “1 or 2 Sided Test?” or “1 or 2 Sided
Interval?” rows. In these rows, you have the option to either enter 1 or 2 directly into
the cell or use the drop-down menu as above.

These rows are treated differently in the Specify Multiple Factors tool and the Plot User
Selected rows tool to other rows. In the Specify Multiple Factors tool, these rows will
have a drop-down menu similar to design table drop-down. In Plot User Selected rows,
these rows will not be available as an option in the X-axis drop-down. To plot the effect
of changing the options in these cells, fill multiple columns with all other values fixed and
then apply the relevant plotting method to all the relevant columns in the same plot.

2.5.3 Customising Table Layout
2.5.3.1 Changing Window Size and Docking

In nQuery, the default size and positioning of each window and element is editable by
user to create the layout which best suits their needs. There are two main elements which
can be edited: windows and tabs.

Manipulating nQuery Windows Windows are the primary user interface unit of an
nQuery design table. By default the three windows displayed are the design table window
(top-left), the Output /Specify Multiple Factors window (bottom-left) and the Help/Notes
window (right). If a plot or plots are created, the Plot window can be manipulated in the
same fashion.

There are two main actions that can be applied to a window: docking/undocking and
resizing.

« Docking/Undocking

To move a window, click and drag the window bar at the top of the window of interest.
This bar will contain the name of the tab currently open in that window (e.g. Help,
Output etc.). While the window is being dragged, two options are given for that window:
dock the window or undock the window.

To dock the window, drag the cursor while the window is selected to a “docking square”
and nQuery will highlight in blue where the window will be docked. Four edge docking
squares will be available on the centre left, right, top and bottom of the nQuery win-
dow which will place the current element to the left /right /above/below all other nQuery
windows. In addition, the “current” nQuery window over which the cursor is placed will
contain the relational docking squares. The centre square will combine the current win-
dow and the docking window into a single window with all of their tabs combined. The
other squares will place the docking window to the left/right/above/below the current
window .

To undock the window, drag the cursor away from the “docking squares” and to the
undocked placement of choice.
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In both cases, when the desired placement is achieved let go of the left mouse button (or
other “clicking” method) and the window will appear in the desired place. An example of
the docking process “in action” for the Output window where it is being placed between
the MTTO Design Table and Help windows is given in Figure 2.17. The effect of this
placement (after resizing) is shown in Figure 2.18.

Q nQuery -

File Edit View Assistants Plot Help

EsdemRE o

Getting Started Wilcoxon/Mann-Whitney | Group Sequential Test of | Two Group t-test of E¢ % | + -
TT0-1/ Two Group t-test of Equal Means I_I 2| Help 7 x

1 2 3 4 ‘ 5 & 7 ‘ | f® 4

Test Significance Level, a 0.050
10r 2 Sided 2 2 2 2 2 2 2 Sample Size per Group, n
Group 1 Mean. ux 1.000 The sample size is the number of subjects or
Group 2 Mean, p2 2000 observations needed for the specified power;
Difference in Means. v - bz oo the larger the sample size, the higher the
Common Standard Deviation, @ 2000 power to detect a specific aliernative.
Effect Size, 8=|u-pz)/c 0.500
Power (%) 80.00% Suggestmn'

» | n per Group 64

Enter the number of subjects you can afford
udy and solve for power.

D Output

A sample size of 64 in each group will have 80% power to detect|a difference in means of -1 (the difference between a Group 1 mean, ps, of 1
and a Group 2 mean, pz, of 2) assuming that the commeon standgrd deviation is 2 using a two group t-test with a 0.05 two-sided significance
level.

o x

eptable Entries

Calcy| Output

@ Two Group t-test of Equal Means-1 | Power (%): 80.0000000000

Figure 2.17: nQuery Window Docking Example

o Resizing

To resize a window, place the cursor at the edge of the nQuery window of interest. The
mouse cursor will change to a <+ symbol. Then hold down the left mouse button and
drag the cursor left/right (for a vertical edge) or up/down (for a horizontal edge) until
the window is the desired size. Note that elements in the table will dynamically update
to show how they will look for a given window size. An example of the output statement
being resized after the docking example above is shown in Figure 2.18.
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Figure 2.18: nQuery Window Resizing Example

Manipulating Window Tabs Window tabs have a single applicable operation: dock-
ing/undocking. This process works similarly to undocking/docking a window. For tabs,
the window element which is clicked and dragged is the tab bar name rather than the
window name. The tab names are found in the grey tab bar at the bottom of an nQuery
window. When a tab is being dragged, the same options are available as for a window.
The three main actions are to undock the tab, place the tab relative to the other windows
or dock the tab into another window.

To undock, drag the select tab away from any of the docking squares and leave. When a
tab is undocked, it will become an nQuery window.

To place relative to the other windows, select on of the left /right /up/down docking squares
and place in the desired position which will be previewed in blue by hovering over a docking
square while dragging.

To dock the tab into another window, drag the cursor over the window of interest and
select the centre docking square in the middle of the current window.

An example where the Output tab is currently being moved and where the Notes tab has
been moved into the main design table window is shown in Figure 2.19.
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Figure 2.19: nQuery Tab Docking Example

Note that you can also drag tab names within the tab bar to place it relative to the other
tab names in the same click and drag fashion.

The user can also close or open table elements by selecting these from the View file menu.

2.5.3.2 Editing Column Names

nQuery provides the user the ability to change a column name. To change a column name,
double-click the number in the column title bar above the column cells. The number will
appear in a white square and will now be editable. Replace the number with the desired
column name and this name will then be displayed in the design table. An example of a
design table with changed column names was shown in Figure 2.2.

Note that these column names will be reflected automatically in the Legend of plots
involving that include the renamed columns.
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3 Advanced nQuery Assistants

3.1 Design Table Side-Tables

Side-tables provide table specific tools which allow users to calculate design parameters
based on additional information which is commonly known or used in a particular design
type. This section will go over the three primary types of side-tables: Effect Size Side-
Tables, Covariance Matrix Side-Tables and Mandatory Side-Tables

3.1.1 Compute Effect Size Side-Table

For an introduction in how to open and use effect size side-tables, see subsection 1.7.4.
In this section, we will briefly summarise the process of opening the side-table, using the
side-table and cover some additional information not included in subsection 1.7.4.

3.1.1.1 Opening an Effect Size Side-Table
There are three main routes to open an effect size side-table: using the “Compute Effect

Size” option in the Assistants menu, using the Compute Effect Size button b in the
menu bar or by selecting the cell(s) in design table which are transferred from that side-
table. Column cells which are the transfer target for an Effect Size side-table will be
indicated in the cell’s Help Card by its “Aid” section.

When a side-table is opened for a column, it will appear below the main analysis table in
the same window as the Output and Specify Multiple Factors tools.

For each column in which a side-table is opened, a unique side-table will open associated
with that selected column. The names of these side-tables are found in the tab bar at the
bottom of the side-table window.

The most common template for a side-table name is [Table Code]S-[Column Number].
For example, opening a side-table in MGTO0 (One Way Analysis of Variance) for column
one will open a side-table named “MGTO0S-1". Note there are some exceptions e.g. Looks-
[Column Number| for Group Sequential Design.

Note that users can edit and transfer from other column side-tables into that column by
selecting them in the tab menu at the bottom of the side-table window.

3.1.1.2 Using an Effect Size Side-Table

For a specific example of an effect size being used, see subsection 1.7.4. The format for
an effect size side-table will be unique depending on the design table being used. For
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3.1 Design Table Side-Tables

guidance on using a specific side-table refer to the help materials, in particular the Home
Card and Help Card “Aid” sections of relevant cells.

In general, the effect size side-table works by the user fully specifying the required cells
in the table.

When the minimum amount of information required in a side-table is completed, the
“Compute” button in the upper-left of the side-table window will become active (un-
greyed). Selecting the Compute button will calculate the design parameter(s) which will
be transferred to the main table and other parameters of interest in certain design tables.

After the Compute button is used, the “Transfer” button (right of the Compute button)
will become active and when selected this will transfer the relevant design parameters
into the associated column in the main design table.

Note that some tables will not contain a “Compute” and/or “Transfer” button. Where the
Compute button is missing, nQuery will automatically calculate the required outputs in
the side-table. Where the Transfer button is missing, nQuery will automatically transfer
the required side-table outputs to main table when the side-table is completed.

To return the side-table to its original state, use the “Clear” button (to the right of the
Transfer button) to remove all user entries, read-only entries and computed values from
the side-table.

Using the right-click context menu gives access to same edit tools and shortcuts as the
main table (see subsection 2.5.1).

An example of an effect size side-table is shown in Figure 3.1.

MGTO0S-2 R X

— = .
& Compute 93§ Transfer | #§ Clear

Group Mean
1 1.100
2 2300
3 3.000
» | Variance of means, V 0.616
v
MGTO0S-2

Figure 3.1: Effect Size Side-Table Example

3.1.1.3 Closing an Effect Size Side-Table

To close a specific effect size side-table, use the “x” in the top-right of the effect size
side-table window. You can also hide the side-table using the pin symbol in the top-right
or by right-clicking on the tab menu name.
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3.1.2 Specify Covariance Matrix Side-Table

The Specify Covariance Matrix side-table provides a convenient method to calculate the
error and Greenhouse-Geisser correction terms for the Repeated Measures ANOVA tables
which use the Greenhouse-Geisser approximation in nQuery. These are MOT4 and MTT3.

Note that a small number of other tables use this option as generic way to open a second
side-table where required.

3.1.2.1 Opening an Effect Size Side-Table

There are three main routes to open an Specify Covariance Matrix side-table: using the
“Specify Covariance Matrix” option in the Assistants menu, using the Specify Covariance

Matrix button z in the menu bar or by selecting the cell(s) in design table which are
transferred from the side-table. These are the “error-term”, sphericity and bias term rows.
This will be indicated in the relevant cell’s Help Card by its “Aid” section.

As per the effect size side-tables, when a covariance matrix side-table is opened for a
column, it will appear below the main analysis table in the same window as the Output
and Specify Multiple Factors tools.

For each column in which a side-table is opened, a unique covariance matrix side-table
will open associated with that selected column. The names of these side-tables are found
in the tab bar at the bottom of the side-table window. The template for a side-table name
is [Table Code]C-[Column Number|. For example, opening a covariance matrix side-table
in MOT4 (One Way Repeated Measures ANOVA (Greenhouse Geisser Approximation)
for column one will open a side-table named “MOT4C-1".

Note that users can edit and transfer from other column side-tables (effect size or covari-
ance matrix) into that column by selecting them in the tab menu at the bottom of the
side-table window.

3.1.2.2 Using a Specify Covariance Matrix Side-Table

There are two modes for filling the Specify Covariance Matrix side-table: the Specify
Standard Deviations and Correlations mode and the Specify Full Covariance Matrix mode.
To switch between the modes, use arrow on the right of the mode drop-down to the right
of the “Transfer” button at the top of the side-table window. This drop-down is shown
in Figure 3.2.
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MTT3C- t
7,3} Specify Standard Deviations and Correlations ~ 4

v Specify Standard Deviations and Correlations
STANDARD DEVIATION N . )
Specify Full Covariance Matrix

Constant o P 0.000 ¥ 0.000 pp=ptothepower1-y+yli-j] 0=2y=<1)

i Pij
b | Level 1
Level 2
Level 3
Level 4
Level 5

| Between-groups error term
Within-group error term
Measure of sphericity, £

Bias term multipler, g.

MTT3C-1

Figure 3.2: Specify Covariance Matrix Mode Drop-down Example

Specify Standard Deviations and Correlations Mode The Specify Standard Devi-
ations and Correlations mode has two primary methods to activate the side-table: using
the Constant Standard Deviations and Correlation Pattern shortcuts or directly filling
the o; and p;; table entries.

Note that changes made in one mode will affect the table values given in the other mode.
1) Constant Standard Deviations and Correlation Pattern

To use the Constant Standard Deviations and Correlation Patterns shortcuts you need
to fill three inputs: the common standard deviation o, the correlation p and the pattern
term .

The common standard deviation value will fill o; in the table below with the same common
standard deviation values. This value must be greater than zero.

The correlation will be the value included in the first diagonal of the p;; table below and
will adjusted downwards by the pattern term as you rightwards in the p;; table. This
value must be between 0 and 1

The pattern term defines the adjustment applied to the correlation as you move right-
wards within the p;; table. The formula for this adjustment is given the table and is
1 — v+ ~v|i — j| where |i — j| is the absolute distance between the first cell in the row in
the p;; and the cell of interest. This value must be between 0 and 1.

The common standard deviation will assign a common standard for the measurements at
each measurement level and the correlation and pattern terms will represent the correl-
ation between measurements taken on a subject at a given “measurement distance”. For
example, the 2nd column cell in row 1 of the p;; table represents the average correlation
between the 1st and 3rd measurement for a subject.

To transfer the relevant o; and p;; values for the specified values given in the Shortcuts
menu, select the “Fill” button to the right of the shortcuts menus. This will activate the
Compute button which will calculate the relevant error-terms, bias and sphericity and
activate the Transfer button. Selecting Transfer will place these values in the associated
main design table column.
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To use a compound symmetry (CS) model, set the constant correlation to the desired value
and set the pattern term to zero. In the CS matrix, the correlation between measurements
is assumed to be constant regardless of the distance between measurements.

To use an autoregressive(1) (AR(1)) model, set the correlation at the desired value (this
will be the “distance 17 correlation) and set the pattern term to one. In the AR(1) matrix,
the correlation between measurements is assumed to decay via an AR(1) process as the
distance between measurement increases.

To achieve a pattern where the correlation does decay but slower than the AR(1) model,
set the correlation at the desired value (this will be the “distance 1” correlation) and set
the pattern term to between zero and one.

An example of using the AR(1) model computed using the shortcuts method is shown in
Figure 3.3.

MTT3C-1 2 x
& Compute Bt Transfer 53 Specify Standard Deviations and Correlations ~ | 3§ Clear a
STANDARD DEVIATIONS CORRELATION PATTERN
:
Constant o 1.000 [+ 0.500 W 1,000 p=ptothepower 1-y+yli-j] 0y
o; By
Level 1 1.000 0.500 0.250 0.125 0.063
Level 2 1.000 0.500 0.250 0.125
Level 3 1.000 0.500 0.250
Level 4 1.000 0.500
b | Level 5 1.000
} | Between-groups error term 1722
Within-group error term 0.713
Measure of sphericity, £ 0.999
Bias term multipler, g. -4.487
MTT3C-1

Figure 3.3: Specify Covariance Matrix SD + Correlation Example

2) Directly Filling Table

In addition to using the shortcuts method, you can fill the o; and p;; in the table dir-
ectly. This can be done with a blank table or the values can be edited from a shortcuts
generated template. This gives the user a large amount of flexibility to set the table to
their specifications. Once all o; and p;; cells are filled, this will activate the Compute
button which will calculate the relevant error-terms, bias and sphericity and activate the
Transfer button. Selecting Transfer will place these values in the associated main design
table column.

An example where we edited from the Figure 3.3 template to have the individual level
standard deviations vary and the distance 4 (i.e. between measurement 1 and 5) correla-
tion equal to zero is shown in Figure 3.4.
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Level 1 1,100 0.500 0.250
b | Level 2 1.050 0.500
Level 3
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0.000

0.250
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Level 5 0.980

» | Between-groups error term 1.515
Within-group error term 0.859
Measure of sphericity, £ 0.734
Bias term multipler, g, -1.865

MTT3C-1

Figure 3.4: Specify Covariance Matrix Manual SD + Correlation Example

Specify Full Covariance Matrix mode The Specify Full Covariance mode works simil-
arly to directly filling the standard deviations and correlations table. However, the covari-
ance matrix is entered directly in this case. In the covariance matrix, the main diagonal
elements are equal to within-measurement level variance and off-diagonal elements rep-
resent the covariance between main diagonal element level and the measurement at that
distance (e.g. the third column entry in row one equals the average covariance between
the first level subject measurement and the third level subject measurement).

There are two main methods to fill the covariance matrix: automatically fill using Con-
stant Standard Deviations and Correlation Pattern mode or manually fill.

As noted at the start of this section, if the standard deviations and correlations table
has been filled (either using the shortcuts menu or manually) in the other mode then
the Covariance Matrix will be filled in this mode. Alternatively, you can fill or edit the
covariance matrix manually to the study’s specifications. Once all elements are filled in the
covariance matrix, this will activate the Compute button which will calculate the relevant
error-terms, bias and sphericity and activate the Transfer button. Selecting Transfer will
place these values in the associated main design table column.

An example of an Specify Covariance Matrix side-table computed using the Specify Full
Covariance Matrix mode is shown in Figure 3.5.
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MTT3C-1 ®ox
& Compute % Transfer 52 Specify Full Covariance Matrix ~ | #§ Clear
oy
¥ | Level 1 5.000 0.578 0.268 0139 0.000
Level 2 1.103 0512 0.265 0.129
Level 3 0.951 0492 0.239
Level 4 1.020 0495
Level 5 0.960
} | Between-groups error term 1.747
Within-group error term 1.223
Measure of sphericity, £ 0.498
Bias term multipler, g, -0.136

MTT3C-1

Figure 3.5: Specify Covariance Matrix Matrix Example

3.1.2.3 Closing a Covariance Matrix Side-Table

To close a specific covariance matrix side-table, use the “x” in the top-right of the effect
size side-table window. You can also hide the side-table using the pin symbol in the
top-right or by right-clicking on the tab menu name.

3.1.3 Mandatory Side-Tables

In the majority of nQuery design tables which use side-tables, the side-table is optional.
In these cases, the role of the side-table is to provide a method for users to derive required
design parameters based on other information they may have access to.

In a minority of nQuery design tables, the side-table is mandatory. In these cases, the
inputs in the side-table(s) are used directly by the solvers of that table. The following is a
list of examples where the table has a mandatory side-table(s) (Table Codes in Brackets):

o Group Sequential Tests (Spending Function, Haybittle-Peto, Wang-Tsiatis, Unified
Family, Custom Boundaries) (GST0, GST1, GST2) (Discussed in chapter 7)

o Group Sequential Tests (Lan-DeMets only) (Means: MOT26, MTT12, MTE32;
Incidence Rates/Counts: MTT40, MTT42; Proportions: POT8, POT13, PTT12;
Survival: STT12, STT15, STT23, STT25) (Discussed in chapter 9)

o Multiple Comparison Procedure - Modeling (MCP-Mod) (MGT5, MGT7, MGTS,
MGT9, PGT3) (Discussed in chapter 10)

« Blinded Sample Size Re-estimation for Overdispersed Poisson Counts (MTT47)

o Multi-Arm Multi-Stage (MAMS) Group Sequential Tests (MGT6, PGT4)

» Potvin 2-Stage Bioequivalence Design (MTE36)

» Bayesian Assurance using Custom Prior (MOT25, MTT21, POT7, PTT13, STT14)
o Stepped-Wedge Cluster Randomized Designs (CRT16, CRT17, CRT18)
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« Multivariate Analysis of Variance (MANOVA) (MGT3)

« Mantel-Haenszel (Cochran) Test (PTT4, PTT4CC, PTT4U, PTT44, PTE22)

« Wilcoxon/Mann-Whitney Rank-Sum Test (Ordered Categories) (MTT2, MTT2U)
« Stratified Win Ratio (PTT42)

o Log-Rank Test, User Specified Survival Rates, Accrual, Dropouts (STT22, STT24,
STT37, STT38)

o Log-Rank Test, User Specified Survival Rates, Accrual, Dropouts (Simulation) (STT3,
STT3U)

o Maximum Combination Linear Rank Tests (STT33, STE11, STE13)
« Two Sample Stratified Log-Rank Test (STT31)
o Test for Polychotomous Kappa (AOT15)

From this list, all except MGT3 and the Group Sequential (see chapter 9) tables, use
the same instructions as for the Effect Size side-tables above to open the side-table. In
each of these design tables except MGT3 and the group sequential tables, there is a row
named “Side Table Name” which will also open the side-table for a column automatically
(assuming all side-table opening conditions are met).

In MGTS3, there are three separate side-tables per column and these are opened by se-
lecting the Factor Level Table, Means Matrix and Covariance Matrix read-only cells in a
column. In the group sequential tables, selecting any cell in a column will open the Looks
side-table.

The side-tables are the same between MTT2/MTT2U, PTT4/PTT4cc, STT3/STT3U,
the Bayesian Assurance custom prior tables (MOT25/POT7 etc.) and the group se-
quential tables (MTT12/PTT12 etc.). These side-tables operate the same as optional
side-tables except they do not have Compute/Transfer buttons. For mandatory side-
tables when the table is filled sufficiently to be used in a solver, the name of the side-table
in “Side Table Name” row (or MGT3 equivalent) will go from grey to black. The table
otherwise will operate as per any other design table.

Note that Looks side-table for the group sequential tables does not require any editing to
be active and is by default read-only. It is only required to be edited if the Information
Times or Spending Function rows are set to “User Specified”. See the help for the group
sequential details for further details.

If a side-table has been completed in any column, you can automatically use that side-
table in another column by selecting the relevant side-table name from the drop-down
options in that column’s “Side Table Name” row.

An example of a mandatory side-table being used in MTT2 is shown in Figure 3.6.
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Figure 3.6: M'TT2 Mandatory Side-Table Example

3.2 Compute Standard Deviation Assistants

nQuery provides a number of assistants which allow a user to derive the standard deviation
for a study based on other parameters or data which the user has.

To access these assistants, select the “Standard Deviation” option from the Assistants
file menu. This will open a radio button list menu containing the standard deviation
assistants. Select an assistant radio button and select OK to open the relevant assistant.

There are 10 standard deviations (SD) assistants available in nQuery. These are (with a
brief description):

1. From Standard Error: Derive SD from sample size (n) and standard error

2. For SD1 and SD2 (pooled SD): Derive pooled SD from group 1 and 2 standard
deviations (SD1/SD2) and sample sizes (nl/n2)

3. From Range: Derive SD from range (using maximum and minimum optionally to
derive range) and sample size, n

4. From Percentile: Derive the SD from the percentile and the difference in upper and
lower percentile values (using upper and lower values optionally).

5. From Coeflicient of Variation: Derive the log-scale SD and mean from the coefficient
of variation and observed mean respectively

6. From Upper Confidence Limit: Derive the upper limit of the SD from the sample
size, observed standard deviation and confidence level.

7. From SD1, SD2, Correlation: Derive the SD for the differences from the first con-
dition SD, the second condition SD and the correlation

8. For Cluster Sampling: Derive the “cluster” SD from the between-cluster and within-
cluster variances, the intra-cluster correlation and subjects per cluster.
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3.3 Data Entry Assistant

9. For specified x values: Derive the SD from a set of x data values. See section 3.3

10. Of residuals: Derive the SD of the residuals and the dependent (Y) variable from
the regression coefficient, correlation coefficient and independent (X) variable SD.

All of these assistants work in the same or similar way as nQuery design tables except for
the “For specified x values” option. Use the guide given in chapter 1 and the individual
Home and help cards provided for guidance on how to use each table.

Options 1 - 4 provide alternative methods to derive a standard deviation for one or two
sample independent means test and Option 6 provides the alternative estimate for the
standard deviation by using the upper confidence limit . Option 5, 7, 8 and 10 provide help
to derive the adjusted standard deviation for specific designs or testing methods. Option
5 would be used if the analysis will be of the log-transformed data, Option 7 would be
used for paired means testing or analysis, Option 8 would be used if the study will use
cluster randomisation and Option 10 is used if the analysis is using linear regression.

3.3 Data Entry Assistant

nQuery provides a data entry assistant to allow users to derive commonly used design
parameters based on data which may be available to the user.

The Data Entry Assistant has three main components: the Data Entry table, the Trans-
formation menu and the Insert Values menu.

3.3.1 Data Entry Table

The data entry table is the main table on the left-hand side of the Data Entry Assistant.
It consists of 20 columns and 500 rows. Each column corresponds to a data set and each
row corresponds to an individual subject’s data value in that column’s data set.

As a user fills a column, four commonly used design parameters will be derived for the
data set. These are the sample size (N), the mean, the sample standard deviation and
population standard deviation, o(z). The difference between the sample and populations
standard deviations is the denominator in the estimate for each is N-1 and N respectively.

3.3.2 Transformations Menu

The transformations menu gives the option to create a new column containing the trans-
formed values for an entered data set. Transformations are commonly used when data is
non-normal but has a distribution which would be amenable to being transformed into a
normally distributed data using a common transformation.

The Transformations menu is found to the right of the Data Entry table and can be
opened by selecting the Transformations tab at the top of the menu window.

The three transformations are a square root transformation (Sqrt(X)), a base 10 log
transformation (logl0(X)) and the natural log transformation (In(X)). In addition, you
can conduct these transformations to the data with a fixed value (A) added to each data
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3.3 Data Entry Assistant

value before transformation. In this case, the user is required to enter a value of A in the
ment.

To use the transformations menu, select the relevant column in the data entry table, select
the transformation required, enter a value for A if a (X+A) transformation is selected and
select “Add”.

This will generate the transformed data (with summary statistics) in the next empty
column to the right of the selected data entry column. The column title will include the
name of the transformation and the column transformed and any transformed columns
will be highlighted in orange.

3.3.3 Insert Values Menu

The insert values menu gives the option to create a number column using an evenly spaced
number of data values in a specified range. This can be useful to generate a large dataset
easily.

The insert values menu is found to the right of the Data Entry table and can be opened
by selecting the Insert Values tab at the top of the menu window.

To generate a column using the insert values menu, specify a From value and To value in
the relevant cells. These correspond to the minimum and maximum values of the range
of interest respectively.

The user can then activate either the Specify Increment or Specify num. values option by
selecting the radio button to the left of each option.

If the Specify Increment option is activated, the entered value will be increments in which
the data will increase going from the “From” to the “To” value. For example, if From =
0 and To = 10 then Specify Increment = 2 will give the five values of [0, 2, 4, 6, 8].

If the Specify num. values option is activated, the entered value will be the number of
data values which will be taken between the “From” and “To” value. For example, if
From = 0 and To = 10 then Specify num. values = 5 will give the five values of [0, 2.5,
5, 7.5, 10].

Once the required values are entered for “From”, “To” and “Specify Increment” /”Specify
num. values”, select “Execute” and that data will be generated on the currently selected
Data Entry Table cell.

An example of Data Entry table using the above options is shown in Figure 3.7.
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3.4 Cumulative Distribution Function Assistants

a nQuery =

Getting Started * | SD Caleulator - 3 x [+

]

X0 Sqrt X0 LnX0 x1 x2 From 0

1 100 1.00 oo K Al o
2 200 141 1.00 250
3 300 173 2.00 500 Specify increment
4 400 200 300 750 S —— s
5.00 224 4,00 10,00
6 500
7 6.00
8 7.00
9 8.00
10 9.00
1
12
13
14
13
16
17
8
N 500 500 10.00 400
Mesn 300 168 450 525
Std.Dev. 1.58 049 303 323
) 141 044 287 280 v

@ 5D Calculator -3

Figure 3.7: Data Entry Assistant Example

In column 1 is a user entered set of values (X0), in column 2 is Sqrt(X) transformed data
for column 1, in column 3 is In(X+1) (i.e. A=1 with natural log transform) transformed
data for column, in column 4 is Insert Values menu data generated with From = 0, To
= 10, Specify Increment = 1 and in column 5 is Insert Values menu data generated with
From = 0, To = 10, Specify num. values = 5.

3.4 Cumulative Distribution Function Assistants

nQuery provides access to the most commonly used cumulative and inverse cumulative
distribution functions used by the nQuery solver algorithms. To open a table for a spe-
cific statistical distribution, select Distribution Function from the Assistants file menu.
This will open a radio button menu of the available statistical distributions. To open a
distribution table, select the relevant radio button to the left of the distribution name
and select “OK”.

There are distribution assistants provided for the following statistical distributions:
1. z (Gaussian/Normal)
2. t (Central)
3. t (Non-central)
4. x*(Central) (Chi-Square)
5. x*(Non-central) (Chi-Square)
6. F (Central)
7. F (Non-central)
8

. Cumulative binomial
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3.5 Survival Parameter Conversion Assistant

The distribution tables work the same as standard nQuery design tables with the solvers
being for the cumulative probability of P(X<x_ p) (all tables), the percentile test statistic
(e.g. F_p, t_p) (all tables except cumulative binomial) and the non-centrality parameter
(non-central tables only).

3.5 Survival Parameter Conversion Assistant

The survival parameter conversion assistant provides a tool to convert between the three
most commonly used survival parameters for an exponential survival curve.

F| Timet
Group 1 Proportion T, at Time t
Group 1 Median Survival, med,
Group 1 Exponential Parameter, A,
Group 2 Proportion m; at Time t
Group 2 Median Survival, med,
Group 2 Exponential Parameter, A;

Hazard Ratio, h=In{m,)/In{m;)=med,/med

Figure 3.8: Survival Parameter Converter

The three parameterizations available are the proportion surviving at time t, the median
survival and the exponential parameter. In the survival parameter conversion assistant,
the three survival parameters can be specified for a two group design individually for each
group. In addition, there are rows for the Time t and the Hazard ratio. The Time t
is required to calculate the proportion surviving at time t from the median survival or
exponential parameter and vice-versa. The hazard ratio is calculated after the median
survival/exponential parameter are specified in each group.

Note that the exponential parameter will automatically calculate the median survival
when specified and vice-versa in each group.

Many nQuery survival tables (e.g. STT2, STT6) contain an Effect Size side-table based on
this assistant but where this is not present the Survival Parameter Conversion Assistant
is available.

3.6 Posterior Error Rate Calculator Assistant

The Posterior Error Rate Calculator is an assistant which allows conversion between fre-
quentist Type I (Significance Level) and II (1 - Power) errors and Bayesian False Positive
(8*) and False Negative («*) errors given a prior probability against the null hypothesis,
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3.6 Posterior Error Rate Calculator Assistant

HO. This is based on theory from [Lee and Zelen, 2000]. The Posterior Error Rate
Calculator is shown in Figure 3.9.

b | Posterior False Negative Error, o*
Posterior False Positive Error, B~
Prior Probability against H,, ©
Significance Level, a

Power (%), 1-B

Figure 3.9: Posterior Error Rate Calculator

The Posterior Error Rate Calculator can be used to calculate any two of the Posterior False
Negative Error, Posterior False Positive Error, Prior Probability against H, Significance
Level or Power given all three other inputs are given in a column.

This completes the general user guidance for using nQuery for sample size and power
calculations. What follows is a series of chapters dedicated to specialized topics where
additional guidance and background will assist in using the referenced features and design
tables.

Note: Posterior Error Rate Calculator Assistant is currently only available for users with
an nQuery Advanced Plus license. Active packages are displayed in the Packages section
in the Home tab. To purchase additional packages, see www. statsols. com.
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4 nQuery Qualification Tools

nQuery provides automated qualification scripts to quickly allow a user to verify that
their nQuery application is installed and operating to the manufacturers specifications.
nQuery specifically has two separate tools for installation qualification (IQ) and operation
qualification (OQ) to assist you in verifying nQuery in regulatory industries.

Note that operational and performance qualification (PQ) are considered interchangeable
based on our correspondence with the relevant stakeholders. However, you may wish to
perform within-application testing for PQ purposes.

4.1 Installation Qualification (IQ) Tool

The nQuery 1Q tool assists you in demonstrating that nQuery has been installed and
maintained to the manufacturer’s specifications. nQuery IQ verifies the integrity of each
file in the nQuery 8 system and provides the user a set of reports detailing the results.

The nQuery Installation Qualification (IQ) Tool validates an nQuery installation by veri-
fying that each installed file is correct with a report generated detailing all file results.
This determination is made using the SHA-1 algorithm to create a hash value for each
file. This thus checks that each file is present and that its integrity has been maintained.

Important: 1Q validation represents the expected state of the system as it is at the time
an installation is completed. If changes are made to the original files subsequently then
these may show as failed when I(Q is run on the system at a later date.

4.1.1 Running nQuery IQ

To run nQuery 1Q, select “Installation Qualification” from the Help file menu. This will
automatically run the nQuery.Tools.InstallationQualification.exe application (found in
your installation folder, default of C:/Program Files (x86)/Statistical Solutions Ltd /nQuery)
and output a HTML report which will display the results automatically in the machine’s
default HTML viewer (e.g. default internet browser).

4.1.2 nQuery IQ Results

The 1Q report file will automatically be saved on the machine when the 1Q tool runs. It
will be saved to the C:\Users\<User Account>\AppData\Local\nQuery\Reports folder
where <User Account> is the named User which currently logged into on the machine.
An example of an IQ report is shown in Figure 4.1.
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4.2 Operational Qualification (OQ) Tool

Installation Qualification 20XX-11-01 11:48:48

User: Rxxx / machine: Rxxxx -STATSOLS
6720/6720 files valid

accord.dll

Expected: BSm/1LesqvGsdhW +HI8prZek8sw=
Actual: BSm/1LesqvGsdhW+HIBprZek8sw=

accord.dll.config

Expected: W1tPzGONIRw2zPjCA6GT4hwY /zF8=
Actual: W1tPzGOnIRw2zPjCA6GT4hwY/zF8=

accord.math.core.dll

Expected: oVABx856InqH4Y +|JF0+dnrToQA=

i

Actual: oVABx856InqH4Y +[JFO+dnrToQA=

accord.math.dll

Figure 4.1: Installation Qualification Report Example

4.2 Operational Qualification (0OQ) Tool

The nQuery OQ tool assists you in demonstrating that nQuery 8 is operational. nQuery
8 uses the nQuery solver functions over each design table for a set of validated design
parameter inputs and will execute, process, and report the solver results.

Note that the files used for OQ are available in the TestData folder in your installation
folder (default is C:/Program Files (x86)/Statistical Solutions Ltd/nQuery)

Important: All nQuery results have been validated exactly against the results from nQuery
+ nTerim 4.0 and the original validation documentation and references. All results should
be identical to nQuery + nTerim 4.0 except for simulation tables. There are slight differ-
ence with simulation tables due to an upgraded random number generator being used in
nQuery. For those tables a 5% precision rule was used for validation. Results were also
compared to EAST 6.5, PASS 2021 and SAS 9.4 Proc Power where the same or similar
methods were implemented in those software for a design table.

4.2.1 Running nQuery OQ

To run nQuery OQ), select “Operational Qualification” from the Help file menu. This will
open the OQ Validation Tool menu which is shown in Figure 4.2.
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4.2 Operational Qualification (OQ) Tool
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AOTO
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AQT2
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AQTS
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CRT2
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CRT4

CRTS 9

Figure 4.2: Operational Qualification Tool

The nQuery OQ window provides a list of all of the nQuery design tables by code (AOT1,
MTEL etc.) and has a three level menu hierarchy: All Tables, Per Table, Per Solver.
Selecting the arrow P> to the left of the “All” option at the top of the menu will open and
collapse the per-table options. Selecting the arrow P to the left of a table code option
will open and collapse the solver options for that table.

For all options, the user can include or exclude a table or solver by selecting or de-selecting
the check-box to the left of that option. Selection is indicated with a tick icon.

Note that the tables selected by default will depend on when the OQ tool is opened. If
the OQ tool is opened on the Getting Started tab or when no tab is open then all tables
will be selected by default. If the OQ tool is opened on a specific design table then only
that table will be selected by default.

Note that a small number of shortcuts are available for the OQ tool. Select the Help file
menu item to see these.
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4.2 Operational Qualification (OQ) Tool

Once the user has selected the tables which will be qualified, select the “Run Tests” button
in the window menu bar. Note that since the nQuery testing data is specifically designed
to include extreme values to test robustness that some tests may take some time to run.
If the user wishes to stop qualification before it is finished, select the “Cancel” button in
the menu bar.

As the OQ tool progresses, each item in the menu will show the Qualification results
per-feature as it is completed in the columns to the right of the code-name.

[

The first column will show a tick symbol if the feature has passed and an “x” symbol
if it has failed. The next “Passed” column will show the number of passed individual
table/solver tests. The final “Out of” column will display the total number of tests ran
for that individual table/solver tests. If a table/solver passes then the tests passed should
equal the total number of tests.

A progress bar in the menu bar will display the total number of tables tests and indicate
overall progress by the amount of the bar filled.

An example of the OQ tool in progress is shown in Figure 4.3.

=] Validation Tool - 0O
Eile Help

Cancel y

Mame Passed | Out Of
P4 [m| Al 20 @~

’ ADCO o 158 158
b AOCT 4 120 120
b ADC2 4 159 159
b ADC3 o 159 159
b ACTO o 200 200
’ AOTH 4 160 160
b ACT2 o 238 238
b ACT3 4 197 197
b AQTS o 193 193
b ACQTT 4 370 370
b ATT3 4 349 349
b ATT4 o 1522 1522
b CRT1 o 283 283
’ CRT11 4 428 428
b CRT12 o 885 485
b CRT2 4 1012 1012
’ CRT2 o 1284 1284
b CRT4 4 1077 1077
b CRT3

Figure 4.3: Operational Qualification Tool - In Progress
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4.2 Operational Qualification (OQ) Tool

4.2.2 nQuery OQ Results

To view the full report of the OQ results, select the “Open Report” option in the menu bar.
This will automatically output a HTML report which will display the results automatically
in the machine’s default HTML viewer. This will often be the users default internet
browser.

To OQ report file will automatically be saved on the machine when a “Open Report” is
used. It will be saved to the C:\Users\ <User Account>\AppData\Local\nQuery\Reports
folder where <User Account> is the named User which currently logged into on the ma-
chine. Alternatively, you can save a report to an alternative folder using the “Save as”
option in the File menu of the OQ window.

If OQ report is opened in a supported application, the structure of the report will be as
follows:

At the start, the report will contain the time and date the tests were run, the number of
passed design table tests and the time taken for testing.

Within the report, there will be an individual report for each design table test run. These
will show the table code, table name, an indication whether the table passed overall, the
time taken to test that table and the number of passed tests for that table.

Within each design table report, there will be a report for each solver in that design table.
This will show the solver name, an indication whether the table solver passed overall, the
time taken to test that table and the number of passed table solver tests. When shown
within a browser, it allows a user to see the individual design parameters used for each
test applied to a solver. To open these, select the “Details” option to the right of the
solver name. An example an OQ report with a Details menu open is shown in Figure 4.4.

Test Run 2017-08-17 13:27:24

20/20 tests passed in 1045373 ms

AOCO Kappa (binary outcome) 409 ms 158/158

CalculateOmega Details [T »i~ oo

# Inputs Result Expected Time
1 [InlineData(0.21761,0.99,1,0.5,0.75,50)] 0.217609911081299 0.21761 81 ms
2 [InlineData(0.227528,0.985,2,0.5,0.75,50)] 0.227528219977332 0.227528 83 ms
3 [InlineData(0.192111,0.98,1,0.5,0.75,50)] 0.192110613399983 0192111 79 ms
4 [InlineData(0.209664,0.975,2,0.5,0.75,50)] 0.209664020388176 0.209664 81 ms
5 [InlineData(0.153862,0.95,1,0.5,0.75,50)] 0.153861961339732 0.153862 81 ms
c MelieaMesafn 467027 AA 2 A E A TE CAN A CI0cAAE419ATI Aacanza e

Figure 4.4: Operational Qualification Tool Report
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5 nQuery Updates and Licensing

5.1 Renewing a License

Important: Internet Access is required to renew nQuery using the Activation key. If you
need to renew offline, please use the “Web Registration” option in the bottom-right of
the Product Activation dialog to obtain a License key on an internet enabled device or if
still unable to renew your software, contact support@statsols.com or login to your online
account

To renew an nQuery License, select the Activate/Renew License option from the Help
menu. This will open the Product Activation dialog. Enter your provided nQuery Activ-
ation Key in the Activation Key field. This is shown in Figure 5.1.

Q Product Activation - o IEEH|

Option 1 - New License / Renewal Automatic Activation - Recommended How to Activate nQuery

Please find the Activation Key in your online account. Enter the Activation Key and

click 'Auto Activate’ button. n ) ;] uer
‘ 4
Activation Key: [ 900B-3F93-A56B-6AAG-F841| || Auto Activate ‘

[ ]
Option 2 - New License / Renewal Manual Activation - Not Frequently Used fr:m> SfafSOIS

During Activation, if you receive the 'Cannot Connect to activation server' error (or a
closely related error), you will be required to manually register your software. Please
copy the Registration ID below, click the "Web Registration” button and follow the

steps provided on the Web Registration page to get your License Key. Once you If you have received an Activation Key
have your License Key you will be able to Manually Activate your license below. or if there is one in your online account,
please enter it in the Option 1 text-field
Web Registration and click ‘Auto Activate”. If you have

not received an Activation Key please
contact your Account Manager or email

Registration ID: | 54LLG98QDI3DMITT ‘register@statsols.com’. For further help
please go to the nQuery Help Center
License Key: Manual Activate "http:/finfo.statsols.com/help-center’.
Web Registration Close

Figure 5.1: Renewal Example

If you have issues you can contact support@statsols.com or login to your online account
and create a support ticket for fastest response.

5.2 Activating an Add-on Module

Important: Internet Access is required to add an Add-on module nQuery. If you need to
add a module offline, please contact support@statsols.com or login to your online account
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5.3 Checking for Software Updates

To purchase an add-on module, either use the link provided in the Getting Started screen
or visit the Statsols website at www.statsols.com

To activate an add-on module, select the Enable Modules option in the Help file menu.
The Enable Modules dialog box should open. This is shown in Figure 5.2.

Enable Modules “

Enter Activation Key

Please enter your activation key. The activation key can be found with your account
information in the nQuery Community. For further assistance please contact your
account manager.

Activation Key: | 3238-4EC5-4743-E3FE-3646 Activate

Components Activated:

D Name Version Activated
] nQuery Advanced 9.1.00 v
1 nQuery Advanced Plus 1.6.0 v
2  nQuery Advanced Pro 14.2
3 nQuery Expert 1.1
Close

Figure 5.2: Module Activation Screen

If you have used a valid nQuery Activation Key in nQuery before, this key will appear in
the Activation Key area. Otherwise, you will need to enter the key provided by Statsols.

To activate the module, click “Activate”. The Components Activated area will refresh
after a couple of seconds and the nQuery Module(s) should have a tick in the Activated
column for the selected module(s) .

All tables in the module(s) will be enabled in nQuery Advanced

If you have issues you can contact support@statsols.com or login to your online account
and create a support ticket for fastest response.

5.3 Checking for Software Updates

Important: Internet Access is required to update nQuery. If you want to manually update,
please contact support@statsols.com or login to your online account
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5.3 Checking for Software Updates

5.3.1 Checking for Updates

nQuery provides automated tools to allow the user to upgrade their nQuery application
to the latest version. There are two methods to update your nQuery application: using
the Help menu option or using the system tray option.

To select the Help menu option, open the Help file menu and select “Check for Updates™.
To use the system tray option, find the Update Statsols - nQuery system tray item,
right-click and select “Open Updater”.

If there are no updates, these will open the Update Statsols - nQuery dialog which will
say that no upgrades are available.

If updates are available, a prompt will open asking the user if they wish to upgrade. An
example of this prompt is shown in Figure 5.3.

Confirmation “

nQuery V 8.0.2.0 is ready to install. Please close the old program before
installation.

OK Cancel

Figure 5.3: Update Prompt Example

Select OK to install the update or Cancel to close this dialog. If you select OK, the
Update Statsols - nQuery dialog will appear and show the download progress. When
downloading is completed, the Figure 5.3 dialog will appear again. Select OK and this
will close any currently open versions of nQuery. An install screen will automatically
appear and update your nQuery application. On completion, your nQuery application
will be updated and can be used again.
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6 nQuery Randomization Lists

Randomization lists is an nQuery tool which can be used to generate a sequence of random
assignments of subjects to multiple treatment groups. Subjects can be randomized into
up to 25 different treatment groups and can be stratified on up to 500 different centers
and on up to 2 stratification factors, each with up to 25 different levels.

Randomization involves random assignment of subjects to receive either experimental
treatment(s) or a control. Randomization forms a critical component of Randomized Con-
trolled Trials (RCTs), which are considered the gold standard for evaluating the causal
relationship between an intervention/treatment and a clinical outcome. Randomization is
needed for several reasons. Firstly, because it provides a basis for the standard methods
of statistical analysis by ensuring that the subjects assigned to the different treatment
groups should not differ in any systematic way. Hence, the two different treatment groups
should essentially become interchangeable, which will allow an estimate to be made of
the reliability of the treatment effect. The second reason for randomization is that ran-
domization forms one of the principal statistical elements that allows one to claim that a
study is unbiased, particularly with regard to selection bias. Selection bias refers to bias
that can be introduced by selecting particular patients to receive a particular treatment,
which could influence the results. In a RCT, this can occur if the physician or subject can
guess or predict the treatment being assigned by examining previous assignments. Using
a randomization algorithm to generate a list of assignments will help to minimize any
discernable pattern in assignments, making it unlikely if not impossible for assignments
to be predicted.

6.1 Randomization Algorithms

Seven algorithms exist in nQuery for generating randomization lists. These vary in several
respects and some algorithms may be more suitable than others for different scenarios.
These algorithms are Block Randomization, Complete (Simple) Randomization, Efron’s
Biased Coin Randomization, Smith’s Randomization, Wei’s Urn Randomization, Random
Sorting and Random Sorting using Maximum Allowable Deviation. Further inforrmation
on all algorithms (except for Random Sorting and Random Sorting using Maximum Al-
lowable Deviation) can be found in [Pocock, 1983] and [Rosenberger and Lachin, 2016].

In this section, we seek to give a high-level understanding of the various algorithms that
can be used for generating randomization lists in nQuery, which should provide users with
information allowing them to make a decision on which algorithm may be most suitable
in their scenario. More information on the workings of each algorithm, including detailed
descriptions of the parameters required for each can be found in the Randomization
Lists Setup subsection (subsection 6.2.3).

Before examining the properties of each algorithm, we will first define some notation. Let
N be the sample size which is to be randomized into the various treatment groups and
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6.1 Randomization Algorithms

let G be the number of treatment groups. Let n; be the target sample size for each of
the treatment groups and let a; be the actual sample size in each treatment group after
randomization has concluded. Note that the actual sample sizes may differ slightly from
the target sample sizes due to the way in which some algorithms operate and also due to
the inputs specified by the user in particular scenarios. Thus,

Let R; be the target allocation ratio for each treatment group. These can then be calcu-
lated as

n;

Ri=

Let p;; denote the probability of subject j being assigned to treatment group i and let
n;[j] be the sample size in treatment group i after the j* subject has been assigned.

It is also important to note that when the list is stratified with centers and/or additional
stratification factors, a stratified randomization will be performed. Stratified randomiz-
ation involves subjects first being divided into various strata based on the user entered
centers/stratification factors and a separate randomization sequence taking place within
each strata in order to ensure an ideal balance between subjects from each strata in each
treatment group. The algorithms described in the following section will be applied indi-
vidually for each strata if stratification is used. As stratified randomization will prevent
imbalance of known risk factors, it will aid in improving power of trials when stratified
factors have a large effect on the outcome, particularly in cases with low sample size.

6.1.1 Block Randomization

Block or Permuted Block Randomization is one of the most commonly used forms of
randomization. Block Randomization can be used for multiple treatment groups where
the groups are allowed to have different allocation ratios. It involves subjects being
assigned in randomized blocks rather than each subject being randomized and assigned
individually. The algorithm works as follows. The minimum block size, B,,;, is calculated
as

a

i=1
Where the R; values are the target allocation ratios. Because the minimum block size
is the sum of the target allocation ratios, the desired allocation ratios will be preserved
within each block. The user provides at least one block size multiplier value (here denoted
as M), which are multiplied by the minimum block size value to get the actual block sizes
(denoted By) that subjects will be assigned using.

Bb - Bmm X Mb
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To properly elucidate to the reader the concept of assigning subjects in blocks, consider
the following example. A researcher wishes to randomize 30 subjects into 3 different
treatment groups: Treatment A, Treatment B and Treatment C. As the researcher wishes
to achieve an equal sample size in each of the treatment groups, the target allocation ratios
are set to 1:1:1 and as a result, B,,;,= 3. The researcher wishes to use block multiplier
values of 1,2 and 3 to ensure that a diverse number of blocks sizes are used for assigning
subjects. As a result, subjects will be assigned using block sizes of 3, 6 and 9. Take the
example of a block size of 3 being used for one particular set of assignments. Subjects
can be randomized in a block size of 3 as follows:

ABC,ACB,BAC,BCA,CAB,CBA

Note that no matter which block is chosen, the target allocations will always be preserved.
This is true regardless of which block size is used.

The block size to be used at each step can be chosen from the possible block sizes in
several different ways by the user. Subjects will be assigned in blocks in this way until
the target sample size is met.

Block randomization will ensure that the proportion of total sample size in each treat-
ment group at the end of the randomization equals the targetted values. It will also
ensure that the desired balance in assignments to the different treatment groups is main-
tained throughout the course of assignments. Once at least two different block sizes are
used, it will be very difficult for researchers or subjects to predict assignments which will
help to minimize selection bias. For these reasons, block randomization is generally the
recommended form of the randomization to use.

6.1.2 Complete (Simple) Randomization

Complete or Simple Randomization is the most basic form of randomization. The prob-
ability of assignment to treatment group i is calculated for each subject as

R;

Pi = =g
ZiG:1 Rz

Each subject is then randomly assigned to a treatment group using these probabilities.
In the case of two treatment groups with equal allocation ratios, this algorithm will be
equivalent to assigning subjects using a coin toss.

The algorithm does not ensure that the actual sample size in each of the treatment groups
will meet the target sample size, and there may be imbalances in the numbers assigned to
each group as the trial progresses. For these reasons, this algorithm is not recommended
when maintaining the desired balance between the treatment groups is important.

This algorithm also has an option for a user to search for a list in which all actual sample
sizes equal the target sample sizes. If the user selects this option, the algorithm will be
repeated until a randomization list is found in which the actual group sample sizes equal
the target sample sizes, or until a maximum number of iterations is exceeded.
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6.1.3 Efron’s Biased Coin Randomization

Efron’s Biased Coin Randomization is a variation on complete randomization which can
only be used for assigning subjects to two treatment groups with equal allocation ratios.
This algorithm simulates a coin toss for assigning subjects to the two treatment groups
with an added feature to improve the degree of balance achieved between the two treat-
ment groups, both throughout the trial and at the end. If the two groups have the same
sample size at any stage throughout the assignment process, the probability of assignment
to either group is 0.5. However, if the sample sizes of the two groups are currently unequal,
the probability of assignment to the group which has less subjects is set to a constant
probability p (called “Efron’s p”), where 0.5 < p < 1. The probability of assignment of
subject j to group 1 is given as

0.5 m[j] = nalj]
Py =P n1[j] < nalj]
1—p nifj] > nalj]

The algorithm works by assigning subjects to the two treatment groups using the above
probabilities, where py; = 1 — py;. This algorithm is outlined in [Efron, 1971].

The algorithm does not ensure that the actual sample size in each of the treatment groups
will meet the target sample size, and there may be imbalances in the numbers assigned to
each group as the trial progresses. However, there will tend to be a much higher degree of
balance between the treatment groups when compared with the same scenario performed
using complete randomization.

This algorithm also has an option for a user to search for a list in which all actual sample
sizes equal the target sample sizes. If the user selects this option, the algorithm will be
repeated until a randomization list is found in which the actual group sample sizes equal
the target sample sizes, or until a maximum number of iterations is exceeded.

6.1.4 Smith’s Randomization

Smith’s Randomization is a variation on complete randomization which can only be used
for assigning subjects to two treatment groups with equal allocation ratios. Similarly to
Efron’s Biased Coin, this algorithm simulates a coin toss for assigning subjects to the
two treatment groups with an added feature to improve the degree of balance achieved
between the number of subjects assigned to the two treatment groups, both throughtout
the trial and at the end. The user enters a value for parameter p (known as “Smith’s
Exponent”), where p > 0 and the probability of assignment of subject j to group 1 is
defined as

nalj —1)°
nilj — 107 + nofj — 1)

P =

The algorithm works by assigning subjects to the two treatment groups using the above
probabilities, where py; = 1 — py;.

The algorithm does not ensure that the actual sample size in each of the treatment groups
will meet the target sample size, and there may be imbalances in the numbers assigned to
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each group as the trial progresses. However, there will tend to be a much higher degree of
balance between the treatment groups when compared with the same scenario performed
using complete randomization.

This algorithm also has an option for a user to search for a list in which all actual sample
sizes equal the target sample sizes. If the user selects this option, the algorithm will be
repeated until a randomization list is found in which the actual group sample sizes equal
the target sample sizes, or until a maximum number of iterations is exceeded.

6.1.5 Wei’'s Urn Randomization

Wei’s Urn Randomization is an adaptive randomization algorithm which can be used
for multiple groups with equal allocation ratios. The algorithm involves simulating a
scenario where each group begins with several balls in an urn, with the initial number of
balls belonging to each group known as Wei’s A, where A > 0. The algorithm begins by
drawing a ball at random and the subject is assigned to the group which corresponds to
that ball and the ball is placed back in the urn. Following this, a number of balls are
added for all groups besides the group which was just drawn, with the number of new
balls being added for the other groups being known as Wei’s B, where B > 1. A ball is
drawn again and the subjects are assigned in this way until the target sample size is met.
The algorithm is outlined in [Wei, 1978].

The algorithm does not ensure that the actual sample size in each of the treatment groups
will meet the target sample size, and there may be imbalances in the numbers assigned to
each group as the trial progresses. However, there will tend to be a much higher degree of
balance between the treatment groups when compared with the same scenario performed
using complete randomization.

This algorithm also has an option for a user to search for a list in which all actual sample
sizes equal the target sample sizes. If the user selects this option, the algorithm will be
repeated until a randomization list is found in which the actual group sample sizes equal
the target sample sizes, or until a maximum number of iterations is exceeded.

6.1.6 Random Sorting

The Random Sorting algorithm can be used for any number of treatment groups and
unequal allocation ratios between treatment groups are allowed. This algorithm involves
assigning each subject a random real number between 0 and 1. The subjects are then
ordered ascendingly according to these random numbers and are assigned in this order.
For example, consider a sample size of 30 being assigned to 3 treatment groups with equal
allocation ratios. Each subject is assigned a number and then ordered according to these
numbers. The first 10 in the ordered list will be assigned to the first group, the second
10 to the second group and the final 10 to the third group.

For non-complex cases this algorithm will generally maintain balance in treatment as-
signments at the end. However, it is not guaranteed that balance will be maintained
between the numbers assigned to the different groups throughout the course of the trial.
For complex cases involving stratified randomization or diverse group sample size targets,
this algorithm may fail to work as intended, as the cohort to be randomized at each stage
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may not be divisible by the allocation ratios. For these reasons, the algorithm is generally
not recommended.

6.1.7 Random Sorting using Maximum Allowable Deviation

Random sorting using Maximum Allowable Deviation is a variation on the Random Sort-
ing algorithm described previously. Subjects are allocated randomly using the same
method as Random Sorting, but the deviation from the target sample size in each group
is calculated after each subject is assigned as

1 Bl
% Deviation;; = it (nilj]) x 100
n;
_ |l =3®| 00
Uz

where i is the treatment group, j is the number of subjects currently assigned and p; =
R;

SR

If any of the deviation values are greater than the user entered maximum deviation value,

the generated list is deleted and the randomization restarts. This process will continue

until an ideal list is found in which all deviations are less than the maximum deviation

value, or until a user entered maximum number of iterations is exceeded.

For example, consider a scenario in which 60 subjects are being assigned to two treatments
groups with equal allocation ratios, with a maximum allowable deviation value of 5%.
Suppose that after 15 assignments, that 6 subjects are assigned to the first treatment
group and 9 subjects assigned to the second treatment group. At this stage, the percentage

deviation in the first group is ‘(%80‘5))‘ x 100 = 5% and the percentage deviation
in the second group is ’(%0(0'5))‘ x 100 = 1.6667%. As both deviation values do not

exceed the the maximum allowable deviation value, the algorithm will continue assigning
subjects. Assume that the next subject is assigned to the second treatment group. Then
percentage deviation values for the two groups will be ‘(6_16(0'5) )‘ x 100 = 6.6667% and

30
‘(%80'5))‘ x 100 = 3.3333%. Since the deviation value in the first group now exceeds

the maximum allowable deviation, the current list will be deleted and the process will
begin again. This will continue until an ideal list is found, or until a maximum number
of iterations value is exceeded.

For non-complex cases this algorithm will generally maintain balance in treatment as-
signments at the end and depending on the value inputted for the maximum allowable
deviation, will generally maintain a greater deal of balance as the trial progresses when
compared with the random sorting algorithm. For complex cases involving stratified
randomization or diverse group sample size targets, this algorithm may fail to work as in-
tended, as the cohort to be randomized at each stage may not be divisible by the allocation
ratios. For these reasons, the algorithm is generally not recommended.
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6.2 nQuery Randomization Lists Demonstration

This section will demonstrate how to generate valid randomization lists using the nQuery
Randomization Lists tool. This demonstration will be split into the following subsections

1. Creating an nQuery Randomization Lists Workspace (subsection 6.2.1)
. nQuery Randomization Lists Workspace Layout (subsection 6.2.2)
. Randomization Lists Setup (subsection 6.2.3)

. Block Randomization Demonstration (subsection 6.2.5)

2
3
4. Results Output Summary (Randomization List/Output) (subsection 6.2.4)
5
6. Block Randomization with Stratification Demonstration (subsection 6.2.6)
7

. Complete Randomization Demonstration (subsection 6.2.7)
8. Other Features (subsection 6.2.8)

Creating an nQuery Randomization Lists Workspace (subsection 6.2.1) gives an
overview of how to create a new nQuery Randomization Lists Workspace.

nQuery Randomization Lists Workspace Layout (subsection 6.2.2) gives an over-
view on the layout of an nQuery Randomization Lists Workspace and how this workspace
can be navigated through.

Randomization Lists Setup (subsection 6.2.3) gives an overview of the various stages
of the Setup required for generating a valid randomization list, as well as a detailed
description of the parameters required for each possible scenario.

Results Output Summary (subsection 6.2.4) gives a high-level overview of the outputs
from randomization lists tool, including the Randomization List and Randomization
List Summary available.

Block Randomization Demonstration (subsection 6.2.5) gives an overview of how to
generate a valid randomization list for the most common and recommended randomization
algorithm, Block Randomization.

Block Randomization with Stratification Demonstration (subsection 6.2.6) gives
an overview of how to generate a valid randomization list for Block Randomization when
stratification also occurs upon enrollment center and 2 additional stratification factors.

Complete Randomization Demonstration (subsection 6.2.7) gives an overview of
how to generate a valid randomization list for the Complete Randomization algorithm.

Other Features (subsection 6.2.8) gives an overview of other features of nQuery Ran-
domization Lists, including information on how to save, export and load Workspaces.

The first 2 subsections and last subsection are common across all randomization al-
gorithms. There will be differences in the remaining subheadings, due to the alternate
algorithms and differing options available throughout the Setup.

6.2.1 Creating an nQuery Randomization Lists Workspace

The nQuery Randomization Lists Workspace is a tab in which the user will setup, run
and view the results of their randomization list generation. To create a new nQuery
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Randomization Lists Workspace, the user can select the Create Randomization List
button in the top-left Home quadrant (1) or select the Create Randomization Lists
option in the dropdown list from the Assistants menu at the top of the software window
(2). This can be seen in Figure 6.1.

Fie Edit View [ASHSNE) Predict Flot Help

[=] Standard Deviation

S

[ Data Entry

(OEIS] - ciciivution Funcion “O Recent Files

oste ¢ Rate Calculator
d Create Prediction
]'& Create Randomization List e
H Open nQuery File = Create Randomization List

& Packages 8 Help & Support

Package Activated E Manual

@ Online Help
& My Account
I Getting Started

£ Contact Us.

nQuery Advanced
nQuery Advanced Plus
nQuery Advanced Pro

nQuery Advanced Expert £3 Create Support Ticket

@ Home | Simulation Setup Step 1 uery |

Figure 6.1: nQuery Randomization Lists Workspace Creation Options

6.2.2 nQuery Randomization Lists Workspace Layout
6.2.2.1 nQuery Randomization Lists Workspace Layout Overview

An nQuery Randomization Lists Workspace will consist of three primary user interface
elements: the workspace navigation bar (1), the Main Display Window (2), and the Help
Window (3). These are numbered in Figure 6.2.

The Workspace Navigation Bar (1) is used to navigate to a specific element (Setup, Re-
port) of the current nQuery Randomization Workspace at any time. Elements are organ-
ized under headers with an example header (Setup) highlighted as per 1A in Figure 6.2.
A specific element can be selected from under a given header. Header elements can be
opened and collapsed by selecting the header name. In Figure 6.2, the Select random-
ization algorithm element can be selected from the Setup header. More options will
become available under the Setup header once the user progresses through the relevant
steps. Once the user procedes through all steps, a Report header will become available.
The Report header will contain two elements; Randomization List and Randomiz-
ation List Summary.
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Figure 6.2: New nQuery Randomization Lists Workspace

The Main Display Window (2) displays the current element selected and is where the
user can input values and view results. During the Setup stage, the user can select the
Next button (2A) or Right-Arrow buttons (2B) to move to the next step (note subsequent
Setup steps will have a corresponding adjacent Back and Left-Arrow buttons to go back
to the prior step) and users can select and enter values in the main fields (e.g. for the
current Select randomization algorithm step, the randomization algorithm can be
selected using radio buttons). Details on what is displayed in the Main Display Window
for a given element will be shown in the sections below.

The Help Window (3) provides context and guidance on all of the elements currently dis-
played in the Main Display Window. The Help will include definitions, context, suggested
values and tips.

6.2.2.2 Editing the nQuery Randomization Lists Workspace Layout

There are three primary ways to change the default layout of an nQuery Randomization
Lists Workspace: collapsing the Workspace Navigation Bar, unpinning the Help Window
and changing the width of the Main Display Window.

To collapse the Workspace Navigation Bar, select the ¢ button to the right of the main
“Workspace” header at the top-right of the Workspace Navigation Bar. When the Work-
space Navigation Bar is collapsed, elements can be shown and selected by clicking the
named bar (name will be the same as the current element shown in the Main Display
Window) on the left-hand side of the nQuery Randomization Lists Workspace. To ex-

pand the Workspace Navigation Bar, select the  button at the top of the named bar on
the left-hand side.

To unpin the Help window, select the * button on the right of Help Window header
in the top-right. When the Help Window is unpinned, the Help Window will not be
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dieH

displayed unless the cursor is placed over the & section in the top-right of the nQuery
Randomization Lists Workspace after which the Help Window will be displayed until a
different element is selected in the nQuery Randomization Lists Workspace. To repin the
Help Window, select the button when the Help Window is open.

To change the width of the Main Display Window, move the cursor over the lefthand
edge (if the Workspace Navigation Bar is not collapsed) or right-hand edge (if the Help
Window is displayed) of the Main Display Window until the cursor changes to a two-way
arrow (<) and click and drag the cursor to change the Main Display Window width.

An example workspace where the Workspace Navigation Bar is collapsed and Help Win-
dow is unpinned and unselected is shown in Figure 6.3, with the user interface items
referenced above highlighted in yellow.

Q nQuery - m] b
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Block Randomization
Complete Randomization
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Wei's Umn Randomization
Random Sorting

Random Serting using Maximum Allowable Deviation

@ Randomization List 1 | Simulation Setup Step 1

Figure 6.3: Collapsed nQuery Randomization Lists Workspace

6.2.3 Randomization Lists Setup

The section will describe how the user can move through the various stages in the Setup
in order to generate a valid randomization list. This will include detailed discussions of
the parameters required in each step. The Setup process is divided into five steps. These
are:

. Select randomization algorithm

. Specify Parameters for [Chosen algorithm]|

1

2

3. Specify target sample size

4. Specify Centers/Stratification Factors
5

. Randomization list options
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The Select randomization algorithm subsection will provide information on how a
randomization algorithm can be selected.

The Specify Parameters for [Chosen Algorithm] subsections will provide inform-
ation on how to correctly specify the parameters needed for each particular algorithm.
As each algorithm requires different parameters, this step will be different depending on
which algorithm the user chooses in Step 1. The discussion of Step 2 for the various
algorithms will be discussed in different subsections. Within each subsection, a detailed
description of the parameters for each algorithm will be given.

The Specify target sample size subsection will provide information on how to specify
a value for the target sample size and correctly provide information on the treatment
groups that subjects will be randomized into.

The Specify Centers/Stratification Factors subsection will provide information on
how the user can stratify subjects based on center of enrollment and/or on up to two
different stratification factors. Note however, that this is an optional step which can be
skipped if the user does not wish to conduct a stratified randomization.

The Randomization list options subsection will provide information on extra options
that are available when generating the randomization list.

6.2.3.1 Step 1 - Select randomization algorithm

The Select randomization algorithm is the first step of the Setup stage for the
randomization list generation in nQuery. The Select randomization algorithm step
selects the specific algorithm which will be used for generating the randomization list. The
Select randomization algorithm step in the nQuery Randomization Lists workspace
is shown in Figure 6.4.

Q nQuery
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Em i
Home ® | Randomization List1 % | + —
Workspace < Select randomization algorithm w
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@ Randomization List1 | Simulation Setup Step 1
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Block Randomization: This is by far the most
commonly used randomization algorithm. It
involves randomizing participants within blocks
such that the number assigned to each
treatment group meets the target allocation
and maintains an ideal balance between
treatment groups over time. The number of
subjects in each block (the block size) is
calculated using values entered for the target
allocations for each treatment group and block
multipliers. To explain the concept of assigning
subjects in blocks, consider the following
example: Researchers wish to randomize 60
subjects into 2 treatment groups, Treatment A
and Treatment B, with allocation ratios of 1:2
(For every subject assigned to treatment A,

Figure 6.4: Overview of the Select randomization algorithm Step
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The appropriate randomization list algorithm can be chosen by clicking the radio button
to the left of the desired option. Information on available algorithms can be found in
section 6.1 or else in the Help Card section on the right-hand side of the nQuery Ran-
domization Lists Workspace.

Once a randomization algorithm is chosen, the Next button in the bottom-right of the
Main window will be enabled. Clicking on this will move the user onto the next Step 2
in the Setup.

6.2.3.2 Step 2 - Select Parameters for Block Randomization

An overview of the options for the Selecting Parameters for Block Randomization
step can be seen in Figure 6.5. This step will involve chosing a number of block multiplier
values to use. Then in the block multiplier table, the user can then enter the values for
each of the block multipliers. The user must also choose whether to use Random, Equal
or Custom Block Subject Allocation. If the user chooses Custom, a table will appear in
which the user should enter allocation ratios which determine the proportion of subjects
that the algorithm aims to assign using each block size. The user should also enter whether
they wish to constrain the block allocation in order to minimize sample size and whether
they wish specify information about block size and block ID in the output.
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Home % | Randomization List1 % | + -
Workspace < Parameters for Block Randomization “ = ®
-~ . . -
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3 Enter the number of block multipliers to be
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Block # Block Multiplier

block multipliers. Choose a value for the block
subject allocation. If custom is chosen, enter
the allocation ratios which will determine the

3 proportion of total sample size that should be
assigned using each block size. Choose
whether or not you wish to constrain block
allocation (and hence minimize sample size)
Ves @ Mo Specify Block ID and Block Size in Qutput and whether you wish specify block ID and
block size for each subject inthe generaled
randomization list.

1 1
2

Random V| Block Subject Allocation

Yes @ No Constrain Block Allocation

Number of Block Multipliers:

Block multipliers are used to calculate the

number of subjects in each block, referred to

as the block sizes. Block sizes are calculated

by multiplying the block multiplier values by the
Back Next sum of the aroup allocation ratios. Enterthe v

@ Randomization List 1

Figure 6.5: Overview of the Parameters for Block Randomization Step

Block Randomization Parameters

o Number of Block Multipliers: Enter an integer between 1 and 10 for the number
of block multipliers. It is recommended that at least 2 block multiplier values are
used to decrease the likelihood that future assignments can be determined from
previous assignments. Once a value is entered for the number of block multipliers,
the Block Multiplier Table will update to have the same number of rows as
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Q. nQuery

the value entered for the number of block multipliers. The default value of 3 is
recommended if the user does not have any strong preference on the number of
block multipliers to be used.

Block Multiplier Table: In this table the user will enter the block multiplier
values used for the calculation of the block sizes. Each row corresponds to one
block multiplier. Block multiplier values can be entered in the second column and
must take the value of integers. These values will be multiplied by the sum of the
target allocation ratios (target allocation ratios are described in the Specify target
sample size step) in order to determine the actual block size values that will be
used for the randomization. If the user decides to use 3 block multiplier values,
values of 1,2 and 3 would be good choice for the block multipliers.

Block Subject Allocation: This value determines the approximate proportion of
the total sample size that should be assigned using each block size. Three options
are available: “Random”, “Equal” or “Custom”. If Random is chosen, the size of
the block at each step will be chosen at random from the possible block sizes. If
Equal is chosen, the algorithm will attempt to assign subjects in such a way that
approximately equal proportions are assigned using each of the possible block sizes.
If Custom is chosen, the Custom Block Subject Allocation Table will become
visible to the user below this field. An example of this table being present within
the step window is provided in Figure 6.6.

File Edit View Assistants Predict Plot Help

22l o

Home
Workspa

% Setup

ce <

% | Randomization List4 % | + -

Parameters for Block Randomization e« =2 ®

v

Block Randomization
Parameters

Block Randomization:

Number of Block Multipliers:

3 Enter the number of block multipliers to be
used. Inthe table, enter the values for the
block multipliers. Choose a value for the block
subject allocation. If custom is chosen, enter
the allocation ratios which will determine the

Block # Block Multiplier
1 1
2 2
3 3 proportion of total sample size that should be
assigned using each block size. Choose:
whether or not you wish to constrain block
Black # Custom Allocation allocation (and hence minimize sample size)
1 1 and whether you wish specify block ID and
1 block size for each subject inthe generated
1 randomization list.

Custom ~|| Block Subject Allocation

® Yes () No Constrain Block Allocation o
Number of Block Multipliers:
o Yes No Specify Block ID and Block Size in Qutput

Block multipliers are used to calculate the

number of subjects in each block, referred to

as the block sizes. Block sizes are calculated

by multiplying the block multiplier values by the
Back Next sum of the aroup allocation ratios. Enterthe  ~

©® Randomization List4. n Juery |

Figure 6.6: Parameters for Block Randomization Step with Custom Block Subject Al-
location Table

Custom Block Subject Allocation Table: This table will be visible if the user
has set the Block Subject Allocation field to “Custom”. This table will have the
same number of rows as the value entered for the number of block multipliers, with
each row corresponding to one block size. Enter the custom block subject allocations
for each block size in the Custom Allocation column. For example, consider a
scenario where a researcher wishes to use three block multiplier values (and hence
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three block sizes). They desire that approximately 2 subjects are assigned using
the first block size for every 1 subject that is assigned with the second block size
and 1 subject assigned with the third block size. In this scenario, in the Custom
Allocation column, they would enter 2,1 and 1 in each of the rows.

o Constrain Block Allocation: In certain scenarios for Block Randomization, the
actual sample size will be larger than the target sample size. As subjects are as-
signed in blocks, it is possible for the target sample size to be exceeded. Consider
an example where a sample size of 100 is being randomized into three different
treatment groups with equal allocation ratios. Hence the minimum block size is
3. Assume further that 2 block multiplier values of 1 and 2 are being used, which
yield actual block sizes of 3 and 6. Subjects will be assigned using these block sizes
until the target sample size is met. Assume that after many random assignments,
99 subjects have been assigned. For the final assignment, a block size of 3 or 6 can
be used, which will bring the actual sample size over the target sample size of 100
to 102 or 105 respectively. If Constrain Block Allocation is set to “Yes”, the al-
gorithm will override the value specified for Block Subject Allocation and choose
the block size which will minimize the actual sample size for the final assignment,
i.e., in the aforementioned example, the block sizse of 3 will be chosen for the final
assignment, regardless of the option chosen for Block Subject Allocation

o Specify Block ID and Block Size in Output: If “Yes” is selected for this option,
information on the block that each subject was assigned with and that block’s block
size will be provided in the generated randomization list.

6.2.3.3 Step 2 - Select Parameters for Complete Randomization

Step 2 in the case where Complete Randomization is used as the randomization algorithm
will involve specifying Parameters for Complete Randomization. The Step 2 Setup
window can be seen below in Figure 6.7.

For Complete Randomization, this step will involve choosing whether the subject wishes
to search for a list in which actual group sample sizes equal the target sample sizes. The
default window for Complete Randomization can be seen in Figure 6.7.
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Figure 6.7: Overview of the Parameters for Complete Randomization Step

Complete Randomization Parameters

e Search for list in which actual group sizes match the target group sizes:
Unlike Block Randomization, the proportion of total sample size in each treatment
group for Complete Randomization may not equal the targetted values. This option
gives the ability for the user to search for a list in which the proportion of the total
sample size in each group equals the values calculated using the target allocation
ratios which are specified in Step 3. If the user wishes to search for a list in which
the actual group sizes match the target group sizes, they should set the radio button
to “Yes”. If “Yes” is selected for this option, a new Maximum number of iterations
when search for list in which actual group sizes match the target group sizes field
will become visible. This field is shown in Figure 6.8.
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Figure 6.8: Parameters for Complete Randomization Step when searching for a list in
which actual group sizes match target group sizes

e Maximum Number of iterations when searching for list in which actual
group sizes match the target group sizes: This parameter controls the max-
imum number of iterations that are to be used when searching for a list in which
actual group sizes match the target group sizes. In some scenarios, it may be im-
possible or take an unreasonably large amount of time in order to find an ideal list.

Back

Next

Complete Randomization
Parameters

Choose if you wish to search for a list in which
actual group sizes match target group sizes. If
yes is chosen for the previous oplion, enter the
maximum number of iterations to be used
when searching for an optimal list before
terminating the algorithm

Search for a list in which actual group
sizes match the target group sizes:

If yes is selected for this option, the algorithm
will check if the number of subjects assigned to
each group in the generated randomization list
maiches the target group sample sizes. If they
do not match, the list will be deleted and the
algorithm will generate a new list. It will repeat
this process until the desired list is found or
until the maximum number of iterations is
exceeded

In these cases, the algorithm will terminate after a certain number of attempts,

which is specified by this parameter. Enter an integer greater than 0 for this value.
A default value of 1000 is used. This value will generally find an ideal list if pos-
sible, while not wastefully searching for an ideal list that is unlikely or impossible

to generate.

6.2.3.4 Step 2 - Select Parameters for Efron’s Biased Coin Randomization

Step 2 in the case where Efron’s Biased Coin Randomization is used as the randomization
algorithm will involve specifying Parameters for Efron’s Biased Coin Randomiz-
ation. Step 2 will involve choosing a value for the Efron’s p parameter and choosing
whether the user wishes to search for a list in which actual group sample sizes equal the
target sample sizes. If the user does wish to search for a list in which actual group sample
sizes equal the target group sample sizes, an additional maximum number of iterations
parameter will be required. The default window for Efron’s Biased Coin Randomization

can be seen in Figure 6.9.

95



6.2 nQuery Randomization Lists Demonstration

Q nQuery - m] X
File Edit View Assistants Predict Plot Help
E = 4l -
Home x | Randomizationlist] x | Randomizationlist2 x | Randomizationlist3 x | + -
Workspace < Parameters for Efron’s Biased Coin “ = u
@
ey v Efron's Biased Coin
Efron's p Randomization Parameters
067 Choose a value for Efron's p. Choose if you
Search for list in which actual group sizes match the target group sizes wish to search for a list in which actual group
Yes @ No sizes match target group sizes. If yes is

chosen for the previous option, enter the
maximum number of iterations to be used
when searching for an optimal list before
terminating the algorithm

Efron'sp

Efron's Biased Coin simulates a coin toss to
randomize the subjects into two groups. For
each assignment, if one group curmently has
more subjects assigned to it, the probability of
being assigned to the two groups will be
altered to improve balance. Efron's p
parameter is the probability of assignment to
the group which currently has less subjects. A

value such as 0.67 will work well to improve
Back Mext halance. v

@ Randomization List 3

Figure 6.9: Overview of the Parameters for Efron’s Biased Coin Randomization Step

Efron’s Biased Coin Randomization Parameters

Efron’s p: Efron’s Biased Coin simulates a coin toss to randomize subjects into the
two groups. For each assignment, if one group currently has less subjects assigned to
it, this group has an increased probability of being selected for the next assignment.
This increased probability is Efron’s P. Efron’s P can take real values of 0.5 < p < 1.
The default value of 0.67 was recommended by Efron (1971) for improving balance
without making assignments too predictable.

Search for list in which actual group sizes match the target group sizes:
Unlike Block Randomization, the proportion of total sample size in each treatment
group for Efron’s Biased Coin Randomization may not equal the targetted values.
This option gives the ability for the user to search for a list in which the proportion
of the total sample size in each group equals the values calculated using the target
allocation ratios which are specified in Step 3. If the user wishes to search for a
list in which the actual group sizes match the target group sizes, they should set
the radio button to Yes. If Yes is selected for this option, a new field will open for
the maximum number of iterations to be used in the search. This field is shown in
Figure 6.10.
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Figure 6.10: Parameters for Efron’s Biased Coin Randomization Step when searching
for a list in which actual group sizes match target group sizes

e Maximum Number of iterations when searching for list in which actual
group sizes match the target group sizes: This parameter controls the max-
imum number of iterations that are to be used when searching for a list in which
actual group sizes match the target group sizes. In some scenarios, it may be im-
possible or take an unreasonably large amount of time in order to find an list. In
these cases, the algorithm will terminate after a certain number of attempts, which
is specified by this parameter. Enter an integer greater than 0 for this value. A
default value of 1000 is used. This value will generally find an ideal list if pos-
sible, while not wastefully searching for an ideal list that is unlikely or impossible

to generate.

Back

Next

Efron's Biased Coin
Randomization Parameters

Choose a value for Efron's p. Choose if you
wish to search for a list in which actual group
sizes match target group sizes. If yes is
chosen for the previous option, enter the
maximum number of iterations to be used
when searching for an optimal list before
terminating the algorithm.

Efron’s p

Efron's Biased Coin simulates a coin toss to
randomize the subjects into two groups. For
each assignment, if one group currently has
more subjects assigned 1o it, the probability of
being assigned to the two groups will be
altered to improve balance. Efron's p
parameter is the probability of assignment to
the group which currently has less subjects. A
value such as 0.67 will work well to improve
balance.

6.2.3.5 Step 2 - Select Parameters for Smith’s Randomization

For Smith’s Randomization, Step 2 will involve choosing a value for the Smith’s
Exponent parameter and choosing whether the user wishes to search for a list in which
actual group sample sizes equal the target sample sizes. If the user does wish to search for
a list in which actual group sample sizes equal the target group sample sizes, an additional
maximum number of iterations parameter will be required. The default Step 2 window

for Smith’s Randomization is provided in Figure 6.11.
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Figure 6.11: Overview of the Parameters for Smith’s Randomization Step

Smith’s Randomization Parameters

Smith’s Exponent: Smith’s Randomization simulates a coin toss to randomize
subjects into the two groups. For each assignment, if one group currently has less
subjects assigned to it, the group with less subjects assigned to it has an increased
probability of being selected for the next assignment. This increased probability
is calculated using Smith’s Exponent (see subsection 6.1.4 for further information
on how this value is calculated). Smith’s Exponent can take any real value greater
than 0. A default value of 5 is generally recommended for improving balance without
making assignments too predictable.

Search for list in which actual group sizes match the target group sizes:
Unlike Block Randomization, the proportion of total sample size in each treatment
group for Smith’s Randomization may not equal the targetted values. This option
gives the ability for the user to search for a list in which the proportion of the total
sample size in each group equals the values calculated using the target allocation
ratios which are specified in Step 3. If the user wishes to search for a list in which
the actual group sizes match the target group sizes, they should set the radio button
to Yes. If Yes is selected for this option, a new field will open for the maximum
number of iterations to be used in the search. This field is shown in Figure 6.12.
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Figure 6.12: Parameters for Smith’s Randomization Step when searching for a list in
which actual group sizes match target group sizes

e Maximum Number of iterations when searching for list in which actual
group sizes match the target group sizes: This parameter controls the max-
imum number of iterations that are to be used when searching for a list in which
actual group sizes match the target group sizes. In some scenarios, it may be im-
possible or take an unreasonably large amount of time in order to find an list. In
these cases, the algorithm will terminate after a certain number of attempts, which
is specified by this parameter. Enter an integer greater than 0 for this value. A
default value of 1000 is used. This value will generally find an ideal list if pos-
sible, while not wastefully searching for an ideal list that is unlikely or impossible
to generate.

6.2.3.6 Step 2 - Select Parameters for Wei’s Urn Randomization

For Wei’s Urn Randomization, Step 2 will involve choosing a value for the Wei’s
A and Wei’s B parameters and choosing whether the user wishes to search for a list in
which actual group sample sizes equal the target sample sizes. If the user does wish to
search for a list in which actual group sample sizes equal the target group sample sizes, an
additional maximum number of iterations parameter will be required. The default Step
2 window for Wei’s Randomization is provided in Figure 6.13.
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Figure 6.13: Parameters for Wei’s Urn Randomization Step

Wei’s Urn Randomization Parameters

e Wei’s A: Wei’'s A controls the number of balls belonging to each group in the
simulated urn at onset. Wei’s A can take integer values greater than or equal to 0.
A value of 0 is often used.

o« Wei’s B: Wei’'s B controls the number of balls that are added to the urn for each
group that were not the previous selection. Wei’s B can take integer values greater
than or equal to 1. A value of 1 is often used.

e Search for list in which actual group sizes match the target group sizes:
This option gives the ability for the user to search for a list in which the proportion
of the total sample size in each group equals the values calculated using the target
allocation ratios which are specified in Step 3. If the user wishes to search for a
list in which the actual group sizes match the target group sizes, they should set
the radio button to Yes. If Yes is selected for this option, a new field will open for
the maximum number of iterations to be used in the search. This field is shown in
Figure 6.14.

100



6.2 nQuery Randomization Lists Demonstration

Q. nawery
File Edit View Assistants Predict Plot Help
Ew sl -
Home x ization List 1 x ization List2 % | +
Whisas .
Workspace < Parameters for Wei's Urn
¥ Setup v
Wei's A
0
Wei's B
1
Search for list in which actual group sizes match the target group sizes
@Yes (No

Maximum number of iterations when searching for list in which actual group sizes match
the target group sizes:

1000

© Randomization List2 | Simulation Setup Step 1

Figure 6.14: Selecting Parameters for Wei’s Urn Randomization when searching for a
list in which actual group sizes match target group sizes

e Maximum Number of iterations when searching for list in which actual
group sizes match the target group sizes: This parameter controls the max-
imum number of iterations that are to be used when searching for a list in which
actual group sizes match the target group sizes. In some scenarios, it may be im-
possible or take an unreasonably large amount of time in order to find an list. In
these cases, the algorithm will terminate after a certain number of attempts, which
is specified by this parameter. Enter an integer greater than O for this value. A
default value of 1000 is used. This value will generally find an ideal list if pos-
sible, while not wastefully searching for an ideal list that is unlikely or impossible

to generate.

6.2.3.7 Step 2 - Select Parameters for Random Sorting

For Random Sorting, no algorithm specific parameters are required. As such, Step
2 is skipped for the Random Sorting algorithm. The Step 2 window for Random

Sorting is provided in Figure 6.13.
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Figure 6.15: Overview of the Parameters for Random Sorting Step

6.2.3.8 Step 2 - Select Parameters for Random Sorting using Maximum Allowable
Deviation

For Random Sorting using Maximum Allowable Deviation, Step 2 will involve
choosing a value for the Maximum Allowable Percentage Deviation and the Maximum
number of iterations to use when conducting a search. The default Step 2 window for
Random Sorting using Maximum Allowable Deviation is displayed in Figure 6.16.
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Figure 6.16: Overview of the Parameters for Random Sorting using Maximum Allowable
Deviation Step

Random Sorting using Maximum Allowable Deviation Parameters

o Max Allowable % Deviation: Enter the maximum allowable percentage devi-
ation. If the percentage deviation in any group at any stage during the randomiza-
tion process exceeds this value, the randomization list will be deleted and the search
will begin again. This field takes real values between 0 and 100.

e Maximum number of iterations: Enter the maximum number of times that the
algorithm may restart the randomization process if a group deviation value exceeds
the max allowable deviation. A value of 1000 is recommended. This cell takes
integer values greater than 0.

6.2.3.9 Step 3 - Specify target sample size

Specify target sample size is the third step in the Randomization Lists Setup. This
step involves specifying the target sample size that is to be randomized into the various
treatment groups and specifying information on the treatment groups. An overview of
Step 3 can be seen in Figure 6.17.
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Figure 6.17: Overview of the Specify target sample size Step

Target Sample Size Parameters

o Target Sample Size: Enter the target number of subjects that you desire to
randomize into the various treatment groups. Note that the actual sample size may
be larger than this value in some scenarios. Enter an integer value greater than or
equal to 2 in this field.

Treatment Groups Parameters

« Title/Name: Enter a general title that will be used for the treatment groups. For
example, you could enter “Treatment”, “Dose” or “Group”. This field takes text
values.

e Number of Treatments: Enter the number of treatment groups that you wish
to randomize subjects into. This field can take integer values between 2 and 25.
When the value for this is altered, the number of rows in the Specify Treatment
Group Information table will change to this value and the values in the table will
reset. Clicking the “Specify” button on the right will hide the Specify Treatment
Group Information table.

o Specify Treatment Group Information Table: The Specify Treatment Group
Information table allows the user to enter the required information for the treat-
ment groups that subjects are randomized into. The Specify Treatment Group
Information Table will have three columns.

— Group: This column will contain the sequential order of the groups. These
values are not editable by the user.

— Treatment Group: This column will have the heading “Treatment Group”
by default, but will take on whatever value the user inputs previously in the
Title/Name field. The values in this column will represent the name or label
that is applied to each treatment group. The groups will by default be labelled
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alphabetically. The user can edit these values by clicking on the desired cell
and entering new values. These cells take text entries.

— Allocation Ratio: This column gives the user the ability to enter an al-
location ratio for each treatment group. The allocation ratio will determine
how the sample size will be ideally split between the treatment groups. For
example, with three groups with allocation ratios of 1,2 and 1, the algorithm
will aim to randomize 25% of the sample size in groups 1 and 3 and 50% of
the sample size in group 2. These values will be one by default, but can be
changed to any integer value.

Note that for the Efron’s Biased Coin Randomization, Smith’s Randomization and Wei’s
Urn Randomization Algorithms there is an additional constraint that the allocation ratios
for the treatment groups must be equal. If the user attempts to enter unequal allocation
ratios for these scenarios, an acceptable entries error will be thrown in the Allocation
Ratio column of the Specify Treatment Group Information Table.

For the readers benefit, an example of a more complex set of inputs for Step 3 than the
default case is provided in Figure 6.18.
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Figure 6.18: Example of Specify target sample size Step for a complex case

6.2.3.10 Step 4 - Specify Centers/Stratification Factors

Step 4 in the Setup involves Specifying Centers/Stratification Factors. This is an
optional step and can be skipped directly by clicking the “Next” button in the bottom-
right if the user does not wish to stratify on Centers/Stratification Factors. An overview
of the options for this step can be seen in Figure 6.19.
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Figure 6.19: Overview of the Specify Centers/Stratification Factors Step

Centers Parameters

e Include Centers: Select whether you wish to stratify upon centers. If “Yes” is
selected for this option, the Specify Centers Information table will appear as as
shown in Figure 6.20.
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@ Ve o Include conterst the ability to stratify the treatment groups

based on enroliment centers. If the user
wishes to maintain balance between subjects
enrolling from different centers in each group,
click yes on the include centers option. Choose
ageneral title for the centers and the number

| of centers that subjects will be enrolling from_

| In the table, choose a name for each center
and enter the allocation ratio for each center.

Title/Name:

MNumber of Centers;
[ e ]
1 Center 1 1

Center | Allocation Ratio

[~ 2. Stratification Factors Include Centers:

Number of Stratification Factors:
o

Select yes if you wish o stratify treatment
groups on centers.

Acceptable Entries:

Yes or No

- Title/Name:
e :

©® Randomization List 1

Figure 6.20: Specifying Center Information

« Title/Name: Enter a general title that will be used for the centers. For example,
you could enter “Center”, “Enrollment Center” or “Site”. This field accepts text
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values.

e Number of Centers: Enter the number of centers that you wish subjects to be
drawn from. This field can take values between 2 and 500. When the value for this
is altered, the number of rows in the Specify Center Information Table will
change to this value and the values in the table will reset. Clicking the “Specify”
button on the right will hide the Specify Center Information Table.

o Specify Center Information Table: The Specify Center Information table allows
the user to enter the required information for the centers. The Specify Center
Information Table will have three columns.

— Level: This column will contain the sequential order of the centers. These
values are not editable by the user.

— Center: This column will have the heading “Center” by default, but will take
whatever value the user inputs previously in the Title/Name field. The values
in this column will represent the name or label that is applied to each center.
These values will by default be Center 1, Center 2 and so on. The user can
edit these values by clicking on the desired cell and entering new values. These
cells take text entries.

— Allocation Ratio: This column gives the user the ability to enter an alloca-
tion ratio for each center. The allocation ratio will determine how the sample
size within each group will be ideally split between the centers. For example,
with 3 centers with allocation ratios of 2,1 and 1, the algorithm will aim to
have 50% of the sample size of each treatment group coming from the first
center and 25% from the second and third centers respectively. These values
will be one by default, but can be changed to any integer value.

An example of the Specify Center Information Table with values inputted is shown
in Figure 6.21.

Q nQuery -

File Edit View Assistants Predict Plot Help
EE

Home X | RandomizationList1 x | +

Workspace <

Specify Centers/Stratification Factors « = *

# Setup

Specify Centers (Optional)
This is an optional step which gives the user
the ability to stratify the treatment groups

LN No Include cent
based on enroliment centers. If the user
Title/Name wishes to maintain balance between subjects
Sit enrolling from different centers in each group,
Number of Centers: click yes on the include centers option. Choose
g ageneral title for the centers and the number
Level Site Allo Rat of centers that subjects will be enrolling from
1 Site A In the table, choose a name for each center
Site B and enter the allocation ratio for each center.
Site C
4 D Include Centers:

Back

Next

Select yes if you wish to stratify treatment
groups on centers

Acceptable Entries:

Yes or No

Title/Name:

@ Randomization List 1

Figure 6.21: Specifying Center Information Table Example
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If the user wishes to stratify upon other stratification factors, they can do so in the
Stratification Factors section. The parameters used for both Factor 1 and Factor 2 are
identical, so the following discussion of parameters will be the same for both factors.

Stratification Factors Parameters

o Number of Stratification Factors: Enter the number of factors that you wish for
subjects to be stratified on. Subjects can be stratified on up to 2 different factors.
Once a value is entered for the Number of Stratification Factors, the required
inputs for Factor 1 (and Factor 2 if Number of Stratification Factors value
is set equal to 2) will appear in the Stratification Factors section. The default
Step 5 window when one and two factors are used can be seen in Figure 6.22 and
Figure 6.23 respectively.

Q nQuery - o X
File Edit View Assistants Predict Plot Help
E — :iii -
Home * | RandomizationList1 % | + ©
Workspace “ Specify Centers/Stratification Factors < = *
#* Setup v

Specify Centers (Optional)
1. Centers This is an optional step which gives the user
the ability to stratify the treatment groups
based on enroliment centers. If the user

Yes @ No Include centers?

2. Stratification Factors ‘wishes to maintain balance between subjects

enrolling from different centers in each group,
Number of Stratification Factors:

1 > click yes on the include centers option. Choose
a general title for the centers and the number
of centers that subjects will be enrolling from

In the table, choose a name for each center

Factor 1 Title/Name:

Factor 1

Factor 1 Levels: and enter the allocation ratio for each center.

2 Specify
Level Factor 1 Allocation Ratio Include Centers:
1 Level 1 1 Select yes if you wish to stratify freatment
2 Level 2 1 groups on centers
Acceptable Entries:
Yes or No
Title/Name:
Back Next v
© Randomization List 1 noJuery |

Figure 6.22: Specify Centers/Stratification Factors Step when Number of Stratification
Factors equals 1
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Figure 6.23: Specify Centers/Stratification Factors Step when Number of Stratification
Factors equals 2

Title/Name: Enter a general title that will be used for the stratification factor.
For example, you could enter “Smoking Status”, “Age” or “BMI”. This field accepts
text values.

Number of Levels: Enter the number of levels within the stratification factor.
This field can take values between 2 and 25. When the value for this is altered,
the number of rows in the Specify Factor Information Table will change to this
value and the values in the table will reset. Clicking the Specify button on the right
will hide the Specify Factor Information Table. Clicking the Specify button
will make the table reappear.

Specify Factor Information Table: The Specify Factor Information Table al-
lows the user to enter the required information for the stratification factor(s). The
Specify Factor Information Table will have three columns.

— Level: This column will contain the sequential order of the levels within the
factor. These values are not editable by the user.

— Factor: This column will have the heading “Factor” by default, but will take
whatever value the user inputs previously in the Title/Name field. The values
in this column will represent the name or label that is applied to each level
within the factor. These values will by default be Level 1, Level 2 and so on.
The user can edit these values by clicking on the desired cell and entering new
values. These cells take text entries.

— Allocation Ratio: This column gives the user the ability to enter an alloca-
tion ratio for each level of the factor. The allocation ratio will determine how
the sample size within each group (if stratification is not used)/center (if only
stratification on centers is used)/factor 1 (if stratification on centers and/or a
stratification factor is used) will be ideally split between the levels of the factor.
These values will be one by default, but can be changed to any integer value.

109



6.2 nQuery Randomization Lists Demonstration

An example where the inputs of the Specify Centers/Stratification Factors step is
filled for two stratification factors, where one stratification factor is smoking status and
the other stratification factor is age is displayed in Figure 6.24.
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2 60-69 2 i
Site"
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Back Next v
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Figure 6.24: Specify Centers/Stratification Factors Step when Two Stratification
Factors are used Example
6.2.3.11 Step 5 - Randomization List Options

Step 5 in the Setup involves specifying two final options for the randomization list. An
overview of the options for this step can be seen in Figure 6.25.
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Figure 6.25: Overview of the Randomization list options Step
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Randomization List Options

« Random Seed: This is the numeric seed that will be used for random number
generation. Using the same random seed value will ensure that the same random
sequence will be generated with each run of the algorithm and the output will not
change. This is often useful for replicating results. If the user wishes to replicate
their results, they can enter an integer value in this field. If the user chooses not
to enter a random seed value, one will be randomly generated. The value for the
random seed will be displayed in the Output Summary for the user, regardless if
it is randomly generated or not.

e Include Unique Randomization Code for each Subject: Setting this option
to “Yes” will include a unique code for each subject in the randomization list. This
information may be helpful in blinding the study, by allowing the information about
treatments, blocks and strata corresponding to each unique randomization code to
be retained.

6.2.4 Results Output Summary

Once the Randomization Lists Setup procedure has been carried out, the output
results section will become available to the user. A separate Reports section will be
listed in the Workspace area on the left hand-side of the screen. This can be seen in
Figure 6.26.

£* Select randomization algorithm

£* Parameters for Block Randomization
 * 3 Specify target sample size

£ Specify Centers/Stratification Factors

¥ Randomization list options

3 Report

:| Randomization List

LA
>

|=| Randomization List Summary

Figure 6.26: nQuery Workspace with Reports Section Included

The Reports section has two further sub-headings: Randomization List and Ran-
domization List Summary. Randomization List will display the generated ran-
domization list and Randomization List Summary will display summary information
on the inputs and results of the generated randomization list. The user can navigate
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between the steps in the setup and these two steps by clicking on the desired step. Simil-
arly to the Setup steps, a help card will be provided on the right-hand side of the screen
which will provide additional information and advice to the user.

6.2.4.1 Randomization List

The Randomization List item in the Reports section will display the randomization
list that is generated using the inputs provided in the Setup. The randomization list will
contain the randomization information for each subject and will be displayed in a spread-
sheet format. These values are not editable. An example of a generated randomization
list can be seen in Figure 6.27.
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Figure 6.27: An example of a generated randomization list in nQuery

Each row in the randomization list will represent one subject. Each row will contain the
subjects position in the sequence of assignment, a subject ID and the treatment group
that the subject is assigned to. Depending on choice of options in the Setup stage, there
may be several other columns specifying which center, factor 1 level and factor 2 level
each subject is drawn from. A unique randomization code may also be included for each
subject and information on the block ID and block size that each subject was assigned
using may also be displayed if block randomization is used.

Mandatory Column Headings

e Sequence: The sequence column contains the position of each subject in the ran-
domization sequence. These will be integer values.

e Subject ID: This column will contain a unique identification number for each
subject. For each stratum, the lead number will increase by 1.

o Treatment Group: This column will take on the value specified in “Title/name”
field in the Specify target sample size step of the Setup, which by default will

112



6.2 nQuery Randomization Lists Demonstration

be “Treatment Group”. This column will contain the group each subejct has been
assigned to. The values in this column will be the group names that were entered by
the user in the Specify Treatment Group Information of the Specify target
sample size step of the Setup.

Non-Mandatory Column Headings

e Center: This column will only be present in the randomization list if the user
has chosen to stratify upon center. This column will take on the heading spe-
cified in “Title/name” field in the Centers section (this will by default be “Cen-
ter”) of the Specify Centers/Stratification Factors step of the setup. In this
column, the center that each subject in the randomization sequence is drawn from
will be specified. Values in this column will take the values which were specified for
center names in the Specify Center Information Table of the Specify Cen-
ters/Stratification Factors step of the Setup.

o Factor 1: This column will only be present in the randomization list if the user
has chosen to stratify upon at least one stratification factor. This column will
take on the heading specified in “Title/name” field for the first stratification factor
in the Stratification Factors section (this will by default be “Factor 1”) of the
Specify Centers/Stratification Factors step of the Setup. In this column,
the factor 1 level that each subject in the randomization sequence is drawn from
will be specified. Values in this column will take the values which were specified
for factor 1 levels in the Specify Factor 1 Information Table of the Specify
Centers/Stratification Factors step of the Setup.

o Factor 2: This column will only be present in the randomization list if the user
has chosen to stratify upon two stratification factors. This column will take on the
heading specified in “Title/name” field for the second stratification factor in the
Stratification Factors section (this will by default be “Factor 2”) of the Spe-
cify Centers/Stratification Factors step of the Setup. In this column, the
factor 2 level that each subject in the randomization sequence is drawn from will
be specified. Values in this column will take the values which were specified for
factor 2 levels in the Specify Factor 2 Information Table of the Specify Cen-
ters/Stratification Factors step of the setup.

« Randomization Code: The Randomization list options step of the Setup
gives the user the option to include a unique randomization code for each subject.
If this option is set to “Yes”, the Randomization Code column will be included in
the randomization list, with each subject being assigned a unique code consisting
of three letters and a number between 0 and 9.

e Block ID: This column is only available if Block Randomization is used as the
randomization algorithm and will be included if the user sets the Specify Block
ID and Block Size in Output option to “Yes” in the Parameters for Block
Randomization step of the Setup. This column will display the sequential order
of blocks that each subject was assigned using.

e Block Size: This column is only available if Block Randomization is used as the
randomization algorithm and will be included if the user sets the Specify Block
ID and Block Size in Output option to “Yes” in the Parameters for Block
Randomization step of the Setup. This column will display the size of the block
that each subject was assigned using.

113



6.2 nQuery Randomization Lists Demonstration

6.2.4.2 Randomization List Summary

This section will provide a description of the Randomization List Summary and the
tools available to explore and edit this report. Multiple examples of the Randomiza-
tion List Summary report are also provided in the demonstrations in later sections
(subsection 6.2.5, subsection 6.2.6 and subsection 6.2.7).

The Randomization List Summary report can be divided into 5 parts:
e Input Summary
e Output Summary

o Algorithm Summary (Will not be present if Random Sorting is used as the ran-
domization algorithm)

o Groups
 Strata (Will only be present if a stratified randomization is conducted)

The Input Summary and the Algorithm Summary sections will give summary in-
formation on the inputs that were used in the Setup phase to generate the current
randomization list. The Output Summary, Groups and Strata sections will give
summary information on the generated randomization list. An example Randomiza-
tion List Summary report displayed in an nQuery Randomization Lists Workspace is
shown in Figure 6.28.
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Figure 6.28: Randomization List Summary Report Example

The Input Summary section is shown for all randomization lists and provides a high-
level summary of the target randomization list and it’s inputs. The Input Summary
provides a summary of the Randomization Algorithm (Block Randomization, Com-
plete Randomization, Efron’s Biased Coin Randomization, Smith’s Randomization, Wei’s
Urn Randomization, Random Sorting, Random Sorting using Maximum Allowable De-
viation), Random Seed (User inputted or generated random seed value) and Unique
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Randomization Code Used? (Yes/No). Examples of the Input Summary section
are provided in Figure 6.29.

Input Summary

Complete Randomization
621354167
Mo

Block Randomization
1

Mo

Smith's Randomization

817504094

Unique Randomization Code Usad? Yes

Figure 6.29: Input Summary Section Examples

The Output Summary section is provided for all randomization lists and provides a
summary of the sample size information for the randomization list alongside information
on the number of treatment groups subjects were randomized into and the strata subjects
are drawn from. The OQutput Summary provides the Target Sample Size that was
specified by the user in the output, as well as the Actual Sample Size of the generated
list. The Number of Treatment Groups in the generated list will be shown, alongside
the Number of Centers subjects are drawn from and the Number of Factor 1 Levels
and Number of Factor 2 Levels that subjects are stratified upon. Note that if the
user does not stratify upon center or other stratification factors, nQuery will assume that
subjects are all drawn from the same center or stratification factor level, and as such the
displayed value for these fields will be 1. Examples of the Output Summary sections
are provided in Figure 6.30.

Qutput Summary Qutput Summary Qutput Summary

Target Sample Size L[Vl Target Sample Size
Adual Sample Size L[V W Actual Sample Size

Target Sample Size
(Actual Sample Size

Number of Treatment Groups 5 Number of Treatment Groups

MNumber of Treatment Groups

MNurmnber of Centers E Number of Centers MNumber of Centers

Mumber of Factor 1 Levek 1 Number of Factor 1 Levek MNumber of Factor 1 Levels

MNumber of Factor 2 Leveks 1 Murmnber of Factor 2 Levek Number of Fadtor 2 Levek

Figure 6.30: Output Summary Section Examples
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The Algorithm Summary section will provide summary information on the parameters
that were used for the chosen randomization algorithm. As different algorithms will re-
quire different parameters, this section will differ depending on choice of algorithm. When
Block Randomization is used as the randomizaiton algorithm, this section will contain
5 items. These are the Block Multipliers that were used, the Block Subject Alloca-
tion (Random/Equal/Custom), the Block Sizes (calculated using the block multipliers
and treatment allocation ratios) that were used, the Constrain Block Allocation value
(Yes/No) and the Specify Block Info in Output (Yes/No) value. An example of the
Algorithm Summary section when Block Randomization is used is provided in
Figure 6.31.

Algorithm Summary
Random
Yes

Figure 6.31: Algorithm Summary Section for Block Randomization Example

When Complete Randomization is used as the randomization algorithm, the Al-
gorithm Summary section can take on two possible forms. In Step 2 of the Setup, if
Search for list in which actual group sizes match the target group sizes is set
to “No”, the Algorithm Summary will display one value, Match Group Sizes as No.
An example of this is shown in part A of Figure 6.32. If however, in Step 2 of the Setup,
the Search for list in which actual group sizes match the target group sizes is
set to “Yes”, the value entered for the Maximum number of iterations when search
for list in which actual group sizes match the target group sizes will also be
displayed in the Algorithm Summary section in a row named Maximum Iterations.
An example of this is shown in part B of Figure 6.32.

Algorithm Summary
Group Sizes No A

Algorithm Summary
Match Group Sizes Yes

Figure 6.32: Algorithm Summary Section for Complete Randomization

When Efron’s Biased Coin Randomization is used as the randomization algorithm,
the Algorithm Summary section can take on two possible forms. Both forms will
display the value entered In Step 2 of the Setup for the Efron’s p parameter. In Step
2, if Search for list in which actual group sizes match the target group sizes
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is set to “No”, the Algorithm Summary will display also display this in the Match
Group Sizes row as No. An example of this is shown in part A of Figure 6.33. If
however, in Step 2 of the Setup, the Search for list in which actual group sizes
match the target group sizes is set to “Yes”, the value entered for the Maximum
number of iterations when search for list in which actual group sizes match
the target group sizes will also be displayed in the Algorithm Summary section in
the Maximum Iterations row. An example of this is shown in part B of Figure 6.33.

Algorithm Summary

Efron’s Biased Coin Parameter 0.6700 A

Algorithm Summary

Figure 6.33: Algorithm Summary Section for Efron’s Biased Coin Randomization

When Smith’s Randomization is used as the randomization algorithm, the Algorithm
Summary section can take on two possible forms. Both forms will display the value
entered In Step 2 of the Setup for the Smith’s Exponent parameter. In Step 2,
if Search for list in which actual group sizes match the target group sizes
is set to “No”, the Algorithm Summary will display also display this in the Match
Group Sizes row as No. An example of this is shown in part A of Figure 6.34. If
however, in Step 2 of the Setup, the Search for list in which actual group sizes
match the target group sizes is set to “Yes”, the value entered for the Maximum
number of iterations when search for list in which actual group sizes match
the target group sizes will also be displayed in the Algorithm Summary section in
the Maximum Iterations row. An example of this is shown in part B of Figure 6.34.

Algorithm Summary
Smith's Bponent 5.0000

Algorithm Summary

Figure 6.34: Algorithm Summary Section for Smith’s Randomization

When Wei’s Urn is used as the randomization algorithm, the Algorithm Summary
section can take on two possible forms. Both forms will display the values entered In Step
2 of the Setup for the Wei’s A and Wei’s B parameters. In Step 2, if Search for
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list in which actual group sizes match the target group sizes is set to “No”, the
Algorithm Summary will display also display this in the Match Group Sizes row as
No. An example of this is shown in part A of Figure 6.35. If however, in Step 2 of the
Setup, the Search for list in which actual group sizes match the target group
sizes is set to “Yes”, the value entered for the Maximum number of iterations when
search for list in which actual group sizes match the target group sizes will also
be displayed in the Algorithm Summary section in the Maximum Iterations row.
An example of this is shown in part B of Figure 6.35.

Algorithm Summary

A
Algorithm Summary
:

B

Figure 6.35: Algorithm Summary Section for Wei’s Urn

When Random Sorting is used as the randomization algorithm, the Algorithm Sum-
mary section will not be present, as the Random Sorting algorithm does not require
and parameters.

When Random Sorting using Maximum Allowable Deviation is used as the ran-
domization algorithm, the Algorithm Summary section will display the values entered
In Step 2 of the Setup for the Max Allowable % Deviation and Maximum num-
ber of iterations parameters. This Algorithm Summary section for this algorithm is
displayed in Figure 6.36.

Algorithm Summary
Max Deviation

LM
=
=
[

0

100
W

Figure 6.36: Algorithm Summary Section for Random Sorting using Maximum Allow-
able Deviation

The Groups section contains a table with four columns; the Treatment Group column
(this will alternatively be the value entered Title/Name field in Step 2 of the Setup),
the Sample Size column, the Actual Allocation % column and the Target Alloca-
tion % column. The Treatment Group column will display the names of each of the
treatment groups which were entered in the Specify Treatment Group Information
Table in Step 2. The Sample Size column will display the number of subjects which
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were randomized into each group. The Actual Allocation % will display the percentage
of the actual total sample size that each group makes up. The Target Allocation %
will display the target percentage allocation that is calculated using the Target Sample
Size and Allocation Ratio values that are entered in Step 2 of the Setup. An example
of the Groups section when three groups are used is provided in Figure 6.37.

Groups

..........

Figure 6.37: Groups Section Example

The Strata section will only be available to the user if a stratified randomization is per-
formed, i.e., if the list is stratified on at least one center and/or at least one stratification
factor. The Strata section contains a table which displays summary information on the
number of subjects in each strata. In total, the number of rows in the Strata table will be
equal to Number of Centers x Number of Factor 1 Levels x Number of Factor 2
Levels which are entered in the Specify Centers/Stratification Factors step. These
values are equal to 1 if they are not specified by the user. The number of columns in
the Strata table will depend on inputs used in the Setup. If subjects are stratified
upon center, there will be a Center column (this column will alternatively be named
whatever value is inputted by the user in the Title/Name field of the Center section
of Specify Centers/Stratification Factors step). The Center column will display
the center value of each strata. If subjects are stratified upon stratification factors, there
will additionally be a column for each factor. The Factor columns (these columns will
alternatively be named whatever value is inputted by the user in the Title/Name field
of the corresponding Factor section of Specify Centers/Stratification Factors step)
will display the level of each factor for that strata. The First Subject ID column will
display the ID of the first subject in that strata. If Block Randomization is used as the
randomization algorithm, there will also be a Blocks Used column, which will display
the number of blocks that were used to randomize subjects in that strata. The Sample
Size column will display the number of subjects in each strata. The Actual Alloca-
tion % column will display the percentage of the total sample size that is made up of
subjects from each strata. The Target Allocation % will display the target percentage
of subjects in each strata calculated using the Target Sample Size and Allocation
Ratio values from the Specify Centers/Stratification Factors step. An example of
the Strata section when the list is stratified on three centers, two factor 1 levels and two
factor 2 levels is provided in Figure 6.38.
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Figure 6.38: Groups Section Example

In nQuery Randomziation List, the Random-

ization List Summary has a toolbar which allows the user to edit, save, print and
export a report. The toolbar options available for nQuery Randomization List Summary
Report is shown in Figure 6.39.

B S aseHN @aca-p- LD =0
1 2 3 4 5 6 7 8 9 10 11 1213 14 15 16 17 18 19 20 21 22 23

Figure 6.39: Report Toolbar

These options are defined as follows:

1.

S A I

10.
11.
12.

Open: Open another nQuery Randomization Lists Report (.prnx)
Save: Save current nQuery Randomization Lists Report (.prnx)
Help: Unused

URL: Unused

Search: Search for text in current report. Select 14 to remove
Print: Open Print menu for current report

Quick Print: Print report using system defaults

Page Setup: Open Page Setup window to edit page size, orientation and margin
sizes

Scale: Open Scale window to rescale size of report text by percentage or page size
First Page: Return to first page if report has multiple pages
Page Up: Go up one page if report has multiple pages

Page Down: Go down one page if report has multiple pages
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13. Last Page: Go to last page if report has multiple pages

14. Navigation Pane: Open and close Navigation Pane. Contains Pages list and Search
Results window

15. Zoom Out: Zoom out report by one increment
16. Zoom: Change the current zoom from list of options
17. Zoom In: Zoom in report by one increment

18. Page Layout: Set out how multiple pages are displayed (Single Page, Two Pages,
Wrap Around)

19. Continuous Scolling: Enable or disable continuous scrolling in report
20. Show Cover Page: Show cover page

21. Export: Export report as other file type. Select arrow to see list in-report or select
icon to open Export window

22. Send: Send report as email in export file type using system default email client.
23. Watermark: Add watermark to result using Watermark menu

The Export option can be used to save the report in the following file formats: PDF,
HTML, MHT, RDF, DOCX, XLS, XLSX, CSV, Plain Text File (TXT), Image File (PNG,
JPEG, BMP, GIF, EMF, WMF, TIFF).

6.2.5 Block Randomization Demonstration

In this section we will demonstrate an example of how Block Randomization can be
used to generate a valid randomization list for a basic example where stratification is
not used. Consider a scenario where researchers wishes to randomize 120 subjects into
three different treatment groups. In these three groups, subejcts will receive a 40mg
dose, an 80mg dose and a placebo dose of a particular drug. After investigating the
various randomization algorithms that can be used, the researchers decide that they will
use Block Randomization to generate the randomization list. Subjects will not be
stratified upon center of enrollment or any other stratification factors. Subjects will be
assigned to the three treatment groups using equal allocation ratios, i.e., the desired
sample size is the same for the three groups.

In order to generate the desired randomization list, the researchers open a new nQuery
Randomization Lists Workspace in order to begin the Setup. For information on how
to open and navigate through the Workspace, see subsection 6.2.1 and subsection 6.2.2.
The first step in the Setup will be the Select Randomization algorithm step. From
the list of possible options in the Target section, the researchers will select the Block
Randomization option. An example of selecting the Block Randomization algorithm
can be seen in Figure 6.40.
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Q. nQuery
File Edit View Assistants Predict Plot Help
2=l o
Home * | Randomization List 1
Workspace <
## Setup ~

£¥ Select randomization algorithm

© Randomization List 1

Select randomization algorithm

Target

(@ Black Randomization
Complete Randomization
Efron's Biased Coin Randomization
Smith’s Randomization
Wei's Urn Randomization
Random Sorting

Random Sorting using Maximum Allowable Deviation

Select Randomization Algorithm

Select the algorithm to be used for creating the
randomization list.

Options:

Block Randomization: This is by far the most
commaonly used randomization algorithm. 1t
involves randomizing participants within blocks
such that the number assigned to each
treatment group meets the target allocation
and mainiains an ideal balance between
treatment groups over time. The number of
subjects in each block (the block size) is
calculated using values entered for the target
allocations for each treatment group and block
multipliers. To explain the concept of assigning
subjects in blocks, consider the following
example: Researchers wish to randomize 60
subjects into 2 treatment groups, Treatment A
and Treatment B, with allocation ratios of 1:2
(For every subject assigned to treatment A,

~

v

Figure 6.40: Selecting Block Randomization in Step 1 of Setup

The second step in the setup is the Parameters for Block Randomization step. After
consideration, the researchers have identified that for the Number of Block Multpliers
value they will choose 3 (the default). Then for the actual Block Multiplier values,
they will use values of 1,2 and 3 (the default). For Block Subject Allocation, they will
choose Random. They will also choose Yes for both the Constrain Block Allocation
and Specify Block ID and Block Size in Output. The researchers have identified that
using 3 block multiplier values of 1,2 and 3 (the default values) will be ideal for generating
the desired the randomization list by ensuring that there is minimal oppurtunities for
selection bias to occur. An example of these values being selected for the Parameters
for Block Randomization step of the Setup is provided in Figure 6.41.
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Q nQuery — [m]
File Edit View Assistants Predict Plot Help
Hrs il -
Home * | Randomization List 1 x [+ -
Workspace < Parameters for Block Randomization “ = *
¥ Setup v -

Block Randomization
Parameters

Block Randomization:

Number of Block Multipliers:
3 Enter the number of block multipliers o be

used. Inthe table, enter the values for the

Hloctd HleckMiiphen block multipliers. Choose a value for the block
L 1 subject allocation. If custom is chosen, enter
B B the allocation ratios which will determine the
3 3 proportion of total sample size that should be
Random ©]| Block Subject Alocation assigned using each block size. Choose
whether or not you wish to constrain block
® Ves () No Constrain Block Allocation

allocation (and hence minimize sample size)
and whether you wish specify block ID and
block size for each subject in the generated
randomization list.

@ Ves () No Specify Block ID and Block Size in Output

Number of Block Multipliers:

Block multipliers are used to calculate the

number of subjects in each block, referred to

as the block sizes. Block sizes are calculated

by multiplying the block multiplier values by the
Back Next sum of the aroup allocation ratios. Enterthe

© Randomization List 1 n luery

Figure 6.41: Specifying Block Randomization Parameters in Step 2 of Setup

The third step in the Setup is Specify target sample size. As previously stated,
the researchers wish to randomly assign 120 subjects into 3 different treatment groups
with equal sample sizes. Subjects in the treatment groups will receive a 40mg dose, a
80mg dose and a placebo respectively. In Step 3, the reserchers set the Target Sample
Size value to 120. Then in the Treatment Groups section, the researchers keep the
value in the Title/Name field as Treatment Group. Following this, the value in the
Number of Treatments field is changed to 3. When the value of 3 is entered, the
Specify Treatment Group Information Table will update to include a third row
for entering information for the third group. In the Treatment Group column of the
Specify Treatment Group Information Table, the researchers change the values in
each of the rows to “40mg”, “80mg” and “Placebo” respectively. No changes are made
in the Allocation Ratio column, as the researchers will be using the default allocation
ratio values of 1,1 and 1. An example of the Specify target sample size step with
these inputs entered is provided in Figure 6.42.
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Q nQuery - o x
File Edit View Assistants Predict Plot Help
BE 4l -
Home % | Randomization List 1 x [+ -
Workspace < Specify target sample size « - fiEl i
o
v . .
# Setup Specify target sample size
1. Target Ssample Size Specify the number of subjecis you wish to
120 randomize into the various treatment groups

2. Treatment Groups Target Sample Size:

Title/Mame: Choose the number of subjects to be
Treatment Group randomized into the different treatment groups
Number of Treatments: For complex cases where large numbers of

3 Specify groups, centers and stratification factor levels

are used. the actual sample size may increase

Group Treatment Group | Allocation Ratio in order to conserve the values provided for the
1 40mg 1 allocation ratios.
2 80mg 1
3 Placebo 1

Acceptable Entries:

Integer = Number of Treaiments

Specify Treatment Groups

Create an overall title for the treatment groups

Specify the number of treatment groups that
Back Mext subjects will be randomized into. A table will

© Randomization List 1 | Simulation Setup Step 1

Figure 6.42: Specifying Target Sample Size and Treatment Group Information in Step
3 of Setup

The fourth step in the Setup is the Specify Centers/Stratification Factors step.
Since the researchers will not be stratifying on center or any other stratification factors,
no options need to be changed for this step. As such, in the Centers section, the option
for Include Centers? can be left as No and in the Stratification Factors section,
the Number of Stratification Factors option can be left as 0. An example of the
Specify Centers/Stratification Factors step with these inputs entered is provided in
Figure 6.43.

Q. nQuery - [m] X
File Edit View Assistants Predict Plot Help
B 4l -
Home % | RandomizationList1 % | RandomizationList2 x | + -
Workspace < Specify Centers/Stratification Factors “ = A= v
£ Set v . - Q
Stup Specify Centers (Optional)
1. Centers This is an optional step which gives the user

the ability to stratify the treatment groups
based on enroliment centers. If the user
wishes to maintain balance between subjects
enrolling from different centers in each group,
click yes on the include centers option. Choose
a general title for the centers and the number
of centers that subjecis will be enrolling from.
In the table, choose a name for each center
and enter the allocation ratio for each center.

Yes @ Mo Include centers?

2. Stratification Factors

Number of Stratification Factors:

a v

Include Centers:

Selectyes if you wish to stratify treatment
groups on centers.

Acceptable Entries:

Yes or No

Title/Name:
Back Next v

@ Randomization List 2

Figure 6.43: Specifying Centers/Stratificiation Factors in Step 4 of Setup
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The fifth (and final) step in the Setup is the Randomization list options step. For
reproducibility, the researchers will use a value of 10 for the Random Seed option. They
also desire a unique randomization code to be attached to each subject, so they will set
the Include Unique Randomization Code for each Subject option to Yes. An
example of the Randomization List options with these options selected is provided in
Figure 6.44.

Q nQuery - o x
File Edit View Assistants Predict Plot Help
4
i)l 4l -
Home % | Randomization List1 % | + -
Workspace “ Randomization list options « *
£* Setu v . . f . 2
P Randomization List Options
0 Random Seed Choose whether to use a random seed and
Ente v le number ter than 0 leave blank N - "
Enter @ whole number greater than 0 or leave blank whether to include a unique randomization
@ Ves (Mo Include Unique Randomization Code for each Subject code for each subject.

Random Seed:

If desired, the user can enter a random seed,
which will allow the user to reproduce the
same results. Otherwise the user may leave
this blank and a generated random seed value
will be used.

Acceptable Entries:

Integer or leave blank

Include Unique Randomization Code for
Each Subject:

Ifyes is chosen, & unigue randomization code
will be attached to each subject in the

Back Run generated randomization list.

@ Randomization List 1 | Simulation Setup Step 1

Figure 6.44: Specifying Randomization List Options in Step 5 of Setup

Once the Setup has been performed, the Reports section in the nQuery Randomization
Lists Workspace will become available. Within this Reports section there will be two
items, Randomization List and Randomization List Summary. Randomization
List will contain the generated randomization list, which can be seen in Figure 6.45.
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Q. nQuery - o x
File Edit View Assistants Predict Plot Help

E=EE EE 4l -
Home ¥ | Randomization List 1 v
Workspace . | Subject ID [ Treatment Group | Randomization Code | Block ID BlockSize | || bialn n
L 1001 40mg DFG4 1 9 ~ o
¥ Setup Ml 1002 Placebo VDN7 1 9 Randomization List
 Reports ~ 1o “om A ! 2 The randomization list displays which
1004 80mg WTXT 1 9
Randomization List W 1005 Dlacebo TRA 1 9 treatment group each subject is assigned fo.
[E] Randomization List Summary ] 1006 40mg CKK3 1 9 Each subject will be represented by a row and
B 1007 40mg LBNG 1 9 will be a given a subject ID. If centres or
: 1008 Placebo NVT4 1 9 additional stratification factors were used, the
|| 1009 80mg VIMO 1 9 level of each that the subject is drawn from will
| 10 1010 Placebo GVMO 2 3 also be displayed.
|| 1 1011 80mg TYAG 2 3
112 o2 A0mg Tead 2 2 Depending on inputs, a unique randomization
|13 101z Placsbo PIHZ 3 : code may also be displayed for each subject. If
L 1o 4mg APDT : : block randomization Is used and the user
15 1015 80mg UXAT 3 3
i T s0ma o A 5 selected to include block ID and block size in
7 017 Placebo P55 n s output, this will also be displayed.
| 18 1018 40mg GVMZ 4 3
BT 019 0mg VORI 5 5 The randomization list can be saved by clicking
50 1020 A0mg Kups 5 & the "Save" icon in the toolbar. This will create a
21 1021 Placebo AAID 5 6 csv file containing the generated randomization
: 22 1022 Placebo OKM2 5 [ list and the nQuery save file. Alternatively, the
| |23 1023 40mg EUH3 5 3 randomization lifi can be copied by first clicking
| |24 1024 80mg usk2 5 6 the top-left comner of the listipressing ctri+a and
[ 125 1025 40ma RVAD [ 3 e Hhon menaninn b n e aane Tho o
< >
Randomization List 1 | Simulation Setup Step 1

Figure 6.45: Generated Randomization List in Block Randomization Demonstration

Randomization List Summary will contain the summary information on the inputs
and results of the generated randomization list. The Randomization List Summary
can be seen in Figure 6.46.

Q. nQuery - o x
File Edit View Assistants Predict Plot Help
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Random Sei w
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Randomization List Summary
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Unique Randomization Code Usi? Yes o
generated randomization list.
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= the randomization algorithm used, the
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the user chose to generate a unique
randomization code for each subject.

The Output Summary table will
compare the actual sample size of the
randomization list with the target
sample size inputted by the user. It
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treatment groups that subjects were
randomized into. If subjects were
stratified using centres or other
stratification factors, the number of
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The Algorithm Information table will v

@ Randomization List 1 | Simulation Setup Step 1

Figure 6.46: Randomization List Summary for Block Randomization Demonstration
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6.2.6 Block Randomization with Stratification Demonstration

In this section we will perform a demonstration in which Block Randomization is used
to generate a valid randomization list for a more complex example where stratification is
desired. Consider a scenario where researchers wish to randomize 540 subjects into five
different treatment groups. These five groups will be named A through E respectively.
After investigating the various randomization algorithms that can be used, the researchers
decide that Block Randomization will be the most appropriate in this scenario. A
stratified randomization will be performed, with subjects being stratified on center of
enrollment, as well as on two stratification factors, Age and Smoking Status. Subjects
will be drawn from 6 centers. For each subject drawn from the last four centers, the
researchers desire 2 subjects from the first 2 centers each. For the Age stratification
factor, subjects will be drawn from three cohorts, those under 40, those between 40 and
60 and those greater than 60. Twice as many subjects will be drawn from the age cohort
between 40 and 60 when compared with the other two age cohorts. For the Smoking
Status stratification factor, subjects will be drawn from three cohorts, those who never
smoked, former smokers and current smokers. For every subject drawn from the never
smoked cohort, two will be drawn from the current smoker and former smoker cohorts.

In order to generate the desired randomization list, the researcher will open a new nQuery
Randomization Lists Workspace in order to begin the Setup. For information on how
to open and navigate through a Workspace, see subsection 6.2.1 and subsection 6.2.2.
The first step in the Setup is the Select Randomization algorithm step. From
the list of possible options in the Target section, the researcher will select the Block
Randomization option. An example of the Block Randomization algorithm being
selected is provided in Figure 6.47.

Q nQuery
File Edit Wiew Assistants Predict Plot Help
Em 4il -
Home * | Randomization List 1 x|+ —
Workspace < Select randomization algorithm - w
 setup - Select Randomization Algorithm
¥ Select randomization algarithm Target
Select the algorithm to be used for creating the
@ Block Randomization randomization list
Complete Randomization
Efran’s Biased Coin Randomization Options:
Smith's Randomization Block Randomization: This is by far the most
Wei's Urn Randomization commonly used randomization algorithm. It
Random Sorting involves randomizing participants within blocks
Random Sorting using Maximum Allowable Deviation such that the number assigned to each
treatment group meets the target allocation
and maintains an ideal balance between
treatment groups over time. The number of
subjects in each block (the block size) is
calculated using values entered for the target
allocations for each treatment group and block
multipliers. To explain the concept of assigning
subjects in blocks, consider the following
example: Researchers wish to randomize 60
subjects into 2 treatment groups, Treatment A
and Treatment B, with allocation ratios of 1:2
Next (For every subject assigned to treatment A, v
© Randomization List 1 uRCays !

Figure 6.47: Select Randomization Algorithm Step in Demonstration of Block Random-
ization with Stratification

The second step in the Setup is the Parameters for Block Randomization step.
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After consideration, the researchers decide they will set the Number of Block Mul-
tipliers to 3 and will set the corresponding Block Mulitplier column values in the
Block Multiplier Table to 1,2 and 3, as these values will ensure that there is a low
level of assignment predictability. They will set the Block Subject Allocation value
to Random. As they wish to ensure that the actual sample size of the generated ran-
domization list is minimized, they will set Constrain Block Allocation to Yes. They
will also set Specify Block ID and Block Size in Output to Yes, as they will find
it helpful having information on the blocks used in the output. The Parameters for
Block Randomization step with these inputs is provided in Figure 6.48.
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@ Yes ('MNo Specify Block ID and Black Size in Output and whether you wish specity black 1D and
block size for each subject in the generated
randomization list.

Block # Block Multiplier

Randem ¥ Block Subject Allocation
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Number of Block Multipliers:

Block multipliers are used to calculate the

number of subjects in each block, referred to

as the block sizes. Block sizes are calculated

by multiplying the block multiplier values by the
Back Next sum of the aroup allocalion ratios. Enferthe ¥

@ Randomization List 1

Figure 6.48: Parameters for Block Randomization step in Block Randomization with
Stratification Demonstration

The third step in the Setup is the Specify target sample size step. As stated pre-
viously, the researchers wish to randomly assign 540 subjects into 5 different treatment
groups with allocation ratios of (2,2,1,1,1). These groups will be named A through E
respectively. In the Target Sample Size section, the researchers should enter 500 in the
field. In the Treatment Groups section, the researchers will keep the default of value of
“Treatment Group” in the Title/Name field. The value in the Number of Treatments
field is changed to 5. When the value of 5 is entered, the Specify Treatment Group
Information Table will update to include 5 rows for entering the required information
for each of the groups. In the Treatment Group column of the Specify Treatment
Group Information Table, the researchers change the values in each of these rows to
“A” «B”, “C”, “D”, “E”. In the Allocation Ratio column, the values are changed to
2,2,1,1,1. An example of the Specify target sample size step with these inputs is
provided in Figure 6.49.
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Figure 6.49: Specify target sample size Step for Block Randomization with Stratification
Demonstration

The fourth step in the Setup is the Specify Centers/Stratification Factors step.
First they examine the Centers section. As the researchers wish to stratify upon center,
they set the Include Centers? option to Yes. They leave the Title/Name field as
“Center”. As they wish to draw subjects from six centers, they change the Number of
Centers value to 6. When this value is changed, the Specify Center Information
Table will update to include 6 rows. The researchers leave the center names in the
Center column as the default values. They change the values in the Allocation Ratio
column to 2,2,1,1,1,1. The Centers section of Step 4 with these inputs is provided in
Figure 6.50.
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Figure 6.50: Centers section of Specify Centers/Stratification Factors Step for Block
Randomization with Stratification Demonstration

Now the researchers will examine the Stratification Factors section. As they wish to
stratify subjects upon two stratification factors, they change the Number of Stratifica-
tion Factors value to 2. They then change the Factor 1 Title/Name value to Age and
change the Factor 1 Levels value to 3. In the Specify Factor 1 Information Table,
they change the values in the Age column to <40, 40-60 and >60. In the Allocation
Ratio column, they change the values to 1,2,1. Following this, they set the Factor 2
Title/Name value to Smoking Status and change the Factor 2 Levels value to 3. In the
Specify Factor 2 Information Table, they change the values in the Smoking Status
column to Never, Former and Current. They will change the values in the Allocation
Ratio column to 1,2 and 2. The Stratification Factors section of Step 4 with these
inputs in provided in Figure 6.51.
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Figure 6.51: Stratification Factors section of Specify Centers/Stratification Factors Step
for Block Randomization with Stratification Demonstration

The fifth step in the Setup is the Randomization list options step. The researchers
enter a value of 100 for the Random Seed, so that the results can be easily reproduced.
They also set the Include Unique Randomization Code for each Subject value to
Yes, as this may be helpful for blinding purposes.

Once the Setup has been performed, the Reports section in the nQuery Randomization
Lists Workspace will become available. Within this Reports section there will be two
options, Randomization List and Randomization List Summary. Randomization
List will contain the generated randomization list, which can be seen in Figure 6.52.
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Figure 6.52: Generated Randomization List in Block Randomization with Stratification
Demonstration

Randomization List Summary will contain the summary information on the inputs
and results of the generated randomization list. The Randomization List Summary
can be seen in Figure 6.53 and Figure 6.54.
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Input Summary
Randomization Algonthrn Black Randomization
Random 5Seed 100

Unique Randomization Code Used? Yes

QutputSummary
Target Sample Size

Adual Sample Size

Number of Treatment Groups
Murnber of Centers

Nurnber of Factor 1 Levek

Nurnber of Factor 2 Levek

Algorithm Summary
Block Multipliers

Block Subject Allocation

Block Sizes

Constrain Bledk Allocation

Specify Blodk ID in Qutput

Groups

A 168 28.57% 2857%
B 168 2857% 2B57%
C 24 14.28% 14.25%
D 24 14.20% 14.29%
E 24 14.29% 14.25%

Figure 6.53: Part 1 of Randomization List Summary for Block Randomization with
Stratification Demonstration
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Strata
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Cemtar 4 <40 Currant 30015 1 7 1% 125%

Figure 6.54: Part 2 of Randomization List Summary for Block Randomization with
Stratification Demonstration

6.2.7 Complete Randomization Demonstration

In this section, a demonstration will be performed in which Complete Randomization
is used to generate a valid randomization list. Consider a scenario where researchers wish
to randomize 3000 subjects into three different treatment groups, which will be called
Group 1, Group 2 and Group 3. They wish to have an approximately equal sample size in
each group. Due to the relatively large sample size, the researchers decide that Complete
Randomization will be sufficient as it is not overly important that the desired sample
sizes in each group are met exactly. A stratified randomization will not be performed.

In order to generate the desired randomization list, the researchers open a new nQuery
Randomization Lists Workspace in order to begin the Setup. For information on how
to open and navigate through a Workspace, see subsection 6.2.1 and subsection 6.2.2.
The first step in the Setup is the Select Randomization algorithm step. From the
list of possible options in the Target section, the researcher will select the Complete
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Randomization option. An example of the Complete
being selected is provided in Figure 6.55.

Q0 nQuery

File Edit View Assistants

22l o

Predict Plot Help

Home * | Randomization List 1
Workspace <
¥ Setup ~

£# Select randomization algorithm

o~
4il -
x|+
Select randomization algorithm
Target

Block Randomization
(®) Complete Randomization
Efron's Biased Coin Randemization
Smith’s Randomization
Wei's U Randomization
Randem Sorting

Randem Serting using Maximum Allowable Deviation

Randomization algorithm

= Help L
Select Randomization Algorithm

Select the algorithm to be used for creating the
randomization list.

Options:

Block Randomization: This is by far the most
commonly used randomization algorithm. It
involves randomizing participants within blocks
such that the number assigned to each
treatment group meets the target allocation
and maintains an ideal balance between
treatment groups over time. The number of
subjects in each block (the block size) is
calculated using values entered for the target
allocations for each treatment group and block.
multipliers. To explain the concept of assigning
subjects in blocks, consider the following
example: Researchers wish to randomize 60
subjects into 2 treatment groups, Treatment A
and Treatment B, with allocation ratios of 1:2
(For every subject assigned to treatment A, v

@ Randomization List 1

Figure 6.55: Select randomization algorithm Step in Complete Randomization Demon-

stration

The second step in the Setup is the Parameters for Complete Randomization step.
After consideration, the researchers decide that they will not utilize the ability to Search
for a list in which actual group sizes match the target group sizes. As a result,
no options need to be changed for this step. An example of the Step 2 window for this
demonstration can be seen in Figure 6.56.
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Q nQuery - O X%
¥
File Edit View Assistants Predict Plot Help
He 4 -
Home % | Randomization List1 % | RandomizationList2 x| + M
Workspace < Parameters for Complete Randomization « = o
¥ Setu v I -
P Complete Randomization
Search for list in which actual group sizes match the target group sizes Parameters
Yes @ No

Choose if you wish to search for a list in which
actual group sizes match target group sizes. If
yesis chosen for the previous option, enter the
maximum number of iterations to be used
when searching for an optimal list before
terminating the algorithm.

Search for a list in which actual group
sizes match the target group sizes:

If yes is selected for this option, the algerithm
will check if the number of subjects assigned to
each group in the generated randomization list
matches the target group sample sizes. If they
do not match, the list will be deleted and the
algorithm will generate a new list. It will repeat
this process until the desired list is found or
until the maximum number of fierations is
exceeded

Back MNext v

© Randomization List 2

Figure 6.56: Parameters for Complete Randomization Step in Complete Randomization
Demonstration

The third step in the Setup is the Specify target sample size step. As the researchers
wish to randomize 3000 subjects, they enter 3000 in the Target Sample Size section.
In the Treatment Groups section, the researchers leave the value in the Title/Name
field as the default value of Treatment Group. They change the value in the Number
of Treatments field to 3. As a result, the Specify Treatment Group Information
Table will update to have three rows. In the Treatment Group column of the table,
they set the names of the treatment groups to “Treatment 17, “Treatment 2” and “Treat-
ment 3”. As they wish to have an approximately equal sample size in each group, they
will leave the values in the Allocation Ratio column as the default values of 1,1,1. An
example of the Step 3 window with these values inputted can be seen in Figure 6.57.
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QU nQuery m} X
File Edit View Assistants Predict Plot Help
Bs 4l -
Home % | Randomization List1 x| + -
Workspace < Specify target sample size « = fiklle ®
% Setu v . . -
P Specify target sample size
1. Target Sample Size Specify the number of subjects you wish to
3000 randomize into the various treatment groups
2. Treatment Groups Target Sample Size:
Titie/Name: Choose the number of subjects 1o be
Treatment Group randomized into the different treatment groups.

MNumber of Treatments: For complex cases where large numbers of
3 Specify groups, centers and stratification factor levels

are used, the actual sample size may increase

Group Treatment Group | Allocation Ratio in order to conserve the values provided for the
1 Group 1 1 allocation ratios.
2 Group 2 1
3 Group 3 1

Acceptable Entries:

Integer = Number of Treatments

Specify Treatment Groups

Create an overall fitle for the {reatment groups.
Specify the number of treaiment groups that
Back Next subjects will be randomized into. A table will

~

© Randomization List 1

Figure 6.57: Specify target sample size step for Complete Randomization Demonstration

The fourth step in the Setup is the Specify Centers/Stratification Factors step. As
the researchers have decided that they will not be conducting a stratified randomization,
this step can be skipped and no options need to be changed. An example of the Step 4
window with these values inputted can be seen in Figure 6.58.

Q nQuery - O X
File Edit View Assistants Predict Plot Help
Br 4 -
Home x | Randomization List1 x| Randomization List2  x | + -
Workspace < Specify Centers/Stratification Factors « = =] u
v . .
8 Setup Specify Centers (Optional)
1. Centers This is an optional step which gives the user

the ability to stratify the treatment groups
based on enroliment centers. If the user
wishes to maintain balance between subjects
enrolling from different centers in each group,
click yes on the include centers option. Choose
a general title for the centers and the number
of centers that subjects will be enrolling from.
In the table, choose a name for each center
and enter the allocation ratio for each center.

Yes @ No Include centers?

2. Stratification Factors

Mumber of Stratification Factors:
0 v

Include Centers:

Selectyes if you wish to stratify treatment
groups on centers.

Acceptable Entries:

Yes or No

Title/Name:
Back Next v

© Randomization List 2

Figure 6.58: Specify Centers/Stratification Factors Step in Complete Randomization
Demonstration

The fifth step in the Setup is the Randomization list options step. The reseachers
decide that for reproducibility purposes, they wish to use a Random Seed value of
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100. They also decide that for blinding purposes, they will set the Include Unique
Randomization Code for each Subject to “Yes” so that each subject obtains a unique
randomization code. The Step 5 window with these options selected can be seen in
Figure 6.59.

Q nQuery - | ®
File Edit View Assistants Predict Plot Help
Rl 4l -
Home * | Randomization List1 x| + -
Workspace < Randomization list options &« miz]2 v
% Setu v P . . . .
P Randomization List Options
100 Randem Seed Choose whether to use a random seed and

Enter a whole number greater than 0 or leave blank whether to include a unique randomization

@ves (INo Include Unique Randomization Code for each Subject code for each subject

Random Seed:

If desired, the user can enter a random seed,
which will allow the user to reproduce the
same results. Otherwise the user may leave
this blank and a generated random seed value
will be used.

Acceptable Entries:

Integer or leave blank

Include Unique Randomization Code for
Each Subject:

If yes is chosen, a unique randomization code
will be attached to each subject in the

Back ) generated randomization list.

@ Randomization List 1

Figure 6.59: Randomization list options Step in Complete Randomization Demonstra-
tion

Once the Setup has been performed, the Reports section in the nQuery Randomization
Lists Workspace will become available. Within this Reports section there will be two
options, Randomization List and Randomization List Summary. Randomization
List will contain the generated randomization list, which can be seen in Figure 6.60.
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Q nQuery
File Edit View Assistants Predict Plot Help
BErsd & o X
Home * | Randomization List1 % | +
Workspace 5 Sequence Subject ID
1 10001
# Setup v 2 10002
3 10003
Reports -~ a )
Randomization List 5 10005
[E] Randomization List Summary 6 10006
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1 10011
2 10012
13 10013
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Treatment Group
Treatment 3
Treatment 1
Treatment 3
Treatment 3
Treatment 2
Treatment 3
Treatment 3
Treatment 2
Treatment 2
Treatment 1
Treatment 3
Treatment 2
Treatment 2
Treatment 2
Treatment 3
Treatment 2
Treatment 3
Treatment 3
Treatment 2
Treatment 1
Treatment 1
Treatment 2
Treatment 3
Treatment 3
Treatment 2
Treatment 3
Treatment 3
Treatment 2
Treatment 1
Treatment 2

Randomizatio...
ujus
ZAY2
Uxx9
SAJ6
ZWF4
1zvs
LGE9.
QK7
VDA3
XKKO
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EXU6
PSM7
Guu7
LHK?
vzv1
NEDS
ZBRS
MEB1
HXIS
LMJ6
EPNO
1GW6
ZRF4
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TFRS

Randomization List

The randomization list displays which treatment group each
subject is assigned to. Each subject will be represented by a
row and will be a given a subject ID. If centres or additional
stratification factors were used, the level of each that the
subject is drawn from will also be displayed.

Depending on inputs, a unique randomization code may also
be displayed for each subject. If block randomization is used
and the user selected to include block ID and block size in
output, this will also be displayed

The randomization list can be saved by clicking the "Save"
icon in the toolbar. This will create a csv file containing the
generated randomization list and the nQuery save file.
Altematively, the randomization lift can be copied by first
clicking the top-left comer of the list/pressing ctri+a and then
pressing ctri+c to copy. The randomization list can then be
pasted for use in other software.

Figure 6.60: Generated Randomization List in Complete Randomization Demonstration

Randomization List Summary will contain the summary information on the inputs
and results of the generated randomization list. The Randomization List Summary
can be seen in Figure 6.61.

Q nQuery

File Edit View Assistants Predict Plot Help

BEsd =

| Home x | Randomization List 1
Workspace <
# Setup v
Reports ]

[ Randomization List
[Z] Randomization List Summary

Page

x

Input Summary

Algorithm Summary
Match Group Sies

Groups

T S [T e

Treatment 1
Treatment2

Treatment3

100

Yes

1005

&ae

Complete Randomization

3350%
3297%

3353%

@ac-ap-@ .

3333%
3333%
3333%

91% ST

Helg L3

Output Summary

The tables displayed here give summary information on the
generated randomization list.

The Input Summary table will display the randomization
algorithm used, the random seed (either inputted or
generated if left blank) and whether the user chose to
generate a unique randomization code for each subject

The Output Summary table will compare the actual sample
size of the randomization list with the target sample size
inputted by the user. It will also display the number of
treatment groups that subjects were randomized into. If
subjects were stratified using centres or other stratification
factors, the number of levels within each factor will also be
displayed

The Algorithm Information table will display the algorithm
specific parameters that were used.

The Groups table will display the number of subjects which
have been randomized into each group. The percentage of
the total sample size which was randomized into each group
will be displayed, along with the target percentage calculated
using the group allocation ratios.

Figure 6.61: Randomization List Summary for Complete Randomization Demonstration
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6.2.8 Other Features
6.2.8.1 Saving and Exporting a Workspace

nQuery provides the file format of .nqrl to save and export an nQuery Randomization
Lists Workspace. To save an nQuery Randomization Lists Workspace, select Save from

the File Menu or select the Save icon = from the toolbar or use the CTRL~S keyboard
shortcut. This will open the Save Workspace window which is shown in Figure 6.62.

Save Workspace “

Please choose a name for the project:

Randomization List 1

Project will be saved in sub-directory of:

CAUsersh, :o000 \Documents Browse

oK Cancel

Figure 6.62: Save Workspace Window

The Save Workspace window allows the user to specify the name of the .nqrl file in
the Please choose a name for the project field and the location to save the .nqrl file
in the Project will be saved in sub-directory of field. The user can also edit the
Project will be saved in sub-directory of using the Browse button, which will open
the Browse for Folder window. To save the project, select the OK button.

When a project is saved, a folder with the Please choose a name for the project:name
will be present in the folder specified in the Project will be saved in sub-directory of
field. This project folder will contain the .nqrl file. If a randomization list has been fully
generated in the current workspace, the project folder will also contain this generated
randomization list in .csv format.

After an nQuery Workspace is saved, if a change is made to the workspace the user can
save over the prior save using the Save options (see above) or save a separate version using
Save As from the File menu.

To open a saved .nqrl file, select the file in Windows Explorer or find the file from the Open
Menu which can be selected from the File Menu, the ™ toolbar icon or CTRL~+O key-
board shortcut. Opening a .nqrl file works as for other nQuery file types (see subsection 1.7.5).

6.2.8.2 Exporting a Generated Randomization List Comma Separated Variable file

Two options exist for exporting a generated randomization list comma separated variable
(csv) file. The first is saving and exporting the nQuery Randomization List Workspace
(see Figure 6.62). In the generated folder, there will be a file containing the generated
randomization list in .csv format. This file will take the name of the value entered for
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the Please choose a name for the project field in the Save Workplace step. An
example of this file in the save folder is displayed in Figure 6.63.

Randomization_List_1 X =p

@ New Tl sort = View

< ~ > Documents > Randomization_List_1 w G Search Randemization_List_1

~
% Home Name Date modified Type Size

}_ 8% randomization_list 071272022 11:27 Microsoft Excel C... BaKe

_. Randomization_List_T.ngrl 07/12/2022 11:27 NGQRL File 400 KB

@ Desktop

- Downloads
. Documents

PN Pictures

@t My Drive

2 Music

i3 Videos

Figure 6.63: Example of an nQuery Randomization Lists Save Folder

The generated randomization list can also be copied to the Windows clipboard directly
from the nQuery Randomization Lists Workspace. To do this, the Randomization List
report in the Reports section must be open. To select the entire randomization list, the
user can use the keyboard shortcut CTRL4A or can click the empty top-left cell of the
Randomization List window. Alternatively, particular rows can be selected by clicking
the empty cell to the left of a row, holding the SHIFT keyboard button and then clicking
the empty cell to the left of another row. Once the Randomization List is selected in
this way, the user can use the keyboard shortcut CTRL+4C to copy the information to
the clipboard. This information can then be pasted in .csv format into relevant software
by using the right-click and paste option or by using the keyboard shortcut CTRL+V.
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7 Group Sequential Design (Spending
Function, Haybittle-Peto,
Wang- Tsiatis, Unified Family,
Custom Boundaries Tables)

This chapter only provides information on the Group Sequential Design (Spending
Function, Haybittle-Peto, Wang-Tsiatis, Unified Family, Custom Boundar-
ies) series of tables and the associated Group Sequential Simulator Tool

For information on the Group Sequential Design (Lan-DeMets Spending Func-
tion Only) tables and their associated Interim Monitoring € Unblinded Sample
Size Re-estimation tools, please refer to chapter 9.

For reference the Spending Function, Haybittle-Peto, Wang-Tsiatis, Unified Family, Cus-
tom Boundaries tables are the GSTX series of tables including GSTO (Information-Based),

GST1 (Two Means), GST2 (Two Proportions), GST3 (Two Survival - Event-Driven or
Fized Follow-up, Piecewise Survival, Accrual %)

The Lan-DeMets Spending Function Only tables are MTT12 (Two Means), MTT40 (Two
Poisson), MTT42 (Two Negative Binomial), MTE32 (Two Means Non-inferiority), MOT26
(One Mean), PTT12 (Two Proportions), POT8 (One Proportion - Alternative Variance),
POT13 (One Proportion - Null Variance), STT12 (Two Survival - Fized Follow-up, Con-
stant Hazard), STT15 (Two Survival - Event-Driven, Constant Hazard), STT23 (Two
Survival - Event-Driven, Piecewise Survival, Accrual Rates), STT25 (Two Survival -
FEvent-Driven, Piecewise Survival, Accrual %). The associated Interim Monitoring & Un-
blinded Sample Size Re-estimation tables are MTT25 (Two Means - linked with MTT12),
PTT21 (Two Proportion - linked with PTT12) and STT17 (Two Survival - linked with
STT12, STT15, STT23, STT25)

7.1 Introduction

This chapter will cover the statistical theory behind the Group Sequential Design
(Spending Function, Haybittle-Peto, Wang-Tsiatis, Unified Family, Custom
Boundaries) series of GSTX tables and will give detailed description of how to design
a group sequential trial in nQuery using these tables. It will also summarize the theory
and user interface of the Group Sequential Design Simulator tool.

The Group Sequential Design and Group Sequential Design Simulator features will only
be available to users if an nQuery Advanced Pro license is active. Active packages are
displayed in the Packages section on the Home tab. To purchase additional packages, see
www. statsols. com.
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7.2 Group Sequential Design Theory

This section will provide an overview of the statistical theory of group sequential design.
It will cover the following aspects:

e Group Sequential Design Theory Overview: Group Sequential Design defini-
tion and statistical background

e Numerical Algorithm for Group Sequential Exit Probabilities: Summary of
theory for deriving required group sequential boundaries based on specified interim
exit probabilities

« Calculating Power /Maximum Information: How to find power or maximum
information for specific group sequential design

o Different Boundary Calculation Methods: Overview and statistical back-
ground on difference group sequential design boundary methods

« Endpoint/Design Specific Sample Size Determination: Overview and stat-
istical background on determining sample size for group sequential designs for spe-
cific endpoints and designs

For further detail on the statistical theory of group sequential design, nQuery recommends
the following books:

o Group Sequential Methods with Applications to Clinical Trials, Jennison, C. and
Turnbull, B. W. (1999) [Jennison and Turnbull, 1999]

o Group Sequential and Confirmatory Adaptive Designs in Clinical Trials, Wassmer,
G. and Brannath, W. (2016) [Wassmer and Brannath, 2016].

7.2.1 Group Sequential Design Theory Overview

Group Sequential Designs are the most common type of adaptive design in confirmatory
clinical trials. Group sequential designs allow for a trial to be stop early at an interim
analysis if there is sufficiently strong evidence at the interim analysis that the trial would
accept or fail to accept the null hypothesis while maintaining the desired overall Type I
(o) and Type II (B) error across all analyses.

In the clinical trial setting, the number of and the timing of the interim analyses are
typically pre-specified with trials stopping early based on whether the evidence is strong
enough to stop early based on a proposed treatment being effective (e.g. mean difference
> 0 - by clinically significant amount) or ineffective/futile (e.g. mean difference = 0)
based on interim analysis. Given the long nature of most clinical trials, group sequential
designs offer a significant opportunity to get effective treatments to patients faster and
reduce clinical trial costs.

Stopping early when there is strong evidence for a proposed treatment being effective
at an interim analysis is called stopping for efficacy. This will occur when the test
statistic crosses the efficacy boundary at a given interim analysis.

Stopping early when there is strong evidence against a proposed treatment being effective
at an interim analysis is called stopping for futility. This will occur when the test
statistic crosses the futility boundary at a given interim analysis.
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The majority of group sequential designs are based on extending a fixed term trial (i.e.
a trial where analysis occurs after all subjects have been followed up) to include interim
analyses.! Naively testing a hypothesis multiple times during a trial can lead to sub-
stantial Type I error inflation. For example, five equally spaced interim analysis without
adjustment can lead to an inflation of the Type I error from 0.05 to 0.142 [Armitage et al.,
1969).

The adjustment for multiple interim analyses is conceptually similar to adjusting for
multiple comparisons generally. However, there are significant efficiencies due to the
correlated nature of interim analyses (since each interim analysis’s data will contain the
same data as from all earlier interim analyses) which substantially reduces the required
information (sample size) compared to naively applying standard multiple comparison
methods such as the Bonferonni adjustment to each interim analysis.

Multiple group sequential design methods have been proposed to calculate interim analysis
boundaries that control the overall Type I error while also allowing control other operating
characeteristics as the probability of exiting early at each given look or the average sample
size. The different boundary calculation methods available in nQuery will be covered in
detail in subsection 7.2.4. However, all these methods take advantage of this correlated
nature of interim analyses and an overview of this theory is provided below as per Jennison
and Turnbull [Jennison and Turnbull, 1999].

7.2.1.1 Group Sequential Assumptions

Let 6 denote the effect difference between the treatment and control arms of a two arm
trial. For example, # may be the mean difference if comparing means or the (log) hazard
ratio for survival analysis.

Assume there are a maximum of K analyses in the trial, which is to say K-1 interim
analyses.

Denote the standardized test statistics from each analysis by Zj, where the interim ana-
lysis look number £ =1,2,..., K — 1, K. We will assume that the per-look standardized
test statistics (Z1, Zs, . .., Zx_1, Zk ) have a canonical joint distribution conditional on the
(Fisher) information levels (Iy, Is, ..., Ix_1, [x) at each look if they satisfy the following
properties:

1. (Z1, %y, ... Zk_1, Zk) are multivariate normal

2. E(Z) =0T, k=1,2,....K — 1K
3. Cov(Zny, Zn)) = |21, 1 < ky < hy < K

Iy, ?

Ik represents the maximum amount of statistical (Fisher) information that can be gained
from the trial at the final analysis. We will denote this mazimum information as ILq..

For each analysis in the trial we obtain an information fraction, ty, where t = It/ .-
For most scenarios considered here this information fraction will be proportional to the
fraction of subjects which have had follow-up i.e. proportional to fraction of total sample

'Note that there are also group sequential methods based on discretizing continuous monitoring tests
such as the sequential probability ratio test (SPRT) [Wald and Wolfowitz, 1948, Wald, 1992] - see for
example the triangular test proposals of Whitehead [Whitehead and Brunier, 1990, Whitehead, 1997]
or many Bayesian sequential designs [Zhou and Ji, 2023].
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size for two means/proportions, proportional to fraction of total events for time-to-event
analysis (under proportional hazards).

At each of these information fractions we assume that one can obtain an efficient estimate
of the true treatment effect, 6 (¢;), and a consistent estimate of the variance of this estim-
ate, Var (6 (tk)) Maximum likelihood estimators, produced by most standard statistical

software packages for example, will be efficient estimators. Given sufficient sample size,

we can also assume: 1

Ik ~ — .
Var (9 (tk))

Suppose we wish to test the hypothesis Hy : 6 = . Then, assuming all the above, the
standardized test statistics are given by the following:

2o = LOI=) _ Gy ) /1

Var (é (tk))

We can therefore show [Scharfstein et al., 1997] that these Z are then asymptotically
multivariate normal where:

1. n = (Q_QO)N/Imam
20 E(Z) =/l k=1,2,....K - 1,K
3. Var(Zy) =1

A Cov(Zn, Zn) = /2 1<k <k < K

Tiy '
where 7 is usually referred to as the drift parameter. The term “drift” is used in relation
to this being the drift of the Brownian motion process for the independent increments

[Lan and Zucker, 1993].

For inequality testing 6, will equal zero while for non-inferiority testing this will equal the
non-inferiority margin.

Derivation of the group sequential theory above for the standarized test statistic scale
can also be found in some resources on other statistic scales. The most common statistics
used are the score statistic (Sk =401 k), the interim treatment effect (Qk) and the B-score

(Z \/ﬁ) [Lan and Wittes, 1988] - note the B-score is not used directly in nQuery at
present but is included for completeness. The equivalent distributional assumptions for
the various scales are:

. Zk ~ N(Q\/]_k, 1), COV(ZklaZkz) = \/ZZT

« O~ N@O,I;Y), COV(Oy,,04,) = I}
e Sp~ N0y, It), COV (S, Siy) = Iy = COV(Sp, — St—1, Sk, — S, 1) =0, i # j
e B ~ N(n\/ﬁ, tk), OOV(Bkl, BkQ) = tkl = COV(B]%, Bk:j — Bkl) =01 <j

Conversions between the standardized test statistic and the treatment effect, score statistic
and p-value scale are discussed in subsubsection 7.2.4.5.

An important assumption for the above group sequential theory to hold is the independent
increments assumption - where it assumed there is no dependence between the informa-
tion, Ix, and the standardized test statistics (Z1, Zs, ... Z_1) at each prior look - This is
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equivalent to following assumption being true for the score statistics/increments:
COV (Sk; — Ski—1,Sk; — Sk;—1) =0

This assumption will hold for a wide variety of statistical models (as shown in subsection 7.2.5)
but could be violated in presence of adaptive pooling/treatment assignment [Jennison and
Turnbull, 1999] or for weighted linear-rank statistics such as the Gehan statistic for time-
to-event analysis [Proschan et al., 2006] for example.

Assuming the independent increments assumption holds, the exit probability for an ar-
bitrary set of boundaries can be found for any specified treatment effect via an efficient
recursive integration algorithm. This algorithm will be discussed next.

7.2.2 Numerical Algorithm for Group Sequential Exit Probabilities

One of the main calculations required in order to define group sequential boundaries is
to calculate the probabilities of a given set of group sequential boundaries being crossed
(the exit probability). A numerical integration algorithm is required for this purpose.

The numerical integration algorithm theory is based on the work of Armitage, McPherson
and others [Armitage et al., 1969, McPherson and Armitage, 1971] and is summarized in
Chapter 19 of Jennison and Turnbull (1999).

The computational implementation of the recursive intergration in nQuery is based on
the “1d98” Fortran code developed by Reboussin et al. [Reboussin et al., 2000] and is
available at https://biostat.wiscweb.wisc.edu/resources/software/.

A detailed breakdown of the integration and the computational aspects are provided in
the resources above but a high level overview is provided below. We will focus on the
one-sided testing scenario for the following however Jenison & Turnbull [Jennison and
Turnbull, 1999] discusses how the below methods can be extended to the 2-sided case.

Using the same notation as in subsubsection 7.2.1.1, we will now define the information
difference as A, = I, — I_1,k=2,3,... | K.

It follows that for Z; ~ N(0+/I1,1) and Zpv/I, — Zp_1\/Te—1 ~ N(0Ay, Ay), for each
k=23, .. K.

Denote at each interim look, the efficacy boundaries as b, and the futility boundaries as
ap for k = 1,2,..., K. We can then denote the probability that an efficacy bound is
crossed at a given analysis as the following:

U (a1, by, ar, by 0) = Pro{ay < Zy < by, apy < Zeoy < by, Zi > by}

and the probability that a futility bound is crossed at a given look is:

& (ar,by, . ag, by 0) = Pro{ay < Zy < by, ey < Zioy < b,y Zk < ax

These probabilities can be calculated under any specified value for 6.

In subsection 7.2.3, these functions will allow us to calculate the per-look and overall
Type I and Type II errors. For the 1-sided case discussed here, note the final efficacy and
futility boundaries will be set to be equal (bx = ar).
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The density of the first standardized test statistic Z; will equal fi(21;0) = é(2 — 0/11)
where ¢ is the probability density function of the standard normal distribution.

Given Zp/Ij,— Zp_1v/Tr_1 ~ N(0Ay, A), it follows for K > 2 that the conditional density
of Zy given Z; = 2z1,...,Zr_1 = zr_1 depends only on z;_; and will equal

fr(ze—1; 28, 0) =

Based on this we can see the conditional density depends only on the data accrued between
the current look and the immediately prior look. Hence v, has the following integral form:

bl bk—l o
Uy (a1, b1, ..., ag, by; 6) :/ / /b f1(2150) f2(29;0) . .. fr(zk—1; 28, 0)dzg . . . dzy
al ap—1 k

We can replace the final integral [, (zx—1; 21, 0)dz;, with the following function:

I — b /I + 0A
er 1 (21, by 0) = D <Zk\/_lc eV k-1t k>

VAL

where @ is cumulative distribution function of the standard normal distribution. & (aq, by, .

can also be re-written in a similar manner.

Rather than calculating the multivariate normal integral directly, the recursive integral
formula of Armitage, McPherson & Rowe (1969) [Armitage et al., 1969] can be applied
to significantly reduce the complexity. Their method allows the direct calculation of the
probability of exiting from looks 1 to k; in turn, which reduces the probability calculation
to a series of one-way integrals for the per-look exit probability p(k, z,6). The formulae
are as follows:

ge(z;0) 2z ¢ Cy

k,z,0) =
p( : ) {0 z e O

01(2:0) = 6(z — 0y/1)

w0 = [ gawit) ji%b (”7 - “f_g - Mk) du

where C; is the continuation region for a given look i.e. the values for the standardized
test statistic where the trial would continue to the next look?. This would be the region
between our futility bound (a) and efficacy bound (b) in our example above.

Note that this formulation based on the standardized test statistic is taken from Jennison
and Turnbull (1999) [Jennison and Turnbull, 1999] - the original Armitage, McPherson
& Rowe derivation used the score statistic scale.

2Replace z with z; in the second equation and replace z with z; and u with z;_; for comparability with
the other formulae related to boundary construction
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Based on the above we can re-write out integral for vy, (ay, by, ..., ax, by; 0) as follows:

/b g (zx; 0)dzy,

bk—l (e.9]
= / /b Gr—1(2k-1; 0) fe(zp—1; 21, 0)dzpdzi—1
ap—1 k

br—1
= gk71(2k71; 9>ek71(2k71§ b, G)dzkfl

ak—1
This integral can be evaluated via a quadrature procedure. While standard numerical
integration functions are now widely available in standard software packages (e.g. integ-
rate in R), a short summary of the integration procedure as described by Jennison and
Turnbull [Jennison and Turnbull, 1999] is provided. This numerical integration function
is the basis of the widely used and adapted “1d98” FORTRAN code by Reboussin et al
[Reboussin et al., 2000] for finding group sequential bounds.

Jennison and Turnbull show in several steps that the integral for vy, (ay,b1, ..., ax, by; 6)
can be approximated by the following summation:

mg—1

> Ry (ik-150) ex—1 (zo—1 (ik-1) , bi, 0)

ha(ir; 0) = wi(in) f1(21(i1); 0)

mg—1

hi(ig; 60) = Z hie—1(k—1; O)wi (ix) fi(zk—1(ik—1); bk, 0)

ig—1=1

where the m is the number of discrete points included to approximate the integral, ¢
represents the index of each point and wy is the weight assigned to each point. m is set
equal to 12r — 3 where r is a user-specified value, see subsection 7.3.7. The gridpoints and
weights for indefinite integrals are selected to have two thirds of the probability density
within 3 standard deviations of the mean and the remaining one third in the tails. For
definite integrals, values outside the bounds are trimmed and re-assigned appropriately
within the integral space. See Chapter 19 of Jennison and Turnbull for further details on
how weights are specifically calculated.

The above calculations are easily extensible to the case of 1-sided efficacy only designs,
1-sided futility only designs and 2-sided efficacy only designs by replacing the relevant
limits for integration described above with infinity or the upper/lower efficacy bounds.
Extension of the above to 2-sided futility bounds is more complicated due to the disjoint
continuation region and adjusting for overlapping futility boundaries which is common at
earlier looks.

Note that nQuery adjusts for overlapping futility boundaries by setting both the upper
and lower boundary equal to 6, and then re-assigns the unused 3 error proportionally
to the future looks to calculate the remaining futility boundaries - this is equivalent to
BETAOVERLAP = TRUE in SAS PROC SEQDESIGN for example. Options imple-
mented in other software are to ignore the overlapping boundaries (BETAOVERLAP =
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FALSE) allowing the beta error to be spent regardless or to re-calculate the boundaries
as if those futility looks were originally planned to be skipped - skipping looks in nQuery
is discussed in subsection 7.3.2.

7.2.3 Calculating Error Rates/Maximum Information

Given a 1-sided analysis with a given set of efficacy and futility boundaries, the definitions
for the Type I (false positive) and Type II (false negative) error rates are as follows:

For the total Type I (a) error, set 8 = 6y (e.g. 0 for inequalty hypothesis for mean
difference) and find boundaries such that the following holds:

K
CYIZ Pro{a1 < 7 < bl,...,CLK,l < L < bkfl,Zk > bk}
k=1

For the total Type II (5) error, set 6 = 6; (e.g. the specified mean difference) and find
boundaries such that the following holds

K
ﬁ :Z P’f‘gl {CLl < I < bl,...,ak_l < Zk—l < bk:—laZk < ak}
k=1

By definition at the final analysis a decision for or against the null hypothesis is made
and therefore for 1-sided testing the final efficacy bound, bx, and final futility boundary,
ag, are forced to be equal at the final analysis.

Note 1— 3 is the statistical power (true positive rate). The statistical power is the typical
output of interest in clinical trial design under the alternative hypothesis and will equal:

K
Power (1 — ) :Z Pro, {a1 < Zy <by,...,a51 < Zj_1 < bp_1, Z > by}
k=1

The cumulative Type I or Type II error (stop at or before current look) at a given look k
can be found by assessing the same probability up to look k instead of the final look K
used above for the total error rates - the components being summed are equivalent to the
incremental (stop at current look only) Type I/Type II errors. This is used directly for the
error spending function approach where the per-look cumulative error rates (o, Ox) are
used to calculate the group sequential boundaries sequentially - see subsubsection 7.2.4.1.

Therefore given a set of boundaries and known maximum information, the Type I and
Type II error can be calculated using the methods described in subsection 7.2.2. The Type
I error will correspond to the Test Significance Level. 1 - Type II error will correspond to
the Power of the test.

For clinical trial design, the primary interest is calculating a set of boundaries which
have the desired value for trial-level parameters (o, 1 — 3, I,44,) and, if defined explicity,
per-look exit probabilities for efficacy (a4) and/or futility (By).

In practice, the interest is in either calculating the power (1 — /) for a given maximum
(Fisher) information (/,,4,) or the maximum information for a given power while con-
trolling for the overall Type I error - increasing the maximum information will increase
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the power. As maximum information increases proportionally with the sample size (or
events for time-to-event analysis), this corresponds to the objective of a standard sample
size determination to find the appropriate sample size to power a trial to the desired level
(e.g. 80%, 90%). Note that it is also common to see these calculations done in terms
of the (alternative hypothesis) drift parameter n discussed in subsubsection 7.2.1.1 which

equals (60 — 00) v ez

In this section, the focus will be on the calculations which use the maximum informa-
tion directly - this corresponds to the calculations available in the design table GSTO -
Information-Based Group Sequential Design. The conversions required from max-
imum information to the sample size (or events) for the specific endpoints and designs
available in nQuery are covered in subsection 7.2.5. Given an appropriate definition for
the treatment effect (f) and maximum information (/,,4,) that GSTO can be used to
construct boundaries for any given clinical trial design.

The calculation of the boundaries will depend on the choice of boundary calculation
method (see subsection 7.2.4) and (if present) whether the futility boundaries are non-
binding or binding.

To calculate the Maximum Information (/,,4.), assume a target type II error rate (1-
Power) has been specified. Then iterate over different values for I,,,, and in conjunction
with the efficacy boundaries and/or futility boundaries, found via their respective group
sequential boundary calculation method, find the value for [,,,, which satisfies the type
IT error /statistical power constraint(s) using the 1, & functions above.

To calculate the Power, assume our Maximum Information (I,,..) has been specified.
Then iterate over different values of the Power (or /) and for each iteration calculate the
futility boundaries via the specified futility boundary calculation method until the final
futility boundary produced matches the final efficacy boundary found via the selected ef-
ficacy boundary calculation method. For efficacy-only designs, the vy (a1, b1, .. ., ag, by; 01)
function can be evaluated directly for the specified 1,4, and efficacy boundaries found via
the selected efficacy boundary calculation method.

Non-binding futility boundaries are futility boundaries where if the futility boundary is
crossed and the trial continues to future analyses, the Type I error rate will not be inflated
by the choice to continue. In the non-binding case, the relevant efficacy boundaries are
calculated first via the chosen efficacy boundary calculation method to satisfy the target
type I error constraint. The futility boundaries are then calculated to ensure the desired
futility exit probabilties given the pre-calculated efficacy boundary. For a futility-only
design, the efficacy bound will only be defined at the final analysis and will equal to
standard normal quantile function assessed at 1 — «;, e.g. 1.96 for a = 0.025.

Binding futility boundaries are futility boundaries where if the futility boundary is
crossed and the trial continues into subsequent analyses the Type I error rate will be
inflated. Therefore, it is highly recommended that the trial be stopped if a Binding
futility boundary is crossed. In the binding case, the efficacy and futility boundaries are
calculated simultaneously to fulfil the respective Type I and Type II error constraints.

Non-binding futility boundaries are the far more popular choice in clinical trials.

Note that for 2-sided design, nQuery assumes symmetrical efficacy and/or futility bounds
and the lower bound will be set equal the upper bound times -1 by the search algorithm.

Standard root-finding algorithms such as the Brent algorithm [Brent, 1971] are appropri-
ate for most of the search algorithms above. A robust bi-section based method is required
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for finding the power in the presence of futility boundaries when finding the final futility
boundary such that the final efficacy and futility boundary are equal.

7.2.3.1 Inflation Factor

For a given group sequential design, the relative efficiency of that group sequential design
if it reached the final analysis and the equivalent fixed term design can be calculated. This
is known as the Inflation Factor (IF). This inflation factor can be used to calculate
the information (i.e. sample size) increase required to convert a fixed term trial to a
given group sequential design or provide context on the maximum possible inefficiency of
a given group sequential design compared to an equivalent fixed term trial.

Tables of inflation factors are provided by Jennison and Turnbull [Jennison and Turnbull,
1999] for a wide variety of group sequential designs as the inflation factor was considered
convenient to calculate the sample size required for a group sequential design by multiply-
ing the calculated sample size for a fixed term trial by the appropriate inflation factor.
Its calculation is as follows:

The drift parameter is a function of the number of looks, Type I error, Type II error

and the group sequential boundaries (i.e. K, a, [, bk, ax). Given the definition of the
2

drift parameter (77 = 9\/Imax) then re-arrangment implies that [, = (g) . For the

Information-Based design, the information required for an equivalent (1-sided) fixed term

trial will equal:

Za+Zﬁ>2

[Fixed = ( 0

Given this definition and the drift parameter, the inflation factor (I F') equals:
9 2
I = (”) Zat Zs
mazx 9 Za + Zﬂ
2 2
= Loz = (Za+Za> U
0 Lo+ Zg

2 [ 2
:[maw:[Fized< 7 ) = mar :< 1 > =]F

Za + ZB IFi:red Za + Zﬁ

7.2.4 Boundary Calculation Methods (Group Sequential Design
Types)

Multiple proposals have been developed for the calculation of group sequential boundaries.

These methods have different strengths and weaknesses with there often being a trade-off

between flexibility and complexity. The following methods for group sequential boundary
calculation are available in nQuery:

o Lan-DeMets Spending Function
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« Haybittle-Peto (p-value) Boundaries
» Wang-Tsiatis/Pampallona-Tsiatis

o Unified Family

« Custom Boundaries

Note that not all these methods are mutually compatible with each other. For a summary
of which methods are compatible in nQuery see subsubsection 7.3.1.1

An overview of each of these methods is provided below.

7.2.4.1 Lan-DeMets Spending Function

The Lan-DeMets error spending function method is the most widely used method to
generate group sequential boundaries in confirmatory clinical trials.

The error spending function concept was introduced by Lan & DeMets [Gordon Lan and
DeMets, 1983, Demets and Lan, 1994] for constructing efficacy boundaries by “spending”
a proportion of the total Type I « error at each analysis. This method was extended to
spending the Type IT 3 error for the construction of futility boundaries [Pampallona et al.,
1995, Pampallona et al., 2001, Chang et al., 1998]. Alpha and beta spending functions
work functionally the same.

The Efficacy Spending Function is used to generate efficacy boundaries which spends a
certain amount of the total type I error («) at each look. In practical terms, the Type I
error is the probability of crossing the efficacy boundary under the null hypothesis (6 = 6)
at any interim analysis or at the final analysis. aj will be used to indicate the interim
cumulative Type I error exit probability (i.e. the probability of stopping early for efficacy
up to and including the current look under the null hypothesis) “spent” at look k.

The Futility Spending Function is used to generate futility boundaries which spends a
certain amount of the total type II error () at each look. In practical terms, the Type I1
error is the probability of crossing the futility boundary under the alternative hypothesis
(0 = 6,) 3 at any interim analysis or at the final analysis. 8 will be used to indicate the
interim cumulative Type II error exit probability (i.e. the probability of stopping early
for futility up to and including the current look under the alternative hypothesis) “spent”
at look k.

The spending function method has the advantage of significant flexibility compared to

other group sequential methods. The error spending approach allows full control over the
desired desired interim (cumulative) error exit probabilities (a1, g . .., ax 10, B1, Ba ..., Br—1, )
at each look while maintaining the overall desired error rates (a, ) . The error spending
approach also does not require equally spaced pre-specified interim analyses - this had

been a constraint of earlier group sequential proposals such as the Pocock and O’Brien-
Fleming sequential designs [Pocock, 1977, O’Brien and Fleming, 1979]. This flexibility
extends to the analysis stage where the error spending boundaries can be easily adjus-

ted for extra interim analyses or for when the interim analysis timing diverges from the
originally planned information time.

3note that 6 and 6; may be used interchangeably for the alternative hypothesis treatment effect below.
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The only rules the spending functions must satisfy are that the cumulative error spent at
each look must be non-decreasing and that the error spent at the start of the trial equals
zero and the error spent at the final analysis equals the desired total error level (a, f3).

After the full spending sequence of errors has been determined by the spending function
then the group sequential boundaries are calculated in sequence (e.g. by then by ... bx_;
then by for efficacy boundaries) to have the appropriate interim exit probability using the
Yy, (exit probability function for efficacy bounds) or & (exit probability function for futility
bounds) function via a search algorithm as described in subsection 7.2.2. Note that the
exit probability functions referenced above output the incremental exit probability (i.e.
the probability of exiting at that specific look) rather than cumulative exit probability
provided by the spending function. The interim probability can be found by substracting
the cumulative exit probability at the prior look from the cumulative exit probability at
the current look e.g. (ax — ag_1).

As noted in subsection 7.2.3, for non-binding futility boundaries the efficacy boundaries
are calculated first and then futility boundaries are found that have the appropriate
B errors based on the fixed efficacy boundary while for binding futility boundaries the
efficacy and futility boundaries are determined simultaneously.

Due to the flexiblity of spending functions, a wide variety of spending function have been
proposed in the literature. The following error spending functions are included in nQuery:

o O’Brien-Fleming

e Pocock

o Hwang-Shih-DeCani

o Power Family

o 2-Parameter Family (Logistic, Normal, Cauchy)

o Exponential

o Beta

o t-distribution

o User Defined
Different spending functions have differing levels of flexibility with less flexible methods
typically selected for having a good balance of statistical power and low average sample
size [Viele, 2023]. More flexible methods allow for more fine control over the error spend-
ing but can easily lead to an inefficient group sequential design. Therefore, the first four
less flexible options (O’Brien-Fleming, Pocock, Hwang-Shih-DeCani, Power Family) con-
tinue to be the most widely used spending functions in practice. In clinical trials, the
efficacy spending function will tend to be conservative (low probability of early exit e.g.

O’Brien-Fleming) while futility spending functions will tend to be more aggressive (higher
probability of early exit e.g. Pocock).

The alpha spending function (e (tx, o, p;)) will use at least the total o error (i.e. test
significance level) and information time (¢;) to generate the cumulative Type I error spent
at look k bur some spending functions will require one or more additional parameter(s) (p;)
- details on these spending function specific parameters are provided below. For futility
boundaries, replace o with the total 5 error (i.e. 1 — Power) for the beta spending
function. These formulae assume a support for the information time () of [0, 1].

A brief overview of each spending function available in nQuery is provided below:
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O’Brien-Fleming The O’Brien-Fleming spending function was proposed by Lan &
DeMets [Gordon Lan and DeMets, 1983]. It generates boundaries, using the total error
and information time alone, that are similar (but not identical! - see subsubsection 7.2.4.3
for details on how to generate the original O’Brien-Fleming boundaries) to those from the
O’Brien-Fleming sequential design [O'Brien and Fleming, 1979].

The O’Brien-Fleming spending function has the following form for both 1-sided efficacy
and futility boundaries and 2-sided futility boundaries:

e (ty,a) =2 (1 _ (Zi/%/?))

For the 2-sided efficacy boundaries, the O’Brien-Fleming spending function has the fol-

lowing form:
Zl—a/4)>
e(tp,a) =41—

Note that some software uses the second equation for 2-sided futility boundaries. However,
this is believed to be incorrect [Wassmer, 2023] despite providing an allowable sequence

of Bk

This is a widely used “conservative” spending function where a small amount of error
is spent at earlier look. This means a lower probability of early exit but that the final
boundary is closer to an equivalent fixed term analysis.

Pocock The Pocock spending function was proposed by Lan & DeMets [Gordon Lan
and DeMets, 1983]. It generates boundaries, using the total error and information time
alone, that are similar (but not identical! - see subsubsection 7.2.4.3 for details on how
to generate the original Pocock boundaries) to those from the Pocock sequential design
[Pocock, 1977].

The Pocock spending function has the following form:

e(tg,a) =aln{l+ (e — 1)t}

This is a widely used “aggressive” spending function where a larger amount of error is
spent at earlier look - the original Pocock proposal had the same p-value efficacy threshold
at each look. This means a higher probability of early exit but that the final boundary is
further from an equivalent fixed term analysis.

Hwang-Shih-DeCani The Hwang-Shih-DeCani spending function was proposed
by Hwang, Shih and DeCani [Hwang et al., 1990]. It is also commonly referred to as the
Gamma spending function as it requires the specification of the gamma () parameter,
alongside the total error and information time, to generate boundaries.

The Hwang-Shih-DeCani (Gamma) spending function has the following form:

(1-e)
5 (tk’ a’ 7) = {a (1767’\/) 7 # O

Oétk ’720
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This is a widely used flexible spending function where the gamma parameter will determ-
ine the error spending pattern.

Negative values will generate a convex spending function where conservatism increases for
lower values. Positive values will generate a concave spending function where high values
will increase the agressiveness. v = 0 spends the error linearly so can be used to generate
the Linear spending function where ap = t;. v = 1 generates boundaries similar to
Pocock. v = —4 generates boundaries similar to O’Brien-Fleming.

While v can take on any value, nQuery restricts the gamma () parameter to values less
than or equal to 3 to prevent unreasonable boundaries being generated.

Power Family The Power Family spending function was proposed by Kim and
DeMets [Kim and Demets, 1987] and generalized by Jennison and Turnbull [Jennison and
Turnbull, 1999]. It is also commonly referred to as the Kim-DeMets spending function
or the rho spending function as it requires the specification of the power (p) parameter,
alongside the total error and information time, to generate boundaries.

The Power Family (Kim-DeMets) spending function has the following form:

€ (tka a, p) = Oétz

Higher values of p generate increasingly conservative boundaries. p = 1 generates bound-
aries similar to Pocock. p = 3 generates boundaries similar to O’Brien-Fleming.

The power rho (p) parameter must be greater than zero.

2-Parameter Family (Logistic, Normal, Cauchy) The 2-Parameter Family spend-
ing function(s) are a series of flexible spending functions based on parametric distri-
butions proposed by Keaven Anderson [Anderson and Clark, 2010] and implemented
for several distributions in Anderson’s R package gsDesign [Anderson, 2024a, Anderson,
2024b]. The 2-Parameter Family of spending functions requires the specification of two
shape parameters (a, b) and the desired parametric distribution, alongside the total error
and information time, to generate boundaries.

Three distributions are supported in nQuery under this spending function option: the
Logistic, Normal and Cauchy distributions. This approach is also extensible to other
distributions.

The 2-Parameter Family spending function has the following form:

e (tg, ,a,b) = aF (a +bF ! (M))
where F' is the cumulative distribution function (CDF) and F~' is the inverse CDF

(quantile) function for the selected distribution. Anderson shows that the Logistic distri-
bution simplifies to:

o (1= (000

These spending functions are very flexible so require careful consideration of parameter
choice. However, Anderson outlines how the two parameters can be estimated for a given
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distribution by specifying a pair of (tx, ) co-ordinates. See the references above for
details.

The a parameter can be any real value, the b parameter must be greater than zero.

Exponential The Exponential spending function was proposed by Keaven Anderson
[Anderson and Clark, 2010] based on the Exponential distribution. It requires the specific-
ation of the exponential () nu rate parameter, alongside the total error and information
time, to generate boundaries.

The Exponential spending function has the following form:

e (tg, o, v) = at”

Higher values of v generate increasingly conservative boundaries. v = 0.8 generates
boundaries similar to the O’Brien-Fleming spending function [Anderson, 2024a] -
however Anderson notes that v = 0.75 generates a superior approximation of the ori-
ginal O’Brien-Fleming design’s boundaries than the O’Brien-Fleming spending func-
tion [Anderson, 2024b].

The Exponential (p) parameter must greater than zero. nQuery restricts this value to a
maximum of 1.5, Anderson recommends values less than 1 [Anderson, 2024b].

Beta The Beta spending function was proposed by Keaven Anderson [Anderson and
Clark, 2010] based on the Beta distribution. It requires the specification of the the two
beta shape parameters (a, b), alongside the total error and information time, to generate
boundaries.

The Beta spending function has the following form:

e (tg, a,a,b) = aly, (a,b)

where I;, is the (regularized) incomplete beta function which is equivalent to cumulative
distribution function of the beta distribution.

This is a highly flexible spending function that can be used to generate a wide range
of spending function patterns and approximate other spending functions. For example,
with parameters (a = p,b = 1) the beta spending function will equal the Power Fam-
ily spending function [Anderson, 2024b| and with parameters (a = 1,b = 1) the beta
spending function will equal the Linear spending function where oy = t;.

Both Beta parameters (a,b) must be greater than zero.

t-distribution The t-distribution spending function was proposed by Keaven An-
derson [Anderson and Clark, 2010] based on the Student’s t-distribution. It requires
the specification of two shape parameters (a,b) and the degrees of freedom for the t-
distribution (df), alongside the total error and information time, to generate boundaries.

The t-distribution spending function has the following form:

£ (tk, a,a, b) = OéFdf ((l -+ de}l (tk))
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where Fy is the cumulative distribution function (CDF) and Fd}l is the inverse CDF
(quantile) function for the t-distribution with df degrees of freedom.

The t-distribution spending function is very flexible so requires careful consideration of
parameter choice. However, Anderson outlines how the two shape parameters can be
estimated for a given distribution by specifying a pair of (tx, ) co-ordinates for a fixed
degrees of freedom.

The a parameter can be any real value, the b parameter must be greater than zero. df
must be an integer greater than two.

User Defined The User Defined spending function is a spending function where
there is full flexibility to assign the cumulative error at each look as the user wants. This
is also known as the piecewise linear or interpolated spending function. This spending
function offers the maximum flexibility possible with the only restriction being that the
cumulative errors are strictly increasing at each look and bounded between 0 and total
Type I/1I error (if specified).

This function requires the user to input the desired amount of alpha and/or beta er-
ror to spend at each interim analysis in the GST Outputs side-table directly - see
subsection 7.3.2 for details. Note that when power is being solved for, the user will input
the proportion of the total (unknown) Type I (5) spent rather than the amount of beta
error spent directly.

Note that the Custom Boundary options for Alpha Error and Beta Error are equi-
valent to the user defined spending function for the efficacy and futility boundaries, see
subsubsection 7.2.4.5 for details.

7.2.4.2 Haybittle-Peto (p-value) Boundaries

The Haybittle-Peto method is a simple method for boundary construction proposed
by Haybittle [Haybittle, 1971] and expanded upon by Peto et al. [Peto et al., 1976]. In
the Haybittle-Peto group sequential design, the efficacy boundaries are specified as p-
values at each interim analysis - a p-value less than the boundary p-value from a standard
unadjusted analysis (e.g. two sample Z-test for means) at an interim analysis would stop
the trial early for efficacy. As the boundaries are specified on the p-value scale these
are also sometimes known simply as p-value boundaries. Note that this method can be
applied to both the 1 and 2 sided case.

There are two options in nQuery for Haybittle-Peto Boundaries: Total Alpha, Last P-
value.

The Total Alpha method is where only the interim p-value boundaries are specified and
the final analysis p-value is derived to ensure a specified overall Type I (a) error rate.
The original Haybittle-Peto method proposed that the same p-value be used for each
interim analysis before calculating the final analysis p-value. However, nQuery allows an
arbitrary set of interim p-value boundaries be entered.

The Last P-value method allows for all p-value boundaries to be specified including
for the final analysis. No Type I («) error rate is specified, though this will be calcu-
lated by nQuery in the Group Sequential Report as the Exact Significance Level - see
subsection 7.2.3 and subsection 7.3.4.
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It is recommended that the interim p-values would typically be set to a small number
(<0.005) so that the final analysis p-value would be reasonably close to the overall test
significance level.

Note that the Custom Boundary option p-value is equivalent the Haybittle-Peto
method for the efficacy boundary and this option can also be used to specify futility
boundaries on the p-value scale, see subsubsection 7.2.4.5 for details.

7.2.4.3 Wang-Tsiatis/Pampallona-Tsiatis Boundaries

The Wang-Tsiatis method is a flexible method for boundary construction proposed by
Wang & Tsiatis [Wang and Tsiatis, 1987] for efficacy boundaries and extended by Pam-
pallona and Tsiatis [Pampallona and Tsiatis, 1994, Pampallona et al., 1995, Pampallona,
et al., 2001] for equivalent futility boundaries. These boundaries are also referred to as
Power Family boundaries. Note that these methods can be applied to both the 1 and 2
sided case.

The Wang-Tsiatis method provides a flexible family of efficacy boundaries that are defined
by a single shape parameter. The Pampallona-Tsiatis boundary method extended the
Wang-Tsiatis method to include futility boundaries defined by their own separate shape
parameter. For clarity, Ay will refer to the Wang-Tsiatis efficacy shape parameter and A,
will refer to the Pampallona-Tsiatis futility shape parameter.

Both papers discuss "near-optimal" designs which search over the shape parameter(s) to
minimize the expected average sample size under a specific hypothesis such as the null
(6o) or alternative hypothesis (6;) treatment effect.

The Wang-Tsiatis boundaries have the following form:

by = C (Ar, o, K) 131 7?

where by is the standardized test statistic efficacy boundary at look k, C' (A1, o, K) is a
constant defined by the efficacy shape parameter (A;), total type I error («) and total
number of looks (K), and ¢ is the information time at look k.

As the boundaries are constructed as a function of this positive constant C' (Aq, o, K), a
numerical search over this constant is performed until the generated boundaries have the
specified total Type I error rate specified - see subsection 7.2.3 for detail on how the Type
I error rate is calculated for a given set of boundaries.

The Pampallona-Tsiatis futility boundaries have the following form:

ar, = 0\ I — C (Ao, B, K) 527/

where ay is the standardized test statistic futility boundary at look k, n is the drift
parameter (see subsubsection 7.2.1.1), t; is the information time and C' (A, 5, K) is a
constant defined by the futility shape parameter (As), total type II error (5) and total
number of looks (K), and ¢, is the information time at look k.

For Pampallona-Tsiatis designs, a two-dimensional search is conducted across both con-
stants. To simplify this search, the following relationships can be used:
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C<A17a7K) :61\/T_C(A2757K>

This constraint ensures that the efficacy and futility boundaries will meet at the final
analysis and, via re-arrangement, calculates the maximum information for any given pair
of constants.

The two-dimensional search will find the pair of constants which have boundaries with
the specified Type I error rate under the null hypothesis (and power if calculating the
maximum information) and specified total Type II error rate under the alternative based
on the exit probability functions - see subsection 7.2.3.

For non-binding futility bounds, the Wang-Tsiatis boundaries will be specified first and
then the Pampallona-Tsiatis boundaries will be calculated based on the fixed efficacy
boundary. For binding futility bounds, both the Wang-Tsiatis and Pampallona-Tsiatis
boundaries are evaluated simultaneously.

Note that the definition for the constants given here are for the standardized test statistic
(Z)) scale are as per Chapter 4 of Jennison and Turnbull [Jennison and Turnbull, 1999].
Note that the original derivations from Wang & Tsiatis/Pampallona & Tsiatis are based
on the score statistic scale (S) - for example the Wang & Tsiatis paper gives the efficacy
score boundaries as b,(WT) = C (Ay, a, K)tp'. As noted by Jennison and Turnbull, the
constants on the score scale can be found by multiplying the standardized test statistic
constants used above by K2,

A shape parameter (A) equal to 0 is equivalent to the original O'Brien-Fleming design
boundaries [O’'Brien and Fleming, 1979] and a value of 0.5 is equivalent to the ori-
ginal Pocock design boundaries [Pocock, 1977] - neither should be confused with the
spending function approximations for these designs of the same name (see section 7.2.4.1,
section 7.2.4.1).

7.2.4.4 Unified Family Boundaries

The Unified Family method is a highly flexible method for boundary construction
proposed by Kittleson and Emerson [Kittelson and Emerson, 1999]. The Kittleson and
Emerson proposal sought to unify a wide range of existing sequential designs [Pocock,
1977, O’Brien and Fleming, 1979, Whitehead and Stratton, 1983, Whitehead and Brunier,
1990, Wang and Tsiatis, 1987, Emerson and Fleming, 1989, Pampallona and Tsiatis, 1994]
into a single group sequential family, while also extending to additional scenarios such as
equivalence testing.

The Unified Family concept was based on the concept that the process for determining
stopping boundaries could be split into 3 parts. The first is a boundary shape function
that defines the relationship between the boundaries. The second is a “critical value”
constant which is chosen to satisfy a given hypothesis (Type I/II error rates). The third
is the reference hypothesis itself.

This section will discuss the two-sided efficacy and futility scenario that requires all four
boundaries as this is the primary basis of the Unified Family work as described by Kittleson
and Emerson. Simpler scenarios are easily accomodated by dropping the unused bound-
aries.
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The Unified Family method provides a flexible family of efficacy and futility boundaries
that are each defined by two shape parameters. The description of Kittleson and Emerson
describes the Unified Family in terms of the four potential boundaries in a group sequential
design: the upper efficacy boundaries (b(u)y), the upper futility boundaries (a(u)y), the
lower futility boundaries (a(l)), the lower efficacy boundaries (b(1)). The Unified Family
method requires b(u), > a(u), > a(l)r > b(l)y.

Note the terminology used here is for consistency with the prior sections, in Kittleson
and Emerson these are referred to (in order) as ag, by, ¢k, dj (note their paper uses j for
the look index rather than k). There are also some other minor differences between the
formulae below and those provided in Kittleson and Emerson, these will be summarized
later.

The four boundaries have the following form on the standardized test statistic scale:

b(w)r = f (tr) Cu)
a(u)y = 0/ I, = f (t4) Cagu
a(l) = 0\/Iy + f () Cag

b(D)r = —f (tx) oy

where f (t)) is a shape function with the following form:

f () = Vi (T +1,77?)

where (7) is the first shape parameter and (p) is the second shape parameter.
In nQuery, p must be greater than zero and the range for 7 is 0 < 7 < 2p.

These shape parameters provide significant flexibility to define the shape of the bound-
aries. As referenced above, the Unified Family can be used to replicate several existing
group sequential proposals using these shape parameters. A tabular summary of these is
provided below:

’ Method ‘ T ‘ p ‘
Pocock (1977) 0 0
O’Brien-Fleming (1979) | 0 | 0.5
Wang-Tsiatis (1987) | 0| 0.5—p
Table 7.1: Unified Family Parameters for Other Sequential Designs

where 0.5—p becomes the shape parameter of the Wang-Tsiatis boundary A (subsubsection 7.2.4.3).
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For Unified Family designs, to construct the boundaries a search is conducted over all the
relevant constants (C’b(u), Ca), Caq), Cb(l)) until the required Type I and/or Type II error
constraints are fulfilled. This evaluated using the appropriate exit probability function(s)
as discussed previously (see subsection 7.2.3).

For non-binding futility bounds, the efficacy boundaries will be specified first and then the
futility boundaries will be calculated based on the fixed efficacy boundary. For binding
futility bounds, both the efficacy and futility boundaries are found simultaneously.

Similar to Wang-Tsiatis, constraints can be imposed to ensure that the appropriate efficacy
and futility boundaries meet at the final analysis. For example, to ensure that the upper
efficacy and upper futility boundaries (in a 2-sided example) meet at the final analysis
the following constraint can be imposed:

fQ) Ob(u) = 0\/ Ix — f(1) Oa(u)
There are number of differences between the implementation described here and that
available in Kittleson and Emerson. A summary is provided below.

First, Emerson and Kittleson derive their boundaries on the score scale. For consistency
with the prior sections, the standardized test statistic (Z;) derivation was used here
instead.

Second, p parameter used here is equal to p* —1/2 where p* is the Kittleson and Emerson
equivalent shape parameter definition.

Third, Kittleson and Emerson include a e term in their boundaries definition to account
for the equivalence testing extension. This has been excluded to focus on the inequality
testing case.

Fourth, for the 2-sided case nQuery restricts the upper and lower boundaries to be sym-
metric for both the efficacy and futility boundaries: b(u), = |b(1)|, a(u)r = |a(l)x]

Fifth, Emerson and Kittleson provided an additional three parameter shape function. The
2-parameter version provided here is equivalent to this parameter (R, in Kittleson and
Emerson) being set to zero.

7.2.4.5 Custom Boundaries

nQuery provides support to enter custom efficacy and futility boundaries on a number of
statistical scales. This provides the user full flexibility to input any series of boundary
values on their preferred statistical scale.

In nQuery, the following boundary scales are available:
o Z-Scale
o p-value Scale
e Score Scale
e O-scale
« Alpha Error (Efficacy Only)
« Beta Error (Futility Only)
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« Conditional Power (Futility Only)

The Z-scale corresponds to setting the boundaries on the standardized test statistic scale.
This is the default scale and is the most widely used in clinical trials due to the widespread
usage of the standardized Z-statistic for hypothesis testing. The Z-statistic based on the
(Fisher) information (I) will equal 6+/1.

The p-value Scale corresponds to setting the boundaries in terms of the p-value. The
p-values to be compared to the boundaries are presumed to come from the appropriate
unadjusted Z-test (e.g. Z-test for means, Chi-Squared Test for proportions, Log-Rank
Test for survival). This is a common boundary scale requested by researchers. The p-
value will equal 1—® (Z) where ® is the cumulative distribution function for the standard
normal distribution.

The Score Scale corresponds to setting the boundaries in terms of the score statistic.
Score statistisc (and other increment based statistics such as the B-value) are widely used
in the derivation of group sequential designs, though less used in practice. The Score
statistic based on the (Fisher) information (/) will equal 1.

The 8-scale corresponds to setting the boundaries in terms of the treatment effect. The
definition will depend on the endpoint of interest. For example, this could be mean
difference of the two-sample Z-test, the risk difference for the chi-squared test or the
log hazard ratio for the log-rank test. This is a common boundary scale requested by
researchers. 6 corresponds to 6 above.

The Alpha Error scale corresponds to setting the boundaries in terms of the cumulative
exit probability for efficacy at a given look under the null hypothesis i.e. the o or Type
I error. This is equivalent to using the User Defined spending function for the efficacy
boundary - see section 7.2.4.1 for details.

The Beta Error scale corresponds to setting the boundaries in terms of the cumulative
exit probability for futility at a given look under the alternative hypothesis i.e. the (8
or Type II error. This is equivalent to using the User Defined spending function for the
futility boundary - see section 7.2.4.1 for details.

The Conditional Power scale corresponds to setting the futility boundaries in terms of
the probability of significance conditional on the data accrued so far. Conditional power
requires an assumption about the “true” treatment effect. nQuery provides two options
for the assumed “true” treatment effect: Estimated ¢ and Design 6. Estimated 6
assumes the treatment effect is equal to the futility boundary on the 6-scale at that
interim analysis. Design 6 assumes the treatment effect is equal to that set for the
original group sequential calculation in the main design table (see subsection 7.3.1).

In nQuery, the underlying group sequential methods are based on the standardized test

statistic Z-scale. The other scales are transformed to the Z-scale before being passed to

the group sequential solver. A brief overview of this transformation is provided for each

test statistic:

= © (pk) 0 <0
(quantile) function

e Score Scale: Z;, = Sy, /I

e d-Scale: Zi, = 6,11

o p-value Scale: , where ¢ is the standard normal inverse CDF
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« Alpha Error: Found via sequential search over ¢y (a, by, ..., ax, bg;0) as per other
spending functions - see subsection 7.2.2 and subsubsection 7.2.4.1 for details.

» Beta Error: Found via sequential search over & (ay, by, ..., a, bg; 0) - see per other
spending functions - see subsection 7.2.2 and subsubsection 7.2.4.1 for details.

Conditional Power: To calculate the exact conditional power, a search is required over the
conditional power function to find standardized test statistic Z-scale futility boundaries

that correspond to the target conditional power for the assumed “true” treatment effect
(0) chosen

To conduct an exact conditional power calculation for a given set of future efficacy and
futility boundaries, the Type I error function (described in subsection 7.2.3) can be used
under the selected @ if the future boundaries are transformed appropriately.

This transformation is shown below for the efficacy boundary at the next look (k + 1):

In
bet1 — Ziy/ 1.5

by, =
k+1
Iyyp1—1Ig
T4

The same adjustment is made to all other subsequent efficacy boundaries (bgys,..., bx) and
the futility boundaries (aj41...., ax) as applicable:

These adjusted boundaries can be passed to the efficacy exit probability function 1 for
the specified “true” 6 as follows:

K
= * * * Pk,
Cp = Z 77Z)j (ak—‘rlv k+17"'7aj7bj79)
j=k+1

In nQuery, the choice of treatment effect is limited to the Estimated 9 (where treatment
effect equals the futility bound at the current look) or the Design O (where treatment
effect equals original value from power calculation). However, this could easily extended
to an abritrary treatment effect. For the Estimated O, the treatment effect for the
conditional power function is equal to Z;/v/I} as implied by the 3-Scale transformation
above.

To convert the specified per-look conditional power boundaries at each look to the equi-
valent standardized test statistic futility boundary, a search can be applied over the two
functions above to boundaries in reverse order (i.e. starting with the final analysis, look
K) to find the Zx which has conditional power equal to the specified conditional power.
The search is in reverse order as all future futility boundaries at given look must be known
on the standardized test statistic scale to calculate the conditional power. The search at
each look can be done via standard search algorithms such as the Brent algorithm [Brent,
1971].

7.2.5 Endpoint/Design Specific Sample Size Determination

The above sections has described group sequential design in terms of the maximum in-
formation (I,,4;) and treatment effect (0). As discussed in subsubsection 7.2.1.1, these
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concepts are easily extensible to any efficient estimator and consistent variance which
covers a wide range of statistical tests and models.

The calculation for the power for a given maximum information and maximum information
for a given power was given in subsection 7.2.3. Given a known relationship between the
sample size and the maximum information, these calculations can be conducted to find the
power or sample size given specified values for all other parameters required to calculate
the maximum information.

In this section, the translation from (/.,60) to sample size (and events for survival
analysis) is summarized for the current design scenarios covered in nQuery.

7.2.5.1 Two Means (GST1)

For an inequality two-sample Z-test for two means, the translations are as follows:

ny no

=X, —X,
n— X1 — X,
(7 +72)

where 07 and o2 are the group 1 and group 2 variances (standard deviation squared), n,
and ngy are the total planned (maximum) sample size per group and X; — X5 is the mean
difference.

To calculate the sample size, the maximum information can be calculated based on the
target statistical power. The formula for [,,,, can be re-arranged for njand n, assuming
a fixed sample size ratio (R = ny/n;) based on the per-group standard deviations.

To calculate the statistical power, the maximum information can be calculated using the
specified per-group values for the standard deviation and sample size. The power can be
calculated based on this maximum information.

7.2.5.2 Two Proportions (GST2)

For an inequality two-sample Z-test for two proportions (equivalent to the chi-squared
test), the translations are as follows:

(wl(pm) _i_7r2(177r2))_1 V(Unpooled)

ni ng

Imam: _ _ _ N —
(FU-m o 2T Y (Pooled)

ni n2

‘9:7'('1—71'2
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T —T2
\/771<177r1>+7r2(17772) V(UﬂpOOZed)

T2 V(Pooled)

[®(1—7) | ®(1—7)
N1 + NagTo
N1 + no

3

where m; and 7wy are the group 1 and group 2 proportions, 7 is the average proportion,
niand ng are the total planned (maximum) sample size per group and 7, — s is the propor-
tion (risk) difference e.g. the specified risk difference at the planning stage. V(Unpooled)
indicates the Unpooled variance was used and V' (Pooled) indicates the Pooled variance
was used

To calculate the sample size, the maximum information can be calculated based on the
target statistical power. The formula for I,,,, can be re-arranged for n; and ny assuming
a fixed sample size ratio (R = ny/n;) based on the group 1 and group 2 proportions.

To calculate the statistical power, the maximum information can be calculated using
the specified per-group values for the proportions and sample size. The power can be
calculated based on this maximum information.

Note there is an alternative proposal for the pooled variance scenario where the drift
parameter and boundaries are multiplied by a fixed factor (h) to improve the Type II
error search performance.

7.2.5.3 Two Survival (Time-to-Event) Analysis (GST3) - Events Determination

For an inequality two sample log-rank test, the translations are as follows:

I _ (Epm (1_pn1))_1 V(Null)
" (Epey (1= pey)) ™" V(Alternative)

0 =In(HR)

Ry (Nwll)

\/ Epny (l—pnl)

T=) _ m@ER V (Alternative)
Epel(]-_pel)

where E is the total number of events at the end of the study, p,, is the proportion of the
total sample size from group 1 (%), PDe, is the proportion of the total events from group

1 (%), E) is the total events at look k (equal to E by t;) and In (HR) is the (natural)
log hazard ratio, where H R is the hazard ratio.

V(Null) indicates when the variance is calculated under the null hypothesis of a hazard
ratio of 1 and therefore the sample size and event per-group allocations are the same.
V(Alternative) indicates when the variance is calculated under the alternative hypothesis
when the hazard ratio is equal to its actual value e.g. alternative hypothesis HR at the
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planning stage. The null hypothesis is the most common choice used for power calculations
in clinical trials.

To calculate the total events, the maximum information can be calculated based on the
target statistical power. The formula for [,,,, can be re-arranged for E. For V(Null),
calculate p,, using the specified sample size ratio (R = ny/ny,) using the following for-
mula: p,, = (ﬁ) For V(Alternative), p., is invariant to the total sample size so find
the event allocation for an arbitrary sample size to determine p., based on the provided
inputs for the accrual process, hazard rates, dropout rates and censoring strategy for any
value of the total sample size. See subsubsection 7.2.5.4 for details on calculating the
number of events for a given sample size. It is recommended to calculate p., with the
unrounded events per-group.

To calculate the statistical power, the maximum information can be calculated using the
specified events (E) and p,, under V(Null). As above for the total events calculation,
pe, for V(Alternative) can be found for an arbitrary total sample size under the relev-
ant design assumptions and can then calculate the maximum information based on this
calculated value of p., and the total events.

Note that while the assumption that the information time is proportional to Et, is reas-
onable for the log-rank test (and Cox Model) under proportional hazards. For weighted
rank tests, often used in the context of non-proportional hazards such as delayed effects,
this proportionality assumption will not hold and the interim timing will be a function
of additional information (e.g. hazard ratio pattern, event weighting) other than just the
events.

As can be seen above, the maximum information and power is not related the
sample size directly. Rather the sample size is estimated on the basis of calculating
the required number of subjects needed to reach the target number of events based on
assumptions regarding the accural process, hazard rates, dropout rates and censoring
strategy. An overview of the relationship between the events and sample size based on
these assumptions is provided below.

7.2.5.4 Survival (Time-to-Event) Analysis (GST3) - Sample Size Determination

The following describes how the sample size and power are calculated for a given number
of events in a two sample log-rank test allowing for piecewise hazard rates, dropout rates
and accrual. The methodology presented is based on the work of Kim & Tsiatis for
survival sequential trials [Kim and Tsiatis, 1990].

Notation

The notation used to model the event and dropout processes are outlined here. Let A(t)
be the hazard function for the event of interest and let §(¢) be the hazard function for the
dropouts. Then:

o A(t) = [y M(#')dt' is the cumulative hazard function for the event.
e D(t) = J35(t")dt' is the cumulative hazard function for the dropouts.

« Probability that a subject has event before time t (and is not censored) = [f K (¢')dt,
where K (t) = \(t)e A®O+D@)]

166



7.2 Group Sequential Design Theory

In nQ

uery, the event and dropout hazards are modelled as piecewise exponential functions

(see subsection 7.3.3), while the accrual process is piecewise constant.

t is a vector of P time periods. i.e. t = (0,...,7),where tp = T = total study
duration.

A; is a vector of event hazard rates in group i, where),;; is the hazard rate in group
i between times ¢t;_; and t; and ¢ € {1,2}

0, is a vector of dropout rates in group i, where §,; is the dropout rate in group ¢
between times t;_; and t; and i € {1, 2}

a is a vector of P proportions used to describe the accrual process, where a; is the
proportion of the total subjects recruited between times t;_; and t;

A = t,_atj_ - is the proportion of the total subjects accrued per unit time between
J J—

times t;_; and ¢; for j € {2, ..., P}

Sample Size Calculations

The sample size in each group (n;) is calculated from the number of events in that group
(E;), as well as the piecewise event rates (\;), dropout rates, (§;) and accrual proportions

(A).

The formula used will depend on the type follow-up approach and length of the follow-up
period. If the follow-up type is event driven, then each subject can be followed until the
end of the study, regardless of when they were recruited.

If the

follow-up type is fixed, then each subject is followed for a specified fixed period (f)

after they were recruited, or until the end of the study (7"), whichever comes first.

Note that if the fixed follow-up time equals the total study time then this is equivalent
to event-driven follow-up.

Case

Let q

Then:

1: Follow-up type = Event-driven

q
be the minimum integer such that > a; =1, i.e. £, is the accrual period.
=1

ni = E[Z Ayttt )(([ Kt [ K@ [ e gan)

Total
Case

Let 7
Tq =

Let s
SQQ =

sample size, N = nq + no
2: Total study time < accrual period + follow-up period.

=t and let ¢; be the minimum integer such that t,, > T — f. I T — f ¢ T set
Tr—rf

=t and let ¢go be the minimum integer such that ¢, < T — f. If T'— f ¢ s.set
Tr—f

g3
Let g3 be the minimum integer such that >> a; =1, i.e. ¢, is the accrual period.

7j=1
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Then

q1

m = B Kan(y Aytr, - 7y0))+

J=2

(3 A7 Kt +(T-s,) [

J=q2 T=s;

T—S]'_l T—Sj_1

Ki(t)dt—/ LK (t)dt))] ™

T—Sj

Total sample size, N = n; + ns

Case 3: Total study time > accrual period + follow-up period.
q
Let ¢ be the minimum integer such that > a; =1, i.e. ¢, is the accrual period.
=1

Then:

q

me = B[ K@ Aty — )

=2

Total sample size, N = ny + ngy

Power Calculation

The power is calculated from the number of events (F), significance level («), hazard

ratio (h) and sample size ratio (R = 22)

R o
= 1 2~ ° -1 1 —
Power Z[\/E n(h) = Z sided)]

Where Z() is the cumulative distribution function of standard normal distribution.

7.3 Group Sequential Design Table User Interface

An overview of the user interface elements for the group sequential design tables is
provided in this section. The group sequential design tables in nQuery have a large
number of user interface elements in common with the other design tables in nQuery so
the primary focus will be on the unique aspects for th suite of tables. See chapter 1,
chapter 2, chapter 3 for further details on the nQuery Ul and Assistant tools.

In this section, the following areas will be summarized:
e Main Design Table
« Group Sequential Side-table
o Group Sequential Report
e Boundary Plot
o Error Spending Plot
e Group Sequential Options Tab
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7.3.1 Main Design Table

The main design table is the primary inputs for the design-specific parameters required
for the sample size or power calculation - see section 1.7.

In the group sequential design tables, the main design table will consist of two primary
types: Fixed Term Parameters, Group Sequential Design Parameters

Fixed Term Parameters are the parameters that would be required for the equivalent
fixed term sample size determination. For example, for GST1 (Group Sequential for Two
Means) this would be the mean difference (and optionally the per-group means), standard
deviation (per-group), test significance level, power and sample size. For the equivalent
Two Sample Z-test table (MTT10), the same parameters are required.

Note that the direction of the hypothesis will depend on the value for the row(s) which
correspond to the treatment effect 6. If the treatment effect is positive then higher values
for the treatment effect (and statistics such as the Z-statistic and Score statistic) are
considered more “effective” and lower values more “futile”. If the treatment effect is
negative then lower values will be considered “better”.

For GST1, positive treatment effect would correspond to a positive mean difference so
the higher the mean difference (and Z-statistic etc) the “better”. For GST2, a “posit-
ive” treatment effect would correspond to a positive proportion difference. For GST3, a
“positive” treatment effect would correspond to a hazard ratio > 1.

Group Sequential Design Parameters are the parameters which will define the group
sequential design. This includes the total number of looks (including the final analysis)
and the Efficacy and/or Futility Boundary Calculation Methods.

This GST1 main design is shown in Figure 7.1:

Test Significance Level, a

1 or 2 Sided Test? 1 1 1 1 1 1 ] 1
Number of Looks, J

Group 1 Mean, p,

Greup 2 Mean, p,

Mean Difference, p, - pz

-

Group 1 Standard Deviation, o,

Group 2 Standard Deviation, o,

Efficacy Bound Calculation Method Spending Function | Spending Func... Spending Func... Spending Func... Spending Func... | Spending Func... Spending Func... =Spending
Futility Bound Calculation Method Custom Boundary = Don't Calculate = Don't Calculate | Don't Calculate  Don't Calculate = Don't Calculate = Don't Calculate = Don't Cal
Group 1 Sample Size, n,

Group 2 Sample Size, n,

Sample Size Ratio, n,/n,

Power (%)

Figure 7.1: GST1 Main Design Table

After the Number of Looks, Efficacy Bound Calculation Method and Futility
Calculation Method fields are filled appropriately, the Group Sequential Side-table
will appear below the main table and can then be filled - see subsection 7.3.2.

Note nQuery may provide defaults for a boundary calculation method which will allow a
sample size or power calculation to occur before editing the Group Sequential Side-table
e.g. O’Brien-Fleming for Spending Function. Therefore, it is highly recommended that
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the side-table be assessed and edited appropriately before running a calculation. This is
prevent solver activation occuring for every subsequent change made in the main design
table or side-table.

A summary of the technical details for the group sequential boundary methods available
in nQuery was provided in subsection 7.2.4. A brief overview of these methods is provided
next.

7.3.1.1 Group Sequential Boundary Calculation Methods

The choice of group sequential boundary calculation method for efficacy and futility
bounds selected in the main design table will affect the statistical and design properties
of the group sequential design (subsection 7.2.4) and also affect the required additional
inputs to run a group sequential design (subsection 7.3.2).

The user selects the desired method for the efficacy and futilty bounds separately using
their respective dropdown fields in the main design table.

nQuery provides the following Efficacy Bound Calculation Methods:
» Spending Function
o Haybittle-Peto
o Wang-Tsiatis
o Unified Family
o Custom Boundary
o Don’t Calculate
nQuery provides the following Futility Bound Calculation Methods:

Spending Function

Pampallona-Tsiatis
Unified Family
Custom Boundary

e Don’t Calculate

Don’t Calculate is used to indicate when an efficacy or futility only design is required
by not including boundaries for the option set to Don’t Calculate.

Note that not all group sequential methods efficacy and futility boundary calculation
method options available in nQuery are mutually compatible with each other. A summary
of the compatibility of the methods is provided below in Table 7.2.

] Fut |, Eff — \ SF \ Haybittle-Peto \ W-T \ UF \ Custom \ DC ‘
Spending Function (SF) v v X X v v
Pampallona-Tsiatis (P-T) | X X v | X X X
Unified Family (UF) | X X X |V X X
Custom Boundary v Ve X X v X
Don’t Calculate (DC) v v I/ v X

*

Table 7.2: Group Sequential Method Compatibility (*1-sided Only)
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7.3.2 Group Sequential Side-table

The Group Sequential side-table appears automatically below the main table after the
Number of Looks, Efficacy Bound Calculation Method and Futility Calculation
Method fields are filled appropriately. During the setup phase, the user can specify the
additional parameters required to setup the desired group sequential design by setting the
group sequential boundary method’s specific additional parameters, the interim analysis
timings, which efficacy or futility looks (if any) that are skipped and the statistical scale
the boundaries will be displayed or inputted on.

The Group Sequential side-table is designed to dynamically update as the user makes
changes in the main design table and within the side-table. After a solver calculation is
activated, the group sequential side-table will also add tabs at the top of the side-table
panel which provide additional results in the Group Sequential Report, Boundary Plot
and Error Spending Plot. These will be described later as we focus on the GSTX-Y input
side-table first.

The input Group Sequential side-table tab will be named GSTX-Y where X will be the
table code number (e.g. GST1 for Two Means) and Y will be column number that the
side-table is associated with.

The Group Sequential side-table will consist of three sub-tables: GST Parameters
(top-left), GST Outputs (right), Additional Parameter (bottom-left, if required).
An example side-table is shown in Figure 7.2.

GST15-1

A/ GST Simulation

GST Parameters GST Outputs 1 2 3 4
Alpha Spending Function Hwang-Shih-DeCani Total Sample Size
Beta Spending Function O'Brien-Fleming Information Time 0.250 0.500 0.750 1.000
Futility Bounds Non-Binding Efficacy Bound
Boundary Scale Z-scale Futility Bound

Stop for Efficacy Yes Yes Yes Yes
Additional Parameters

Stop for Futility Yes Yes Yes Yes

Efficacy HSDC Parameter, y(o) 5
Cumulative Alpha

Cumulative Beta

Figure 7.2: Group Sequential Side-table Example

The GST Simulation button (above the GST Parameters table in top-left if available
for that design table) will open the Group Sequential Design Simulation tool. If no
solver has been activated in the current column, the GST Simulation tool will open in a
default “empty” state. If a solver is activated in the current column, the GST Simulation
tool will inherit the relevant values from the main design table and the GST Output
table. See chapter 8 for details on the Group Sequential Design Simulator tool and its
integrations with the GSTX series of tables.

An overview of the each Group Sequential input sub-table is provided next.
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7.3.2.1 GST Parameters

The GST Parameters tables specifies the primary Bound Calculation Method inputs,
specifies the type of Futility Bound and the scale on which the bounds will be shown or
inputted in the GST Outputs table. As the GST Parameters side-table will auto-
matically update depending on Efficacy Bound Calculation Method and Futility
Bound Calculation Method selected, the GST Parameters will be summarized in the
following sections:

o Method Specific Inputs
— Spending Function
— Haybittle-Peto
— Wang-Tsiatis/Pampallona-Tsiatis
— Unified Family
o Futility Bounds (Non-Binding/Binding)
o Boundary Scale
— Boundary Scale (Output)
— Efficacy Boundary Scale (Input)
— Futility Boundary Scale (Input)

Method Specific Inputs The fields shown in the GST Parameters table will depend

on the Efficacy Bound Calculation Method and Futility Bound Calculation
Method selected in the main design table with the efficacy and futility bounds defined
separately. The three primary boundary calculation methods which affect the GST Para-
meters table are the Spending Function, Haybittle-Peto, Wang-Tsiatis/Pampallona-
Tsiatis and Unified Family methods.

In terms of the other methods interaction with the GST Parameters table, Custom
Boundary will be discussed in the Boundary Scale options section below and Don’t
Calculate has no additional inputs as it means there is no efficacy or futility boundary
and therefore these methods can be skipped here. The relevant methods effect on the
GST Parameters will be discussed in turn next:

Spending Function If Spending Function option is selected in the Efficacy Bound
Calculation Method row in the main design table then a Alpha Spending Function
row will be added to the GST Parameters table.

If Spending Function option is selected in the Futility Bound Calculation Method
row in the main design table then a Beta Spending Function row will be added to the
GST Parameters table.

If both efficacy and futility bounds are active, the spending functions are set separately
for each boundary via the Alpha Spending Function and Beta Spending Function rows.
The same set of spending functions are available for both efficacy and futility bounds.
Technical detail on spending functions is provided in subsubsection 7.2.4.1These spending
functions available are as follows :
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o O’Brien-Fleming

» Pocock

« Hwang-Shih-DeCani ()

« Power Family (p)

o 2-Parameter Family (Dist., a, b)
« Exponential (v)

« Beta (a,b)

« t-Distribution (a, b, df)

o User Defined

For spending functions that require additional parameter inputs, the symbols in brack-
ets indicate the inputs required in the Additional Parameters table (described in
subsubsection 7.3.2.3) for that spending function. User Defined requires the input of
the custom alpha/beta errors in the GST Outputs side-table (see subsubsection 7.3.2.2).
For the O’Brien-Fleming and Pocock spending functions, solver activation can occur
without any further input.

An example spending function GST Outputs table is provided in Figure 7.3.

173



7.3 Group Sequential Design Table User Interface

GS5T Parameters

Alpha Spending Function Hwang-5hih-DeCani

Beta Spending Function D'BriEﬂ—FIemind v

Futility Bounds O’'Brnien-Fleming

Boundary Scale Pocock
Hwang-5hih-DeCani

Additional Parameters Power Family

Efficacy HSDC Parameter, y Z-Parameter Family
Exponential
Beta
t-Distribution
User Defined

Figure 7.3: Spending Function GST Parameters Table Example

Haybittle-Peto If Haybittle-Peto is selected in the Efficacy Bound Calculation
Method row in the main design table then a Fixed Parameter row will be added to
the GST Parameters table. Fixed Parameter is a dropdown field that can be set to
Total Alpha or Final p-value.

If Fixed Parameter = Total Alpha, the p-value row in the GST Outputs table will
be editable except for the final column value. This method allows the user to set the in-
terim p-values but calculate the final p-value to maintain the specified Test Significance
Level from the main design table.

If Fixed Parameter = Last p-value, the p-value row in the GST Outputs table
will be fully editable including the final column value. This method allows the user to
set the interim p-values and the final p-value. This means the actual Type I error rate
may diverge significantly from the Test Significance Level from the main design table.
The Exact Significance Level field in the Group Sequential Report will provide
the actual Type I error for the specified Haybittle-Peto boundaries.
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In both cases, all editable p-value row values in GST Outputs will be set to 0.005. For
further details on the p-value row in the GST Outputs table, see subsubsection 7.3.2.2.
Technical details on the Haybittle-Peto method are provided in subsubsection 7.2.4.2.

Wang-Tsiatis/Pampallona-Tsiatis If Wang-Tsiatis is selected in the Efficacy Bound
Calculation Method row in the main design table then a Efficacy Shape, A; row will
be added to the GST Parameters table.

If Pampallona-Tsiatis is selected in the Futility Bound Calculation Method row
in the main design table then a Futility Shape, A, row will be added to the GST
Parameters table.

Note that while Wang-Tsiatis can be selected with Pampallona-Tsiatis or Don’t
Calculate for the Futility Bound Calculation Method, Pampallona-Tsiatis can
only be selected with Wang-Tsiatis. Therefore, either the Efficacy Shape, A; will
either be shown alone or alongside the Futility Shape, A, row. If both are active,
the two parameters control the efficacy and futility bound respectively. By default, both
parameters are set to zero which is equivalent to the O’Brien-Fleming design boundaries.
[O’Brien and Fleming, 1979]

For technical detail on the Wang-Tsiatis and Pampallona-Tsiatis method see subsubsection 7.2.4.3
- this section also discusses common parameter choices and the allowable input range for
each.

An example GST Parameters side-table with both Wang-Tsiatis and Pampallona-
Tsiatis selected in the main table is provided in Figure 7.4.

GST Parameters

Efficacy Shape, 4, 0.250
Futility Shape, A, -0.250
Futility Bounds Non-Binding

Boundary Scale /-scale

Figure 7.4: Wang-Tsiatis/Pampallona-Tsiatis GST Parameters Table Example

Unified Family If Unified Family is selected in the Efficacy Bound Calculation
Method row in the main design table then the Efficacy Shape 1, 7 («) and Efficacy
Shape 2, p(a) row will be added to the GST Parameters table.

If Unified Family is selected in the Futility Bound Calculation Method row in the
main design table then the Futility Shape 1, 7 () and Efficacy Shape 2, p () row
will be added to the GST Parameters table.
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If Efficacy Bound Calculation Method = Unified Family, it can be selected with
Unified Family or Don’t Calculate for the Futility Bound Calculation Method. If
Futility Bound Calculation Method = Unified Family, it can only be selected with
Unified Family for the Efficacy Bound Calculation Method. Therefore, either the
Efficacy Shape parameters will either be shown alone or alongside the Futility Shape
parameter rows. If both are active, the two sets of parameters control the efficacy and
futility bound respectively. No default values are set for the Unified Family parameters.

For technical detail on the Unified Family method see subsubsection 7.2.4.4- this section
also discusses common parameter choices and the allowable input range for each.

An example GST Parameters side-table with both Unified Family options selected in
the main table is provided in Figure 7.5.

G5T Parameters

Efficacy Shape 1, t(x) 0.000
Efficacy Shape 2, p(a) 0.100
Futility Shape 1, T(B) 0.200
Futility Shape 2, p(B) 0.200
Futility Bounds Non-Binding

Boundary Scale Z-scale

Figure 7.5: Unified Family GST Parameters Table Example

Futility Bounds The Futility Bounds row controls whether the futility bounds should
be Non-binding or Binding. This row will be shown in the Futility Bound Calcula-
tion Method row in the main design table is set to Spending Function, Pampallona-
Tsiatis or Unified Family. Custom Boundary futility bounds are always assumed to
be Non-binding and Don’t Calculate indicates there is no futility bound so this row
is not shown for either of those options.

Non-binding calculates non-binding futility bounds where if the futility bound is crossed
at a given look the trial can continue to future looks without inflating the Type I («) error.
This is the far more popular choice in clinical trials and is default in nQuery.

Binding calculates binding futility bounds where if the futility bound is crossed at a
given look then continuing the trial to future looks will inflate the Type I («) error.
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For technical background on the difference between constructing non-binding or binding
futility bounds, see subsection 7.2.3. In short, for non-binding futility bounds the efficacy
bounds are calculated first as per an efficacy only design and then futility bounds are
found with correct Type II () exit probabilities while for binding futility bounds the
efficacy and futility bounds are constructed simultaneously for the correct Type I and
Type II exit probabilities respectively.

Boundary Scale Boundary Scale type rows control the statistical scale under which the
efficacy and/or futility bounds will be shown or inputted on in the GST Outputs table.

For Bound Calculation Methods = Spending Function, Wang-Tsiatis/Pampallona-
Tsiatis or Unified Family, the Boundary Scale row will control the statistical scale
on which the Efficacy Bound and/or Futility Bound rows will be shown in the GST
Outputs table.

The Boundary Scale row has the following options:
o Z-scale
o p-value Scale
» Score Scale
e O-scale

For Efficacy Bound Calculation Method = Custom Boundary, the Efficacy
Boundary Scale will control the input scale of the Efficacy Bound (if 1-sided) or
Upper Efficacy Bound (if 2-sided) row in the GST Outputs table.

The Efficacy Boundary Scale row has the following options:
o Z-scale
o p-value Scale
» Score Scale
o O-scale
o Alpha Error

For Futility Bound Calculation Method = Custom Boundary, the Futility Bound-
ary Scale will control the input scale of the Futility Bound (if 1-sided) or Upper
Futility Bound (if 2-sided) row in the GST Outputs table.

The Efficacy Boundary Scale row has the following options:
o Z-scale
o p-value Scale
» Score Scale
e O-scale
o Beta Error

« Conditional Power
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Details on each of these statistical boundary scales is provided in subsubsection 7.2.4.5
including conversions to the Z-scale for all other scales.

These rows above are not shown for Haybittle-Peto method if Futility Calculation
Bound Method = Don’t Calculate as Haybittle-Peto has its own unique fixed p-
value row in the GST Outputs table and Don’t Calculate means there is no futility
bound t control. All other Don’t Calculate scenarios will have one of the boundary
scale type rows as both boundary method rows cannot be set to Don’t Calculate.

Examples are provided below for the following scenarios: Boundary Scale row only
(top-left), Efficacy Boundary Scale only (top-right), Futility Boundary Scale and
Boundary Scale (bottom-left), Efficacy Boundary Scale and Futility Boundary
Scale (bottom-right).

GST Parameters

Alpha Spending Function O'Brien-Fleming
GST Parameters

Beta Spending Function O'Brien-Fleming

Efficacy Boundary Scale p-value scale
Futility Bounds MNon-Binding
Boundary Scale Z-scale GST Parameters
GST Parameters Efficacy Boundary Scale Alpha Error
Alpha Spending Function O'Brien-Fleming Futility Boundary Scale Conditional Power
Boundary Scale Score scale
Futility Boundary Scale 5-scale

Figure 7.6: Boundary Scale/Efficacy Boundary Scale/Futility Boundary GST Paramet-
ers Examples

7.3.2.2 GST Outputs

The GST Outputs table contains the key group sequential design boundary information
where the rows indicate different types of key group sequential input (e.g. Information
Time) or output (per-look sample sizes). It will contain the following types of row:

o Total Sample Size

o Information Time

« Efficacy Bounds/p-value

« Futility Bounds

 Stop for Efficacy/Stop for Futility

« Cumulative Alpha/Cumulative Beta

Depending on the Efficacy Bound Calculation Method, Futility Bound Calcula-
tion Method, 1 or 2 Sided values inputted into the main design table, the number
and type of row in the GST Outputs table may change substantially. GST Outputs
changes may also change the definition and behavior of some GST Outputs rows.
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In the GST Outputs table, each column represents an analysis and therefore the number
of columns will equal Number of Looks row value from the main design table. The
final column will represent the final analysis planned for the trial. The GST Outputs
table only provides the essential information required to understand the group sequential
design, for a detailed review of a group sequential design (including information such
as the average sample size and boundary exit probabilites) see the Group Sequential
Report (subsection 7.3.4).

For context, an example of the GST Outputs table for Efficacy Bound Calcula-
tion Method = Spending Function and Futility Bound Calculation Method
= Spending Function for the 1-sided case is shown before and after a solver calcula-
tion is shown in Figure 7.7.

GST Outputs 1 2 3 4 5
} | Total Sample Size
Information Time 0.200 0.400 0.600 0.800 1.000
Efficacy Bound
Futility Bound
Stop for Efficacy Yes Yes Yes Yes Yes
Stop for Futility Yes ‘fes Yes Yes Yes

Cumulative Alpha

Cumulative Beta

GST Qutputs 1 2 3 4 5
Total Sample Size 20.000 40.000 60.000 80.000 100.000
Information Time 0.200 0.400 0.600 0.800 1.000
Efficacy Bound -4.877 -3.357 -2.680 -2.290 -2.031
Futility Bound 3.030 0.785 -0.452 -1.318 -2.031
Stop for Efficacy Yes Yes es Yes Yes
Stop for Futility Yes Yes ‘es Yes Yes
Cumulative Alpha 0.000 0.000 0.004 0.012 0.025
Cumulative Beta 0.000 0.000 0.004 0.013 0.027

Figure 7.7: GST Outputs Examples

These the different type of GST Outputs row are summarized next.

Total Sample Size The Total Sample Size row represents the sample size at each
look in the specified group sequential design.

The maximum sample size will be the value in the final column and will equal the sum of
the sample size rows from the main design table. The sample size required at which each
interim analysis will occur is displayed in the other prior columns of the Total Sample
Size row. These will equal the maximum sample size times the Information Time in
each column.
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By default, interim sample sizes will be rounded to the nearest integer which will update
the information fractions based on these rounded interim sample sizes during solver calcu-
lations. The unrounded sample sizes can be used instead by using the Integer Interim
N option from the Options tab at the bottom of the Help window on the right - see
subsection 7.3.7 for detail.

In certain tables, the Total Sample Size row will be replaced with an equivalent row on
which the Maximum Information is based - subsection 7.2.5 for table specific technical
details. The current replacements are currently in nQuery:

e GSTO (Information-Based): Cumulative Information

o GST3 (Survival): Total Events

Information Time The Information Time is the proportion of the information accrued
at each look in the specified group sequential design.

The Information Time is formally equal to (tx = Ij./Ina) as per subsubsection 7.2.1.1.
In practice, this will equal the proportion of the total sample size (ny/N) or events for
survival analysis at which an interim analysis will occur. Assuming linear accrual and
fixed follow-up, this would also be approximately the proportion of the total study length
at which an interim analysis would occur.

The final information time is set to one and cannot be changed. This ensures Information
Time is normalized to a [0, 1] proportion support.

By default, the interim informations in all other columns are set to have equally spaced
interim analyses (k/K). These interim information fractions can be edited to have un-
equally spaced interim analyses with the values restricted to between 0 and 1 and strictly
increasing going right-wards within the Information Time row. An example where the
Information Times from Figure 7.7 has been updated to information fractions of 0.3, 0.5,
0.7, 0.9 (representing interim analyses after 30%, 50%, 70% and 90% of subjects have had
follow-up) is shown in Figure 7.8.

GST Qutputs 1 2 3 4 5
Total Sample Size 30.000 50.000 70.000 90.000 100.000
Information Time 0.300 0.500 0.700 0.900 1.000
¥ | Efficacy Bound -3.929 -2.966 -2.462 -2.149 -2.070
Futility Bound 1.622 0.046 -0.960 -1.717 -2.070
Stop for Efficacy ‘es Yes Yes es Yes
Stop for Futility es Yes Yes Yes Yes
Cumulative Alpha 0.000 0.002 0.007 0.018 0.025
Cumulative Beta 0.000 0.002 0.009 0.022 0.029

Figure 7.8: Information Times Change Example

By default, interim sample sizes will be rounded to the nearest integer which will update
the information fractions based on the rounded interim sample sizes during solver calcu-
lations. However, the Information Time values will not be changed within the GST
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Outputs table, these updated Information Times rows are only shown in the Group
Sequential Report - see subsection 7.3.4 for details. This is to prevent the information
times iterating away from their original input values if multiple solver calculations are
made in the same column.

The unrounded sample sizes can be used instead by using the Integer Interim N
option from the Options tab at the bottom of the Help window on the right - see
subsection 7.3.7 for detail. In this case, the Information Times in the GST Outputs
table will always be the same as the true information times used by the solver.

Efficacy Bound/p-value The Efficacy Bound is the boundary beyond which the trial
is planned to stop for efficacy. The efficacy bound row(s) will change substantially in
terms of display and behavior based on the choice for the 1 or 2 Sided Test? and
Efficacy Bound Calculation Method rows in the main design table and with changes
to the Boundary Scale or Efficacy Boundary Scale rows in the GST Parameters
table. These changes will be summarized in turn next.

1 or 2 Sided Test? If 1 or 2 Sided Test? = 1 then there will be one Efficacy
Bound row unless the Efficacy Bound Calculation Method = Haybittle-Peto then
there will be a single p-value row shown instead which is equivalent to the efficacy bound
row on the 1-sided test p-value scale

If 1 or 2 Sided Test? = 2 then there will be a Upper Efficacy Bound and a Lower
Efficacy Bound row unless the Efficacy Bound Calculation Method = Haybittle-
Peto then there will be a single p-value row shown instead which is equivalent to the
efficacy bound row on the 2-sided test p-value scale

A 2-sided example (using Spending Function) for the efficacy bounds is provided in
Figure 7.9.

GST Outputs 1 2 3 4 5
Total Sample Size 30.000 50.000 70.000 90.000 100.000
Information Time 0.300 0.500 0.700 0.900 1.000
Lower Efficacy Bound 4412 3.346 2.782 2429 2.333
Upper Efficacy Bound -4.412 -3.346 -2.782 -2.429 -2.333
Cumulative Alpha 0.000 0.001 0.006 0.017 0.025

Figure 7.9: 2-Sided Efficacy Bounds GST Outputs Table Example

Efficacy Bound Calculation Method For Efficacy Bound Calculation Method
= Spending Function, Wang-Tsiatis, Unified Family, Custom Boundary either
an Efficacy Bound row (1-sided) or a Lower Efficacy Bound and Upper Efficacy
Bound rows (2-sided) will be displayed.

For Spending Function, Wang-Tsiatis and Unified Family, all efficacy bound row
(Efficacy Bound, Lower Efficacy Bound, Upper Efficacy Bound as applicable)
values in the GST Outputs table will be a read-only and will only be populated with
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the efficacy boundaries after a solver calculation is run in that column. The definition of
the output rows will depend on the choice of Boundary Scale in the GST Parameters
table. Examples of this are shown above in Figure 7.7 and Figure 7.9.

For Custom Boundary, the Efficacy Bound (1-sided) or Upper Efficacy Bound (2-
sided) rows will editable - they will be empty by default and must be filled appropriately
before solver calculations can occur. For 2-sided, the Lower Efficacy Bound will be
read-only and will be set the symmetric lower bound - this will equal -Upper Efficacy
Bound for the Z-scale, Score Scale and §-Scale and set to equal to Upper Efficacy
Bound for p-value Scale and Alpha Error. The definition and the range of the input
rows will depend on the choice of Efficacy Boundary Scale in the GST Parameters
table. A 2-sided Efficacy Boundary Scale example for Custom Boundary is shown
for the d-Scale in Figure 7.10.

GST Parameters GST Qutputs 1 2 3 4 5
Efficacy Boundary Scale S-scale Total Sample Size 30.000 50.000 70.000 90.000 100.000
Information Time 0.300 0.500 0.700 0.900 1.000
Lower Efficacy Bound 3.000 2.000 1.500 1.250 0.500
* | Upper Efficacy Bound -3.000 -2.000 -1.500 -1.250 -0.500

Figure 7.10: Custom Boundary Efficacy Example

For Efficacy Bound Calculation Method = Haybittle-Peto there will be a single
p-value row shown instead of this efficacy bound rows.

If Fixed Parameter = Total Alpha in the GST Parameters table, the p-value
row in the GST Outputs table will be editable except for the final column value. This
method allows the user to set the interim p-values but calculate the final p-value to
maintain the specified Test Significance Level from the main design table.

If Fixed Parameter = Last p-value in the GST Parameters table, the p-value row
in the GST Outputs table will be fully editable including the final column value. This
method allows the user to set the interim p-values and the final p-value. This means the
actual Type I error rate may diverge significantly from the Test Significance Level from
the main design table. The Exact Significance Level field in the Group Sequential
Report will provide the actual Type I error for the specified Haybittle-Peto boundaries.

An example of the GST Outputs table for the Haybittle-Peto method is shown in
Figure 7.11.

GST Parameters GST Outputs 1 2 3 4 5
Fixed Parameter Total Alpha Total Sample Size 30.000 50.000 70.000 90.000 100.000
Information Time 0.300 0.500 0.700 0.900 1.000
p-value 0.005 0.005 0.005 0.005 0.017
GST Parameters GST Outputs 1 2 3 4 5
Fixed Parameter Last P-Value Total Sample Size 30.000 50.000 70.000 90.000 100.000
Information Time 0.300 0.500 0.700 0.900 1.000
p-value 0.005 0.005 0.005 0.005 0.005

Figure 7.11: Haybittle-Peto Example

In both cases, all editable p-value row values in GST Outputs will be set to 0.005 by
default. It is recommended that p-values be set to low values (<0.005) to ensure the final
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p-value boundary is comparable to an equivalent fixed term trial. p-values can be set
between 0 and 1 but for Total Alpha the following error will be displayed if the interim
alpha makes it impossible to find a final p-value boundary which maintains the specified
Test Significance Level: Fuiled to calculate the efficacy bound. Please recheck input
parameters. Reduce one or more of the interim p-values to prevent this error.

Technical details on the Haybittle-Peto method are provided in subsubsection 7.2.4.2.

Boundary Scale The Boundary Scale row in the GST Parameters table will
change the statistical scale on which the Efficacy Bound (1-sided) or Upper Efficacy
Bound and Lower Efficacy Bound (2-sided) rows are displayed if these bounds are
read-only output rows (i.e. Spending Function, Wang-Tsiatis, Unified Family as
discussed above). These bounds can be shown on the Z-scale, p-value Scale, Score
Scale and /-Scale. Note that the Boundary Scale will also affect any read-only output
Futility Bounds if present.

Note that the direction of the hypothesis will depend on the value for the row(s) which
correspond to the treatment effect  in the main design table. If the treatment effect is
positive then higher values for the treatment effect (and statistics such as the Z-statistic
and Score statistic) are considered more “effective” and lower values more “futile”. If the
treatment effect is negative in the main design table then lower values will be considered
“better”. This will change the sign and the relation to the Futility Bounds and between
the Upper and Lower Efficacy Bound as applicable.

Note that for 2-sided efficacy boundaries, the p-value Scale will split the p-value at each
look into «v/2 for Upper Efficacy Bound and 1 — a/2 for the Lower Efficacy Bound as per
the GST Outputs table. This is done for consistency with the other boundary scales
but in practical terms if using a standard statistical test the efficacy boundary would be
crossed if it provided a p-value of < « i.e. twice the Upper Efficacy p-value Bound at
each look.

For GST1, positive treatment effect would correspond to a positive mean difference so
the higher the mean difference (and Z-statistic etc) the “better”. For GST2, a “posit-
ive” treatment effect would correspond to a positive proportion difference. For GST3, a
“positive” treatment effect would correspond to a hazard ratio > 1.

To illustrate this compare the GST Outputs table in Figure 7.7 where the mean differ-
ence was negative (therefore Efficacy Bounds < Futility Bounds) to the same design
except with the mean difference being of the opposite side in the first table in Figure 7.12.

183



7.3 Group Sequential Design Table User Interface

GST Outputs 1 2 3 4 5
Total Sample Size 20.000 40.000 60.000 80.000 100.000
Information Time 0.200 0.400 0.600 0.800 1.000
Efficacy Bound 4877 3.357 2680 2.290 2.031
Futility Bound -3.030 -0.785 0452 1.318 2.031
Stop for Efficacy Yes Yfes Yes Yes Yes
Stop for Futility Yes Yfes Yes Yes Yes
Cumulative Alpha 0.000 0.000 0.004 0.012 0.025
Cumulative Beta 0.000 0.000 0.004 0.013 0.027

Figure 7.12: GST Outputs Bounds with Positive Effect Size

The effect of changing Boundary Scale in the GST Parameters table, on both the
Efficacy Bound and Futility Bound rows, for the above example to the p-value Scale,
Score Scale and /-Scale (in that order) is shown in Figure 7.13.

Efficacy Bound 0.000 0.000 0.004 0.011 0.021
Futility Bound 0.999 0.784 0325 0.094 0.021
Efficacy Bound 8.724 8.493 8.305 8.192 8.124
Futility Bound -5.420 -1.986 1.402 4714 8124
Efficacy Bound 2.726 1.327 0.865 0.640 0.508
Futility Bound -1.694 -0.310 0.146 0.368 0.508

Figure 7.13: Boundary Scale Change GST Outputs Example

Efficacy Boundary Scale The Efficacy Boundary Scale row changes the statistical
scale definition of the values inputted into the Efficacy Bound (1-sided) or Upper
Efficacy Bound (2-sided) when Efficacy Bound Calculation Method = Custom
Boundary. The available statistical scales are Z-scale, p-value Scale, Score Scale,
0-Scale and Alpha Error.

At a general level, Z-scale, Score Scale, /-Scale can take on any real values. The
p-value Scale and Alpha Error options must be between 0 and 1.

Note that the direction of the hypothesis will depend on the value for the row(s) which
correspond to the treatment effect § in the main design table and this can have an effect
on the input requirements. If the treatment effect is positive then higher values for the
treatment effect (and statistics such as the Z-statistic and Score statistic) are considered
more “effective” and lower values more “futile”. If the treatment effect is negative in the
main design table then lower values will be considered “better”.

If both Efficacy Boundary Method Calculation and Futility Boundary Calcu-
lation Method = Custom Boundary then for a positive treatment effect, the Z-
scale/Score Scale/d-scale Efficacy Bounds must be higher than the Futility Bounds.
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For a negative treatment effect, the Z-scale/Score Scale/d-scale Efficacy Bounds must
be lower than the Futility Bounds. For p-value Scale, the Efficacy Bounds must
always be less than the Futility Bounds.

Note that for 2-sided efficacy boundaries, the p-value Scale will split the p-value at each
look into «/2 for Upper Efficacy Bound and 1 — a/2 for the Lower Efficacy Bound as per
the GST Outputs table. This is done for consistency with the other boundary scales
but in practical terms if using a standard statistical test the efficacy boundary would be
crossed if it provided a p-value of < « i.e. twice the Upper Efficacy p-value Bound at
each look.

While these boundaries are not enforced for other Futility Boundary Calculation
Method options (as the futility bound is unknown prior to solver calculation), efficacy
bounds should ideally be selected to be consistent with the expected futility bounds for
that method.

For GST1, positive treatment effect would correspond to a positive mean difference so
the higher the mean difference (and Z-statistic etc) the “better”. For GST2, a “positive”
treatment effect would correspond to a positive proportion difference. For GST3, a
“positive” treatment effect would correspond to a hazard ratio > 1 i.e. log hazard ratio
> 0.

A Custom Boundary example was provided in Figure 7.10.

Futility Bound The Futility Bound is the boundary beyond which the trial is planned
to stop for futility. The futility bound row(s) will change substantially in terms of display
and behavior based on the choice for the 1 or 2 Sided Test? and Futility Bound
Calculation Method rows in the main design table and with changes to the Boundary
Scale or Futility Boundary Scale rows in the GST Parameters table.

1 or 2 Sided Test? If 1 or 2 Sided Test? = 1 then there will be one Futility
Bound row and if 1 or 2 Sided Test? = 2 then there will be a Upper Futility Bound
and a Lower Futility Bound row

Futility Bound Calculation Method For Futility Bound Calculation Method
= Spending Function, Pampallona-Tsiatis, Unified Family, Custom Bound-
ary either an Futility Bound row (1-sided) or a Lower Futility Bound and Upper
Futility Bound rows (2-sided) will be displayed.

For Spending Function, Wang-Tsiatis and Unified Family, all futility bound row
(Futility Bound, Lower Futility Bound, Upper Futility Bound as applicable)
values in the GST Outputs table will be a read-only and will only be populated with
the futility boundaries after a solver calculation is run in that column. The definition of
the output rows will depend on the choice of Boundary Scale in the GST Parameters
table.

For Custom Boundary, the Futility Bound (1-sided) or Upper Futility Bound (2-
sided) rows will editable - they will be empty by default and must be filled appropriately
before solver calculations can occur. For 2-sided, the Lower Futility Bound will be
read-only and will be set the symmetric lower bound - this will equal -Upper Futility
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Bound for the Z-scale, Score Scale and §-Scale and set to equal to Upper Futility
Bound for p-value Scale, Alpha Error and Conditional Power. The definition and
the range of the input rows will depend on the choice of Futility Boundary Scale in
the GST Parameters table.

Boundary Scale The Boundary Scale row in the GST Parameters table will
change the statistical scale on which the read-only output Futility Bound rows are dis-
played - this is relevant for the Spending Function, Pampallona-Tsiatis and Unified
Family methods. These bounds can be shown on the Z-scale, p-value Scale, Score
Scale and d-Scale. This option also affects the applicable Efficacy Bounds. As refer-
enced above, the direction will depend on the treatment effect direction. Examples of the
Boundary Scale translations and effect of direction were shown for Efficacy Bounds
and Futility Bounds was shown in Figure 7.13 and Figure 7.12 above.

Futility Boundary Scale The Futility Boundary Scale row changes the statistical
scale definition of the values inputted into the Futility Bound (1-sided) or Upper
Futility Bound (2-sided) when Futility Bound Calculation Method = Custom
Boundary. The available statistical scales are Z-scale, p-value Scale, Score Scale,
0-Scale, Beta Error and Conditional Power.

At a general level, Z-scale, Score Scale, J-Scale can take on any real values. The
p-value Scale, Beta Error and Conditional Power options must be between 0 and
1.

Note that the direction of the hypothesis will depend on the value for the row(s) which
correspond to the treatment effect 6 in the main design table and this can have an effect
on the input requirements. If the treatment effect is positive then higher values for the
treatment effect (and statistics such as the Z-statistic and Score statistic) are considered
more “effective” and lower values more “futile”. If the treatment effect is negative in
the main design table then lower values will be considered “better”. For GST1, positive
treatment effect would correspond to a positive mean difference so the higher the mean
difference (and Z-statistic etc) the “better”. For GST2, a “positive” treatment effect would
correspond to a positive proportion difference. For GST3, a “positive” treatment effect
would correspond to a hazard ratio > 1 i.e. log hazard ratio > 0.

If both Efficacy Boundary Method Calculation and Futility Boundary Calcu-
lation Method = Custom Boundary then for a positive treatment effect, the Z-
scale/Score Scale/d-scale Efficacy Bounds must be higher than the Futility Bounds.
For a negative treatment effect, the Z-scale/Score Scale/d-scale Efficacy Bounds must
be lower than the Futility Bounds. For p-value Scale, the Efficacy Bounds must
always be less than the Futility Bounds.

While these boundaries are not enforced for other Fuility Boundary Calculation
Method options (as the efficacy bound is unknown prior to solver calculation), effic-
acy bounds should ideally be selected to be consistent with the expected efficacy bounds
for that method.

Futility Method = Custom Boundary examples for the Z-scale (1-sided) and p-
value Scale (2-sided) is provided in Figure 7.14.
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GST Parameters GST Outputs 1 2 3 4 5
Alpha Spending Function Q'Brien-Fleming Total Sample Size 20.000 40.000 60.000 80.000 100.000
Boundary Scale Z-scale Information Time 0.200 0.400 0.600 0.800 1.000
Futility Boundary Scale Z-scale Efficacy Bound 4877 3.357 2.680 2.290 2.031
Futility Bound -2.000 0.000 0.000 1.000 2.031
} | Cumulative Alpha 0.000 0.000 0.004 0012 0.025
GST Parameters GST Outputs 1 2 3 4 5
Alpha Spending Function Pocock Total Sample Size 20.000 40.000 60.000 80.000 100.000
Boundary Scale p-value scale Information Time 0.200 0.400 0.600 0.800 1.000
Futility Boundary Scale p-value scale Lower Efficacy Bound 0.004 0.004 0.004 0.004 0.004
Upper Efficacy Bound 0.004 0.004 0.004 0.004 0.004
Lower Futility Bound 0.300 0.200 0.100 0.050 0.004
} | Upper Futility Bound 0.300 0.200 0.100 0.050 0.004
Cumulative Alpha 0.007 0.013 0.018 0.022 0.025

Figure 7.14: Custom Futility Boundary Examples

Stop for Efficacy/Stop for Futility The Stop for Efficacy and Stop for Futility
rows in the GST Outputs table are used to skip either an efficacy or futility analysis at
a specific look. This allows the user to have either an efficacy only or futility look while
assessing both at other looks. To skip a look, select No instead of Yes at the desired
look from the relevant Stop for Efficacy or Stop for Futility row.

The Stop for Efficacy and Stop for Futility rows will only be shown in the GST Out-
puts table if Efficacy Bound Calculation Method = Spending Function, Wang-
Tsiatis, Unified Family and Futility Bound Calculation Method = Spending
Function, Pampallona-Tsiatis, Unified Family. For these boundary calculation
methods, “skipping” a look is equivalent to calculating the boundaries as if that look
had not existed during the boundary calculation process. For example, if the information
times were (0.2,0.4,0.6,0.8,1) then skipping the third look would be equivalent to input-
ting information times of (0.2,0.4,0.8,1) into the boundary calculation method instead.
See subsection 7.2.4 for technical details on boundary calculations.

For Stop for Efficacy, the user can select rhe first K — 2 look columns. For example, if
Number of Looks = 5 then the user can skip the first three efficacy look columns. In
nQuery, efficacy look skipping is restricted such that when an efficacy look is skipped all
prior efficacy looks must also be skipped. For example, if No is selection in the Stop for
Efficacy row in the second column then the Stop for Efficacy value in the first column
will also be forced to equal No.

For Stop for Futility, the user can select rhe first K — 1 look columns. For example,
if Number of Looks = 5 then the user can skip the first four look columns. Unlike
Stop for Efficacy, there are no restrictions on the pattern for futility boundary skips
outside of that Stop for Efficacy and Stop for Futility cannot both equal No in a
given column.

When a look is skipped, the appropriate value in the Efficacy Bound or Futility Bound
will be displayed as NaN in the GST Outputs table after solver calculation.

An example where the first two efficacy looks are skipped and the third futility look is
skipped is provided in Figure 7.15.

187



7.3 Group Sequential Design Table User Interface

GST Qutputs 1 2 3 4 5
Total Sample Size 20.000 40.000 60.000 80.000 100.000
Informatien Time 0.200 0.400 0.600 0.800 1.000
Efficacy Bound NaN NaN 2.669 2.289 2.031
Futility Bound -3.043 -0.794 NaN 1.347 2.031
Stop for Efficacy No No es Yes Yes
Stop for Futility ‘fes ‘es MNo ‘fes Yes
¥ | Cumulative Alpha 0.000 0.000 0.004 0.012 0.025
Cumulative Beta 0.000 0.000 0.000 0.013 0.026

Figure 7.15: Skipping Looks GST Outputs Example

Cumulative Alpha/Cumulative Beta The Cumulative Alpha and Cumulative Beta
rows in the GST Outputs table contain the cumulative Type I (a)) and Type II (8) error
spent at each look when using the Spending Function bound calculation method.

The Cumulative Alpha row will only be shown if Efficacy Bound Calculation
Method = Spending Function. The Cumulative Beta row will only be shown
if Futility Bound Calculation Method = Spending Function.

For all Spending Functions other than User Defined, these rows will be read-only
outputs which will contain the outputs of the selected spending function from the GST
Parameters table and the parameters, if any, provided in the Additional Parameters
table - see subsubsection 7.3.2.1 and subsubsection 7.3.2.3 for spending function inputs
and subsubsection 7.2.4.1 for technical background on spending functions. The Cumual-
ative Alpha and Cumulative Beta rows were shown in several of the example figures
provided in the prior sections.

If a Alpha and/or Beta Spending Function is set to User Defined in the GST
Parameters table then the Cumulative Alpha and/or Cumulative Beta row will
be editable except for the final column values. The desired cumulative Type I (a) and
Type II (B) exit probabilities at each look are inputted for each look column except when
calculating the power where the Cumulative Beta rows becomes the proportion of the
total (unknown) Beta Error that will be spent rather than Beta Error spent directly.
The actual Beta Error spent will replace these proportions after the power solver has
ran.

These values should be strictly increasing from left to right and should not exceed the
overall Type I error rate (i.e. Test Significance Level) or Type II error rate (i.e. 1-Power)
respectively. For additional detail see section 7.2.4.1.

The user may be interested in viewing the error spending function visually after solver
calculation. See subsection 7.3.6 for details on the Error Spending Plot tab for that
purpose.

An example where both the Alpha Spending Function and Beta Spending Function
were set to User Defined and user inputs were provided for their respective custom
spending functions is provided in Figure 7.16.
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GST Parameters GST Outputs 1 2 3 4 5
Alpha Spending Function User Defined Total Sample Size 20.000 40.000 60.000 80.000 100.000
Beta Spending Function User Defined Information Time 0.200 0.400 0.600 0.800 1.000
Futility Bounds Non-Binding Efficacy Bound 3.090 2622 2.454 2.164 2221
Boundary Scale Z-scale Futility Bound -2.221 -0.919 -0.265 0.108 2.221
Stop for Efficacy Yes Yes Yes Yes Yes
Stop for Futility Yes Yes Yes Yes Yes
Cumulative Alpha 0.001 0.005 0.010 0.020 0.025
» | Cumulative Beta 0.000 0.000 0.001 0.001 0.030

Figure 7.16: User Defined Spending Function GST Outputs Example

7.3.2.3 Additional Parameters

The Additional Parameters table is an optional table which appears below the GST
Parameters table when it is required for the selected group sequential method. There are
two scenarios where the Additional Parameters table is required: spending functions,
custom futility conditional power bounds

The Additional Parameters side-table is required for the following Spending Func-
tions:

« Hwang-Shih-DeCani ()

« Power Family (p)

o 2-Parameter Family (Dist., a, b)
« Exponential (v)

« Beta (a,b)

« t-Distribution (a, b, df)

where the value in brackets indicate the parameter symbol. For technical detail on these
spending functions and their additional parameters see subsubsection 7.2.4.1.

Note the Additional Parameters table will contain separate rows for the efficacy and
futility bound spending functions if both require additional parameter input(s). Efficacy
parameters are indicated by («) and futility parameters by (/3) after the symbol e.g. v («)
for the Hwang-Shih-DeCani gamma parameter for the efficacy spending function and ~ (/3)
for the Hwang-Shih-DeCani gamma parameter for the futility spending function.

Example Additional Parameters tables are shown for a variety of scenarios in
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GST Parameters GST Parameters GST Parameters
Alpha Spending Function O'Brien-Fleming Alpha Spending Function Power Family Beta Spending Function 2-Parameter Family
Beta Spending Function = Hwang-Shih-DeCani Boundary Scale Z-scale Futility Bounds Non-Binding
Futility Bounds Non-Binding Boundary Scale Z-scale
Additional Parameters
Boundary Scale Z-scale -
Efficacy Power Parameter, p(o) 1.500 Additional Parameters
Additional Parameters Futility Distribution Family Logistic
Futility HSDC Parameter, y(B) -1.000 GST Parameters Futility Parameter 1, a(B) 2.000
Alpha Spending Function Exponential Futility Parameter 2, b(B) 2.000
GST Parameters . )
Beta Spending Function Beta
i i = _ GST Parameters
Alpha Spending Function Hwang-Shih-DeCani Futility Bounds Non-Binding
i i A - - Beta Spending Function t-Distribution
Beta Spending Function  Hwang-Shih-DeCani Boundary Scale Z-scale P g =
Futility Bounds Non-Binding Futility Bounds Binding
Boundary Scale Z-scale Additional Parameters Boundary Scale Z-scale
Efficacy Exp. Parameter, (o) 0.800
Additional P t Additional Parameters
ftlonal Farameters Futility Shape 1, a(g) 2,000
i = Futility Parameter 1, a 1.500
Efficacy HSDC Parameter, y(a) 4,000 Futility Shape 2, b(B) 2,000 ity B)
Futility HSDC Parameter, y(B) 1.000 Futility Parameter 2, b(B) 2.000
Futility df(p) 10

Figure 7.17: Additional Parameters Table Examples for Spending Functions

For Futility Bound Calculation Method = Custom Boundary, if Futility Bound-
ary Scale is set to Conditional Power then the Additional Parameters table will
contain the Conditional Power Assumption row. Conditional Power Assumption
can be set to Estimated 6 or Design 6.

Estimated 6 assumes the “true” treatment effect (6), such as the mean difference, will
equal the treatment effect at the futility boundary itself for the purposes of calculating
conditional power.

Design 6 assumes the “true” treatment effect (#), such as the mean difference, will equal
the treatment effect specified for the original solver calculation (i.e. in the main design
table) for the purposes of calculating conditional power.

Technical detail on Conditional Power boundaries can be found in subsubsection 7.2.4.5.

An custom boundary conditional power example including the additional parameters table
is provided in Figure 7.18.

GST Parameters GST Qutputs 1 2 3 4 5
Alpha Spending Function Hwang-Shih-DeCani Total Sample Size 20.000 40.000 60.000 80.000 100.000
Boundary Scale Z-scale Information Time 0.200 0.400 0.600 0.800 1.000
Futility Boundary Scale Conditional Power Efficacy Bound 3.253 2.986 2.692 2374 2.025
Futility Bound 0.100 0.200 0.300 0.500

Additional Parameters

} | Cumulative Alpha 0.001 0.002 0.005 0.011 0.025
Efficacy HSDC Parameter, y(ox) -4.000
Conditional Power Assumption Estimated 8

Figure 7.18: Custom Conditional Power Boundary Example

7.3.2.4 Summary

The above sections have covered the Group Sequential Side-table (GSTXS-Y) where
the group sequential design inputs are provided, alongside some of the primary group
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sequential design outputs, in the GST Parameters, GST Outputs and (if required)
Additional Parameters tables.

For the majority of group sequential tables, before solver calculation the Group Sequen-
tial Side-table will only contain the input tab as per Figure 7.2. Solver calculation is
dependent on the GSTXS-Y side-table being filled appropriately.

At present, the one exception to the above is GST3 (Two Survival Group Sequential
Design) which will also have the Piecewise Survival Information table tab that must
be filled prior to solver calculations. See subsection 7.3.3 for details.

After solver calculation, additional tabs are available at the top of the side-table panel
which provide additional information about the calculated group sequential design. These
are the Group Sequential Report (subsection 7.3.4), Boundary Plot (subsection 7.3.5)
and Error Spending Plot (subsection 7.3.6) and these will be covered in the following
sections. These tabs are present post-calculation in Figure 7.19.

Group Sequential Report | Boundary Plot | Error Spending Plot -_ - X
A0 GST Simulation

GST Parameters GST Qutputs 1 2 3 4 5

Alpha Spending Function QO'Brien-Fleming Total Sample Size 20.000 40.000 60.000 80.000 100.000

Beta Spending Function O'Brien-Fleming Information Time 0.200 0.400 0.600 0.800 1.000

Futility Bounds Non-Binding Efficacy Bound 4877 3.357 2.680 2.290 2.031

Boundary Scale Z-scale Futility Bound -3.030 -0.785 0452 1318 2031
Stop for Efficacy Yes Yes Yes Yes Yes
Stop for Futility Yes Yes Yes Yes Yes
Cumulative Alpha 0.000 0.000 0.004 0.012 0.025
Cumulative Beta 0.000 0.000 0.004 0.013 0.027

Figure 7.19: Group Sequential Side-Table including Group Sequential Report, Boundary
Plot, Error Spending Plot

7.3.3 Piecewise Survival Information (GST3 only)

In nQuery, certain group sequential survival analysis tables will allow for piecewise in-
formation to be provided for the accrual process, hazard rates and dropout rates. These
tables will require the user specify this piecewise survival information in the Piecewise
Survival Information tab before solver calculation. This piecewise survival information
table is similar to the mandatory side-table required for tables such as STT3 and STT24.

The Piecewise Survival Information tab will only be available after the user specified
the Number of Periods and the Hazard Ratio in the main design table. The Piece-
wise Survival Information tab for GST3 (pre-calculation) is shown in Figure 7.20 for
Number of Period = 4.
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[EELRN Piecewise Survival Information v X

& Clear

0 1 2 3 4

¥ | End of Period, Time t 0.000

Accrual (% of Total) 100.000

Group 1 Exponential Hazard Rate, A, 0.000

Group 2 Exponential Hazard Rate, A, 0.000

Group 1 Expected % Surviving Time t 100.000

Group 2 Expected % Surviving Time t 100.000

Group 1 Exponential Dropout Rate, d, 0.000

Group 2 Exponential Dropout Rate, d, 0.000

GST35-1

Figure 7.20: Piecewise Survival Information Example

Note that we have selected the Piecewise Survival Information at the top of the
group sequential side-table window to open this tab. The previously discussed Group
Sequential Side-table could be shown instead by selecting the GST3S-1 tab shown
here.

For GST3, the Piecewise Survival Information has the following rows: End of
Period, Time t, Accrual (% of Total), Group 1 Exponential Hazard Rate, )\,
Group 2 Exponential Hazard Rate, )y, Group 1 Expected % Surviving Time t,
Group 2 Expected % Surviving Time t, Group 1 Exponential Dropout Rate,
di, Group 2 Exponential Dropout Rate, ds.

A brief overview of each is provided below:

End of Period, Time t: The time up to which the current column period will apply.
The specified rates in a column will apply between the Time t specified in the previous
column and the Time t specified in the current column. All values must be greater than
zero and strictly increasing going from left to right. The Time t specified in the final
column will correspond the planned study length, also known as the maximum follow-up.

Accrual (% of Total): The percentage of the total sample size accrual which will occur
in the current time period. The Accrual % values must be between 0 to 100 (inclusive)
and the writable columns values must sum to 100. The read-only Column 0 will be equal
to 100 - 3 Accrual(%) and therefore will equal 0 when this row is filled appropriately. For
cases where the accrual period is shorter than the study length, enter the desired accrual
pattern up the Time t corresponding the accrual period length and then set accrual %
to 0 in all remaining post-accrual period rows.

Group 1 Exponential Hazard Rate, \; is the piecewise exponential survival hazard
rate in group 1 in the current time period. Theses values must all be zero or greater.
When ) is specified, the Group 2 Exponential Hazard Rate, \; will be automatically
calculated based on the Hazard Ratio specified in the main design table. If the Time
t is specified for all columns up to and including the current column then the Group 1
Expected % Surviving Time t and Group 1 Expected % Surviving Time t will
both be automatically calculated when \; is specified. A\; can be automatically calculated
for in a similar manner if the Time t row is fully specified up to the current column
and the Group 1 Expected % Surviving Time t is inputted in the current column.
The user may also be interested in the Survival Parameter Converter tool available
from the Assistants file menu which can calculate the exponential hazard based on the
median survival or proportion surviving (see section 3.5).
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Group 2 Exponential Hazard Rate, )\, is the piecewise exponential survival hazard
rate in group 2 in the current time period. This row is read-only and must be calculated
on the basis of the Group 1 Exponential Hazard Rate, )\; in the current column and
the Hazard Ratio specified in the main design table.

Group 1 Expected % Surviving Time t is the percentage of subjects expected to have
not had the event of interest (e.g. death) in group 1 at Time t given the full piecewise
survival pattern up to the end of the current time period Time t. These values must all
be between 0 to 100 and strictly decreasing from left to right. If the Time t is specified for
all columns up to and including the current column then when the Group 1 Expected
% Surviving Time t is inputted then the Group 2 Expected % Surviving Time t,
Group 1 Exponential Hazard Rate, \; and Group 2 Exponential Hazard Rate,
Ao will all be automatically calculated based on the Hazard Ratio specified in the main
design table. Similarly, the Group 1 Expected % Surviving Time t can be calculated
based on the Group 1 Exponential Hazard Rate, \; in the current column and the
Time t values specified up to and including the current column.

Group 2 Expected % Surviving Time t is the percentage of subjects expected to
have not had the event of interest (e.g. death) in group 2 at Time t given the full
piecewise survival pattern up to the end of the current time period Time t. This row
is read-only and must be calculated on the basis of the Time t up to and including the
current column, the Group 1 Expected % Surviving Time t in the current column
and the Hazard Ratio specified in the main design table.

Group 1 Exponential Dropout Rate, d; is the piecewise exponential dropout hazard
rate in group 1 in the current time period. Theses values must all be zero or greater.
Note that these are the exponential dropout rates not the dropout rates per unit time.
The user may wish to use the Survival Parameter Converter tool available from the
Assistants file menu to calculate the exponential dropout rate based on the median
survival or proportion surviving (see section 3.5) after a fixed period.

Group 2 Exponential Dropout Rate, d; is the piecewise exponential dropout hazard
rate in group 2 in the current time period. Theses values must all be zero or greater.
Note that these are the exponential dropout rates not the dropout rates per unit time.
The user may wish to use the Survival Parameter Converter tool available from the
Assistants file menu to calculate the exponential dropout rate based on the median
survival or proportion surviving (see section 3.5) after a fixed period.

After the table is complete, the user can select Plot Survival vs Time to generate a
plot showing the specified survival pattern for each group based on the % survival rows.
The Clear button can be used to quickly remove all inputs in the Piecewise Survival
Information table. The right-click context menu includes options for Cut (cut selected
cells), Copy (copy selected cells), Paste (paste into current cell(s)), Select All (select
all cells in table), Fill Right (fill all columns to right with same value/value pattern),
Clear (clear selected cell(s)) and Copy Table (copy entire table).

Note that other versions of the piecewise survival table may remove some of these rows
(e.g. % Surviving) and replace rows with similar variants (e.g. Accrual Rates per unit
time rathet than Accrual %). These will be summarized as needed here.

As stated above, solver calculation requires the Piecewise Survival Information table
to be filled appropriately. An example of piecewise survival trial are generated where
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the accrual period was 10 months, the total study length was 20, one third of the ac-
crual occured in the first five months and the rest in the remaining 5 months, the group
exponential rate increased from 0.1 to 0.4 over time and dropout rate was set to an expo-
nential rate of ~0.004 which is equivalent to 5% per year using the Survival Parameter
Converter tool with Proportion Surviving = 0.95; Time = 12 months. This is shown in
Figure 7.21.

[EYERRN Piecewise Survival Information v X

& Clear |24 Plot Survival vs Time

0 1 2 3 4
¥ | End of Period, Time t 0.000 5.000 10.000 15.000 20.000
Accrual (% of Total) 0.000 33333 66.667 0.000 0.000
Group 1 Exponential Hazard Rate, A, 0.000 0.100 0.200 0.300 0.400
Group 2 Exponential Hazard Rate, A, 0.000 0.200 0.400 0.600 0.800
Group 1 Expected % Surviving Time t 100.000 60.653 22313 4979 0.674
Group 2 Expected % Surviving Time t 100.000 36.788 4979 0.248 0.005
Group 1 Exponential Dropout Rate, d, 0.000 0.004 0.004 0.004 0.004
Group 2 Exponential Dropout Rate, d, 0.000 0.004 0.004 0.004 0.004

Figure 7.21: Piecewise Survival Information Example

7.3.4 Group Sequential Report

After a group sequential solver calculation occurs, the Group Sequential Report is
generated which provides a full review of the inputs into the group sequential design and
a detailed summary of the operating characteristics of the group sequential design.

As mentioned above, the Group Sequential Report tab will be shown at the top of the
side-table window after a solver calculation has occured in the associated column. Select
the Group Sequential Report tab to open the report within the side-table panel as
per Figure 7.22.

GST1S-3 REIGIVRELIENENEL W @ Boundary Plot ‘ Error Spending Plot | v X

£=F Expand Report Show/Hide Toolbar

= 8 ae O @aQ-aB- @
- - - ~ %
= | oe Y [ & - Z .
Test Parameters Output
e o i e i )
0024 1 20000 3200 0200 4877 3030 0000 0000
— 2 40000 5400 0400 3357 0785 0000 0000
3 60.000 9500 0:600 2680 0452 0.0 0004
4 80000 12580 0800 2290 1318 0012 0013
: 5 100.000 16.000 1000 2031 2031 0025 00z

Figure 7.22: Group Sequential Report (Within Side-Table)
7.3.4.1 Group Sequential Report Buttons and Toolbar

At the top of the group sequential report, there is the Expand Report button, the
Show/Hide Toolbar button and (just below those buttons) the Toolbar.
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The Expand Report button will open a separate window which will contain the full
report. Given the large amount of information within the Group Sequential Report,
this window may be more convenient for exploring the report results.

The Show/Hide Toolbar button will collapse or uncollapse the Toolbar which is just
below this button. By default, the toolbar is shown but the user may wish to hide the
toolbar to provide additional viewing area for the report itself.

The Toolbar contains buttons which provide options for document search, printing,
page setup, zoom, page view and export options. The toolbar options available for for
the Group Sequential Report are shown in Figure 7.23.

1

= 8 = e L @aqQ-a@g-f@- B-=2-A

2 3 4 5 6 7 & 9 10 11 1213 14 15 16 17 18 19 20 21 22 23

Figure 7.23: Report Toolbar

These options are defined as follows (with the most important bolded):

1.

10.
11.
12.
13.
14.

15.
16.
17.

Open: Open another nQuery Predict Report (.prnx) - not recommended as over-
writes current report

Save: Save current nQuery Predict Report (.prnx) - not recommended, see Export
(21) for better save options

. Help: Unused here

URL: Unused here

Search: Search for text in current report. This will appear in Navigation Panel on
right. Select “x” in top-right or Navigation Panel (14) button to hide.

. Print: Open Print menu for current report

Quick Print: Print report using system defaults

. Page Setup: Open Page Setup window to edit page size, orientation and margin

sizes. Note that the report does not scale automatically to the new page setup.

Scale: Open Scale window to rescale size of report text by percentage or page size.
Note the page size is not automatically updated to reflect changes to scale.

First Page: Return to first page (if report has multiple pages)
Page Up: Go up one page (if report has multiple pages)
Page Down: Go down one page (if report has multiple pages)
Last Page: Go to last page if report has multiple pages

Navigation Pane: Open and close Navigation Pane. Contains Pages list and Search
Results window

Zoom Out: Zoom out report by one increment
Zoom: Change the current zoom level from list of options

Zoom In: Zoom in report by one increment
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18. Page Layout: Set out how multiple pages are displayed (Single Page, Two Pages,
Wrap Around)

19. Continuous Scolling: Enable or disable continuous scrolling in report
20. Show Cover Page: Show cover (first) page

21. Export: Export report as other file type. Select arrow to see list in-report or select
icon to open Export window. The Export option can be used to save the report in

the following file formats: PDF, HTML, MHT, RDF, DOCX, XLS, XLSX, CSV,
Plain Text File (TXT), Image File (PNG, JPEG, BMP, GIF, EMF, WMF, TIFF).

22. Send: Send report as email in export file type using system default email client.

23. Watermark: Add watermark to report using Watermark menu

7.3.4.2 General Group Sequential Report Sections

The group sequential reports generated by the group sequential (GSTX) series of tables
will have a significant number of sections in common regardless of the specific group
sequential table selected. In this section, these in-common sections are described.

The Group Sequential Report can be split into two columns with the left-hand column
containing fields summarizd by a single value while the right-hand column contains tabular
information.

The following sections are included in the left-hand column in all group sequential reports:
o Test Parameters (Exact Error Rates, Number of Looks)

o Design Parameters (Fixed Term Parameters, Average Sample Size, Maximum In-
formation, Drift)

« Boundary Parameters (Bound Calculation Method, GST Parameters)
 Calculation Specific Parameters (Group Sequential Options)

The following table sections are included in the right-hand column in all group sequential
reports:

o Output (Boundary Information - Sample Size, Information Time, Boundaries)

 Incremental Exit (Boundary Crossing) Probabilities (Exit Probabilities under Null
Hypothesis and Alternative Hypothesis)

Some group sequential tables will contain sections unique to that table (e.g. Piecewise
Survival Parameter Table in GST3). These will be discussed in subsubsection 7.3.4.3.

A summary of each section is provided next which will cover the fields included in each
section alongside providing an overview any changes due to the group sequential table
selected and group sequential methods chosen:

Test Parameters The Test Parameters section provides the overall trial error rates
and the high-level design parameters for the group sequential design.

The Test Parameters section will contain the following fields:
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Target Sig. Level:  The target significance level, equal to Test Significance Level,
a from the main design table

Exact Sig. Level:  The actual overall significance level (Type I error («)) for the
specified design. This will equal the sum of the exit probabilities for efficacy under the
null hypothesis (e.g. Under HO - Efficacy column in Incremental Exit (Boundary
Crossing) Probabilities table). For most designs this should either equal or be quite
closer to the Target Sig. Level - however certain designs (e.g. Haybittle-Peto using
Last P-value) can cause the target and exact significance levels to diverge significantly.

Exact Power: The exact power achieved for the specified design. This will equal the
Power (%) row in the main design table and also the sum of the exit probabilities for ef-
ficacy under the alternative hypothesis (e.g. Under H1 - Efficacy column in Incremental
Exit (Boundary Crossing) Probabilities table).

1 or 2 Sided?:  Whether the test was a one-sided or two-sided test. This will be
hidden for tables without this option e.g. Non-inferiority designs are always 1-sided

Number of Looks:  The total number of looks (including final analysis) specified for
the group sequential design. Will equal Number of Looks, J from main design table.

An example Test Parameters section is provided in Figure 7.24.

Test Parameters

0.025

0.024

9733 %

COne-sided

Figure 7.24: Group Sequential Report Test Parameters Section Example

Design Parameters The Design Parameters section provides an overview of the fixed
term design parameters, sample size and important group sequential summary parameters.

The Design Parameters section will contain the following fields:
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“Design-Specific” Fields: The set of fixed parameter inputs required for that spe-
cific design scenario. These will differ significantly depending on group sequential table
and will typically be taken from the equivalent row in the main design table. For example,
in GST1 (Two Means) the Group 1 Mean, Group 2 Mean, Mean Difference, Group
1 Standard Deviation, Group 2 Standard Deviation and Effect Size fields would
be included in the Design Parameters section.

“Maximum Sample Size” Fields: The maximum sample size fields summarize the
maximum sample size including the total sample size, the sample sizes per group and the
sample size ratio as required. For example, in GST1 (Two Means) the Group 1 Sample
Size, Group 2 Sample Size, Sample Size Ratio and Total Sample Size fields are
included in the Design Parameters section.

Note that for survival analysis tables (e.g. GST3), the Design Parameters section will
include similiar fields for the Maximum Number of Events and Events per Group,
alongside the sample size fields above. For Information-Based designs (GSTO0), these
fields will not be included as the Maximum Information field below is equivalent for
Information—Based Designs.

“Expected Sample Size” Fields:  The expected sample size fields summarize the
expected total sample size expected under the null hypothesis (Hy) and alternative hy-
pothesis (H;) given the probability of stopping early under the specified group sequential
boundaries in the Output Table. For example in GST1, the Expected Sample Size
under H, and Expected Sample Size under H; are included in the Design Para-
meters section. This can be calculated by taking the sum of all exit probabilities under
a given hypothesis at a given look and multiplying this by the interim sample size at that
look. Then sum these product values from each look to find the expected sample size.

Note that for survival analysis tables (e.g. GST3), the Design Parameters section
will include similiar fields for the Expected Events under H, and Expected Events
under H;, alongside the sample size fields above. For Information-Based designs (GST0),
these fields will be replaced with the Expected Information under H, and Expected
Information under H;.

Maximum Information: The maximum information (/,,,,) achieved at the final
analysis. See subsubsection 7.2.1.1 and subsection 7.2.5 for details on what the maximum
information is and how it is derived for specific design scenarios.

Drift:  The drift parameter (n) for the group sequential design. See subsubsection 7.2.1.1
for details on the drift parameter.

An example Design Parameters section from GST1 is provided in Figure 7.25
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Design Parameters

: Group 1Mean, p, 0.000
' Group 2 Mean, i3 1,000
E Mean Difference 1.000
i Group 1 5tandard Devation 1.250
' Group 2 Standard Devation 1250
E Effect Size 1.000

' Sample Size Ratio 1.000

:Gmup1 Sample Size 50

|

| Group 2 5ample 5ize 50

|

| -

, Total Sample Size 100

|

| Expected Sample 5ize under HO 63.615
|

 Expected Sample Size under H1 64.184
|

: Maximum Information 16.000

| Dnift 4.000

Figure 7.25: Group Sequential Report Design Parameters Section Example

Boundary Parameters The Boundary Parameters section provides an overview of
the methods used to construct the efficacy and/or futility boundaries for the group se-
quential design.

The Boundary Parameters section will contain the following fields:

Efficacy Bound Calc. Method: The group sequential method used to construct
the efficacy boundaries. Will equal the Efficacy Bound Calculation Method value
from the main design table. Efficacy Bound Calc. Method and the “Efficacy Bound
Method” Specific Fields (see below) will be hidden if Efficacy Calculation Method
= Don’t Calculate as no efficacy boundaries were constructed.

Futility Bound Calc. Method: The group sequential method used to construct the
futility boundaries. Will equal the Futility Bound Calculation Method value from
the main design table. Futility Bound Calc. Method and the “Futility Bound
Method” Specific Fields (see below) will be hidden if Futility Calculation Method
= Don’t Calculate as no futility boundaries were constructed.
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“Efficacy Bound Method” Specific Fields:  The specific additional fields specified
for the Efficacy Bound Calculation Method in the GST Parameters and (if present)
Additional Parameters tables within the Group Sequential Side-Table. A short
summary of fields included in Boundary Parameters by calculation method is provided
here:

o Spending Function: Alpha Spending Function provided in the GST Paramet-
ers table. If present, Additional Parameters specified for efficacy spending func-
tion are all included (see subsubsection 7.3.2.3) and will be indicated by symbol(«)
e.g. 7(B) for Hwang-Shih-DeCani Alpha Spending Function

o Haybittle-Peto: Fixed Parameter which will be Total Alpha or Last P-value
as per GST Parameters table selection. The interim p-values are in the Output
table.

o Wang-Tsiatis: Efficacy Shape Parameter, A; value provided in the GST Para-
meters table

o Unified Family: Efficacy Shape 1, 7(«) and Efficacy Shape 2, p(«) values
provided in the GST Parameters table.

o Custom Boundaries: N/A. Custom Boundaries are provided in the Output Table
with chosen Efficacy Boundary Scale included in the column title of the custom
efficacy boundaries.

“Futility Bound Method” Specific Fields:  The specific additional fields specified
for the Futility Bound Calculation Method in the GST Parameters and (if present)
Additional Parameters tables within the Group Sequential Side-Table. A short
summary of fields included in Boundary Parameters by calculation method is provided
here:

« Spending Function: Beta Spending Function provided in the GST Parameters
table. If present, Additional Parameters specified for futility spending function
are all included (see subsubsection 7.3.2.3) and will be indicated by symbol(3) e.g.
~v(p) for Hwang-Shih-DeCani Beta Spending Function

o Wang-Tsiatis: Futility Shape Parameter, A, value provided in the GST Para-
meters table

o Unified Family: Futility Shape 1, 7(5) and Futility Shape 2, p(f) values
provided in the GST Parameters table.

o Custom Boundaries: N/A. Custom Boundaries are provided in the Output Table
with chosen Futility Boundary Scale included in the column title of the custom
futility boundaries.

For further detail on the “Efficacy Bound Method” Specific Fields and “Futility
Bound Method” Specific Fields, see subsubsection 7.3.2.1 and subsubsection 7.3.2.3.

Futility Bounds: Indicator for whether the futility boundaries are Non-Binding or
Binding. This field will be hidden if Futility Bound Calculation Method = Don’t
Calculate (No Futility Bounds), Custom Boundaries (alway Non-Binding)

Examples of Boundary Parameters for a variety of scenarios is provided in Figure 7.26.
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Boundary Parameters

: Efficacy Bound Calc. Method Spending Function
Al A e O'Brien-Fleming Boundary Parameters
|

: Efficacy Bound Calc. Method ‘Wang-Tsiatis
|
Bou ndal’y Parameters | Futility Bound Calc. Method Pampallona-Tsiatis
[
| Efficacy Bound Calc. Method Spending Function | Shape 1, s -0.100
f

i
| Futility Bound Calc. Method Spending Function ; Shape 2, Az 0100
[

(
| Alpha Spending Function Hwang-Shih-DeCani : Futility Bounds Non-Binding
f

} Beta Spending Function 2-Parameter Family
| Boundary Parameters

| Futility Bounds Non-Binding

} | Efficacy Bound Calc. Method Unified Farnily
| Efficacy HSDC Parameter, y(a) -1.000 i
| | Futility Bound Calc Method Unifed Family
| Futility Distribution Family Logistic ]
1 | Efficacy Shape 1, T(o) 0100
| Futility Parameter 1, a(p) 2000 :

i | Efficacy Shape 2, pla) 0.200
| Futility Parameter 2, b(B) 2.000

E Futility Shape 1, 7€) 0.000
Boundary Parameters | Futiity Shape 2, p(@) 0.300
i

| Efficacy Bound Calc. Method Haybittle Peto (p-value) | Futility Bounds Non-Binding
|

| Fixed Parameter Total Alpha

i

Figure 7.26: Group Sequential Report Boundary Parameters Examples

Calculation Specific Parameters The Calculation Specific Parameters provides an
overview of the group sequential algorithm tuning parameters set in the Group Sequen-
tial Options tab (see subsection 7.3.7).

The Calculation Specific Parameters section will contain the following fields:

Extreme Z-value: The bound for the Z-statistic used by the search algorithm when
searching for the group sequential boundaries. The search algorithm will search from
[— Zewtremes Zewtreme). By default this will equal 8 which is adequate for any reasonable
normally distributed statistic (® (8) = 6.220961e — 16)

R: The turning parameter used to determine the number of points that will be used
to numerically evaluate the integral. See subsection 7.2.2 for details. By default this will
be set to 20 which is reasonable for most group sequential design.

Integer Interim N:  Set whether the interim sample sizes will be rounded to the
nearest integer after finding the maximum sample size. This will re-run the solver using
the updated maximum information to give the exact power. By default, this is set to Yes.
For most cases, this will make minimal difference.

For survival tables (e.g. GST3) this is replaced with Rounded N & E which controls
whether the sample size (N) and events (E) will be rounded to the nearest integer - note
this is applied to both the interim values and the maximum values of the sample size and
events.

Note this option is not included for Information-Based Designs (GSTO0) as the information
is always unrounded.
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Two-Sided Power: Set whether the lower tail efficacy exit probabilities under the
alternative hypothesis should be included when calculating the exact power for a two-
sided test.

The default is Yes, where the power will include the upper and lower efficacy exit prob-
abilties under the alternative hypothesis - this is equivalent to the sum of all the Under
H1 - Lower Efficacy and Under H1 - Upper Efficacy values from Output table.
Selecting No will exclude the lower efficacy exit probabilities - this is equivalent to taking
only the sum of the Under H1 - Upper Efficacy column from the Output table.

Output (Table) The Output table provides an overview of the per-look sample size,
information, information times, boundaries and spending function error rates.

The Output table will have a number of rows equal to the Number of Looks specified
in the main table and provided in the Test Parameters sections. The columns will
change depending on the group sequential design specified with the following common
column types:

Analysis/Look Number:  The look number (k) associated with each row of the
Output table. The final row corresponds to the final planned analysis.

Sample Size:  The sample size required for each interim analysis. The final row will
equal the Maximum Sample Size provided in the Design Parameters section. For
survival tables (e.g. GST3), this will be replaced with Events. For Information-Based
(GSTO) designs, this column will be excluded.

Information:  The (Fisher) information at each interim analysis. The final row value
is equal to the Maximum Information provided in the Design Parameters sec-
tion. The Information column is provided for all tables but effectively replaces Sample
Size for Information-Based (GSTO) designs. For detail on the Fisher Information see
subsubsection 7.2.1.1 and subsection 7.2.5.

Information Fraction:  The information fraction at each interim analysis. This is
equivalent to the proportion of the total sample size/events/maximum information at
a given look and will equal the Information at each look divided by the Maximum
Information.

Boundaries:  These column(s) provide the group sequential efficacy and/or futility
boundaries on the desired statistical scale.

The columns will have a column title of the form “Boundaries (Scale) - (Upper/Lower)
Efficacy /Futility” where Scale refers to the statistical scale the boundary is provided on,
Upper/Lower are provided for a 2-sided design to differentiate between the upper and
lower bounds and Efficacy/Futility refers to if the boundary is an efficacy or futility
bound.

The six primary types are:
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1. Boundaries (Scale) - Efficacy: The 1-sided efficacy boundary beyond which the
trial would stop for efficacy. Only present if 1 or 2 Sided Test? = 1 and Efficacy
Bound Calculation Method # Don’t Calculate in main design table

2. Boundaries (Scale) - Futility: The 1-sided futility boundary beyond which the
trial would stop for futility. Only present if 1 or 2 Sided Test? = 1 and Futility
Bound Calculation Method # Don’t Calculate in main design table

3. Boundaries (Scale) - Upper Efficacy: The 2-sided upper efficacy boundary
above which the trial would stop for efficacy. Only present if 1 or 2 Sided Test?
= 2 and Efficacy Bound Calculation Method # Don’t Calculate in main
design table. Note nQuery defines “upper” as the direction of the specified treatment
effect from the main design table e.g. in GST1 if Mean Difference > 0 then upper
boundaries will be higher than lower boundaries and vice-versa if Mean Difference
< 0.

4. Boundaries (Scale) - Lower Efficacy: The 2-sided lower efficacy boundary
below which the trial would stop for “efficacy” - assuming both directions are truly
considered “effective”]. Only present if 1 or 2 Sided Test? = 2 and Efficacy
Bound Calculation Method # Don’t Calculate in main design table. Note
nQuery defines “upper” as the direction of the specified treatment effect from the
main design table e.g. in GST1 if Mean Difference > 0 then upper boundaries
will be higher than lower boundaries and vice-versa if Mean Difference < 0.

5. Boundaries (Scale) - Upper Futility: The 2-sided upper futility boundary
where the trial will stop early for futility if the test statistic falls between the upper
and lower futility boundaries. Only present if 1 or 2 Sided Test? = 2 and Futility
Bound Calculation Method # Don’t Calculate in main design table. Note
that 2-sided futility bounds may not be the most appropriate option for a clinical
trial as they only consider values near the null hypothesis treatment effect to be
futility, not treatment effects in the opposite direction of the specified treatment
effect.

6. Boundaries (Scale) - Lower Futility: The 2-sided lower futility boundary where
the trial will stop early for futility if the test statistic falls between the upper and
lower futility boundaries. Only present if 1 or 2 Sided Test? = 2 and Futility
Bound Calculation Method # Don’t Calculate in main design table. Note
that 2-sided futility bounds may not be the most appropriate option for a clinical
trial as they only consider values near the null hypothesis treatment effect to be
futility, not treatment effects in the opposite direction of the specified treatment
effect.

The statistical scale that is provided in the Group Sequential Report for the Bound-
aries column(s) is determined by the choice of Boundary Scale (for Spending Func-
tion, Wang-Tsiatis/Pampallona-Tsiatis, Unified Family) or Efficacy Boundary
Scale/Futility Boundary Scale (for Custom Boundaries) in the GST Outputs.

Boundary Scale can be set to Z-scale, p-value Scale, Score Scale and d-Scale (i.e.
treatment effect e.g. mean difference in GST1). The scale used for the Boundaries in
the Output table will depend on the scale chosen at the time of solver calculation. If a
different scale is desired in the Group Sequential Report, select the desired Boundary
Scale in GST Options and then re-run the solver by selecting the Run button below
the main design table.
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Efficacy Boundary Scale can be set to Z-scale, p-value Scale, Score Scale, /-Scale
(i.e. treatment effect e.g. mean difference in GST1) and Alpha Error. The scale used
for the Boundaries in the Output table will equal the Efficacy Boundary Scale
option selected except for the Alpha Scale which will provide the Z-scale boundaries
(and Error Rates -Alpha column) as per the equivalent User Defined Spending
Function option.

Futility Boundary Scale can be set to Z-scale, p-value Scale, Score Scale, /-Scale
(i.e. treatment effect e.g. mean difference in GST1), Beta Error and Conditional
Power. The scale used for the Boundaries in the Output table will equal the Futility
Boundary Scale option selected except for the Alpha Scale which will provide the
Z-scale boundaries (and Error Rates -Alpha column) as per the equivalent User
Defined Spending Function option. Note the Conditional Power scale option leaves
the final row value empty as conditional power is not defined for the end of a trial.

An exception to the above is when Efficacy Bound Calculation Method = Haybittle-
Peto. In this case, the efficacy boundaries are shown on both the Z-scale and p-value
Scale in separate columns.

Error Rates:  These columns provide the alpha and/or beta error spent at each look
by the spending function.

The Error Rates - Alpha column provides a summary of the alpha error “spent” at
each look. Alpha («) is the Type I error and is equivalent to the cumulative efficacy exit
probability under the null hypothesis. The Error Rates - Alpha column will be only
shown in the Output table if Efficacy Bound Calculation Method = Spending
Function or Spending Calculation Method = Custom Boundary + Efficacy
Boundary Scale = Alpha Error.

The Error Rates - Beta column provides a summary of the alpha error “spent” at
each look. Alpha («) is the Type I error and is equivalent to the cumulative efficacy exit
probability under the null hypothesis. The Error Rates - Alpha column will be only
shown in the Output table if Efficacy Bound Calculation Method = Spending
Function or Spending Calculation Method = Custom Boundary + Efficacy
Boundary Scale = Alpha Error.

Examples of Output tables for a variety of scenarios is provided in Figure 7.27.
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Output
lysis/Look Sample Size Information Information Fraction o Trm(eE o) Error Rates -
Efficacy
20000 3200 0200 2724 0.003 5 Look Design - 1-sided
2 40000 6400 0400 2590 0.007 Efficacy Only - Spending

Function

3 60.000 9.600 0.600 2450 0012
Z-scale Bounds

4 80.000 12.800 0.800 2314 0018
5 100000 16.000 1000 2181 0025

Output

Boundaries - -
Boundaries Boundaries Boundaries
Information (S(ore scale) - Error Rates - Ermor Rates - X )
Analysis/Look | Sample Size | Information [ L (Score scale) - (Score scale) - | (Score scale) - Alpha Beta 3 Look Design - 2-sided
Lower Efficacy Efﬁ( Lower Futility | Upper Futility . .
acy Efficacy + Futility - Both
33000 5.280 0330 6354 -6.354 1354 -1354 0.006 0.042 Spending Function
2 67.000 10720 0670 8459 -8.459 5176 -5176 0014 0.071 Score Scale Bounds
3 100000 16.000 1000 9624 -0624 9624 -9624 0025 0.093
Output

Boundaries (Z-scale) Bol.mdanes (p-value | Boundary p value -

4 Look Design - 1-sided
25000 4.000 0250 2576 0300 0.005

Efficacy = Haybittle-Peto
2 50.000 8.000 0.500 2576 0.200 0.005 Futility = Custom p-value
3 75.000 12.000 0750 2576 0.100 0.005

4 100.000 16.000 1.000 2.090 0.018 0.018

Output

[ — Boundaries (Score | Boundaries (Score | Boundaries (Score | Boundaries (Score 2 Look Design _2-sided
lysis/Look Sample Size Information Fractio scale) - Lower scale) - Upper scale) - Lower scale) - Upper ) .
1CHon Efficacy Efficacy Futiity Futiity Efficacy + Futility - Both

100000 16,000 0500 9240 9240 -0.000 0.000 Unified Family

8-Scale Bounds
2 200000 32,000 1000 11788 1788 11788 11788

Figure 7.27: Group Sequential Report Output Table Examples

Incremental Exit (Boundary Crossing) Probabilities (Table) The Incremental Exit
(Boundary Crossing) Probabilities table provides an overview of the probability of
crossing the specified boundaries under the null hypothesis and alternative hypothesis
treatment effect.

The Incremental Exit (Boundary Crossing) Probabilities table will have a number
of rows equal to the Number of Looks specified in the main table and provided in the
Test Parameters sections.

As the title implies, this table provides the incremental exit probabilites which are the
probabilities of exiting at a specific look. The cumulative exit probability, the probability
of exiting at any look up to and including the present look, can be found by summing all
the incremental probabilities up to and including the current look.

The columns will change depending on the group sequential design specified with the
following common column types:

Analysis/Look Number:  The look number (k) associated with each row of the
Output table. The final row corresponds to the final planned analysis.

Under HO The Under HO columns provide the exit probability for the specified
boundaries under the null hypothesis treatment effect (e.g. mean difference = 0 in GST1).

These columns will have a column title of the following form: Under HO - (Bound Name)
where Bound Name will have the same name as the bounds included in the Output table
(see section 7.3.4.2).
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The six possible column names for Under HO are:

Under HO - Efficacy - Column present only if 1 or 2 Sided = 1 and Efficacy
Bound Calculation Method # Don’t Calculate

Under HO - Futility - Column present only if Futility Bound Calculation Method
# Don’t Calculate

Under HO - Upper Efficacy - Column present only if 1 or 2 Sided = 2 and Efficacy
Bound Calculation Method # Don’t Calculate

Under HO - Lower Efficacy - Column present only if 1 or 2 Sided = 2 and Efficacy
Bound Calculation Method # Don’t Calculate

Under H1  The Under H1 columns provide the exit probability for the specified
boundaries under the alternative hypothesis treatment effect (e.g. mean difference equals
value set in the main design table for GST1).

These columns will have a column title of the following form: Under H1 - (Bound Name)
where Bound Name will have the same name as the bounds included in the OQutput table
(see section 7.3.4.2).

The six possible column names for Under H1 are:

Under H1 - Efficacy - Column present only if 1 or 2 Sided = 1 and Efficacy
Bound Calculation Method # Don’t Calculate

Under H1 - Futility - Column present only if Futility Bound Calculation Method
# Don’t Calculate

Under H1 - Upper Efficacy - Column present only if 1 or 2 Sided = 2 and Efficacy
Bound Calculation Method # Don’t Calculate

Under H1 - Lower Efficacy - Column present only if 1 or 2 Sided = 2 and Efficacy
Bound Calculation Method # Don’t Calculate

Examples of Output tables for a variety of scenarios is provided in Figure 7.28.
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Incremental Exit (Boundary Crossing) Probabilities

! 0002 0175 5 Look Design
z 0004 0319 1-sided
3 0.005 0267 Efficacy only

0.006
0.007

0.148
0.062

Incremental Exit (Boundary Crossing) Probabilities

s~ v 1 -
3 Look Design

1 0596 0020 1-sided

2 0306 0.014 Futility Only

3 0078 0.010

Incremental Exit (Boundary Crossing) Probabilities

Under HO - Efficacy Under HO - Futility Under H1 - Efficacy Under H1 - Futility

0.000 0501 0076 0021 3 Look Design

2 0.006 0304 0701 0014 1-sided
Futility + Efficacy
3 0014 0075 0177 0011

Incremental Exit (Boundary Crossing) Probabilities

Under HO - Lower Efficacy Under HO - Upper Efficacy Under H1 - Lower Efficacy Under H1 - Upper Efficacy

1 0009 0009 0.000 0.680 4 Look Design
2 0007 0007 0.000 0274 2-sided

’ ) ’ Efficacy Only
E] 0005 0005 0.000 0.041
4 0004 0004 0.000 0.004

Incremental Exit (Boundary Crossing) Probabilities

fysis/Look Under HO - Lower Under HO - Upper Under HO - Under H1 - Lower Under H1 - Upper
Efficacy Efficacy Efficacy Efficacy 2 Look Design
0015 0015 0.398 0.000 0966 0000 2-sided

2 0010 0,010 0553 0.000 0034 0,000 Efficacy + Futility

Figure 7.28: Group Sequential Report Incremental Exit (Boundary Crossing) Probabil-
ities Table Examples

7.3.4.3 Table Specific Group Sequential Report Sections

The Group Sequential Report has additional sections for certain specific tables. In
this section, these unique sections will be outlined for the relevant tables.

GST3 - Group Sequential Design for Two Survival Curves using Log-Rank Test
(Piecewise Accural %, Hazard Rates, Dropout Rates) In GST3, there are three
additional sections added to the Group Sequential Report. These sections are:

e Hj Trial Information Table
e H; Trial Information Table
o Piecewise Survival Parameter Table

A overview of each of these is provided below:

H, Trial Information Table The H, Trial Information Table provides practical
information about the expected timing, sample size recruited, remaining accrual pipeline
and dropouts at each analysis under the null hypothesis hazard ratio.
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The timing of an interim analysis for a survival analysis group sequential trial is a function
of the total events not the sample size. Given that the time-to-event is the random variable
of interest this means that practical estimates of the likely length of study time are useful
for study planning.

One scenario of particular interest would be the null hypothesis where the Hazard Ratio
= 1 i.e. hazard rates are both equal to the specified group 1 hazard rate. Based on this
null hazard ratio, the provided piecewise accrual rates, hazard rates and dropout rates
from the Piecewise Survival Information table and the relevant main design table
parameters (Group 1 Sample Size, Group 2 Sample Size, Follow-up Type -
Event-Driven or Fixed Follow-up - require Fixed Follow-up Time for latter) the
practical outcomes at each interim analysis can be calculated via the same formulae used
to calculate the sample size for survival analysis (see subsubsection 7.2.5.4 for details).

The columns that are provided in the Hy Trial Information Table are:

Analysis/Look

The look number (k) associated with each row of the Output table. The final row
corresponds to the final planned analysis.

Information Fraction

The information fraction at each interim analysis. This is equivalent to the proportion
of the total sample size/events/maximum information at a given look and will equal the
Information at each look divided by the Maximum Information.

Time

The expected calendar time at which the target number of Events will be achieved for
each analysis under the null hypothesis. This assumes that the start of the study had
Time = 0. It is possible for the target number of events not to be reached within the
planned study time under the null hypothesis. In this case, the final Time values may
be set to exceed the planned study length. In this case, a warning will be provided in the
main table indicating this increase in the planned study length has occured.

Sample Size Recruited

The number of subjects expected to be recruited at the time of each analysis given the
planned accural pattern. Sample Size Recruited is calculated based on the Time of
each analysis from above and the accrual pattern specified in the Piecewise Survival
Information table.

Events

The total number of events required to conduct analysis. As the timing of each analysis
depends on reaching these target number of events, these values are fixed and taken
directly from the Output table above where they equal the Maximum Events times
the Information Fraction at each look.

Dropouts

The total number of dropouts expected to have occured by the time of each analysis. This
can apply to any subject lost to follow-up who can no longer have the event of interest.
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Dropouts is calculated based on the Time of each analysis from above and piecewise
dropout exponential rates specified in the Piecewise Survival Information table.

In Pipeline

The expected number of subjects at each analysis who have already been recruited but
who have not had the event of interest of dropped out. A common concern in survival
analysis group sequential trials is the overhang of subjects who have been recruited but
are still available at an interim analysis. In Pipeline provides a useful estimate of
this expected overhang. In Pipeline will equal Sample Size Recruited - Events -
Dropout in each row.

Remaining Recruitment

The maximum number of subjects expected to be left to be recruited by the time of each
analysis. Remaining Recruitment provides insight into the remaining recruitment left
to occur in the trial which can useful for resource allocation. Remaining Recruitment
will equal Maximum Sample Size - Sample Size Recruited.

Maximum Available

The maximum number of subjects left who could have the event of interest who are already
recruited or could be recruited in the future by the time of each analysis. Maximum
Available provides insight into the total number of subjects left who could have the event
of interest. Achieving the required number of events given the original planned sample
size could become a concern if the dropout rate was higher than expected for example.
Maximum Available will equal In Pipeline + Remaining Recruitment.

An example of the Hy Trial Information Table is provided in Figure 7.29

Hp Trial Information Table

- Information Sample Sze - Remaining Maximum
-"’c'e“mmm““ﬁ“‘m
0.250 8.077 256.000 72.000 2.000 182.000 88.000 270.000

0.500 11.068 344.000 145.000 4.000 195.000 0.000 195.000
0752 14.069 344000 218.000 6.000 120.000 0.000 120.000

= W P —

1.000 18.240 344000 290.000 8.000 46.000 0.000 46.000

Figure 7.29: Group Sequential Report Hy Trial Information Table Example

H, Trial Information Table The H; Trial Information Table provides practical
information about the expected timing, sample size recruited, remaining accrual pipeline
and dropouts at each analysis under the alternative hypothesis hazard ratio.

The timing of an interim analysis for a survival analysis group sequential trial is a function
of the total events not the sample size. Given that the time-to-event is the random variable
of interest this means that practical estimates of the likely length of study time are useful
for study planning.

One scenario of particular interest would be the alternative hypothesis under which the
power was calculate. The alternative hypothesis Hazard Ratio will equal the Hazard
Ratio, h = \y;/\y; specified in the main design table. Based on this alternative hazard
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ratio, the provided piecewise accrual rates, hazard rates and dropout rates from the
Piecewise Survival Information table and the relevant main design table parameters
(Group 1 Sample Size, Group 2 Sample Size, Follow-up Type - Event-Driven
or Fixed Follow-up - require Fixed Follow-up Time for latter) the practical outcomes
at each interim analysis can be calculated via the same formulae used to calculate the
sample size for survival analysis (see subsubsection 7.2.5.4 for details).

The columns that are provided in the H; Trial Information Table are:

Analysis/Look

The look number (k) associated with each row of the Output table. The final row
corresponds to the final planned analysis.

Information Fraction

The information fraction at each interim analysis. This is equivalent to the proportion
of the total sample size/events/maximum information at a given look and will equal the
Information at each look divided by the Maximum Information.

Time
The expected calendar time at which the target number of Events will be achieved for

each analysis under the alternative hypothesis. This assumes that the start of the study
had Time = 0.

Sample Size Recruited

The number of subjects expected to be recruited at the time of each analysis given the
planned accural pattern. Sample Size Recruited is calculated based on the Time of
each analysis from above and the accrual pattern specified in the Piecewise Survival
Information table.

Events

The total number of events required to conduct analysis. As the timing of each analysis
depends on reaching these target number of events, these values are fixed and taken
directly from the Output table above where they equal the Maximum Events times
the Information Fraction at each look.

Dropouts

The total number of dropouts expected to have occured by the time of each analysis. This
can apply to any subject lost to follow-up who can no longer have the event of interest.
Dropouts is calculated based on the Time of each analysis from above and piecewise
dropout exponential rates specified in the Piecewise Survival Information table.

In Pipeline

The expected number of subjects at each analysis who have already been recruited but
who have not had the event of interest of dropped out. A common concern in survival
analysis group sequential trials is the overhang of subjects who have been recruited but
are still available at an interim analysis. In Pipeline provides a useful estimate of
this expected overhang. In Pipeline will equal Sample Size Recruited - Events -
Dropout in each row.
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Remaining Recruitment

The maximum number of subjects expected to be left to be recruited by the time of each
analysis. Remaining Recruitment provides insight into the remaining recruitment left
to occur in the trial which can useful for resource allocation. Remaining Recruitment
will equal Maximum Sample Size - Sample Size Recruited.

Maximum Available

The maximum number of subjects left who could have the event of interest who are already
recruited or could be recruited in the future by the time of each analysis. Maximum
Available provides insight into the total number of subjects left who could have the event
of interest. Achieving the required number of events given the original planned sample
size could become a concern if the dropout rate was higher than expected for example.
Maximum Available will equal In Pipeline 4+ Remaining Recruitment.

An example of the H; Trial Information Table is provided in Figure 7.30. This is taken
from the same example used for the H, Trial Information Table in Figure 7.29 so it may
be valuable to compare these two tables for this case where the alternative hypothesis
hazard ratio was 0.666.

H; Trial Information Table

Information Sample Size Remalnlng Maximum
T sl O =l N ) C e P

0.250 8618 281.000 72.000 2.000 207.000 63.000 270.000
2 0.500 1.821 344.000 145.000 6.000 193.000 0.000 193.000
3 0753 15183 344.000 218.000 7.000 119.000 0.000 119.000
4 1.000 20.000 344.000 290.000 9.000 45.000 0.000 45.000

Figure 7.30: Group Sequential Report Hy Trial Information Table Example

Piecewise Survival Parameter Table The Piecewise Survival Parameter table
provides information about the piecewise accrual process, hazard rates and dropout rates.
It is based on the Piecewise Survival Information side-table.

While the Piecewise Survival Parameter table transposes the Piecewise Survival
Information table (so each row now corresponds to each survival piece and each column
corresponds to a parameter) and has some minor column name changes made for aesthetic
fit, these two tables are effectively indentical and therefore refer to subsection 7.3.3 for
further information on the definition of each column. An example Piecewsie Survival
Parameter table is provided in Figure 7.31.

Piecewise Survival Parameter Table

End of Period, Accrual (% TotaD Group 1 Hazard Group 2 Hazard Group 1% Group 2 % Group 1Dropout | Group 2 Dropout
Time t Rate, A Rate, A= Surviving Surviving Rate, d1 Rate, d=

0.000 0.000 0.000 0.000 100.000 100.000 0.000 0.000
5.000 33333 0.100 0.067 60.653 71653 0.004 0.004
10.000 66.667 0.200 0133 22313 36788 0.004 0.004
15.000 0.000 0.300 0.200 4979 13534 0.004 0.004
20.000 0.000 0400 0.267 0674 3.567 0.004 0.004

Figure 7.31: Group Sequential Report Piecewise Survival Parameter Table Example
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7.3.5 Boundary Plot

The Boundary Plot provides a visual and tabular summary of the group sequential
boundaries, which can be found in the Group Sequential Side-Table (see subsection 7.3.2)
and Group Sequential Report (see subsection 7.3.4), and the associated exit and con-
tinuation regions at each look. It can be opened by selecting the Boundary Plot tab
at the top of the Group Sequential Side-table panel after a solver calculation has
occured in the associated main design table column.

The Boundary Plot allows the user to visually inspect the boundaries on multiple
statistical scales (Z-scale, p-value Scale, Score Scale, §-Scale) and also export these
plots to assist in the exploration and communcation of a planned group sequential design.

An example Boundary Plot is shown in Figure 7.32.

GST1S-1 | Group Sequential Report EHILGELANE Error Spending Plot v X
Edit.. v Boundary Scale.. v E\l Save Plot @ Save Table

Boundary Plot

Efficacy Bounds
A Futility Bounds

04 0.6 08 1

~

Boundary (Z-scale)

=}

o
o
[N}

Information Fraction

Look Efficacy Bound Futility Bound
1 433263365 0.09259189
296313104 0.87384773
2.35904432 147307362
2.01409027 2.01409027

= ow N

Figure 7.32: Group Sequential Boundary Plot Example - 1-sided Efficacy and Futility
Design

The Boundary Plot tab consists of three primary elements: the Boundary Plot
(middle), Boundary Table (bottom) and the Toolbar (top). Each of these will be
summarized next.

7.3.5.1 Boundary Plot

The Boundary Plot provides a visual summary of the group sequential boundaries
and the resulting continuation and exit regions on the specified statistical scale for the
boundaries.

The Boundary Plot is a shaded line plot where each boundary, on the specified statistical
scale, is plotted against a measure of trial progress on the X-axis.

X-axis The X-axis corresponds to how far into the trial each analysis occurs.
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The X-axis will range from zero to the maximum value for the specified X-axis parameter
scale (e.g. 1 for Information Fraction) but the series will only be plotted from the first
analysis to the final analysis.

The X-axis can be plotted on the following scales: Information Fraction, Cumulative
Information, Total Sample Size. The scale can be changed from the Edit menu in
the Toolbar or right-click context menu under the Series > X-axis Scale option - see
section 7.3.5.3.

By default, the X-axis will be shown on the Information Fraction scale which is
equivalent to the proportion of the total sample size analyzed at each analysis. The
name of the X-axis by default will be same as the statistical scale used for the X-axis.
Use Titles > X-axis Scale option from the Edit menu to change the X-axis Title
(show /hide, X-axis name, X-axis font) - see section 7.3.5.3.

Note that Total Sample Size scale is not available for Information-Based Design (GSTO)
and that Total Sample Size is replaced with Total Events for Survival Analysis (e.g.
GST3).

Y-axis The Y-axis corresponds to the test statistical values achieved at a given time for
the specified statistical scale and is used to plot the boundaries calculated and provided
in the GST Outputs table and Group Sequential Report.

The Y-axis range will dynamically change to include the lowest and highest boundary
value on the specified scale with an additional buffer to improve visual clarity. The one
exception is that for the Z-scale (used here), Score Scale and §-Scale the Y-axis will
be extended to include zero if it does not fall between the lowest and highest boundary
value. Zero is always highlighted using a horizontal line for these scales.

The Y-axis can be plotted on the following statistical scales: Z-scale, p-value Scale,
Score Scale, /-Scale. Technical detail on the scales is provided in subsubsection 7.2.1.1
and subsubsection 7.2.4.5. The scale can be changed from Boundary Scale... option
from the Toolbar or the Edit menu in the Toolbar or right-click context menu under
the Series > Y-axis Scale option - see section 7.3.5.3 and section 7.3.5.3 .

The default statistical scale for the Y-axis will be set by the value selected in the
GST Options table for the Boundary Scale or (if Efficacy Boundary Calculation
Method = Custom Boundary) Efficacy Boundary Scale rows. Where neither field
is available or Efficacy Boundary Scale = Alpha Error, the Z-scale is selected.
The name of the Y-axis by default will equal Boundary (Selected Scale) e.g. Boundary
(Z-scale) and will update automatially if the Boundary Scale is changed. Use Titles
> Y-axis Scale option from the Edit menu to change the Y-axis Title (show/hide,
X-axis name, X-axis font) - see section 7.3.5.3.

After an option is selected, the Boundary Plot and Boundary Table will automatically
update to the boundaries to the selected statistical scale. See subsubsection 7.2.4.5 for
technical detail on the statistical scale conversions.

Efficacy Bounds By default, the Efficacy Bounds are plotted as a blue line. The exit
region for efficacy is the area highlighted in blue beyond the Efficacy Bounds, where the
exit region specifies the range of values at which the trial would stop for efficacy at each
look. For example, in Figure 7.32 the exit region for efficacy is shown as the blue area
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above the Efficacy Bounds series. The continuation region where the trial will continue
is the unhighlighted area between the bounds..

Note the Z-scale (used here), Score Scale and J-Scale can take on any real value
therefore it is implied that the exit area extends beyond the upper edge of the Y-axi
upwards to oo.

For the p-value scale, the “maximum” p-value is 0 (lower p-values are better) so the
efficacy bound is implied to extend to zero if that Y-axis does not include 0 in its range.

The visual aspects of the Efficacy Bounds such as the color, transparency of the exit area
and marker style and size can be changed from the Edit menu in the Toolbar or right-
click context menu under the Series > Efficacy Bounds option - see section 7.3.5.3.

Futility Bounds By default, the Futility Bounds are plotted as a red line. The exit
region for futility is the area highlighted in red beyond the Futility Bounds, where the
exit region specifies the range of values at which the trial would stop for futility at each
look. For example, in Figure 7.32 the exit region for futility is shown as the red area
below the Futility Bounds series. The continuation region where the trial will continue
is the unhighlighted area between the bounds.

Note the Z-scale (used here), Score Scale and J-Scale can take on any real value
therefore it is implied that the exit area extends beyond the lower edge of the Y-axi
upwards to —oo. For the p-value scale, the “minimum” p-value is 1 (higher p-values are
worse) so the lower bound is implied extend to one if that Y-axisdoes not include 1 in its
range.

The visual aspects of the Futility Bounds such as the color, transparency of the exit area
and marker style and size can be changed from the Edit menu in the Toolbar or right-
click context menu under the Series > Futility Bounds option - see section 7.3.5.3.

Legend The Boundary Plot Legend provides an indication of the color for the Ef-
ficacy Bounds and Futility Bounds.

By default, the Legend is shown to the right of the boundary plot. To toggle whether the
Legend is shown, change the location of the Legend or change the Legend Border use
the Edit menu in the Toolbar or right-click context menu under the Legend option -
see section 7.3.5.3. The colors in the plot and legend are defined by the Efficacy Bounds
and Futility Bounds series which are edited under the Series option in the Edit menu
- see section 7.3.5.3.

Tooltip The Boundary Plot Tooltip provides the user information about the bound-
ary values at a specific look based on which look is highlighted by the cursor within the
area of the Boundary Plot. When the cursor is not within the Boundary Plot area
the Tooltip will not be shown as in Figure 7.32. The values shown in the Tooltip will
correspond to the values provided in the Boundary Table for the highlighted look.

A Boundary Plot with the Tooltip active for the third look is shown in Figure 7.33.
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GST1S-1 | Group Sequential Report JESIRGELNRMOM Error Spending Plot -
Edit.. Vv Boundary Scale... Vv E Save Plot E{ Save Tahle

Efficacy Bounds: 0.75000000,2.35904432
A Futility Bounds: 0.75000000,1.47307362

Boundary Plot

{/)’_—_——-v Efficacy Bounds

'//_ A Futility Bounds
0

0 02 04 06 08 1

Information Fraction

Figure 7.33: Boundary Plot Tooltip

Resize Boundary Plot The grey bars at the bottom and to the right of the can be used
to re-size the Boundary Plot. Click and drag the grey bar to increase or decrease the
vertical and horizontal size respectively. The Boundary Plot will also automatically
scale if the side-table panel is resized.

The Edit... dropdown available from the Toolbar or right-click context menu provides
options to edit the visual aspects of the plot such as the titles, legend and color alongside
options to save or print the Boundary Plot. Some of the primary options where refer-
enced above but see section 7.3.5.3 for details on the full set of options available to edit
the Boundary Plot.

To provide additional clarity about the behavior of the Boundary Plot for different
design scenarios examples of the changes due to changes to 1 or 2 Sided Test?, cer-
tain combinations of the Efficacy Bound Calculation Method and Futility Bound
Calculation Method rows and the Boundary Scale... option from the Toolbar are
provided next for the following scenarios:

» Efficacy Only 1-sided (1 or 2 Sided Test? = 1, Futility Bound Calculation Method
= Don’t Calculate)

o Futility Only 1-sided (1 or 2 Sided Test? = 1, Efficacy Bound Calculation Method
= Don’t Calculate)

« Efficacy and Futility 1-sided (1 or 2 Sided Test? = 1, Efficacy Bound Calcu-
lation Method # Don’t Calculate & Futility Bound Calculation Method # Don’t
Calculate)

« Efficacy Only 1-sided (1 or 2 Sided Test? = 2, Futility Bound Calculation Method
= Don’t Calculate)

o Futility Only 1-sided (1 or 2 Sided Test? = 2, Efficacy Bound Calculation Method
= Don’t Calculate)

« Efficacy and Futility 1-sided (1 or 2 Sided Test? = 2, Efficacy Bound Calcu-
lation Method # Don’t Calculate & Futility Bound Calculation Method # Don’t
Calculate)

The exact boundaries for each of the example Boundary Plots below is provided in the
next Boundary Table subsection (subsubsection 7.3.5.2).
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Efficacy Only 1-sided Example Boundary Plots for the Efficacy Only 1-sided
scenario are shown for the four Boundary Scale options (Z-scale, p-value Scale,
Score Scale, §-Scale) in Figure 7.34.

Boundary Plot Boundary Plot

IS

Boundary (Z-scale)
Boundary (p-value scale)

0 0.2 04 0.6 0.8 1 0 02 04 0.6 08 1

Information Fraction Information Fraction

Boundary Plot Boundary Plot

Boundary (6-scale)

Boundary (Score scale)

0 0.2 04 06 08 1 0 02 04 06 0.8 1

Information Fraction Information Fraction

Figure 7.34: Boundary Plots for Efficacy Only 1-sided Scenario

For the Efficacy Only 1-sided scenario, the efficacy exit region (highlighted in blue)
shows test statistic values higher than the Efficacy Boundary at each look will lead to
early stopping for efficacy for the Z-scale, Score Scale and )-Scale. Test statistics less
than the Efficacy Boundary are in the continuation region where the trial will proceed
to the next look.

In this example, a test statistic at the first interim analysis (Information Time = 0.25)
greater than 4.333, 7.221, 2.600 would stop the trial early for efficacy on the Z-scale,
Score Scale and §-Scale (§ = mean difference in GST1 for Two Means) respectively.
Otherwise, the trial would continue to the next look.

For the p-value Scale, an (unadjusted) test p-value less than the efficacy boundary will
lead to early stopping for efficacy. In this example, a p-value (from two sample Z-test for
GST1 Two Means) at the first interim analysis (Information Time = 0.25) less than
7.367E-06 would stop the trial early for efficacy. Otherwise, the trial would continue to
the next look.

Futility Only 1-sided Example Boundary Plots for the Futility Only 1-sided scen-
ario are shown for the four Boundary Scale options (Z-scale, p-value Scale, Score
Scale, §-Scale) in Figure 7.35.
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Boundary Plot Boundary Plot

Boundary (Z-scale)
Boundary (p-value scale)

0 0z 04 06 08 1 0 02 04 08 08 1

Information Fraction Information Fraction

Boundary Plot Boundary Plot

Boundary (Score scale)
Boundary (8-scale)

0 : 04 06 08 1 0 02 04 06 08 1
Information Fraction Information Fraction

Figure 7.35: Boundary Plots for Futility Only 1-sided Scenario

For the Futility Only 1-sided scenario, the futility exit region (highlighted in red) shows
test statistic values lower than the Futility Boundary at each look will lead to early
stopping for futility for the Z-scale, Score Scale and §-Scale. Test statistics greater
than the Futility Boundary are in the continuation region where the trial will proceed
to the next look.

In this example, a test statistic at the first interim analysis (Information Time = 0.25)
less than than 0.083, 0.139, 0.050 would stop the trial early for futility on the Z-scale,
Score Scale and ¢-Scale (§ = mean difference in GST1 for Two Means) respectively.
Otherwise, the trial would continue to the next look.

For the p-value Scale, an (unadjusted) test p-value greater than the efficacy boundary
will lead to early stopping for efficacy. In this example, a p-value (from two sample Z-test
for GST1 Two Means) at the first interim analysis (Information Time = 0.25) greater
than 0.467 would stop the trial early for futility. Otherwise, the trial would continue to
the next look.

Efficacy and Futility 1-sided Example Boundary Plots for the Efficacy and Futility
1-sided scenario are shown for the four Boundary Scale options (Z-scale, p-value
Scale, Score Scale, §-Scale) in Figure 7.36.
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Figure 7.36: Boundary Plots for Efficacy and Futility 1-sided Scenario

For the Efficacy and Futility 1-sided scenario, the efficacy exit region (highlighted in
blue) shows test statistic values greater than the Efficacy Boundary at each will look
will lead to early stopping for efficacy and the futility exit region (highlighted in red)
shows test statistic values lower than the Futility Boundary at each look will lead to
early stopping for futility for the Z-scale, Score Scale and §-Scale. Test statistics that
fall between the Efficacy Boundary and Futility Boundary are in the continuation
region where the trial will proceed to the next look.

In this example, a test statistic at the first interim analysis (Information Time = 0.25)
greater than 4.333, 7.221, 2.600 would stop the trial early for efficacy on the Z-scale,
Score Scale and §-Scale (§ = mean difference in GST1 for Two Means) respectively,
while a test statistic less than than 0.093, 0.154, 0.056 would stop the trial early for futility
for the respective scales. If the test statistic falls between 4.333 and 0.093 (Z-scale), 7.221
and 0.154 (Score Scale) or 2.600 and 0.056 (d-Scale) then the trial continues to the next
look.

For the p-value Scale, an (unadjusted) test p-value less than the efficacy boundary will
lead to early stopping for efficacy. In this example, a p-value (from two sample Z-test for
GST1 Two Means) at the first interim analysis (Information Time = 0.25) less than
7.367TE-06 would stop the trial early for efficacy, a p-value greater than 0.4631 would stop
the trial early for futility and a p-value between 7.367E-06 and 0.4631 would mean the
trial continues to the next look.

Efficacy Only 2-sided FExample Boundary Plots for the Efficacy Only 2-sided
scenario are shown for the four Boundary Scale options (Z-scale, p-value Scale,
Score Scale, )-Scale) in Figure 7.37.
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Figure 7.37: Boundary Plots for Efficacy Only 2-sided Scenario

For the Efficacy Only 2-sided scenario, the upper and lower efficacy exit regions (high-
lighted in blue) shows test statistics greater than the Upper Efficacy Boundary at
each will look or less then the Lower Efficacy Boundary will lead to early stopping for
efficacy for the Z-scale, Score Scale and /-Scale. Test statistics that fall between the
Lower Efficacy Boundary and Upper Efficacy Boundary are in the continuation
region where the trial will proceed to the next look.

In this example, a test statistic at the first interim analysis (Information Time = 0.25)
greater than 4.333, 7.221, 2.600 or less than -4.333, -7.221, -2.600 would stop the trial
early for efficacy on the Z-scale, Score Scale and §-Scale (§ = mean difference in GST'1
for Two Means) respectively. If the test statistic falls between -4.333 and 4.333 (Z-scale),
-7.221 and 7.221 (Score Scale) or -2.600 and 2.600 (6-Scale) then the trial continues to
the next look.

For the p-value Scale, the respective equivalent “Upper” (at bottom of Boundary
Plot) and “Lower” (at top of Boundary Plot) 1-sided test p-values for a directional
hypothesis are provided for comparability with the other boundary scales. However the
Lower Efficacy Boundaries are unlikely to be used directly and in practice we compare
the Upper Efficacy Bound directly to the p-value from a 1-sided test (e.g. two sample
Z-test for GST1 Two Means) or double the Upper Efficacy Bound (2U EL) and compare
this to 2-sided test p-value. In this example, at the first interim analysis (Information
Time = 0.25), the Upper Efficacy Bound p-value is 7.367E-06 so for a 1-sided test
the trial would stop early for a p-value less than 7.367E-06 and for a 2-sided test the trial
would stop early for a p-value less than 2 (7.367F — 06) i.e. 1.473E-05.

As the Upper Efficacy Bound is effectively equivalent to the 1-sided Efficacy Bound
for design with the Test Significance Level divided by two (e.g. 2-sided Test Signifiance
Level of 0.05 is equivalent to 1-sided Test Significance Level of 0.025) then the choice of
whether to design the group sequential design for a 1-sided or 2-sided test is relatively
inconsequential for positive effect sizes. This is not true where 2-sided Futility Bounds
as will be shown next!
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Futility Only 2-sided Example Boundary Plots for the Futility Only 2-sided scen-
ario are shown for the four Boundary Scale options (Z-scale, p-value Scale, Score
Scale, -Scale) in Figure 7.38.
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Figure 7.38: Boundary Plots for Futility Only 2-sided Scenario

For the Futility Only 2-sided scenario, the futility exit region (highlighted in red) shows
test statistics between the Lower Futility Boundary and Upper Futility Boundary
at each will look will lead to early stopping for futility for the Z-scale, Score Scale
and d-Scale. Test statistics that fall below the Lower Futility Boundary or above the
Upper Futility Boundary are in the continuation region where the trial will proceed
to the next look.

In this example, a test statistic at the first interim analysis (Information Time = 0.25)
between -0.285 to 0.285 (Z-scale), -0.475 to 0.475 (Score Scale) or -0.171 to 0.171 (0-
scale e.g. mean difference in GST1 for Two Means) would stop the trial early for futility
on the respective scales. If the test statistic falls below -0.285 or above 0.285 (Z-scale),
below -0.475 or above 0.475 (Score Scale) or below -0.171 or above 0.171 (§-scale) the
trial continues to the next look

For the p-value Scale, the respective equivalent “Upper” and “Lower” 1-sided test p-
values for a directional hypothesis are provided for comparability with the other boundary
scales. However both boundaries are unlikely to be used directly and in practice we can
compare two times the Upper Futility Bound directly to the p-value from a 2-sided
test. In this example, at the first interim analysis (Information Time = 0.25), the
Upper Futility Bound p-value is 0.387 so for a 2-sided test the trial would stop early
for a p-value less than 2 (0.387) = 0.774 .

2-sided Futility Boundaries are not comparable to 1-sided Futility Boundaries con-
structed at half the 2-sided Test Significance Level (e.g. 2-sided Test Significance
Level of 0.05 equivalent to 1-sided Test Significance Level of 0.025). The enclosed area
2-sided Futility Boundaries around zero are correct for a true 2-sided hypothesis where
a treatment is truly “effective” in both effect size directions but in practice most clinical
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trials have an effect size direction of interest and therefore it is recommended that equi-
valent 1-sided Futility Bounds are used as per section 7.3.5.1 unless the consequences
of 2-sided Futility Bounds are well understood.

Efficacy and Futility 2-sided Example Boundary Plots for the Efficacy and Futility
2-sided scenario are shown for the four Boundary Scale options (Z-scale, p-value
Scale, Score Scale, §-Scale) in Figure 7.39.
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Figure 7.39: Boundary Plots for Efficacy and Futility 2-sided Scenario

For the Efficacy and Futility 2-sided scenario, the upper and lower efficacy exit regions
(highlighted in blue) shows test statistics greater than the Upper Efficacy Boundary
at each will look or less then the Lower Efficacy Boundary will lead to early stopping
for efficacy for the Z-scale, Score Scale and /-Scale while the futility exit region
(highlighted in red) shows test statistics between the Lower Futility Boundary and
Upper Futility Boundary at each will look will lead to early stopping for futility for
the Z-scale, Score Scale and §-Scale. Test statistics that fall between the Lower
Futility Boundary and Upper Futility Boundary or between the Upper Futility
Boundary and Upper Efficacy Boundary are in the continuation region where the
trial will proceed to the next look.

In this example, a test statistic at the first interim analysis (Information Time = 0.25)
greater than 4.333, 7.221, 2.600 or less than -4.333, -7.221, -2.600 would stop the trial early
for efficacy on the Z-scale, Score Scale and §-Scale (§ = mean difference in GST1 for
Two Means) respectively while a test statistic at the first interim analysis (Information
Time = 0.25) between -0.291 to 0.291 (Z-scale), -0.484 to 0.484 (Score Scale) or -
0.174 to 0.174 (d-scale) would stop the trial early for futility on the respective scales. If
the test statistic falls between -4.333 and -0.291 or between 4.333 and 0.291 (Z-scale),
between -7.221 and -0.484 or between 7.221 and 0.484 (Score Scale) or between -2.600
and -0.174 or between 2.600 and 0.174 (J-scale) the trial continues to the next look

For the p-value Scale, the respective equivalent “Upper” and “Lower” 1-sided test p-
values for a directional hypothesis are provided for comparability with the other boundary
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scales. However these boundaries are unlikely to be used directly and in practice we can
compare two times the Upper Efficacy Bound and two times the Upper Futility
Bound directly to the p-value from a 2-sided test. In this example, at the first interim
analysis (Information Time = 0.25), the Upper Efficacy Bound p-value is 7.367E-6
and the Upper Futility Bound is 0.386 so for a 2-sided test the trial would stop early
for efficacy for a p-value less than 2 (7.367E — 6) = 1.473FE — 5 or stop early for futility
for a p-value greater than 2 (0.386) = 0.772.

2-sided Futility Boundaries are not comparable to 1-sided Futility Boundaries con-
structed at half the 2-sided Test Significance Level (e.g. 2-sided Test Significance
Level of 0.05 equivalent to 1-sided Test Significance Level of 0.025). The enclosed area
2-sided Futility Boundaries around zero are correct for a true 2-sided hypothesis where
a treatment is truly “effective” in both effect size directions but in practice most clinical
trials have an effect size direction of interest and therefore it is recommended that equi-
valent 1-sided Efficacy and Futility Bounds are used as per section 7.3.5.1 unless the
consequences of 2-sided Futility Bounds are well understood.

7.3.5.2 Boundary Table

The Boundary Table is a tabular summary of the group sequential boundaries as plot-
ted in the Boundary Plot. The Boundary Table appears immediately below the
Boundary Plot.

The Boundary Scale that the boundaries are shown in the Boundary Table will be
the same for the current Boundary Plot. The Boundary Scale can be the following
statistical scales: Z-scale, p-value Scale, Score Scale, J-Scale. Technical detail on
these statistical scales is provided in subsubsection 7.2.1.1 and subsubsection 7.2.4.5. The
scale can be changed from Boundary Scale... option from the Toolbar or the Edit
menu in the Toolbar or right-click context menu under the Series > Y-axis Scale
option - see section 7.3.5.3 and section 7.3.5.3 .

The Boundary Table can be saved as a .CSV or .TXT file using the Save Table...
button in the Toolbar or Edit... menu - see subsubsection 7.3.5.3.

The number of rows will equal the Number of Looks specificed in the main design table.
The number of columns will depend on the scenario and will match the Boundary Plot
scenarios outlined previously:

» Efficacy Only 1-sided (1 or 2 Sided Test? = 1, Futility Bound Calculation Method
= Don’t Calculate)

o Futility Only 1-sided (1 or 2 Sided Test? = 1, Efficacy Bound Calculation Method
= Don’t Calculate)

« Efficacy and Futility 1-sided (1 or 2 Sided Test? = 1, Efficacy Bound Calcu-
lation Method # Don’t Calculate & Futility Bound Calculation Method # Don’t
Calculate)

» Efficacy Only 1-sided (1 or 2 Sided Test? = 2, Futility Bound Calculation Method
= Don’t Calculate)

o Futility Only 1-sided (1 or 2 Sided Test? = 2, Efficacy Bound Calculation Method
= Don’t Calculate)
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o Efficacy and Futility 1-sided (1 or 2 Sided Test? = 2, Efficacy Bound Calcu-
lation Method # Don’t Calculate & Futility Bound Calculation Method # Don’t
Calculate)

An example of the Boundary Table is provided for each scenario across the difference
Boundary Scale options below. However, since the interpretation and decision rules
for these boundaries was discussed in the subsubsection 7.3.5.1 above these will not be
repeated here. The Boundary Tables here will be for the same plots shown in the
subsubsection 7.3.5.1.

Efficacy Only 1-sided Boundary Table Example Boundary Tables for the Efficacy
Only 1-sided scenario are shown for the four Boundary Scale options (Z-scale, p-
value Scale, Score Scale, /-Scale) in Figure 7.40.

Look Efficacy Bound
3.74955184

1

2 253004224 Z_Scale
3 2.01606987

4 1.72017715

Look Efficacy Bound

1 000008858 p-va lue
2 0.00554354

3 002189633 Scale
4 0.04270012

Look Efficacy Bound

1 6.24925306 SCO re

2 598670128

3 531989242 Scale

4 5.73392382

Loaok Efficacy Bound

1 2.24973110

2 1.07760623 S—Sca|e

0.69838709
0.51605374

Bow

Figure 7.40: Boundary Table for Efficacy Only 1-sided

Futility Only 1-sided Boundary Table Example Boundary Tables for the Futility
Only 1-sided scenario are shown for the four Boundary Scale options (Z-scale, p-
value Scale, Score Scale, )-Scale) in Figure 7.41.
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Figure 7.41: Boundary Table for Futility Only 1-sided
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Efficacy and Futility 1-sided Boundary Table Example Boundary Tables for the
Efficacy and Futility 1-sided scenario are shown for the four Boundary Scale options

(Z-scale, p-value Scale, Score Scale, /-Scale) in Figure 7.42.

Look

NN TV R

Look

W

Look

T

Look

o o

Efficacy Bound
3.749557184
2.53994224
201606987
172017715

Efficacy Bound
0.00008858
0.00554354
0.02189633
0.04270012

Efficacy Bound
6.24925306
5.98670128
5.81989242
5.73392382

Efficacy Bound
2.24973110
1.07760623
0.69838709
0.51605314

Futility Bound
-0.13837441
0.608431186
1.18432409
172017715

Futility Bound
0.55502774
0.27145077
0.11814240
0.04270012

Futility Bound
-0.23062402
1.43408600
3.41884917
5.73392382

Futility Bound
-0.08302465
0.25813548
0.41026190
0.51605314

Z-scale

p-value
Scale

Score
Scale

5-Scale

Figure 7.42: Boundary Table for Efficacy and Futility 1-sided
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Efficacy Only 2-sided Boundary Table Example Boundary Tables for the Efficacy
Only 2-sided scenario are shown for the four Boundary Scale options (Z-scale, p-
value Scale, Score Scale, /-Scale) in Figure 7.43.
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Figure 7.43: Boundary Table for Efficacy Only 2-sided

Efficacy Bound (Lower)
-4.33263365
-2.96313104
-2.35904432
-2.01409027

Efficacy Bound (Lower)
0.99999263
0.99847737
0.99083897
0.97799997

Efficacy Bound (Lower)
-7.22105608
-6.98416685
-6.80997437
-6.71363422

Efficacy Bound (Lower)
-2.59958019
-1.25715003
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Futility Only 2-sided Boundary Table Example Boundary Tables for the Futility
Only 2-sided scenario are shown for the four Boundary Scale options (Z-scale, p-
value Scale, Score Scale, )-Scale) in Figure 7.44.
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Figure 7.44: Boundary Table for Futility Only 2-sided

Futility Bound (Lower)
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Efficacy and Futility 2-sided Boundary Table Example Boundary Tables for the
Efficacy and Futility 2-sided scenario are shown for the four Boundary Scale options
(Z-scale, p-value Scale, Score Scale, /-Scale) in Figure 7.45.
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Figure 7.45: Boundary Table for Efficacy and Futility 2-sided
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7.3.5.3 Toolbar

The Toolbar for the group sequential Boundary Plot provides access to options to
edit the Boundary Plot, change the statistical scale the Boundary Plot is displayed
on and save the Boundary Plot or Boundary Table. The Toolbar is found at the
top of the Boundary Plot window and consistes of the Edit... dropdown, Boundary
Scale dropdown, Save Plot button and Save Table button. The Toolbar specifically
is shown in Figure 7.46.

Edit.. W Boundary Scale.. “ @ Save Plot Ig' Save Table

Figure 7.46: Boundary Plot Toolbar

Edit... The Edit... dropdown provides options to edit the visual aspects of the plot
such as the titles, legend and color schemes while also providing options for printing and
saving. The Edit menu for the Boundary Plot is similar to that described in section 1.9
for all plots so may be reviewed for additional context.

When selected the Edit... dropdown will display the options available for editing, printing
and saving the Boundary Plot. Dropdown items with a » at their right edge indicate
a sub-menu which will open when that option is highlighted or selected. This Edit...
menu can also be selected from the right-click context menu within the Boundary Plot.
An example of the Edit... dropdown menu being open via the Toolbar is shown in
Figure 7.47.

GST15-1 | Group Sequential Report JENILUELRSWE Error Spending Plot v X
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2.01409027 2.01409027

B w N

Figure 7.47: Boundary Plot Edit Menu
The full set of Edit... dropdown menu options is:

e Print: Open Print window for Boundary Plot

e Print Preview: Open Print Preview window for Boundary Plot
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The

Titles »: Edit Main Title, X-axis Title and Y-axis Title of Boundary Plot
Series »: Edit Efficacy Bounds and Futility Bounds plot series of Boundary Plot
Gridlines »: Add or remove gridlines from Boundary Plot

Legend »: Edit Boundary Plot Legend

Save Plot As: Save Boundary Plot as .pdf or .jpeg file

Save Table As: Save Boundary table as .csv or .txt file

Print and Print Preview options are available as per all other plots so will not

be discussed further. The Save Plot As and Save Table As options are equivalent to
the Save Plot and Save Table buttons in the Toolbar buttons so will be discussed
separately.

A breakdown of the Titles, Series, Gridlines and Legend sub-menus is provided next.

Titles The Titles menu allows the user to edit the Chart Title, X-axis Title and
Y-axis Title by choosing to show or hide that title, rename that title and change the

font

of that title. The tabular summary of the Titles menu , where » indicate where

an option will open an additional sub-menu and = indicates where an option will open a
separate pop-out window, is as follows:

Titles »
— Chart Title »

« Hide/Show Chart Title: Hide or show main Chart Title, name will de-
pend on whether Chart Title is currently shown in Boundary Plot -
Default: Show

* Rename = : Opens Rename Title window where Chart Title can be
edited. Default: Boundary Plot

x Font = : Opens Update Title Font window for Chart Title where
can edit the Font (select desired font from dropdown), Font Size, Font
Type (Bold, Italics), Font Color (select from Color Panel or create
custom color in Colors window opened if select More Colors) Default:
Font: Segoe UI; Font Size: 21; Font Type: No Bold, No Italics; Font
Color: Black (Automatic)

— X-axis Title »

« Hide/Show Chart Title: Hide or show X-axis Title, name will depend on
whether X-axis Title is currently shown in Boundary Plot - Default:
Show

x Rename = : Opens Rename Title window where X-axis Title can be
edited - Default: Selection from “Series > X-axis Scale” edit menu

x Font = : Opens Update Title Font window for X-axis Title where
can edit the Font (select desired font from dropdown), Font Size, Font
Type (Bold, [talics), Font Color (select from Color Panel or create
custom color in Colors window opened if select More Colors) - Default:
Font: Segoe Ul; Font Size: 16; Font Type: No Bold, No Italics; Font
Color: Black (Automatic)
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— Y-axis Title »

« Hide/Show Chart Title: Hide or show Y-axis Title, name will depend on
whether Y-axis Title is currently shown in Boundary Plot - Default:
Show

x Rename = : Opens Rename Title window where Y-axis Title can be
edited - Default: Selection from “Series > Y-axis Scale” edit menu

x Font = : Opens Update Title Font window for X-axis Title where
can edit the Font (select desired font from dropdown), Font Size, Font
Type (Bold, Italics), Font Color (select from Color Panel or create
custom color in Colors window opened if select More Colors) - Default:
Font: Segoe UI; Font Size: 16; Font Type: No Bold, No Italics; Font
Color: Black (Automatic)

Series The Series menu allows the user to edit the X-axis Scale, the Y-axis Scale,
the number of Decimal Places shown in the plot tooltip, edit the Efficacy Bounds
aesthetic aspects and the edit the Futility Bounds aesthetic aspects. The tabular
summary of the Series menu , where » indicate where an option will open an additional
sub-menu and = indicates where an option will open a separate pop-out window, is as
follows:

o X-axis Scale » : Choose the scale on which the Boundary Plot X-axis is defined.
The sub-menu has the following options to select: Information Fraction, Cumulative
Information, Total Sample Size - Default: Information Fraction

e Y-axis Scale » Choose the scale on which the Boundary Plot Y-axis is defined.
This sub-menu is equivalent to the Boundary Scale toolbar option and has the
following options: Z-scale, p-value Scale, Score Scale, d-Scale Default: Same as
Boundary Scale

e Decimal Places = Opens Choose Number of Decimal Places window where
user can set the number of decimals displayed in Boundary Plot tooltip - Default:
8

« Efficacy Bounds »

— Marker Style »: Choose the marker style of the X-axis series plot points. This
sub-menus has the following options to select: Hidden, Circle, Cross, Hexagon,
Ring, Square, Star, Triangle - Default: Circle

— Marker Size = : Opens Update Marker Size window where user can set

size of X-axis series plot points - Default: 8

— Rename = : Opens Rename Series window where user can edit name of
X-axis series shown in the Legend - Default: Efficacy Bounds

— Color = : Opens Select Series Color window where user can edit color of X-
axis plot points and shaded areas. Select from Color Panel or create custom
color using More Colors - Default: Blue

— Transparency »: Choose transparency of the shaded area for efficacy bound
exit and X-axis plot points. This sub-menu has the following options: 0%,
10%, 20%, 30%, 40%, 50%, 60%, 70%, 80%, 90%, 100% - Default: 50%
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o Futility Bounds »

— Marker Style »: Choose the marker style of the Y-axis series plot points. This
sub-menus has the following options to select: Hidden, Circle, Cross, Hexagon,
Ring, Square, Star, Triangle - Default: Circle

— Marker Size = : Opens Update Marker Size window where user can set
size of Y-axis series plot points - Default: §

— Rename = : Opens Rename Series window where user can edit name of
X-axis series shown in the Legend - Default: Futility Bounds

— Color = : Opens Select Series Color window where user can edit color of X-
axis plot points and shaded areas. Select from Color Panel or create custom
color using More Colors - Default: Red

— Transparency »: Choose transparency of the shaded area for futility bound
exit and Y-axis plot points. This sub-menu has the following options: 0%,

10%, 20%, 30%, 40%, 50%, 60%, 70%, 80%, 90%, 100% - Default: 50%

Gridlines The Gridlines menu consists of two options: Show/Hide X-axis Grid-
lines and Show/Hide Y-axis Gridlines. The options will change between Show and
Hide depending on if that gridlines option is currently shown in the Boundary Plot .

By default both the X-axis and Y-axis gridlines are not shown. When shown the major
gridlines will be shown at the numbered major ticks on the relevant axis and the minor
gridlines at the 4 unnumbered ticks between each major tick.

Legend The Legend menu allows the user to edit the Boundary Plot Legend
including whether to show the legend, legend border color and the vertical and horizontal
position of the legend. The tabular summary of the Legend menu , where » indicate
where an option will open an additional sub-menu and = indicates where an option will
open a separate pop-out window, is as follows:

o Show/Hide Legend: Hide or show Legend, name will depend on whether Legend
is currently shown in Boundary Plot - Default: Show

e Border Color = Opens Select Legend Border Color window where user can
edit color of border of the Legend. Select from Color Panel or create custom color
using More Colors - Default: Black

o Horizontal Position »: Choose the horizontal position of the plot and whether the
plot should be inside or outside the Boundary Plot area. This sub-menu has the
following options: Left, Outside; Left, Inside; Center; Right, Outside; Right, Inside
- Default: Right, Outside

o Vertical Position »: Choose the vertical position of the plot and whether the plot
should be inside or outside the Boundary Plot area. This sub-menu has the

following options: Top, Outside; Top, Inside; Center; Top, Outside; Top, Inside -
Default: Center
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Boundary Scale The Boundary Scale dropdown provides the option to quickly change
the statistical scale on which the group sequential boundaries are shown on the Y-axis.

The Boundary Scale dropdown contains the following four options: Z-scale, p-value
Scale, Score Scale, §-Scale. These options are also available from the Edit menu under
Edit > Series > Y-axis Scale.

The default scale the Boundary Plot will depend either on the option selected in the
GST Options table for the Boundary Scale or (if Efficacy Boundary Calculation
Method = Custom Boundary) Efficacy Boundary Scale rows. Where neither
field is available or Efficacy Boundary Scale = Alpha Error, the Z-scale is selected.
After an option is selected, the Boundary Plot and Boundary Table will automatically
update to the boundaries to the selected statistical scale. See subsubsection 7.2.4.5 for
technical detail on the statistical scale conversions.

Note that for 2-sided efficacy boundaries, the p-value Scale will split the p-value at each
look into «v/2 for Upper Efficacy Bound and 1 — a/2 for the Lower Efficacy Bound as per
the GST Outputs table. This is done for consistency with the other boundary scales
but in practical terms if using a standard statistical test the efficacy boundary would be
crossed if it provided a p-value of < « i.e. twice the Upper Efficacy p-value Bound at
each look.

Save Plot The Save Plot button will open the Save As... window as seen in Figure 1.17
except that the available Save as type filetypes will be .pdf and .jpeg. Use the Naviga-
tion bar on the left and main explorer window to find the desired save location, enter the
desired file name in the File Name field and select Save to save the plot in the selected
filetype above.

Save Table The Save Table button will open the Save As... window as seen in
Figure 1.17 except that the available Save as type filetypes will be .csv and .txt. Use
the Navigation bar on the left and main explorer window to find the desired save location,
enter the desired file name in the File Name field and select Save to save the table in
the selected filetype above.

7.3.6 Error Spending Plot

The Error Spending Plot provides a visual and tabular summary of Error Spending
Function for the Spending Function method where a specified proportion of the Alpha
(Type I («)) and Beta (Type II (5)) errors are spent at each interim analysis.

The Alpha Error is the cumulative probability of exiting for efficacy under the null hypo-
thesis (e.g. mean difference = 0 in GST1 Two Means) at any look up to and including the
current look. The Beta Error is the cumulative probability of exiting for futility under the
alternative hypothesis (e.g. mean difference = 0 in GST1 Two Means) at any look up to
and including the current look. 1-Beta Error is also known as the statistical power. See
subsection 7.2.3 and subsubsection 7.2.4.1 for the technical details on Type I and Type
IT errors, and the Lan-DeMets Spending Function method.

For Spending Functions, the error spent is provided in the Cumulative Alpha and/or
Cumulative Beta rows of the GST Outputs table in the GSTXS-Y side-table - see
subsubsection 7.3.2.2.
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For methods other than the Spending Function such as Wang-Tsiatis and Unified
Family, the Error Spending Plot provides the estimated Type I and Type II error
at each look based on the Incremental Exit (Boundary Crossing) Probabilities
table in the Group Sequential Report. Type I error can be calculated as the sum of
the Under HO - Efficacy rows up to the current look and Type II error as the sum of
the Under H1 - Futility rows up the current look. Incremental exit probabilities are
the probability of exiting at that specific look only.

The Error Spending Plot can be opened by selecting the Error Spending Plot tab
at the top of the Group Sequential Side-table panel after a solver calculation has
occured in the associated main design table column.

The Error Spending Plot allows the user to visually inspect the cumulative Type I and
Type II error spent at each analysis and also export this plots to assist in the exploration
and communcation of a planned group sequential design.

An example Error Spending Plot is shown in Figure 7.48.
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Figure 7.48: Group Sequential Boundary Error Spending Plot

The Error Spending Plot tab consists of two primary elements: the Error Spending
Plot (middle) and the Toolbar (top). Each of these will be summarized next.

7.3.6.1 Error Spending Plot

The Error Spending Plot provides a visual and tabular summary of Error Spending
Function for the Spending Function method where a specified proportion of the Alpha
(Type I (o)) and Beta (Type II (/3)) errors are spent at each interim analysis or, for non-
spending function methods, the estimated Type I and Type II error at each look based
on the Incremental Exit (Boundary Crossing) Probabilities table in the Group
Sequential Report.

The Error Spending Plot is a line plot where the Alpha Error and/or Beta Error
probabilties are plotted against a measure of trial progress on the X-axis.
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X-axis The X-axis corresponds to how far into the trial each analysis occurs.

The X-axis will range from zero to the maximum value for the specified X-axis parameter
scale (e.g. 1 for Information Fraction). The first point will be plotted at a value of
zero where the error spent will also be zero i.e. co-ordinate (0,0).

The X-axis is plotted on the Information Fraction scale. The scale can be changed
from the Edit menu in the Toolbar or right-click context menu under the Series > X-
axis Scale option. By default, the X-axis will be shown on the Information Fraction
scale which is equivalent to the proportion of the total sample size analyzed at each
analysis. The name of the X-axis by default will be “Information Fraction”. Use Titles
> X-axis Scale option from the Edit menu to change the X-axis Title (show/hide,
X-axis name, X-axis font).

Note that Total Sample Size scale is not available for Information-Based Design (GSTO)
and that Total Sample Size is replaced with Total Events for Survival Analysis (e.g.
GST3).

Y-axis The Y-axes corresponds to the amount of Alpha Error and/or Beta Error
spent at each look. The left Y-axis will correspond to the amount of Alpha Error
spent and the right Y-axis will correspond to the amount of Beta Error spent.

Both Y-axis will have a minimum value of zero for their range. The left Y-axis range
will scale such that the Total Alpha (i.e. Test Significance Level from main design
table) is the upper bound, with a small buffer for aesthetic clarity. The right Y-axis
range will scale such that the Total Beta (i.e. 1-Power from main design table) is the
upper bound, with a small buffer for aesthetic clarity. NB: The left and right axis
are not on the same scale if both are present.

The name of left Y-axis will be set to “Alpha Error” and the right Y-axis to “Beta
Error” if Alpha Error and Beta Error are both active. If only one of Alpha Error or
Beta Error are active then there will be only a left Y-axis named after the active error
term. Use Titles > Y-axis Scale (Left/Right) option from the Edit menu to change
the Y-axis Title (show/hide, Y-axis name, Y-axis font).

Alpha Error By default, the Alpha Error is plotted as a blue line with each point
providing the cumulative amount of alpha spent at each look. The Alpha Error will
equal 0 when the minimum X-axis value of zero and, for the Spending Function method,
will equal the Test Significance Level for the maximum X-axis value (e.g. 1 for Inform-
ation Time). For other methods than spending function, the Alpha Error will equal
the Exact Sig. Level field in the Test Parameters section of the Group Sequential
Report for the maximum X-axis value - seesubsection 7.3.4.

The Alpha Error color can changed from the Edit menu in the Toolbar or right-click
context menu under the Series option.

Beta Error By default, the Beta Error is plotted as a red line with each point providing
the cumulative amount of beta spent at each look. The Beta Error will equal 0 when
the minimum X-axis value of zero and will equal 1 - Power for the maximum X-axis
value.
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The Beta Error color can changed from the Edit menu in the Toolbar or right-click
context menu under the Series option.

Legend The Spending Function Plot Legend provides an indication of the color for
the Alpha Error and Beta Error series.

By default, the Legend is shown to the right of the boundary plot. To toggle whether
the Legend is shown, change the location of the Legend or change the Legend Border
use the Edit menu in the Toolbar or right-click context menu under the Legend option.
The colors in the plot and legend are defined under the Series option in the Edit menu.

Tooltip The Error Spending Plot Tooltip provides the user information about the
Alpha Error and/or Beta Error at a specific look based on which look is highlighted
by the cursor within the area of the Error Spending Plot. When the cursor is not
within the Boundary Plot area the Tooltip will not be shown as in Figure 7.48. The
values shown in the Tooltip will correspond to the values provided in the Boundary
Table for the highlighted look.

A Error Spending Plot with the Tooltip active for the second interim look (third
point ignoring Information Time = 0 “look”) is shown in Figure 7.49.
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Figure 7.49: Error Spending Plot Tooltip

Resize Boundary Plot The grey bars at the bottom and to the right of the can be
used to re-size the Boundary Plot. Click and drag the grey bar to increase or de-
crease the vertical and horizontal size respectively. The Error Spending Plot will also
automatically scale if the side-table panel is resized.

Editing and Saving Options to edit, save or print the Error Spending Plot are
available from the Toolbar in the top-right of the Error Spending Plot window or
from the right-click context menu within the Error Spending Plot. These options are
summarized in subsubsection 7.3.6.2.
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To provide additional clarity about the behavior of the Error Spending Plot for different
design scenarios examples of the changes due to changes to Efficacy Bound Calculation
Method and Futility Bound Calculation Method rows and the Boundary Scale...
option from the Toolbar are provided next for the following scenarios:

o Alpha Error Only - Efficacy Only (Futility Bound Calculation Method = Don’t
Calculate)

o Beta Error Only - Futility Only (Efficacy Bound Calculation Method = Don’t
Calculate)

o Alpha Error and Beta Error - Efficacy and Futility (Efficacy Bound Calcu-
lation Method # Don’t Calculate & Futility Bound Calculation Method # Don’t
Calculate)

Alpha Error Only - Efficacy Only An example Error Spending Plot for the Effic-
acy Only scenario is shown for a 4-look equally spaced looks O’Brien-Fleming
Spending Function in Figure 7.50.
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Figure 7.50: Error Spending Plot - Alpha Error Only

For the Alpha Error Only scenario there is only one Y-axis and it is for the Alpha
Error.

Beta Error Only - Futility Only An example Error Spending Plot for the Futil-
ity Only scenario is shown for a 4-look equally spaced looks Pocock Spending
Function in Figure 7.51.
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Figure 7.51: Error Spending Plot - Beta Error Only
For the Beta Error Only scenario there is only one Y-axis and it is for the Beta Error.

Alpha Error and Beta Error - Efficacy and Futility An example Error Spending
Plot for the Efficacy and Futility scenario is shown for a 4-look equally spaced
looks with Hwang-Shih-DeCani Alpha Spending Function (y = —4) and Power
Family Beta Spending Function (p = 1) in Figure 7.52.
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Figure 7.52: Error Spending Plot - Alpha Error Only

For the Alpha Error and Beta Error scenario there are two Y-axis. The left Y-axis
is for the Alpha Error and the right Y-axis is for the Beta Error. Both Y-axis scales
are not scaled to the same maximum error rate.

7.3.6.2 Toolbar

The Toolbar for the Error Spending Plot provides access to options to edit the Error
Spending Plot and save Error Spending Plot. The Toolbar is found at the top of
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the Error Spending Plot window and consistes of the Edit... and Save Plot button.
The Toolbar specifically is shown in Figure 7.53 with the Edit.. dropdown menu open.

Edit... W @ Save Plot

= Print
a Print Preview
Titles... b

Series... b
Gridlines... »

Legend... !
l.il Save As

Figure 7.53: Boundary Plot Toolbar

Edit... The Edit... dropdown provides options to edit the visual aspects of the plot such
as the titles, legend and color schemes while also providing options for printing and saving.
The Edit menu for the Error Spending Plot is similar to that for the Boundary Plot
and for plots generally.

When selected the Edit... dropdown will display the options available for editing, printing
and saving the Error Spending Plot. Dropdown items with a » at their right edge
indicate a sub-menu which will open when that option is highlighted or selected. This
Edit... menu can also be selected from the right-click context menu within the Error
Spending Plot.

The full set of Edit... dropdown menu options is:
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Print: Open Print window for Error Spending Plot
Print Preview: Open Print Preview window for Error Spending Plot
Titles »: Edit Main Title, X-axis Title and Y-axis Title of Error Spending Plot

Series »: Edit Color of Alpha Error and/or Beta Error series in Error Spend-
ing Plot

Gridlines »: Add or remove gridlines from Error Spending Plot
Legend »: Edit Error Spending Plot Legend
Save As: Save Error Spending as .pdf or .jpeg file

The Print and Print Preview options are available as per all other plots so will not be
discussed further. The Save As options is equivalent to the Save Plot buttons in the
Toolbar buttons so will be discussed separately.

A breakdown of the Titles, Series, Gridlines and Legend sub-menus is provided next.

Titles The Titles menu allows the user to edit the Chart Title, X-axis Title and
Y-axis Title by choosing to show or hide that title, rename that title and change the
font of that title. The tabular summary of the Titles menu , where » indicate where
an option will open an additional sub-menu and = indicates where an option will open a
separate pop-out window, is as follows:

Titles »
— Chart Title »

« Hide/Show Chart Title: Hide or show main Chart Title, name will de-
pend on whether Chart Title is currently shown in Error Spending
Plot - Default: Show

x Rename = : Opens Rename Title window where Chart Title can be
edited. Default: Error Spending Plot

x Font = : Opens Update Title Font window for Chart Title where
can edit the Font (select desired font from dropdown), Font Size, Font
Type (Bold, Italics), Font Color (select from Color Panel or create
custom color in Colors window opened if select More Colors) Default:
Font: Segoe UI; Font Size: 21; Font Type: No Bold, No Italics; Font
Color: Black (Automatic)

— X-axis Title »

« Hide/Show Chart Title: Hide or show X-axis Title, name will depend
on whether X-axis Title is currently shown in Error Spending Plot -
Default: Show

* Rename = : Opens Rename Title window where X-axis Title can be
edited - Default: Information Time

x Font = : Opens Update Title Font window for X-axis Title where
can edit the Font (select desired font from dropdown), Font Size, Font
Type (Bold, [talics), Font Color (select from Color Panel or create
custom color in Colors window opened if select More Colors) - Default:
Font: Segoe Ul; Font Size: 16; Font Type: No Bold, No Italics; Font
Color: Black (Automatic)
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— Y-axis Title » - Note if Alpha and Beta Error Active then Y-axis
replaced with Y-axis Title (Left) and Y-axis Title (Left) which have
same options and defaults as below except where indicated

« Hide/Show Chart Title: Hide or show Y-axis Title, name will depend
on whether Y-axis Title is currently shown in Error Spending Plot -
Default: Show

* Rename = : Opens Rename Title window where Y-axis Title can be
edited - Default: Alpha Error for Left Y-azxis and Beta Error for Right
Y-axis (if present), unless Beta Error only then Left Y-axis is Beta Error

x Font = : Opens Update Title Font window for X-axis Title where can
edit the Font (select desired font from dropdown), Font Size, Font Type
(Bold, [talics), Font Color (select from Color Panel or create custom
color in Colors window opened if select More Colors) - Default: Font:
Segoe UI; Font Size: 16; Font Type: No Bold, No Italics; Font Color: Left
Y-axis: Blue unless Beta Error only then Red, Right Y-axis: Red

Series The Series menu contains two options: Select color for alpha error and
Select color for beta error. If either the Alpha Error or Beta Error is not active
in the plot then that color option will be not be selectable (greyed out).

Selecting either option will open the Select Series Color window where the user can
edit color for the selected error series. Select from Color Panel or create custom color
using More Colors.

By default, the Alpha Error series will be blue and the Beta Error series will be red.

Gridlines The Gridlines menu consists of two options: Show/Hide X-axis Grid-
lines and Show/Hide Y-axis Gridlines. The options will change between Show and
Hide depending on if that gridlines option is currently shown in the Error Spending
Plot . By default both the X-axis and Y-axis gridlines are not shown. When shown the
major gridlines will be shown at the numbered major ticks on the relevant axis and the
minor gridlines at the 4 unnumbered ticks between each major tick.

Legend The Legend menu allows the user to edit the Error Spending Plot Le-
gend including whether to show the legend, legend border color and the vertical and
horizontal position of the legend. The tabular summary of the Legend menu , where
» indicate where an option will open an additional sub-menu and = indicates where an
option will open a separate pop-out window, is as follows:

o Show/Hide Legend: Hide or show Legend, name will depend on whether Legend
is currently shown in Error Spending Plot - Default: Show

e Border Color = Opens Select Legend Border Color window where user can
edit color of border of the Legend. Select from Color Panel or create custom color
using More Colors - Default: Black

o Horizontal Position »: Choose the horizontal position of the plot and whether the
plot should be inside or outside the Error Spending Plot area. This sub-menu
has the following options: Left, Outside; Left, Inside; Center; Right, Outside; Right,
Inside - Default: Right, Outside
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o Vertical Position »: Choose the vertical position of the plot and whether the plot
should be inside or outside the Error Spending Plot area. This sub-menu has
the following options: Top, Outside; Top, Inside; Center; Top, Outside; Top, Inside
- Default: Center

Save Plot The Save Plot button will open the Save As... window as seen in Figure 1.17
except that the available Save as type filetypes will be .pdf and .jpeg. Use the Naviga-
tion bar on the left and main explorer window to find the desired save location, enter the
desired file name in the File Name field and select Save to save the plot in the selected
filetype above.

7.3.7 Group Sequential Options Tab

The Group Sequential Options Tab provides access to additional tuning parameters
for the group sequential algorithm (see subsection 7.2.2 for technical detail) and for choices
regarding issues such as integer rounding for sample size or the events.

To open the Group Sequential Options Tab select the Options tab from the bottom
of the Help window to the right of the main design table. An example where the Options
tab is highlighted and has been selected is provided in for GST1 - Group Sequential
Design for Two Means.

&% nQuery = X

File Edit View Assistants Predict Plot Help

IEmEd ®Q! S il ~
Home X | Group Sequential Des x | + -
* || Options i3
1 2 3 4 5 6 7 8 9 e
» | Test Significance Level, « A
R 20
1 0r 2 Sided Test? 1 1 1 1 1 1 1 1 1
Extreme Z 8
Number of Looks, J .
Integer Interim N Yes
Group 1 Mean, , N
Two-Sided Power Yes
Group 2 Mean,
Mean Difference, u, - 1, ®
Group 1 Standard Deviation, o,
Group 2 Standard Deviation, o, R
Efficacy Bound Calculation Method Spending Func... Spending Func... Spending Func.. Spending Func... Spending Func.. Spending Func... Spending Func.. Spending Func... Spendin¢ This is the value for R which is used in the integration
Futility Bound Calculation Method Don't Calculate | Don't Calculate ~ Don't Calculate | Don't Calculate | Don't Calculate  Don't Calculate  Don't Calculate | Don't Calculate | Don't C: algorithm in all cases except where two-sided futility
Group 1 Sample Size, n, + |} boundaries are concerned.
< >

v :’ Suggestion:

The default value is 20. Increasing this value will
W E include accuracy but may extend calculation time.
Note that Jennison & Turnbull (2000) indicate that
increasing this value may be necessary if gaps
between information fractions are quite small.

The value cannot be empty. If the value is deleted, it
will be reset to the default value. If the value is setto a
value below the minimum or above the maximum
allowable value, it will be reset to the minimum or
maximum value.

Acceptable Entries: v
Output Options

@ Group Sequential Designs for Two Means (Spending Function, Haybittle-Peto, Wang-Tsiatis, Unified Family, Custom Boundaries)-1

Figure 7.54: Group Sequential Menu Options Tab

The table of Group Sequential Options will be shown at the top of the window. Edit
the desired fields in the Group Sequential Options table to update how the group
sequential calculations are conducted for all columns in the currently open table.

A Help card is provided below the Group Sequential Options table which provides
the definition, suggestions for setting the value and the acceptable entries range for that
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field. The Help card will update automatically to reflect the currently selected field in
the Group Sequential Options table. The Help card can be hidden by selecting the 1
button between the Group Sequential Options and Help card. To re-open the Help
Card, select the | in the same spot.

The set of parameters shown in the Group Sequential Options Tab will depend on
the specific GST table being used. For example, the Integer Interim N field is not
included in GSTO (Information-Based Group Sequential Design) as this table uses the
Information directly which is real value so never requires rounding to the nearest integer
unlike the sample size (N).

The Group Sequential Options Tab will contain the following fields (applicable tables
in brackets for each field) follows. A brief summary is provided with additional detail
available, including the allowable range, in the Help card for each option within the
Options tab.

7.3.7.1 Extreme Z-value (All GST Tables)

The bound for the Z-statistic used by the search algorithm when searching for the group
sequential boundaries. The search algorithm will search from [—Ze ireme, Zewtreme) -

By default this will equal 8. This is adequate for any reasonable normally distributed
statistic e.g. under null hypothesis (¢ (—8) = 6.220961e — 16).

7.3.7.2 R (All GST Tables)

The turning parameter used to determine the number of points that will be used to
numerically evaluate the integral. See subsection 7.2.2 for details.

By default this will be set to 20. This is reasonable for most group sequential designs.

7.3.7.3 Two-Sided Power (GSTO0, GST1, GST2, GST3)

Set whether the lower tail efficacy exit probabilities under the alternative hypothesis
should be included when calculating the exact power for a two-sided test.

The default is Yes, where the power will include the upper and lower efficacy exit prob-
abilties under the alternative hypothesis - this is equivalent to the sum of all the Under
H1 - Lower Efficacy and Under H1 - Upper Efficacy values from Output table
from the Group Sequential Report. Selecting No will exclude the lower efficacy exit
probabilities - this is equivalent to taking only the sum of the Under H1 - Upper
Efficacy column from the Output table from the Group Sequential Report. See
subsection 7.3.4 for additional detail on the Group Sequential Report.

7.3.7.4 Integer Interim N (GST1, GST2)

Integer Interim N sets whether the interim sample sizes will be rounded to the nearest
integer after finding the maximum sample size. This will re-run the solver using the
updated maximum information to give the exact power.

By default, this is set to Yes. For most cases, this will make minimal difference.
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7.3.7.5 Rounded N & E (GST3)

Rounded N & E controls whether the sample size (N) and events (E) will be rounded
to the nearest integer - this is applied to both the interim values and the maximum values
of the sample size and events unlike Integer Interim N which only affects the interim
sample sizes.

By default, this is set to Yes. There can be substantial differerences in the events and
sample size depending on if rounding is used so the user may want to explore the effect
of the option thoroughly.
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8 Group Sequential Design Simulation
Tool

The Group Sequential Design (chapter 7) and Group Sequential Design Simulation fea-
tures will only be available to users if an nQuery Advanced Pro license is active. Active
packages are displayed in the Packages section on the Home tab. To purchase additional
packages, see www. statsols. com.

8.1 Group Sequential Design Simulation Overview

Understanding the operating characteristics of adaptive designs (where a decision or
change is made to the trial based on interim data) such as group sequential designs
is vital to generate trial designs which have strong performance for success criteria such
as Type I error control, high statistical power and low average sample size. This informa-
tion can help illustrate the value of a given adaptive design by allowing comparison to an
equivalent fixed term trials, other types of adaptive design or the same type of adaptive
design with different input parameters.

Monte Carlo simulation (referred to as simply simulation from hereon) is a powerful and
flexible tool for assessing the operating characteristics of a given adaptive design over
a wide variety of scenarios. For example, the FDA strongly supported simulation as a
tool for assessing the performancen of an adaptive design in their Adaptive Design
Clinical Trials for Drugs and Biologics Guidance for Industry Guidance Docu-
ment published in 2019. Simulation can find the operating characteristics not only for
the standard null hypothesis or alternative hypothesis scenario but also easily for any
arbitrary hypothesis and data generating process.

In nQuery, the Group Sequential Design Simulation Tool provides a powerful and
accessible tool for performing simulations for the wide variety of group sequential designs
scenarios available in nQuery. For detail on the group sequential design tables available
in nQuery see chapter 7.

The following chapter provides an overview on how to use the Group Sequential Design
Simulation Tool in the following sections:

e Opening Group Sequential Design Simulation Tool
— From Assistants Menu
— From Group Sequential Design (GST) Tables

e Group Sequential Design Simulation Tool Layout

e Group Sequential Design Simulation Input Steps
— Step 0: Select GST Simulation Type
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8.2 Opening Group Sequential Design Simulation Tool

— Step 1: Simulation Inputs
— Step 2: Sequential Design Inputs
— Step 3: Boundary Table
— Step 4: Simulation Controls
o Group Sequential Design Simulation Outputs
— Simulation Report
— Rejection Plot
— Boundary Plot
» Saving/Loading Group Sequential Design Simulations
e Group Sequential Design Simulation Technical Background
— Data Generating Process
— Test Statistic Calculation
— Group Sequential Boundaries
— Additional Input Options
— Group Sequential Outputs

Opening Group Sequential Design Simulation Tool (section 8.2) will cover the
steps required to open the Group Sequential Design Simulation Tool from either
the Assistants File menu or from within a Group Sequential Design table based on
the specified group sequential design.

Group Sequential Design Simulation Tool Layout (section 8.3) provides a high-
level summary of the Group Sequential Design Simulation Tool user interface.

Group Sequential Design Simulation Input Steps (section 8.4) provides a detailed
per-step breakdown of the input fields required to generate simulation results using the
Group Sequential Design Simulation Tool.

Group Sequential Design Simulation Outputs () provides a breadown of the results
and plots generated after running a simulation using the Group Sequential Design
Simulation Tool

Saving/Loading Group Sequential Design Simulations provides an overview of
how to save and open Group Sequential Design Simulation Tool files using the
nqgs file type.

Group Sequential Design Simulation Technical Background provides the technical
details about statistical methods used by the Group Sequential Design Simulation
Tool including the data generating process using to simulate data, the options for gener-
ating the test statistics and boundary adjustments, the group sequential boundary table
for each available statistical scale and how summary results in the simulation report are
generated.

8.2 Opening Group Sequential Design Simulation Tool

There are two methods available to open the Group Sequential Design Simulator:
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e Select Group Sequential Design Simulator option from the Assistants file
menu

o Open from within a Group Sequential Design Table using the GST Simulation
button

The method selected to open the Group Sequential Design Simulator will affect at
which Input Step the tool will open at and which default values (if any) are provided for
the various fields at each Input Step so the route used to open the simulator tool should
be carefully considered - see section 8.4 for details on the Group Sequential Design
Simulator Input Steps.

An overview of each method to open the Group Sequential Design Simulator is
provided next.

8.2.1 Open GSD Simulation Tool From Assistants Menu

The Group Sequential Design Simulation can be opened from the Assistants file
menu. The Assistants file menu is found at the top of the nQuery application. The
Group Sequential Design Simulation option is highlighted within the Assistants
file menu in Figure 8.1.

& nQuery

File Edit View Predict Plot Help

1B i p X il 14l ~
[=]  Standard Deviation .
o

[& Datakntry

“D Recent Files

FH  Posterior Error Rate Calculator
GSTO 2 Sided Efficacy Only Example.nqt
[— Create Prediction & .. shortcut-targets-by-id » 1FH2Wdctpywt6gb9BwiOu2-qtTPMH797v » nQuery 9.4 Spring 2024 Prototypes » Pro - Adapt

Create Randomization List

|/ Group Sequential Design Simulation

Open nQuery File S Create Randomization List
ndomi

¢k Packages 2 Help & Support

Package Activated B Manual
@ Online Help
& My Account
1} Getting Started
£ Contact Us
3 Create Support Ticket

@ Home nQuery

Figure 8.1: Group Sequential Design Simulation Tool in Assistant File Menu

If Group Sequential Design Simulation is opened from the Assistants file menu, it
will open at Step 0: Select GST Simulation Type where the user will specify the En-
dpoint of Interest (Means, Proportions, Survival, Counts, Regression), the Number of
Groups (1, 2, >2) and the Analysis Method (Inequality, Equivalence, Non-inferiority).
Detail on Step 0: Select GST Simulation Type can be found in subsection 8.4.1.

No default values will be provided for the subsequent Group Sequential Design Simu-
lation Input Steps if opening the Group Sequential Design Simulation Tool from
the Assistants file menu.
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8.2.2 Open GSD Simulation Tool From Group Sequential Design
Table

The Group Sequential Design Simulation Tool can be opened from within Group
Sequential Design Tables where that simulation scenario is supported by the tool. For
detail on Group Sequential Design Tables, see chapter 7.

If the Group Sequential Design Simulation Tool is available for a selected Group
Sequential Design Tables, the GST Simulation button will be available from the
Group Sequential Design Side-table which appears in the bottom left panel after
the Number of Looks field in filled in the main design table (top-left panel). An
example for the design table GST1 - Group Sequential Design for Two Means
with the GST Simulation button highlighted is provided in Figure 8.2.

nQuery - x
File Edit View Assistants Predict Plot Help
End 2o ERE!
Home X | Group Sequential Des: X | Group Sequential Des: X | + v
£ 2 x
1 2 3 4 5 6 7 8 I | O 4

Test Significance Level, «

1or 2 Sided Test? 1 1 1 1 1 1 1 1 1 Number of Looks, J

»  Number of Looks, J 5 Enter the number of looks planned for the frial. This is
Group 1 Mean, the total number of analyses (the interim analyses plus
Group 2 Mean, . the final analysis). For example, a five in this field
Mean Difference, ; - 1 means that four interim analyses are planned in
Group 1 Standard Deviation, o, addition to the final analysis.

Group 2 Standard Deviation, o,
Efficacy Bound Calculation Method Spending Func... Spending Func... Spending Func... Spending Func... Spending Func... Spending Func... Spending Func... Spending Func... Spendin Suggestion:
Futility Bound Calculation Method Don't Calculate | Don't Calculate  Don't Calculate | Don't Calculate | Don't Calculate  Don't Calculate | Don't Calculate | Don't Calculate | Don't C:

Two to five interim analyses would be common in

Group 1Sample Size, n, - . R
P P clinical trials. Increasing the number of looks will lead

Group 2 Sample Size, n, "
P 2amp to longer calculation times.

Sample Size Ratio, n./n,

Power (% .
= g N Acceptable Entries:
Y] =T |
GST1S-1 v x| Aid
" Once a value is given for Number of Looks, J, is
va GST Simulation
inputted, the Group Sequential Design side-table will
GST Parameters GST Outputs 1 2 3 4 5 appear below the main table. This is where the Group
Alpha Spending Function  O'Brien-Fleming | | » Total Sample Size Sequential Design aspects of the trial are chosen in
Boundary Scale Z-scale Information Time 0200 0400 0.600 0800 1.000 the GST Parameters, GST Outputs and Additional
Efficacy Bound Parameters tables.
Cumulative Alpha
Aftar rinnin » calelation thie cida tahla will ha v

GST1S-1 Help

@ Group Sequential Designs for Two Means (Spending Function, Haybittle-Peto, Wang-Tiatis, Unified Family, Custom Boundaries)-1 | Number of Looks, J: 5 . nQuel

Figure 8.2: GST Simulation Button in GST1 Group Sequential Design for Two Means

When the GST Simulation button is selected, a Group Sequential Design Simula-
tion Tool tab will be opened at Step 1: Simulation Inputs where the user specifies
the Design Parameters and Allocation Parameters. The Design Parameters and
Allocation Parameters available at Step 1: Simulation Inputs will be specific the
scenario implied by the Group Sequential Design Table that the Group Sequential
Design Simulation Tool was opened from.

In general, changing the Endpoint of Interest will change the Design Parameters
(e.g. continuous data will requires means, binomial endpoints will require proportions,
survival endpoints require hazard rates etc.) and changing the Number of Groups will
change the Allocation Parameters (e.g. one group design would only have a Total
Sample Size instead of Group 1 Sample Size and Group 2 Sample Size).

For example, the Step 1: Simulation Inputs opened from GST1 - Group Sequential
Design for Two Means would have the following Design Parameters: Group 1
Mean, Group 2 Mean, Mean Difference, Group 1 Standard Deviation, Group 2 Standard
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8.2 Opening Group Sequential Design Simulation Tool

Deviation; and the following Allocation Parameters: Group 1 Sample Size, Group 2
Sample Size, Sample Size Ratio, Randomization Type.

A significant advantage of opening the Group Sequential Design Simulation Tool
using the GST Simulation button is the potential to inherit defaults for the majority
of inputs specified during the Group Sequential Design Simulation Input Steps.
As the Input Steps are covered in detail in section 8.4, only a quick summary of this
inherit behavior is provided here.

Defaults will only be passed for columns in a group sequential design table which have
activated the solver calculation, such as for sample size or power. This requires the
column in the main design table be fully specified and the Group Sequential Design
Side-table be filled appropriately. An example where a sample size calculation has been
run in column 1 is provided in Figure 8.3.

Home X | Group Sequential Desi x | +
GST1-1/ Group Sequential Designs for Two Means (Spending Function, Haybittle-Peto, Wang-Tsiatis, Unified Family, Custom Boundaries) L
1 2 3 4 5 6 7 8 9
Test Significance Level, o 0.025
1 or 2 Sided Test? 1 1 1 1 1 1 1 1 1
Number of Looks, J 5
Group 1 Mean, p, 0.000
Group 2 Mean, p, 1.000
Mean Difference, p, - p» -1.000
Group 1 Standard Deviation, o, 2.500
¥ | Group 2 Standard Deviation, o, 2.500
Efficacy Bound Calculation Method Spending Func... Spending Func... Spending Func... Spending Func... = Spending Func.. Spending Func... Spending Func.. Spending Func.. Spending
Futility Bound Calculation Method Don't Calculate  Don't Calculate = Don't Calculate = Don't Calculate | Don't Calculate = Don't Calculate | Don't Calculate | Don't Calculate = Don't Ci
Group 1 Sample Size, n, 101
Group 2 Sample Size, n, 101
Sample Size Ratio, n./n, 1.000
Power (%) 80.176
< >
Calculate sample sizes v m
Group Sequential Report | Boundary Plot | Error Spending Plot v X
|2/ GsT simulation
GST Parameters GST Outputs 1 2 3 4 5
Alpha Spending Function O'Brien-Fleming Total Sample Size 40.000 81.000 121.000 162.000 202.000
Boundary Scale Z-scale Information Time 0.200 0400 0.600 0.800 1.000
Efficacy Bound -4.903 -3.352 -2.683 -2.286 -2.032
Cumulative Alpha 0.000 0.000 0.004 0.012 0.025
GST15-1

o Group Sequential Designs for Two Means (Spending Function, Haybittle-Peto, Wang-Tsiatis, Unified Family, Custom Boundaries)-1 Group 2 Standard Deviation, o,: 2.500000000

Figure 8.3: Group Sequential Design Table Example for Group Sequential Design Sim-
ulation Tool

When the GST Simulation button is selected in this solver complete column then
the Step 1: Simulation Inputs fields will have been filled appropriately based on the
main design table column values (under the alternative hypothesis) as in Figure 8.4.
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Simulation Inputs -
Design Parameters Allocation Parameters
Group 1 Mean 0.00 Group 1 Sample Size, n, 101
Group 2 Mean 1.00 Group 2 Sample Size, n, 101
Mean Difference -1.00 Sample Size Ratio 1
Group 1 Standard Deviation 2.50 Randomization Fixed by Ratio v
Group 2 Standard Deviation 2.50

Figure 8.4: Inherited Values in Step 1 | Simulation Inputs from Group Sequential Design
Example

Similarly, the Input Steps of Step 2: Sequential Design Inputs and Step 3:
Boundary Table will inherit values from the relevant main design table and side-table
rows from the original solver complete column.

Note the Step 3: Boundary Table fields will be cleared of the inherited defaults if 1
or 2 Sided?, Number of Looks, Efficacy Bound Parameterization or Futility
Bound Parameterization as these change the group sequential design sufficiently for
the original boundaries to no longer be appropriate.

The Step 2: Sequential Design Inputs and Step 3: Boundary Table defaults
inherited for this example are shown in Figure 8.5.
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Sequential Design Inputs

Sequential Design Parameters

Standard Deviation Definition Pooled Known, o(f) b

Known Standard Deviation, alZ) 2.50

Boundary Decision Z-Distribution W

1 or 2 Sided? 1 W

Number of Looks 5

Efficacy Bound Parameterization Z-scale W

Futility Bound Parameterization MNone v

Boundary Table
Look Sample Size Information Time Efficacy Bound

1 40 0.20 -4.9025
2 81 0.40 -3.3524
3 121 0.60 -2.6831
4 162 0.80 -2.2859
5 202 1.00 -2.0316

Figure 8.5: Inherited Values for Step 2 and 3 from Group Sequential Design Example

Using these defaults, the user can quickly assess the operating characteristics of a group
sequential design specified (for example in GST1 - Group Sequential Design for
Two Mean) under the alternative hypothesis and by changing the Step 1: Simulation
Inputs assess the operating characteristics for other important scenarios such as the null
hypothesis (e.g. by setting Mean Difference to zero in the example above).

These defaults will only be inherited if a solver calculation has been activated in that
column. Partially filled will not inherit any values and the majority of fields at each Input
Step will be empty as per opening the Group Sequential Simulation Tool via the
Assistants file menu (subsection 8.2.1)

If GST Simulation button is not shown in a specific Group Sequential Design Table
that indicates that group sequential simulation is not currently supported for that design
table scenario.
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8.3 Group Sequential Design Simulation Tool Layout

This section provides a high level overview of the Group Sequential Design Simula-
tion Tool’s layout. While each Input Step has a series of unique input fields, these
occur within a common user interface which has the following elements:

1. Main Window

2. Workspace Bar

3. Help Window

4. Next/Run Button (Input Stages Only)

These elements have been numbered as above for the Step 1: Simulation Inputs Step
in Figure 8.6.

& nQuery 5 X
File Edit View Assistants Predict Plot Help
IErsd I il ~
Home x | Group Sequential Des: X | Group Sequential Desi X | + v
< "
Workspace Simulation Inputs *

% Setup
¥ Simulation Inputs
% Sequential Design Inputs

¥ Boundary Table Group 1 Mean 000 Group 1 Sample Size, n, 101 group 1 population mean that will be
¥ Simulation Controls Group 2 Mean 1.00 Group 2 Sample Size, n; 101 simulated from.
B ~ Mean Difference -1.00 Sample Size Ratio 1 .
Reports P Suggestion:
Simulation Report Group 1 Standard Deviation 250 Randomization Fixed by Ratio If this simulation has been accessed
X Plots i Group 2 Standard Deviation 250 through a group sequential table then the

X Rejection Plot
< Boundary Plot
[ Tables
[ summary Data Per-Simulation

[ Per-Simulation Subject Data

Design Parameters

Allocation Parameters

Group 1 Mean, p1 3

This is the assumed true value for the

default value here will be the equivalent
value from that table.

If the p-value scale is selected for the
Efficacy Bound Parameterization and/or
Futility Bound Parameterization at Step

2 then the p-values will be converted
under the assumption of a positive
effect size. For example in a 2-sided
design, the upper efficacy/futility
bounds will be assumed to positive and
lower efficacy/futility bounds assumed
to be negative on the Z-statistic scale.

Acceptable Entries:
Any Value

7Y |

@ Calculation ran in 99ms

@ Group Sequential Design Simulation 1 Group 2 Standard Deviation, o 2.500000000

Figure 8.6: Group Sequential Simulation Tool Layout

A brief overview of each Group Sequential Simulation Tool layout element is provided
next.

8.3.1 Main Window

The Main Window of the Group Sequential Design Simulation Tool is where
inputs or outputs of the currently selected item in the Workspace Bar (subsection 8.3.2)
are displayed.

For Input Steps, the Main Window will show the name of the input step at the top
and provide the relevant input fields or input tables below that. Within most input fields
there will be options to copy, paste and similar available from the right-click context
menu.
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For Group Sequential Simulation Tool Outputs, such as the Reports, Plots and
Tables available from the Workspace Bar in Figure 8.6, the Main Window will show
the currently selected report (e.g. Simulation Report), plot (e.g. Rejection Plot)
or table (e.g. Summary Data Per-Simulation). For these fields there will often be
additional options to edit, copy or save these outputs via a toolbar of the right-click
context menu.

8.3.2 Workspace Bar

The Workspace Bar contains all the input and output objects associated with the
current Group Sequential Design Simulation workspace. There are four primary
headers under which the Workspace Bar organizes these objects. These are: Setup,
Reports, Plots and Tables.

Setup contains a field for each Group Sequential Design Simulation Input Step.
The Input Steps are described in section 8.4. Note that Step 0: Select GST Simu-
lation Type will not be available if the Group Sequential Design Simulation Tool
was opened using the GST Simulation button within a Group Sequential Design
Table - see subsection 8.2.2 for details.

Reports will contain the reports generated in the Group Sequential Design Outputs.
The only report available in the Group Sequential Design Simulation Outputs
at present is the Simulation Report which summarizes the results of the simulation
including the average sample size, power and proportion of simulations that stopped at
each look - see subsection 8.5.1 for details.

Plots will contain the plots generated in the Group Sequential Design Outputs. Two
plots are available in the Group Sequential Design Simulation Outputs at present.
These are the Rejection Plot and the Boundary Plot. The Rejection Plot visually
displays the proportion of simulations which had each outcome (stopped for efficacy,
stopped for futility, continued to next look) at each look - see subsection 8.5.2 for details.
The Boundary Plot visually displays the group sequential boundaries specified for the
simulation at the Step 3: Boundary Table Input Step - see subsection 8.4.4 for
details.

Tables will contain the tabular outputs (tables, spreadsheets) generated in the Group
Sequential Design Outputs. Two optional tables are available in the Group Sequen-
tial Design Simulation Outputs at present. These are the Summary Data Per-
Simulation spreadsheet and the Per-Simulation Subject Data spreadsheet. The
Summary Data Per-Simulation spreadsheet provides a per-look overview of the sum-
mary statistics and decision for each simulation The Per-Simulation Subject Data
spreadsheet provides the per-subject simulated values for the number of simulations spe-
cified at the Step 4: Simulation Controls Input Step. See subsection 8.5.4 for details
on these table outputs. Both these tables can be added or removed from the outputs at
the Step 4: Simulation Controls Input Step - see subsection 8.4.5.

If a primary header title (Setup, Reports, Plots, Tables) is selected within the Work-
space Bar, this will either show the objects within that header (if they were hidden) or
hide the objects with that head (if they were being shown). If an object (Input Step,
Report, Plot, Table) is selected under a primary header this object will be displayed
in the Main Window.
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The Workspace Bar can be collapsed by the selecting the arrow in the top-right of the
Workspace Bar. Select the arrow in top-left to uncollapse the Workspace Bar.

8.3.3 Help Card

The Help Card is provided to give the user information, context and suggestions for
each Input (input fields, input tables) and Output (Reports, Plots and Tables) of the
Group Sequential Design Tool. By default, it provided to the right of the Main
Window and will update automatically to reflect the currently selected Input/Output.
These Help Cards are mostly the same as those provided in standard design tables and
are summarized further in subsection 1.7.2.

At Group Sequential Design Simulation Inputs Steps, the Help Cards provide
information designed to help the user understand and fill the currently selected input field
or table.

The most common structure is for a given Help Card to have an Overview section, a
Suggestions section and an Acceptable Entries section.

The Overview section provides a summary of the selected input field, including that
field’s definition and high-value contextual information about that field.

The Suggestions section provides common values for the selected input field or provides
methods for calculating the selected input field value from other commonly available
sources.

The Acceptable Entries section provides the range of allowable values for the selected
input field - if a value outside the Acceptable Entries is entered into the field an Out-
of-Range Error will be shown in that field and user will not be able to continue to the
next Input Step - see subsection 2.2.1 for details on Out-of-Range Errors.

For Group Sequential Design Simulation Outputs, the Help Card will provide
information and context about he currently selected output.

For Reports, the Help Card provides a summary of the report overall and of each
section in the selected report.

For Plots, the Help Card provides a summary of the plot, how to interpret the plot and
guidance on the options available to edit and save the plot.

For Tables, the Help Card provides a summary of the overall table and a definition and
overview of each column and row as necessary.

The Help Card can be hidden by selecting the pin icon in the top-right of the Help Card
window. Select Help in the top-right to show the Help Card while it is highlighted,
select the pin icon to permanently restore the Help Card.

8.3.4 Next/Run Button (Input Steps Only)

The Next button is selected to confirm that the current provided Inputs at the cur-
rent step are correct and that these should be passed onto the next step and/or Group
Sequential Simulation algorithm.
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At the final Input Step of Step 4: Simulation Controls, the Run button is provided
instead. When the Run button is selected this confirms that the user wants to run
the Group Sequential Simulation and generate the Group Sequential Simulation
Outputs based on the inputs from all prior Input Steps.

The user can manually navigate to any Input Step from the Workspace Bar on the left-
hand side under the Setup header. Note that if changes are made at a given Input Step
the Next button must be pressed for these changes to take effect and the Run button
must be pressed for the Group Sequential Simulation Outputs to be updated based
on all confirmed changes.

8.4 Group Sequential Design Simulation Input Steps

This section provides a summary of each Input Step required to use the Group Se-
quential Design Simulation Tool to generate simulation results for the desired group
sequential design scenario.

As referenced in section 8.2, the default values provided at these Input Steps will depend
on how the Group Sequential Design Simulation Tool was opened. For conveniece,
the defaults used for the example where Group Sequential Design Simulation Tool
was opened using the GST Simulation button within GST1 - Group Sequential
Design for Two Means in subsection 8.2.2 will be used as starting point, with the ex-
ception of Step 0: Select GST Simulation Type as this Input Step is only available
if using the Assistants menu option to open the Group Sequential Simulation Tool
- see subsection 8.2.1. Additional changes and scenarios will the be explored as necessary.

8.4.1 Step 0: Select GST Simulation Type

The Step 0: Select GST Simulation Type Input Step provides the user the option
to select the group sequential design simulation scenario of interest for their trial. This
Input Step is only available if the user opened the Group Sequential Design Sim-
ulation Tool from the Assistants file menu at the top of the nQuery window as per
subsection 8.2.1. As stated there, Step 0: Select GST Simulation Type will be the
Input Step opened when Group Sequential Design Simulation is selected from the
Assistants file menu. Step 0: Select GST Simulation Type is shown in
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Home x | Group Sequential Des: X | Group Sequential Desi X | Group Sequential Des X | +

Workspace < Select GST Simulation Type >
% Setup
2§ Select GST Simulation Type Endpoint of Interest Number of Groups

Endpoint of Interest

Specify the endpoint of interest for your trial.

® Mean
Proportion e Suggestion:

The endpoint will effect the fields available at Step 1

(Simulation Inputs) and Step 2 (Sequential Design Inputs).

See the help cards available at future steps for further detail.

Acceptable Entries:
Analysis Method
Mean, Proportion, Survival, Counts, Regression

@ Inequality

Figure 8.7: Step 0: Select GST Simulation Type

The Step 0: Select GST Simulation Type consists of the following radio button
columns: Endpoint of Interest, Number of Groups, Analysis Method. At Step
0: Select GST Simulation Type, the user is required to select the desired option
under each radio button column that corresponds the characteristics of the planned group
sequential design.

Not all scenario combinations will be supported. For any given combination of column
selections, the incompatible options in each other column will not be selectable and will
be greyed out.

After the appropriate options are selected from each column, select the Next button in
the bottom-right to continue to Step 1: Simulation Inputs.

A summary of the options available under the Endpoint of Interest, Number of
Groups, Analysis Method columns is provided next.

8.4.1.1 Endpoint of Interest

Endpoint of Interest selects the endpoint type for the outcome of interest in the planned
group sequential trial. It has the following options: Mean, Proportion, Survival,
Counts, Regression.

Mean indicates the clinical trial endpoint is continuous and can be summarized by the
mean(s) and standard deviation(s).

Proportion indicates the clinical trial endpoint is binary and can be summarized by the
proportion(s).

Survival indicates the clinical trial endpoint is a time-to-event endpoint and can be
summarized by the hazard rate(s) or equivalent parametric inputs.

Counts indicates the clinical trial endpoint is a count (or incidence rate) endpoint and
can be summarized by the count/incidence rate(s).
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Regression indicates the clinical trial endpoint is a coefficient from a regression model
(e.g. linear regression) and can be summarized as the /31 coeflicient from the regression
model and it’s associated variance.

The effect of Endpoint of Interest choice on each subequent Input Step will be
highlighted for the currently supported scenarios in the per input step summary sections
provided later.

8.4.1.2 Number of Groups

Number of Groups selects the number of (independent) treatment groups there will be
in the planned group sequential trial. It has the following options: 1, 2, >2

1 indicates that there is a single treatment group in the study where the treatment effect
will be compared to a standard value (e.g. based on database)

2 indicates that there are two (independent) treatment groups in the study where the
treatment effect will be the average change between the two groups (e.g. mean difference,
odds ratio, hazard ratio, rate ratio).

>2 indicates that there a greater than two (independent) treatment groups in the study.
This is equivalent to specifying a Multi-Arm Multi-Stage (M AMS) Design where
the treatment effect will (typically) be the difference between a control group and the
multiple treatment groups.

8.4.1.3 Analysis Method

Analysis Method indicates the method or hypothesis type that will used for testing in
the planned group sequential trial. It has the following options: Inequality, Equival-
ence, Non-inferiority

Inequality indicates the hypothesis of interest is for inequality where the objective is
to test if the treatments are different. This corresponds to a null hypothesis where the
treatment effect indicates the treatment groups are the same (e.g. null hypothesis mean
difference = 0). This is also known as superiority testing and is the most common hypo-
thesis type in clinical trials. Note that for Number of Groups = 1, Inequality and
Non-inferiority are the same hypothesis test.

Non-inferiority indicates the hypothesis of interest is for non-inferiority where the ob-
jective is to show a treatment is no worse than another treatment by a specified amount.
This corresponds to the null hypothesis where the treatment effect is below the non-
inferiority margin (H, : § < NIM). This is a common objective in trials for medical
devices. Note that for Number of Groups = 1, Inequality and Non-inferiority are
the same hypothesis test.

Equivalence indicates the hypothesis of interest is for equivalence where the objective is
to show a treatment is equivalent to another treatment in both treatment effect directions.
This corresponds to the null hypothesis where the treatment effect is below the lower
equivalence margin or above the upper equivalence margin (Hy : 6 < LEM or
0 > UEM) and is typically evaluated using the Two One-Sided Test (TOST) procedure
[Schuirmann, 1987]. This is a common objective in bioequivalence trials for generic drug
approval.

255



8.4 Group Sequential Design Simulation Input Steps

8.4.2 Step 1: Simulation Inputs

The Step 1: Simulation Inputs specifies the data generating model which will be used
to generate simulations for the scenario of interest. Step 1: Simulation Inputs will in-
clude sections such as Design Parameters and Allocation Parameters where Design
Parameters are the endpoint specific parameters passed to the statistical distribution(s)
used to generate simulations and Allocation Parameters controls how the sample size
is allocated across the treatment groups and the randomization process.

However, the input fields available in Step 1: Simulation Inputs will change signi-
ficantly depending on the Endpoint of Interest, Number of Groups and Analysis
Method selected at Step 0: Select GST Simulation Type either explicitly (if opened
using Group Sequential Design Simulation option from the Assistants file menu
- subsection 8.2.1) or implicitly (if opened using the GST Simulation button within a
Group Sequential Design Table - see subsection 8.2.2).

Due to these significant differences, a summary is provided for all currently supported
scenarios in the Group Sequential Design Simulation Tool. The supported scenarios
at present are as follows:

« FEndpoint of Interest = Mean; Number of Groups = 2; Analysis Method = Inequality
(equivalent to GST Simulation from GST1 - Group Sequential for Two Means)

o Endpoint of Interest = Proportion; Number of Groups = 2; Analysis Method =
Inequality (equivalent to GST Simulation from GST1 - Group Sequential for Two
Means)

The Step 1: Simulation Inputs for each of these scenarios above is summarized next.

8.4.2.1 Two Means Inequality: Mean, 2 Groups, Inequality (GST1)

The Step 1: Simulation Inputs for the Two Means Inequality scenario is shown in
Figure 8.8.

The Two Means Inequality scenario is equivalent to setting Endpoint of Interest
to Mean, Number of Groups to 2 and Analysis Method to Inequality at Step O:
Select GST Simulation Type (see subsection 8.2.1 and subsection 8.4.1) or to opening
the Group Sequential Design Simulation Tool using the GST Simulation button
in the GST1 - Group Sequential for Two Means design table (see subsection 8.2.2).
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Home x | Group Sequential Des: X | Group Sequential Des: X | Group Sequential Desi X | Group Sequential Desi X | + v

Workspace < Simulation Inputs 2

¥ Setup A

2% Simulation Inputs Design Parameters Allocation Parameters

Randomization

Choose the type of subject randomisation to be performed

Group 1 Mean Group 1 Sample Size, n,

101 inthe simulated study.

Group 2 Mean Group 2 Sample Size, n, "Fixed by Ratio" randomization assigns simulated subjects

101
intwo blocks such that the simulated sample size ratio is

Mean Difference Sample Size Ratio exactly the same (or as to as close as possible to) the
1 1 . .
Sample Size Ratio inputted above.

Group 1 Standard Deviation Randomization .
P 2.50 Fixed by Ratio v "Complete" randomly allocates each subject to each group

proportional to Sample Size Ratio based on a Bernoulli

Group 2 Standard Deviation -~ process.

Suggestion

The default here is "Fixed by Ratio" as this restricts how
much the group allocation can deviate from the planned
sample size ratio, similar to block randomization
procedures. Complete randomization can cause the sample

size ratio to deviate from the stated sample size ratio at
each look as it is based on random sampling.

Acceptable Entries:

Fixed by Ratio or Complete

Next

Figure 8.8: Step 1: Simulation Inputs for Two Means Inequality Scenario

For the Two Means Inequality scenario there are the following sections for the in-
put fields: Design Parameters and Allocation Parameters. A summary of each is
provided next.

Design Parameters The Design Parameters specifies the input parameters passed
to the Normal distributions that will be used to generate simulations for the two
independent groups in the Two Means Inequality scenario.

For each group, the algorithm will draw random simulations from a Normal distribution
with a mean equal to the respective Group Mean and a variance equal to the respective
Group Standard Deviation squared - see subsubsection 8.7.1.1 for the technical details.

For Two Means Inequality scenario the following fields will need to be filled in the
Design Parameters section to proceed to the next Input Step:

e Group 1 Mean: The mean response expected in group 1
e Group 2 Mean: The mean response expected in group 2
e Mean Difference: The expected mean difference between group 1 and group 2

e« Group 1 Standard Deviation: The expected standard deviation for responses
in group 1

e Group 2 Standard Deviation: The expected standard deviation for responses
in group 2

The Group 1 Mean, Group 2 Mean and Mean Difference have a fixed relationship
where Mean Difference must equal Group 1 Mean minus Group 2 Mean. If two
out of three of these input fields are specified, the third will be automatically calculated.
If all three are specified and one of these parameters is changed then one of the other two
parameters is updated accordingly - if Group 1 Mean or Group 2 Mean is updated
then the Mean Difference will update and if the Mean Difference is changed the
Group 2 Mean is updated - see subsection 1.7.4 for further informations on the auto-
calculation feature.
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If the Group Sequential Design Simulation Tool was opened from GST1 - Group
Sequential Design for Two Means using the GST Simulation button for a solver
complete column then each of the Design Parameter fields above will be filled with
the values from the rows of the same name in the main design table - see subsection 8.2.2
for details. Otherwise, these fields will be empty and will need to be filled by the user.

Allocation Parameters The Allocation Parameters specifies the sample size of the
two independent groups in the Two Means Inequality scenarios and also the random-
ization algorithm that will be used to assign simulation to each independent group.

For Two Means Inequality scenario the following fields will need to be filled in the
Allocation Parameters section to proceed to the next Input Step:

e« Group 1 Sample Size, n;: The number of subjects planned to be recruited in
group 1

e Group 1 Sample Size, ny: The number of subjects planned to be recruited in
group 2

o Sample Size Ratio: The planned ratio between the group 1 and group 2 sample
sizes (ng/ny)

« Randomization: The randomization allocation algorithm to be used to assign
simulations to the treatment groups. Select from Fixed by Ratio and Complete
Randomization

The Group 1 Sample Size, Group 2 Sample Size and Sample Size Ratio have a
fixed relationship where the Sample Size Ratio must equal the Group 2 Sample Size
divided by the Group 1 Sample Size (R = ny/n1). If two out of three of these input
fields are specified, the third will be automatically calculated. If all three are specified
and one of these parameters is changed then one of the other two parameters is updated
accordingly - if Group 1 Sample Size or Group 2 Sample Size is updated then the
Sample Size Ratio will update and if the Sample Size Ratio is changed the Group
2 Sample Size is updated - see subsection 1.7.4 for further informations on the auto-
calculation feature. Note that since Group 1 Sample Size and Group 2 Sample
Size must be integers that these values will be rounded to the nearest integer if the
Sample Size Ratio would not lead to an auto-calculation providing an integer directly.

If the Group Sequential Design Simulation Tool was opened from GST1 - Group
Sequential Design for Two Means using the GST Simulation button for a solver
complete column then each of the Design Parameter sample size fields above will
be filled with the values from the rows of the same name in the main design table - see
subsection 8.2.2 for details. Otherwise, these fields will be empty and will need to be filled
by the user.

If Randomization = Fixed by Ratio, the algorithm will generate simulations where
the allocation of simulated subjects to each group is fixed to ensure the Sample Size
Ratio specified here is retained at each look (excepting the small effect due to rounding
of interim sample sizes).

If Randomization = Complete Randomization, the algorithm will treat treatment
assignment as a random Binomial variable with probability of treatment group assignment

to Group 1 equal to ( Ll ) Complete Randomization provides a treatment group

ni1+n2
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allocation similar that specified in the Allocation Parameters on average but is not
guaranteed to be the same due to random variability. However, this randomness may
better reflect the group allocation in a real clinical trial.

For technical detail on the Randomization algorithm for the Two Means Inequality
scenario see subsubsection 8.7.1.1. For more information on randomization in clinical
trials generally, see chapter 6 which covers the variety of allocation algorithms available
in nQuery’s Randomization List feature.

After all Design Parameters and Allocations Parameters are filled appropriately,
select the Next button in the bottom right of the Main Window to proceed to Step
2: Sequential Design Inputs.

8.4.2.2 Two Proportion Inequality: Proportion, 2 Groups, Inequality (GST2)

The Step 1: Simulation Inputs for the Two Proportions Inequality scenario is
shown in Figure 8.9.

The Two Proportions Inequality scenario is equivalent to setting Endpoint of In-
terest to Proportion, Number of Groups to 2 and Analysis Method to Inequality
at Step 0: Select GST Simulation Type (see subsection 8.2.1 and subsection 8.4.1)
or to opening the Group Sequential Design Simulation Tool using the GST Sim-
ulation button in the GST2 - Group Sequential for Two Proportions design table
(see subsection 8.2.2).

Home X | Group Sequential Des: X | Group Sequential Des: X | Group Sequential Des: X | Group Sequential Des X | Group Sequential Desi X | Group Sequential Desi X | + v

Workspace < Simulation Inputs > !

% Setup A

¢ Simulation Inputs Design Parameters Allocatior ters Group 1 Proportion,

This is the assumed true value for the group 1 population

Group 1 Proportion 500 proportion that will be simulated from.

Group 1 Sample Size, n;

Group 2 Proportion Group 2 Sample Size, n;

060 500 Suggestion

If this simulation has been accessed through a group
Proportion Difference 010 Sample Size Ratio 7 sequential table then the default value here will be the
equivalent value from that table.

Randomization fied by Ratio =
s If the p-value scale is selected for the Efficacy Bound

Parameterization and/or Futility Bound Parameterization
at Step 2 then the p-values will be converted under the
assumption of a positive effect size. For example ina 2-
sided design, the upper efficacy/futility bounds will be
assumed to positive and lower efficacy/futility bounds
assumed to be negative on the Z-statistic scale.

Acceptable Entries:

O<m<1

Figure 8.9: Step 1: Simulation Inputs for Two Proportions Inequality Scenario

For the Two Proportions Inequality scenario there are the following sections for the
input fields: Design Parameters and Allocation Parameters. A summary of each is
provided next.

Design Parameters The Design Parameters specifies the input parameters passed
to the Binomial distributions that will be used to generate simulations for the two
independent groups in the Two Proportions Inequality scenario.
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For each group, the algorithm will draw random simulations from a Binomial Distri-
bution with the probability of each trial success (p) equal to the respective Group
Proportion - see subsubsection 8.7.1.2 for the technical details.

For Two Proportions Inequality scenario the following fields will need to be filled in
the Design Parameters section to proceed to the next Input Step:

e Group 1 Proportion: The proportion of successes expected in group 1
e Group 2 Proportion: The proportion of successes expected in group 2
e Proportion Difference: The proportion difference between group 1 and group 2

The Group 1 Proportion, Group 2 Proportion and Proportion Difference have
a fixed relationship where Proportion Difference must equal Group 1 Proportion
minus Group 2 Proportion. If two out of three of these input fields are specified, the
third will be automatically calculated. If all three are specified and one of these parameters
is changed then one of the other two parameters is updated accordingly - if Group 1
Proportion or Group 2 Proportion is updated then the Proportion Difference
will update and if the Proportion Difference is changed the Group 2 Proportion is
updated - see subsection 1.7.4 for further informations on the auto-calculation feature.

Note that while the allowable range for Proportion Difference is (—1,1), the auto-
calculation can still generate a Group 1 Proportion or Group 2 Proportion that is
not within their allowable range of [0, 1] when the other proportion is specified. In these
cases, an OQut-of-Range error will be shown in the auto-calculated cell.

If the Group Sequential Design Simulation Tool was opened from GST2 - Group
Sequential Design for Two Proportions using the GST Simulation button for
a solver complete column then each of the Design Parameter ficlds above will be
filled with the values from the rows of the same name in the main design table - see
subsection 8.2.2 for details. Otherwise, these fields will be empty and will need to be
filled by the user.

Allocation Parameters The Allocation Parameters specifies the sample size of the
two independent groups in the Two Proportions Inequality scenarios and also the
randomization algorithm that will be used to assign simulation to each independent group.

For Two Proportions Inequality scenario the following fields will need to be filled in
the Allocation Parameters section to proceed to the next Input Step:

e Group 1 Sample Size, n;: The number of subjects planned to recruited in group
1

e Group 1 Sample Size, n,: The number of subjects planned to recruited in group
2

o Sample Size Ratio: The planned ratio between the group 1 and group 2 sample
sizes (ng/mny)

« Randomization: The randomization allocation algorithm to be used to assign
simulations to the treatment groups. Select from Fixed by Ratio and Complete
Randomization

The Group 1 Sample Size, Group 2 Sample Size and Sample Size Ratio have a
fixed relationship where the Sample Size Ratio must equal the Group 2 Sample Size
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divided by the Group 1 Sample Size (R = ny/ny). If two out of three of these input
fields are specified, the third will be automatically calculated. If all three are specified
and one of these parameters is changed then one of the other two parameters is updated
accordingly - if Group 1 Sample Size or Group 2 Sample Size is updated then the
Sample Size Ratio will update and if the Sample Size Ratio is changed the Group
2 Sample Size is updated - see subsection 1.7.4 for further informations on the auto-
calculation feature. Note that since Group 1 Sample Size and Group 2 Sample
Size must be integers that these values will be rounded to the nearest integer if the
Sample Size Ratio would not lead to an auto-calculation providing an integer directly.

If the Group Sequential Design Simulation Tool was opened from GST2 - Group
Sequential Design for Two Proportions using the GST Simulation button for a
solver complete column then each of the Design Parameter sample size fields above
will be filled with the values from the rows of the same name in the main design table -
see subsection 8.2.2 for details. Otherwise, these fields will be empty and will need to be
filled by the user.

If Randomization = Fixed by Ratio (the default), the algorithm will generate sim-
ulations where the allocation of simulated subjects to each groups is fixed to ensure the
Sample Size Ratio specified here is retained at each look (excepting the small effect
due to rounding of interim sample sizes).

If Randomization = Complete Randomization, the algorithm will treat treatment
assignment as a random Binomial variable with probability of treatment group assignment
to Group 1 equal to (ﬁ) Complete Randomization provides a treatment group
allocation similar that specified in the Allocation Parameters on average but is not
guaranteed to be the same due to random variability. However, this randomness may

better reflect the group allocation in a real clinical trial.

For technical detail on the Randomization algorithm for the Two Proportions In-
equality scenario see subsubsection 8.7.1.2. For more information on randomization in
clinical trials generally, see chapter 6 which covers the variety of allocation algorithms
available in nQuery’s Randomization List feature.

After all Design Parameters and Allocations Parameters are filled appropriately,
select the Next button in the bottom right of the Main Window to proceed to Step
2: Sequential Design Inputs.

8.4.3 Step 2: Sequential Design Inputs

The Step 2: Sequential Design Inputs step allows the user to specify the Sequential
Design Parameters which specify the number of looks, whether to conduct a one or
two sided tests, the scale on which the group sequential boundaries will be inputted and
additional scenario specific options such as using t-test adjusted boundaries for the Two
Means Inequality scenario.

A number of input fields for Step 2: Sequential Design Inputs will be shared across
different scenarios but there will also be unique input fields depending on the Endpoint
of Interest, Number of Groups and Analysis Method selected at Step 0: Select
GST Simulation Type either explicitly (if opened using Group Sequential Design
Simulation option from the Assistants file menu - subsection 8.2.1) or implicitly (if
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opened using the GST Simulation button within a Group Sequential Design Table
- see subsection 8.2.2).

A summary is provided for all currently supported scenarios in the Group Sequential
Design Simulation Tool. The supported scenarios at present are as follows:

o Endpoint of Interest = Mean; Number of Groups = 2; Analysis Method = Inequality
(equivalent to GST Simulation from GST1 - Group Sequential for Two Means)

o Endpoint of Interest = Proportion; Number of Groups = 2; Analysis Method =
Inequality (equivalent to GST Simulation from GST1 - Group Sequential for Two
Means)

The Step 2: Sequential Design Inputs for each of these scenarios is summarized next.

8.4.3.1 Two Means Inequality: Mean, 2 Groups, Inequality (GST1)

The Step 2: Sequential Design Inputs for the Two Means Inequality scenario is
shown in Figure 8.10.

The Two Means Inequality scenario is equivalent to setting Endpoint of Interest
to Mean, Number of Groups to 2 and Analysis Method to Inequality at Step O:
Select GST Simulation Type (see subsection 8.2.1 and subsection 8.4.1) or to opening
the Group Sequential Design Simulation Tool using the GST Simulation button
in the GST1 - Group Sequential for Two Means design table (see subsection 8.2.2).

Workspace < Sequential Design Inputs Sl

¥ Setup v Standard Deviation Definition

Sequential Design Parameters
Choose the definition to be used for the standard deviation
Standard Deviation Definition Pooled Known, o(Z) -4 in the test statistic.

Known Standard Deviation, o(2) 250

"Pooled" refers to where the standard error is calculated
assuming the standard deviation is the same in each group
1 or 2 Sided? 1 v based on the pooled variance. "Unpooled" refers to where
the standard error is calculated using the per-group
standard deviations

Boundary Decision Z-Distribution v

Number of Looks 5

Efficacy Bound Parameterization Z-scale v

(Means Only): "Known" refers to case where true standard
deviation(s) are known and defined here in Step 2. This
corresponds to the Z-test assumption. "Unknown" refers to
case where the true standard deviation(s) are unknown and
calculated based on the simulated data. This corresponds to

Futility Bound Parameterization None v

the test assumption.

Suggestion

Select Pooled or Unpooled based on the test statistic which
will be used in the study analysis.

For proportions, if this simulation has been accessed
through a group sequential table then the default value will
be the equivalent value from that table.

Unknown would be suggested as this calculates the
Back Next . . o ..

Figure 8.10: Step 2: Sequential Design Inputs for Two Means Inequality Scenario

For the Two Means Inequality scenario there is the following section for the input
fields: Sequential Design Parameters.

Sequential Design Parameters The Sequential Design Parameters specifies the
standard deviation used to calculate the standard error used for test statistic calculations,
whether to use the t-test adjusted boundaries, whether the test is one-sided or two-sided,
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the number of looks and the efficacy and futility boundary scale parameterizations in the
Two Means Inequality scenario.

For Two Means Inequality scenario the following fields will need to be filled in the
Sequential Design Parameters. section to proceed to the next Input Step:

« Standard Deviation Definition: Select the standard deviation used in the stand-
ard error for test statistic calculation, choose from: Pooled Known o(Z), Un-
pooled Known ¢(7), Pooled Unknown s(¢), Unpooled Unknown s(t)

— Known Standard Deviation, o(Z) (Standard Deviation Definition = Pooled
Known o(Z) only): Assumed known true pooled standard deviation used to
calculate standard error

— Group 1 Known Standard Deviation, o(Z) (Standard Deviation Defini-
tion = Unpooled Known o(Z) only): Assumed known true group 1 standard
deviation used to calculate standard error

— Group 2 Known Standard Deviation, o(Z) (Standard Deviation Defini-
tion = Unpooled Known o(Z) only): Assumed known true group 2 standard
deviation used to calculate standard error

Boundary Decision: Select whether to use original Z-test boundaries or adjusted
approximate t-test boundaries, choose from Z-distribution, t-Distribution

1 or 2 Sided?: Select if the test will be a 1-sided or 2-sided, choose from 1 or 2

o Number of Looks: Specify the total number of looks (including the final analysis)
the group sequential design will have

Efficacy Bound Parameterization: Select the statistical scale on which the
efficacy boundaries will be specified at Step 3: Boundary Table, choose from
Z-scale, p-value Scale, Score Scale, /-Scale

Futility Bound Parameterization: Select the statistical scale on which the futil-
ity boundaries will be specified at Step 3: Boundary Table, choose from Z-scale,
p-value Scale, Score Scale, -Scale

A summary of each of these fields is provided next.

Standard Deviation Definition allows the user to specify how the standard error will
be calculated.

The Z-test requires the standard deviation to be known therefore for simulation results
to match the equivalent group sequential design (e.g. from GST1 - Group Sequential
Design for Two Means) the standard deviation should be fixed to its Known value from
the design stage when calculating the standard error. However, in practice most clinical
trials will calculate the standard error based on the interim estimate of the standard
deviation(s), which is Unknown a priori, even if the group sequential Z-test analysis.

In addition, different trials may used the Pooled or Unpooled estimate of the variance
to calculate the standard error - for example, if using the two sample t-test which assumes
a common within-group standard deviation.

To accomodate all these scenarios, Standard Deviation Definition field contains the
following options: Pooled Known ¢(Z), Unpooled Known ¢(Z), Pooled Unknown
s(t), Unpooled Unknown s(t)
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For Pooled Known o(Z) the standard error is calculated using the “known” estimate for
the pooled standard deviation in the Known Standard Deviation, ¢(Z) field which
will appear below the Pooled Known o(Z) when that option is selected. Known
Standard Deviation, ¢(Z) will not be shown for the other Standard Deviation
Definition options.

For Unpooled Known o(Z) the standard error is calculated using the “known” estimates
for the per-group standard deviations in the Group 1 Known Standard Deviation,
0(Z) and Group 2 Known Standard Deviation, ¢(Z) fields which will appear below
the Pooled Known o(Z) when that option is selected. Group 1 Known Standard
Deviation, ¢(Z) and Group 2 Known Standard Deviation, ¢(Z) will not be shown
for the other Standard Deviation Definition options.

For Pooled Known s(t), the standard error is calculated using the interim estimate for
the pooled standard deviation based on the simulated data. Pooled Unknown s(t),
does not require any addiitonal field inputs.

For Unpooled Known s(t), the standard error is calculated using the interim estimates
for the group 1 standard deviation and group 2 standard deviation based on the simulated
data. Unpooled Unknown s(t), does not require any addiitonal field inputs.

By default, Pooled Known o(Z) is selected for Standard Deviation Definition with
the Known Standard Deviation, o(Z) calculating the pooled standard deviation based
on the Group 1 Standard Deviation, Group 2 Deviation, Group 1 Sample Size
and Group 2 Sample Size specified at Step 1: Simulation Inputs.

For Unpooled Known o(Z), the Group 1 Known Standard Deviation, ¢(Z) and
Group 2 Known Standard Deviation, o(Z) will by default be filled with Group 1
Standard Deviation and Group 2 Standard Deviation specified at Step 1: Sim-
ulation Inputs

Technical details on how the test statistic is constructed using the above assumptions
regarding the standard deviation is provided in subsubsection 8.7.2.1.

Boundary Decision allows the user to specify whether to use the Z-test boundaries
or the (approximate) t-test boundaries. Select from Z-Distribution (default) and t-
Distribution.

In clinical trials, the t-test is the most popular test for comparing means. However,
the group sequential boundaries are calculated under the assumption of a (multvariate)
Z-distribution process (subsubsection 7.2.1.1 for details) which corresponds to using the
Z-test. While it is possible to construct exact boundaries for the t-test, this adds
significant complication compared to constructing under a Z-distribution assumptions.

However, Jennison and Turnbull [Jennison and Turnbull, 1999] showed that approxim-
ate t-test boundaries can be constructed based on the more commonly available Z-test
boundaries by applying the standard normal cumulative distribution function (®) to the
Z-test boundaries (e.g. ®(—1.96) ~ 0.025) to generate the p-value boundaries and then
applying the (central) t-distribution inverse cumulative distribution (quantile) function
(T df) to the p-value boundaries where the degrees of freedom, df = Ny —2 where N}, is the
total sample size at look k. A formal technical treatment is provided in subsection 8.7.3.

1 or 2 Sided? determines if the test will a one-sided (1) or two-sided (2) test. Note
that if this value is changed any existing values in the Boundary Table at Step 3:
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Boundary Table will be deleted as this option will significantly alter the Boundary
Table. Note this deletion will apply to boundaries inherited from GST1 - Group
Sequential Design for Two Means see subsection 8.2.2.

If the Group Sequential Design Simulation Tool was opened from GST1 - Group
Sequential Design for Two Means using the GST Simulation button for a solver
complete column then each of the 1 or 2 Sided? will be filled with the 1 or 2 Sided
Test? value from the main design table - see subsection 8.2.2 for details. Otherwise, a
default of 1 (1-sided) will be used.

Number of Looks determines the total number of looks (including final analysis) in
the group sequential design. This will determine the number of rows in the Boundary
Table at Step 3: Boundary Table. Due to this if this value is changed any existing
values in the Boundary Table at Step 3: Boundary Table will be deleted as this
option will significantly alter the Boundary Table. Note this deletion will apply to
boundaries inherited from GST1 - Group Sequential Design for Two Means see
subsection 8.2.2.

If the Group Sequential Design Simulation Tool was opened from GST1 - Group
Sequential Design for Two Means using the GST Simulation button for a solver
complete column then the Number of Looks field above will be filled with the Number
of Looks value from the main design table - see subsection 8.2.2 for details. Otherwise,
the Number of Looks field will be empty and will need to be filled by the user.

Efficacy Bound Parameterization defines the statistical scale on which the group
sequential efficacy boundaries will be specified in the Boundary Table at Step 3:
Boundary Table. The available statistical scales are: Z-scale, p-value Scale, Score
Scale, /-Scale (i.e. treatment effect scale - Mean Difference for Two Means In-
equality scenario) and Don’t Calculate (i.e. no efficacy boundary). Detail on these
statistical scales and the conversions between them are provided in subsubsection 7.2.1.1,
subsubsection 7.2.4.5 and subsection 8.7.3 - note that the conversions which require the
Information will derive that value based on the the fields in Step 1: Simulation
Inputs.

Here the focus will be on the practical aspects of filling the Bounds columns. Note that
for the Z-scale, Score Scale and J-Scale the direction of the hypothesis if 1 or 2
Sided? = 1 will depend on the final boundary value specified in the Boundary Table
but that for the p-value Scale it is always assumed that higher values for the treatment
effect (mean difference for the Two Means Inequality scenario) are considered better.
Note that if this value is changed any existing values in the Boundary Table at Step
3: Boundary Table will be deleted as this option will significantly alter the Boundary
Table. Note this deletion will apply to boundaries inherited from GST1 - Group
Sequential Design for Two Means see subsection 8.2.2.

Futility Bound Parameterization defines the statistical scale on which the group
sequential efficacy boundaries will be specified in the Boundary Table at Step 3:
Boundary Table. The available statistical scales are: Z-scale, p-value Scale, Score
Scale, /-Scale (i.e. treatment effect scale - Mean Difference for Two Means In-
equality scenario) and Don’t Calculate (i.e. no futility boundary). Detail on these
statistical scales and the conversions between them are provided in subsubsection 7.2.1.1,
subsubsection 7.2.4.5 and subsection 8.7.3 - note that the conversions which require the
Information will derive that value based on the fields in Step 1: Simulation Inputs.
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Here the focus will be on the practical aspects of filling the Bounds columns.Note that
for the Z-scale, Score Scale and /-Scale the direction of the hypothesis if 1 or 2
Sided? = 1 will depend on the final boundary value specified in the Boundary Table
but that for the p-value Scale it is always assumed that higher values for the treatment
effect (mean difference for the Two Means Inequality scenario) are considered better.
Note that if this value is changed any existing values in the Boundary Table at Step
3: Boundary Table will be deleted as this option will significantly alter the Boundary
Table. Note this deletion will apply to boundaries inherited from GST1 - Group
Sequential Design for Two Means see subsection 8.2.2.

If the Group Sequential Design Simulation Tool was opened from GST1 - Group
Sequential Design for Two Means using the GST Simulation button for a solver
complete column then the Efficacy Bound Parameterization and Futility Bound
Parameterization fields above will be based on the Boundary Scale used in the GST
Outputs side-table - see subsubsection 7.3.2.2 and subsection 8.2.2 for details. Other-
wise, the Efficacy Bound Parameterization = Z-scale and Futility Bound Para-
meterization = Don’t Calculate.

8.4.3.2 Two Proportion Inequality: Proportion, 2 Groups, Inequality (GST2)

The Step 2: Sequential Design Inputs for the Two Proportions Inequality scenario
is shown in Figure 8.11.

The Two Proportions Inequality scenario is equivalent to setting Endpoint of In-
terest to Proportion, Number of Groups to 2 and Analysis Method to Inequality
at Step 0: Select GST Simulation Type (see subsection 8.2.1 and subsection 8.4.1)
or to opening the Group Sequential Design Simulation Tool using the GST Sim-
ulation button in the GST2 - Group Sequential for Two Proportions design table
(see subsection 8.2.2).

Workspace < Sequential Design Inputs « 2

2 Setu
P ) Number of Looks, J

Sequential Design Parameters

The total number of looks (including final analysis) that will

be conducted in the sequential design. This will set the

1or 2 Sided? 1 v number of rows (looks) in the Boundary Table in Step 3

Standard Deviation Definition Unpooled v

Numbe!

Suggestion

Efficac If this simulation has been accessed through a group

Futility Bound Parat ization None v sequential table then the default value here will be the
equivalent value from that table. The inherited boundaries
will be deleted if this value is changed.

Acceptable Entries
Jz2

Figure 8.11: Step 2: Sequential Design Inputs for Two Proportions Inequality Scenario

For the Two Proportions Inequality scenario there is the following section for the
input fields: Sequential Design Parameters.
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Sequential Design Parameters The Sequential Design Parameters specifies the
standard deviation used to calculate the standard error used for test statistic calculations,
whether to use the t-test adjusted boundaries, whether the test is one-sided or two-sided,
the number of looks and the efficacy and futility boundary scale parameterizations in the
Two Means Inequality scenario.

For Two Means Inequality scenario the following fields will need to be filled in the
Sequential Design Parameters. section to proceed to the next Input Step:

o Standard Deviation Definition: Select the standard deviation used in the stand-
ard error for test statistic calculation, choose from: Pooled, Unpooled

1 or 2 Sided?: Select if the test will be a 1-sided or 2-sided, choose from 1 or 2

o Number of Looks: Specify the total number of looks (including the final analysis)
the group sequential design will have

o Efficacy Bound Parameterization: Select the statistical scale on which the
efficacy boundaries will be specified at Step 3: Boundary Table, choose from
Z-scale, p-value Scale, Score Scale, -Scale

o Futility Bound Parameterization: Select the statistical scale on which the futil-
ity boundaries will be specified at Step 3: Boundary Table, choose from Z-scale,
p-value Scale, Score Scale, -Scale

A summary of each of these fields is provided next.

Standard Deviation Definition allows the user to specify how the standard error
will be calculated. For the two sample Z-test for two proportions (equivalent to the
chi-squared test), two common choices for the standard error is the Pooled standard
error and Unpooled standard error. The Unpooled standard error uses the Group 1
Proportion and Group 2 Proportion to calculate the per-group variances (p; (1 — p;))
while the Pooled standard error calculates the variance in each group using the average
proportion (p (1 — p)). The choice of standard deviation should reflect that which will be
used in the clinical trial of interest.

Technical details on how the test statistic is constructed using the above assumptions
regarding the standard deviation is provided in subsubsection 8.7.2.2.

1 or 2 Sided? determines if the test will a one-sided (1) or two-sided (2) test. Note
that if this value is changed any existing values in the Boundary Table at Step 3:
Boundary Table will be deleted as this option will significantly alter the Boundary
Table. Note this deletion will apply to boundaries inherited from GST2 - Group
Sequential Design for Two Proportions see subsection 8.2.2.

If the Group Sequential Design Simulation Tool was opened from GST2 - Group
Sequential Design for Two Proportions using the GST Simulation button for a
solver complete column then each of the 1 or 2 Sided? will be filled with the 1
or 2 Sided Test? wvalue from the main design table - see subsection 8.2.2 for details.
Otherwise, a default of 1 (1-sided) will be used.

Number of Looks determines the total number of looks (including final analysis) in
the group sequential design. This will determine the number of rows in the Boundary
Table at Step 3: Boundary Table. Due to this if this value is changed any existing
values in the Boundary Table at Step 3: Boundary Table will be deleted as this
option will significantly alter the Boundary Table. Note this deletion will apply to
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boundaries inherited from GST2 - Group Sequential Design for Two Proportions
see subsection 8.2.2.

If the Group Sequential Design Simulation Tool was opened from GST2 - Group
Sequential Design for Two Proportions using the GST Simulation button for a
solver complete column then the Number of Looks field above will be filled with the
Number of Looks value from the main design table - see subsection 8.2.2 for details.
Otherwise, the Number of Looks field will be empty and will need to be filled by the
user.

Efficacy Bound Parameterization defines the statistical scale on which the group se-
quential efficacy boundaries will be specified in the Boundary Table at Step 3: Bound-
ary Table. The available statistical scales are: Z-scale, p-value Scale, Score Scale,
0-Scale (i.e. treatment effect scale - Proportion Difference for Two Proportions
Inequality scenario) and Don’t Calculate (i.e. no efficacy boundary). Detail on these
statistical scales and the conversions between them are provided in subsubsection 7.2.1.1,
subsubsection 7.2.4.5 and subsection 8.7.3 - note that the conversions which require the
Information will derive that value based on the the fields in Step 1: Simulation
Inputs.

Here the focus will be on the practical aspects of filling the Bounds columns.Note that for
the Z-scale, Score Scale and /-Scale the direction of the hypothesis if 1 or 2 Sided?
= 1 will depend on the final boundary value specified in the Boundary Table but that
for the p-value Scale it is always assumed that higher values for the treatment effect
(proportion difference for the Two Proportions Inequality scenario) are considered
better. Note that if this value is changed any existing values in the Boundary Table
at Step 3: Boundary Table will be deleted as this option will significantly alter the
Boundary Table. Note this deletion will apply to boundaries inherited from GST2 -
Group Sequential Design for Two Proportionss see subsection 8.2.2.

Futility Bound Parameterization defines the statistical scale on which the group se-
quential efficacy boundaries will be specified in the Boundary Table at Step 3: Bound-
ary Table. The available statistical scales are: Z-scale, p-value Scale, Score Scale,
0-Scale (i.e. treatment effect scale - Proportion Difference for Two Proportions
Inequality scenario) and Don’t Calculate (i.e. no futility boundary). Detail on these
statistical scales and the conversions between them are provided in subsubsection 7.2.1.1,
subsubsection 7.2.4.5 and subsection 8.7.3 - note that the conversions which require the
Information will derive that value based on the fields in Step 1: Simulation Inputs.

Here the focus will be on the practical aspects of filling the Bounds columns. Note that
for the Z-scale, Score Scale and J-Scale the direction of the hypothesis if 1 or 2 Sided?
= 1 will depend on the final boundary value specified in the Boundary Table but that
for the p-value Scale it is always assumed that higher values for the treatment effect
(proportion difference for the Two Proportions Inequality scenario) are considered
better. Note that if this value is changed any existing values in the Boundary Table
at Step 3: Boundary Table will be deleted as this option will significantly alter the
Boundary Table. Note this deletion will apply to boundaries inherited from GST2 -
Group Sequential Design for Two Proportionssee subsection 8.2.2.

If the Group Sequential Design Simulation Tool was opened from GST2 - Group
Sequential Design for Two Proportions using the GST Simulation button for a
solver complete column then the Efficacy Bound Parameterization and Futility
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Bound Parameterization fields above will be based on the Boundary Scale used in
the GST Outputs side-table - see subsubsection 7.3.2.2 and subsection 8.2.2 for details.
Otherwise, the Efficacy Bound Parameterization = Z-scale and Futility Bound
Parameterization = Don’t Calculate.

After all Design Parameters and Allocations Parameters are filled appropriately,
select the Next button in the bottom right of the Main Window to proceed to Step
3: Boundary Table.

8.4.4 Step 3: Boundary Table

Step 3: Boundary Table is the Input Step where the group sequential boundaries
are specified in the Boundary Table. The simulated test statistics calculated for each
look, based on the Inputs from Step 1: Simulation Inputs and relevant Step 2: Se-
quential Design Inputs fields, will be compared to the specified boundaries to evaluate
what outcome (stop for efficacy, stop for futility, continue) occured at that look. Given
a sufficient number of simulations this will provide an estimate of the exit probability at
each look for the specified simulation data generating process and design scenario.

An example Boundary Table from Step 3: Boundary Table is shown in subsection 8.4.4.

Home x | Group Sequential Desi X | Group Sequential Des: % | Group Sequential Desi X | Group Sequential Des: X | Group Sequential Desi X | Group Sequential Desi X | Group Sequential Desi X | + v

Workspace < Boundary Table <2 ’

¥ Setu v
k Look Sample Size Information Time | Efficacy Bound Boundary Table
40 0.20 -4.902523218 In the Boundary Table, specify the Sample Size/Information
81 040 -3.352400617 Time at with each look (i.e. row) will occur and efficacy

121 060 ~2.68310351 and/or futility bounds each look based on boundary

162 080 -2.285878749

arameter scale(s) specified in Step 2 (Sequential Design
202 1.00 -2.031611147 P (<) sp P2 (Seq 9

Inputs)

s |wln|a

Suggestion

If this simulation has been accessed through a group
sequential table then the default values here will be the
equivalent value from that table.

Updating the Sample Size or Information Time will
automatically update the other in that row.

The Efficacy and Futility Bound columns will depend on
whether 1 or 2 sided hypothesis and the respective
boundary scale selected at Step 2 (Sequential Design
Inputs). See Acceptable Entries below for more detail on
allowable ranges depending on scenario.

If the p-value scale is selected for the Efficacy Bound
Parameterization and/or Futility Bound Parameterization
at Step 2 then the p-values will be converted under the
assumption of a positive effect size. For example in a 2-

Back Next sided design, the upper efficacy/futility bounds will be

Figure 8.12: Step 3: Boundary Table

The Boundary Table allows the user to edit the Sample Size/Information Time at
each Look where each row of the Boundary Table corresponds to a planned interim
analysis with the final row (Look 5 in subsection 8.4.4) being the final planned analysis.
The number of rows is set by the Number of Looks field at Step 2: Sequential
Design Inputs. Note that if the Number of Looks is changed any existing values in
the Boundary Table will be deleted.

The Boundary Table columns will consist of the Look, Sample Size, Information
Time and at least one Bound row from the following options: Efficacy Bound, Futility
Bound, Upper Efficacy Bound, Lower Efficacy Bound, Upper Futility Bound,
Lower Futility Bound. The boundaries shown will depend on the selection made
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for the 1 or 2 Sided?, Efficacy Bound Parameterization and Futility Bound
Parameterization fields at Step 2: Sequential Design Inputs. These boundary
scenarios will be discussed later but the Look, Sample Size and Information columns
will be discussed first.

The Look column is a read-only column which allows the user quickly see which Look
number each row in the Boundary Table corresponds to. The Look column value in
the final row will equal Number of Looks from Step 2: Sequential Design Inputs.

The Sample Size column in the Boundary Table is the total sample size planned for
the specified Look’s interim analysis to occur. This Sample Size value in the final row
for the final analysis will equal the Maximum Sample Size and is based on the sample
sizes specified at Step 1: Simulation Inputs. This final row Maximum Sample Size
value is read-only and can only be changed by editing relevant sample size related fields
in Step 1: Simulation Inputs and selecting the Next button. For example, for the
Two Means Inequality Scenario referenced above this final row Sample Size value
would equal the sum of the Group 1 Sample Size and Group 2 Sample Size fields.
Note that Sample Size will be replaced with Events for survival analysis (Endpoint
of Interest = Survival in Step 0: Select GST Simulation Type or table such as
GST3 - Group Sequential Design for Two Survival)

The Information Time column in the Boundary Table specifies the proportion of the
Maximum Sample Size (sample size is proportional to the (Fisher) Information - see
subsection 7.2.5) required for a specified Look’s interim analysis to occur. The value for
the Information Time is set to 1 and cannot be edited as this is maximum value by
definition for the Information Time (subsubsection 7.2.1.1).

In rows other than the final row, the Sample Size row values will equal the Maximum
Sample Size multiplied by the Information Time in that row. Alternatively, the
Information Time will equal the Sample Size in that row divided by the Maximum
Sample Size. Given this relationship if either the Sample Size or Information Time
are edited in a given row then the other value will be automatically updated to ensure
consistency. Note that since Sample Size is an integer, the calculated sample size may
be rounded for a given Information Time input.

If the Group Sequential Design Simulation Tool was opened using the GST Sim-
ulation button for a solver complete column in Group Sequential Design Table
(e.g. GST1 - Group Sequential Design for Two Means) then the Sample Size
and Information Time column values will be based on the Total Sample Size and
Information Time rows in the GST Outputs side-table - see subsubsection 7.3.2.2
and subsection 8.2.2 for details. Note that all defaults for the Boundary Table will be
deleted if following fields are changed at Step 2: Sequential Design Inputs: 1 or 2
Sided?, Number of Looks, Efficacy Bound Parameterization, Futility Bound
Parameterization.

Otherwise, an equally spaced design is assumed where the Information Time equals
the value for Look column in each row divided by the value for Look in the final row

(k/K) .

We will now discuss the Boundary column(s) available in the Boundary Table. As
stated earlier, the Boundary Table must include at least one Bound column from the
following options: Efficacy Bound, Futility Bound, Upper Efficacy Bound, Lower
Efficacy Bound, Upper Futility Bound, Lower Futility Bound.
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The Boundary columns displayed will depend on the options chosen for the 1 or 2
Sided?, Efficacy Bound Parameterization and Futility Bound Parameterization
fields at Step 2: Sequential Design Inputs.

Both the Bound Parameterization fields have the same options (Z-scale, p-value
Scale, Score Scale, /-Scale and Don’t Calculate). For the purposes of the deciding
which which Bound columns appear the Z-scale, p-value Scale, Score Scale, /-
Scale are inter-changeable with the Don’t Calculate providing different outcomes. The
full list of combinations possible for the Bound columns with their associated Step 2:
Sequential Design Inputs is as follows:

Efficacy Bound - 1 or 2 Sided? = 1 & Efficacy Bound Parameterization
# Don’t Calculate & Futility Bound Parameterization = Don’t Calculate

Futility Bound - 1 or 2 Sided? = 1 & Efficacy Bound Parameterization
= Don’t Calculate & Futility Bound Parameterization # Don’t Calculate

Efficacy Bound, Futility Bound - 1 or 2 Sided? = 1 & Efficacy Bound
Parameterization # Don’t Calculate & Futility Bound Parameterization
# Don’t Calculate

Upper Efficacy Bound , Lower Efficacy Bound - 1 or 2 Sided? = 2 &
Efficacy Bound Parameterization # Don’t Calculate & Futility Bound
Parameterization = Don’t Calculate

Upper Futility Bound, Lower Futility Bound - 1 or 2 Sided? = 2 &
Efficacy Bound Parameterization = Don’t Calculate & Futility Bound
Parameterization # Don’t Calculate

Upper Efficacy Bound, Lower Efficacy Bound, Upper Futility Bound,
Lower Futility Bound - 1 or 2 Sided? = 2 & Efficacy Bound Paramet-
erization # Don’t Calculate & Futility Bound Parameterization # Don’t
Calculate

All six scenario Boundary Table are shown in (unfilled) in Figure 8.12.
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Boundary Table 1 Boundary Table 4

T Sample Size Information Time | Efficacy Bound Look Sample Size | Information Time | Lower Efficacy Bound | Upper Efficacy Bound
10 020 1 40 0.20

81 040 2 81 0.40

121 060 3 121 0.60

162 080 4 162 0.80

200 100 5 202 1.00

s win -

Boundary Table 2 Boundary Table 5

Look Sample Size Information Time Futility Bound Look Sample Size Information Time Lower Futility Bound | Upper Futility Bound
40 020 40 0.20

81 040

121 0.60

162 0.80

202 1.00

1

2 81 040
3 121 0.60
4 162 0.80
5 202 1.00

ol we -

dary Tabl . ) -
Boundary Table 3 1: 1-sided, Efficacy # Don't Calc,, Futility = Don't

Look Sample Size Information Time | Efficacy Bound Futility Bound Calculate

i 40 020 2: 1-sided, Efficacy = Don't Calc., Futility # Don't
2 81 0.40
B o 050 Calculate
4 162 040 3: 1-sided, Efficacy # Don't Calc., Futility # Don't
J 202 o Calculate
Boundary Table 6 4: 2-sided, Efficacy # Don't Calc., Futility = Don't
Calculate
Look Sample Size Information Time | Lower Efficacy Bou... | Upper Efficacy Bou... | Lower Futility Bound | Upper Futility Bound ! . . _ . - \
. o 020 5: 2-sided, Efficacy = Don't Calc., Futility # Don't
2 81 040 Calculate
i 12; 252 6: 2-sided, Efficacy # Don't Calc., Futility # Don't
5 T 100 Calculate

Figure 8.13: Boundary Table Scenarios

To simplify future discussions, these will be referred to as the 1-sided Efficacy Only, 1-
sided Futility Only, 1-sided Efficacy and Futility, 2-sided Efficacy Only, 2-sided
Futility Only and 2-sided Efficacy and Futility respectively.

The interpretation of the Bounds in terms of user input will depend on the choice of
Efficacy Bound Parameterization and/or Futility Bound Parameterization fields
at Step 2: Sequential Design Inputs. Assuming a Bound column is available it was
specified on one of the following scales: Z-scale, p-value Scale, Score Scale, §-Scale

Technical detail on each of these scales and conversions between them can be found in
subsubsection 7.2.1.1, subsubsection 7.2.4.5 and subsection 8.7.3. Note that the conver-

sions which require the Information will derive that value based on the the fields in
Step 1: Simulation Inputs.

Here the focus will be on the practical aspects of filling the Bounds columns.

If the Bound Parameterization = Z-scale, Score Scale, §-Scale then the Bounds
row values can take on any real value - restrictions on these scales will only exist to ensure
the Bounds are consistent. The p-value Scale Bounds must be between 0 and 1 and
also consistent. Consistent means the boundaries are not contradictory e.g. Efficacy
Bounds crossing over with Futility Bounds mid-trial.

In addition, the directionality of the hypothesis is determined by the Bound values in
the final row of the Boundary Table. The directionality refers to which direction of the
treatment effect (e.g. mean difference for Two Means Inequality scenario) is considered
“better”. This will determine the exit regions for the specified (Upper/Lower) Efficacy
Bounds and/or (Upper/Lower) Futility Bounds.

For example, for the 1-sided Efficacy Only scenario if the final Efficacy Bound value
is greater than zero (i.e. positive) when Efficacy Bound Parameterization = Z-
scale, Score Scale, d-Scale then this implies that higher treatment effects (e.g. more
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positive mean differences) are “better” and lower treatment effects are “worse”. Therefore,
Stopping for Efficacy will only occur at each interim look if the simulated test statistic
is greater than the specified Efficacy Bound value on the selected boundary scale.
Conversely, if the final Efficacy Bound was negative (<0) then Stopping for Efficacy
would only occur if the simulated test statistic is less than the specified Efficacy Bound
value at each look.

Note that for the p-value Scale, the hypothesis is always assumed to positive but for
p-values this equates to lower p-values being considered “better” than higher p-values.
This is expected given the normal usage of p-values within the context of null hypothesis
testing where the test is rejected for sufficiently low p-value regardless of hypothesis
direction. Therefore, for p-value scale can invert the rules discussed for other scales below
for “higher treatment effect better” e.g. Efficacy p-value must always be lower than
Futility p-value, Stopping for Efficacy always happens if below Efficacy p-value
Bound.

If the Group Sequential Design Simulation Tool was opened using the GST Sim-
ulation button for a solver complete column in Group Sequential Design Table
(e.g. GST1 - Group Sequential Design for Two Means) then the relevant Bounds
column values will be based on the corresponds Bounds rows of the same name in the
GST Outputs side-table - see subsubsection 7.3.2.2 and subsection 8.2.2 for details.
Note that all defaults for the Boundary Table will be deleted if following fields are
changed at Step 2: Sequential Design Inputs: 1 or 2 Sided?, Number of Looks,
Efficacy Bound Parameterization, Futility Bound Parameterization.

To assist users, a summary of the consistency and directionality criteria are collated
for the six scenarios referenced above for the Z-scale, Score Scale, J-Scale (p-value
Scale always same direction - see above).. Note we will assume that where Efficacy
Bounds and Futility Bounds are both present that both have been selected on the
same Parameterization. Note this is not required in the nQuery interface, which will
automatically convert all bounds to the Z-scale and check for consistency, but is done for
clarity.

8.4.4.1 1-Sided Efficacy Only

Consistency No consistency constraints

Directionality Defined by final row value in Efficacy Bound column

o If Final Efficacy Bound > 0 then higher treatment effects better = Stop Early

for Efficacy if Test Statistic > Efficacy Bound, otherwise continue to next
look

o If Final Efficacy Bound > 0 then lower treatment effects better = Stop Early

for Efficacy if Test Statistic < Efficacy Bound, otherwise continue to next
look

8.4.4.2 1-Sided Futility Only

Consistency No consistency constraints
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Directionality Defined by final row value in Futility Bound column

o If Final Futility Bound > 0 then higher treatment effects better = Stop Early
for Futility if Test Statistic < Futility Bound, otherwise continue to next
look

o If Final Futility Bound > 0 then lower treatment effects better = Stop Early
for Futility if Test Statistic > Futility Bound, otherwise continue to next
look

8.4.4.3 1-Sided Efficacy and Futility

Consistency All Efficacy Bound > Futility Bound or All Efficacy Bound <
Futility Bound

Directionality Defined by order of interim bounds

o If Interim Efficacy Bounds > Interim Efficacy Bounds then higher treatment
effects better = Stop Early for Efficacy if Test Statistic > Efficacy Bound
or Stop Early for Futility if Test Statistic < Futility Bound, otherwise
continue to next look

o If Interim Efficacy Bounds < Interim Efficacy Bound then lower treatment
effects better = Stop Early for Efficacy if Test Statistic < Efficacy Bound
or Stop Early for Futility if Test Statistic > Futility Bound, otherwise
continue to next look

8.4.4.4 2-Sided Efficacy Only

Consistency All Upper Efficacy Bound > Lower Efficacy Bound or All Upper
Efficacy Bound < Lower Efficacy Bound

Directionality Defined by order of all bounds

o If All Upper Efficacy Bound > All Lower Efficacy Bound then higher treat-
ment effects better = Stop Early for Efficacy if Test Statistic > Upper Effic-
acy Bound or Test Statistic < Lower Efficacy Bound, otherwise continue
to next look

o If All Upper Efficacy Bound < All Lower Efficacy Bound then lower treat-
ment effects better = Stop Early for Efficacy if Test Statistic < Upper Effic-
acy Bound or Test Statistic > Lower Efficacy Bound, otherwise continue
to next look

8.4.4.5 2-Sided Futility Only

Consistency All Upper Futility Bound > Lower Futility Bound or All Upper
Futility Bound < Lower Futility Bound
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Directionality Defined by order of all bounds

o If All Upper Futility Bound > All Futility Efficacy Bound then higher
treatment effects better = Stop Early for Futility if Lower Futility Bound <
Test Statistic < Upper Futility Bound i.e. between futility bounds, otherwise
continue to next look

o If All Upper Futility Bound > All Lower Futility Bound then lower treat-
ment effects better = Stop Early for Futility if Lower Futility Bound >
Test Statistic > Upper Futility Bound i.e. between futility bounds, other-
wise continue to next look

8.4.4.6 2-Sided Efficacy and Futility

Consistency Upper Efficacy Bound > Upper Futility Bound > Lower Futility
Bound > Lower Efficacy Bound or Upper Efficacy Bound < Upper Futility
Bound < Lower Futility Bound < Lower Efficacy Bound

Directionality Defined by order of all bounds

o If All Upper Efficacy Bound > Upper Futility Bound > Lower Futil-
ity Bound > Lower Efficacy Bound then higher treatment effects better =
Stop Early for Efficacy if Test Statistic > Upper Efficacy Bound or Test
Statistic < Lower Efficacy Bound or Stop Early for Futility if Lower Fu-
tility Bound < Test Statistic < Upper Futility Bound i.e. between futility
bounds, otherwise continue to next look i.e. continue if between Upper Fu-
tility Bound and Upper Efficacy Bound or between Lower Efficacy Bound
and Lower Futility Bound

o If All Upper Efficacy Bound < Upper Futility Bound < Lower Futil-
ity Bound < Lower Efficacy Bound then lower treatment effects better =
Stop Early for Efficacy if Test Statistic < Upper Efficacy Bound or Test
Statistic > Lower Efficacy Bound or Stop Early for Futility if Lower Fu-
tility Bound > Test Statistic > Upper Futility Bound i.e. between futility
bounds, otherwise continue to next look i.e. continue if between Upper Fu-
tility Bound and Upper Efficacy Bound or between Lower Efficacy Bound
and Lower Futility Bound

Practical examples of the rules for stopping were provided in subsubsection 7.3.5.2 so may
be worth reviewing. A technical treatment of the above is provided in subsection 8.7.3.

After the Boundary Table has been filled appropriately, select the Next button in the
bottom right of the Main Window to proceed to Step 4: Simulation Controls.

8.4.5 Step 4: Simulation Controls

Step 4: Simulation Controls provides control over the number of simulation, refresh
frequency during the simulation process, the random seed used by the simulation quasi-
random process and which options Tables should be provided in the Group Sequential
Design Simulation Outputs. Step 4: Simulation Controls is shown in Figure 8.14.
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Home x | Group Sequential Des: X | Group Sequential Desi X | Group Sequential Des: X | Group Sequential Desi X | Group Sequential Desi X | Group Sequential Desi X | Group Sequential Desi X | Group Sequential Des X | + v

Workspace < Simulation Controls <

Setu| o . "
skseup Cimulation Contol Simulation Controls
imulation Controls
The Simulation Controls provides options to setup the
simulation and define which outputs will be provided in the

Refresh Frequency 1000 simulation results.

Number of Simulations 10000

Random Seed
Simulation Options:

Output Options Number of Simulations: The total number of simulations
that will be used.
/| Save summary statistics for every simulation run
Refresh Frequency: The number of simulations after which
the simulation loading screen will refresh. Interim reporting
will update after each refresh.

/| Save subject-level data for | 10 simulation runs

Random Seed: The random seed for the pseudo-random
number generator. By default, this is blank and will be based
on the system time. Note that the seed used will be
outputted within the Simulation Report once the simulation
has completed.

Output Options:

Save summary statistics for every simulation run: Check
this box if you want a table containing summary statistics for
each simulation at each look.

Save subject-level data for every X simulation runs:
Back Run Check this box if you want a table containing the simulation

Figure 8.14: Step 4: Simulation Controls

The Step 4: Simulation Controls is unaffected by any of the prior Input Steps and
therefore the same for all scenarios. Step 4: Simulation Controls has two sections:
Simulation Controls, Output Options

8.4.5.1 Simulation Controls

The Simulation Controls fields controls the simulation overall and has the following
input fields:

e Number of Simulations: The total number of simulated trials that will be gen-
erated. The higher this value the more reliable the estimates will be but it will take
longer to generate simulation results - Default: 10000

o Refresh Frequency: Controls how often the Calculation in Progress window
will be updated while simulations are being generated. The Calculation in Pro-
gress window will show the Average Sample Size, Efficacy % and Futility %
based for the displayed proportion of the total simulations complete at that point
in time. The total number of updates equals Number of Simulations divided by
Refresh Frequency. Higher values will update the Calculation in Progress values
more often at a small performance cost - Default: 1000

« Random Seed: Random seed for quasi-random method used to generate random
simulations. This can be set to an explicit value so that a simulation can be exactly
replicated later. If left blank, a random seed is generated based on the system clock
- this seed is provided in the Simulation Summary section of the Simulation
Report (subsection 8.5.1). - Default: (Blank)

Note that to prevent slow performance nQuery sets a limit on the maximum Number of
Simulations. By default this limit is 100000. This limit can be changed by editing the
Maximum Number of Simulations field under the Predict heading in the Options
menu available under the File menu. See section 2.3 for details on the Options menu.

Output Options
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The Output Options fields control which additional spreadsheet outputs are generated
under the Tables header in the Group Sequential Design Simulation Outputs. It
has the following fields:

« Save summary statistics for every simulation run: Select if a spreadsheet
containing a summary of every simulation run (on per-look basis) should be provided
in the Summary Data Per-Simulation table in the Group Sequential Design
Simulation Outputs. Check or uncheck the box to the left of this option to
include or exclude the Summary Data Per-Simulation table - Default: On

« Save subject-level data for every X simulation runs: Select if a spreadsheet
containing “X” number of runs of the simulated data should be provided in the Per-
Simulation Subject Data table in the Group Sequential Design Simulation
Outputs. Specify the desired number of simulation runs to include in the “X” field
and check or uncheck the box to the left of this option to include or exclude the
Per-Simulation Subject Data table. - Default: On, X = 10

Note that to prevent slow performance nQuery sets a limit on the maximum number of
rows that can be displayed in Table outputs. By default this limit is 20000. This limit
can be changed by editing the Maximum Number of Rows in Generated Reports
field under the Predict heading in the Options menu available under the File menu.
See section 2.3 for details on the Options menu.

Save summary statistics for every simulation run number of rows will equal Num-
ber of Simulations

Save subject-level data for every X simulation runs number of rows will depend
on when a given simulation stopped (data after stopping early is excluded) but will have
maximum equal to “X” multipled by Maximum Sample

After the Simulation Controls has been filled appropriately, select the Run button in
the bottom right of the Main Window. This will open the Calculation in Progress
dialog which will provide updated estimates for the Average Sample Size, Efficacy %
and Futility % until the simulation is complete and the Group Sequential Design
Simulation Outputs are generated. The Main Window will then display the Simu-
lation Report containing the simulation results.

8.5 Group Sequential Design Simulation Outputs

After all Group Sequential Design Simulation Input steps have filled appropriately
in turn, Run is selected at Step 4: Simulation Controls step to run the simulation
algorithm. After the Calculation in Progress dialog is complete, simulation is finished
and the Group Sequential Design Simulation Outputs are generated.

Group Sequential Design Simulation Outputs provide multiple outputs which allow
the user to understand, explore and visualize the results of the simulation that was ran.
These outputs can also be saved and exported for further collaboration.

The are four primary Group Sequential Design Simulation Outputs:
e Simulation Report

* Rejection Plot
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« Boundary Plot

e Output Tables (optional)
— Summary Data Per-Simulation
— Per-Simulation Subject Data

A detailed summary of each of these Group Sequential Design Simulation Outputs
is provided next.

8.5.1 Simulation Report

The Simulation Report provides a detailed summary of the inputs and simulation
results for the current simulation. The Simulation Report is shown by default after a
simulation is run but can also be opened from the Reports header in the Workspace Bar
on the left side (section 8.3). An example Simulation Report is shown in Figure 8.15.

wospace =B Cseedn @ac-apE B =0 JE
% Setup ~
¥ Simulation Inputs

¥ Sequential Design Inputs
¥ Boundary Table

¥ Simulation Controls. . .
Design Parameters Boundaries

[El Reports ~ " " "
et
[E] simulation Report
1.000000000 1 0.200000000 -4902523218
b ~
FPlots m -1.000000000 2 0.400000000 -3.352400617
5o
bl e 2500000000 3 0600000000 2683103510
3% Boundary Plot |
| Group 2 Standard Deviation 2.500000000 4 0.800000000 -2.285878749
[ Tables " 80.940000000% 5 1000000000 2031611147
[ summary Data Per-Simulation
Per-Simulation Subject Data .
8 Allocation Parameters Number Stopping
o sarpesn
101 1 2 0,020000000% 2 0,020000000%
1.000000000 2 579 5.790000000% 579 5.790000000%
Fixed by Ratio 3 2531 25.310000000% 2531 25.310000000%
;Avemgesampbﬁe 162136600000 4 3081 30.810000000% 3081 30.810000000%
5 1901 19,010000000% 3807 38.070000000%
Distribution Parameters Total 8094 80.940000000% 10000 100.000000000%

| Standard Deviation Definition Pooled Known, 6 Z)

25500000000

Figure 8.15: Group Sequential Simulation Report

8.5.1.1 Simulation Report Toolbar
At the top of the group sequential report, there is the Toolbar. The Toolbar contains
buttons which provide options for document search, printing, page setup, zoom, page

view and export options. The toolbar options available for for the Simulation Report
are shown in Figure 8.16.

B S ae HE @ac-apBin =3
1 2 3 4 5 6 7 8 9 10 11 1213 14 15 16 17 18 19 20 21 22 23

Figure 8.16: Report Toolbar

These options are defined as follows (with the most important bolded):
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. Open: Open another nQuery Predict Report (.prnx) - not recommended as over-

writes current report

Save: Save current nQuery Predict Report (.prnx) - not recommended, see Export
(21) for better save options

3. Help: Unused here

URL: Unused here

Search: Search for text in current report. This will appear in Navigation Panel on
right. Select “x” in top-right or Navigation Panel (14) button to hide.

6. Print: Open Print menu for current report

10.
11.
12.
13.
14.

15.
16.
17.
18.

19.
20.
21.

22.

23

Quick Print: Print report using system defaults

. Page Setup: Open Page Setup window to edit page size, orientation and margin

sizes. Note that the report does not scale automatically to the new page setup.

Scale: Open Scale window to rescale size of report text by percentage or page size.
Note the page size is not automatically updated to reflect changes to scale.

First Page: Return to first page (if report has multiple pages)
Page Up: Go up one page (if report has multiple pages)
Page Down: Go down one page (if report has multiple pages)
Last Page: Go to last page if report has multiple pages

Navigation Pane: Open and close Navigation Pane. Contains Pages list and Search
Results window

Zoom Out: Zoom out report by one increment
Zoom: Change the current zoom level from list of options
Zoom In: Zoom in report by one increment

Page Layout: Set out how multiple pages are displayed (Single Page, Two Pages,
Wrap Around)

Continuous Scolling: Enable or disable continuous scrolling in report
Show Cover Page: Show cover (first) page

Export: Export report as other file type. Select arrow to see list in-report or select

icon to open Export window. The Export option can be used to save the report in
the following file formats: PDF, HTML, MHT, RDF, DOCX, XLS, XLSX, CSV,
Plain Text File (TXT), Image File (PNG, JPEG, BMP, GIF, EMF, WMF, TIFF).

Send: Send report as email in export file type using system default email client.

Watermark: Add watermark to report using Watermark menu

8.5.1.2 Simulation Report Sections

The Simulation Report can be split into two columns with the left-hand column con-
taining fields summarizd by a single value while the right-hand column contains tabular
information.

The following sections are included in the left-hand column:

279



8.5 Group Sequential Design Simulation Outputs

o Design Parameters (Step 1 Design Parameters, Average Power)
 Allocation Parameters (Step 1 Allocation Parameters, Average Sample Size)
« Distribution Parameters (Endpoint Specific Step 2 Parameters)
o Simulation Summary (Step 4 Parameters)

The following table sections are included in the right-hand column:
» Boundaries (Step 3 Boundary Table)

o Number Stopping (Number of Simulation and % Simulations stopped at each look
for each boundary)

Some group sequential simulation scenarios require sections unique to that scenario (e.g.
Piecewise Survival table for survival endpoint). These will be discussed later.

A summary of each section is provided next.

Design Parameters The Design Parameters section provides an overview of the fixed
term design parameters and average power.

The Design Parameters section will contain the following fields:

“Design-Specific” Fields: The set of fixed parameter inputs required for that spe-
cific design scenario. These will differ significantly depending on group sequential scenario
and will be taken from the Design Parameters section in Step 1: Simulation In-
puts. For example for the Two Means Inequality scenario (Endpoint of Interest
= Mean, Number of Groups = 2, Analysis Method = Inequality), the Group
1 Mean, Group 2 Mean, Mean Difference, Group 1 Standard Deviation and
Group 2 Standard Deviation fields would be included in the Design Parameters
section. See subsection 8.4.2 for Design Parameters required at Step 1: Simulation
Inputs for all currently supported Group Sequential Design Simulation scenarios.

Average Power The Average Power is the percentage of simulations where the
trial Stopped for Efficacy. This will equal the sum of all the (Upper/Lower) Ef-
ficacy % rows in the Number Stopping table in the Simulation Report (or 100 -
> (Upper/Lower) Efficacy % if only Futility % available)

In statistical testing, statistical power is the probability of rejecting the null hypothesis
given a specified alternative hypothesis. It also equals 1 - Type II error, which the
probability of finding for Futility given a specified alternative hypothesis. Simulation
provides a very flexible mechanism to find statistical power for a given group sequential
design for a wide variety of scenarios. See subsection 7.2.3 for technical discussion on
Type II error and statistical power in the context of group sequential designs.

Example Design Parameters sections for the Two Mean Inequality and Two Pro-
portion Inequality scenarios are provided in Figure 8.17

280



8.5 Group Sequential Design Simulation Outputs

Designh Parameters

I Group 1 Mean 0.000000000
|

: Group 2 Mean 1.000000000

: Mean Difference -1.000000000
|
' Group 1 Standard Deviabion 2500000000
|
: Group 2 Standard Deviation 2.500000000

: Average Power (%) 80.940000000%

Design Parameters

i Group 1 Proportion 0.500000000

: Group 2 Proportion 0.600000000
-0.100000000
88.030000000%

Figure 8.17: Simulation Report Design Parameters Section Examples

Allocation Parameters The Allocation Parameters section provides an overview of
the allocation parameters such as the sample size and randomization method.

The Allocation Parameters section will contain the following fields:

Allocation Parameters “Sample Size” Fields:  The sample size fields summarize
the sample size parameters from the Allocation Parameters section from Step 1:
Simulation Inputs. For example, for the Two Means Inequality and Two Propor-
tions Inequality scenarios the Allocation Parameters section will contain Group 1
Sample Size, Group 2 Sample Size and Sample Size Ratio as per their respective
Step 1: Simulation Inputs.

Note that for Endpoint of Interest = Survival, the Allocation Parameters section
will include similiar fields for the Number of Events and Events per Group, alongside
the sample size fields above.
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Randomization The randomization algorithm selected from the Allocation Para-
meters section in Step 1: Simulation Inputs. Will equal either Fixed Allocation
(data simulated to have exact per-group sample sizes specified in Step 1: Simulation
Inputs) or Complete Randomization (allocation controlled by random binomial vari-
able). These allocation methods are discussed in detail in subsection 8.4.2 and section 8.7.
Note this option will not be shown if Number of Groups = 1 since there is no allocation
in single arm trials.

Average Sample Size The expected sample size the expected total sample size ex-
pected given the Group Sequential Design Simulation Inputs provided. This will
equal taking sum of the multiplication of each row of Total %/100 (from Number
Stopping table) by the Sample Size (from Boundary Table).

For example, if values were inherited from a Group Sequential Design Table using
the GST Simulation button (see subsection 8.2.2) then if the defaults were used for
each step this would be the average sample size under the alternative hypothesis (H;)
and should approximately equal the Expected Sample Size under H; in the Group
Sequential Report (subsection 7.3.4) from the original design table. Similarly if the only
change made was set the treatment effect to the null hypothesis (e.g. Mean Difference = 0
for Two Means Inequality scenario) then this should approximate Expected Sample
Size under H,.

An example Allocation Parameters section for the Two Mean Inequality scenario
is provided in Figure 8.18

Allocation Parameters

- Group 1 Sample Size 101
101

1.000000000
Fixed by Ratio

162136600000

Figure 8.18: Simulation Report Allocation Parameters Section

Distribution Parameters The Distribution Parameters section provides an overview
of scenario specific fields specified at Step 2: Sequential Design Inputs.

For example for the Two Means Inequality scenario where Standard Deviation
Definition = Known Pooled Z(c), the following fields are included in the Distribution
Parameters section: Standard Deviation Definition, Known Standard Devi-
ation, Boundary Decision
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Given that the Distribution Parameters required will change depending on the design
scenario, the reader is referred to subsection 8.4.3 for details for a summary of the scenario
specific Distribution Parameters.

Example Distribution Parameters sections (first two Two Mean Inequality, third
for Two Proportion Inequality) are provided in Figure 8.19

Distribution Parameters

: Standard Deviation Definbion Pooled Known, o (£}

: Known 5Standard Dewviation 2.500000000
|

' Boundary Decision Z-Distribution

Distribution Parameters

Unpooled Unknown, sit)

t-Distribution

Distribution Parameters

|
| Standard Deviation Definition Unpooled

Figure 8.19: Simulation Report Distribution Parameters Section

Simulation Summary The Simulation Summary section provides an overview of sim-
ulation tuning parameters specified at Step 4: Simulation Controls. It contains the
following fields for all scenarios:

Random Seed Random seed for quasi-random method used to generate random sim-
ulations. If this was left blank at Step 4: Simulation Controls. a random seed was
generated based on the system clock which is being provided in this field.

Number of Simulations The total number of simulated trials generated. The higher
this value the more reliable the estimates will be.

Simulation Time (s) The length of time, in seconds, it took for the simulation to
complete.

An example Simulation Summary section is provided in Figure 8.20
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Simulation Summary

[
| Seed 1601925320
10000

:Simhti:]nTlnE (s) 1.639053800

Figure 8.20: Simulation Report Allocation Parameters Section

Boundaries The Boundaries table provides a summary of the group sequential efficacy
and/or futility boundaries on the desired statistical scale. Each row will correspond
to a Look. The table will contain the following columns: Analysis/Look Number,
Information Fraction and Boundaries columns.

Analysis/Look Number:  The look number (k) associated with each row of the
Boundary Table from Step 3: Boundary Table. The final row corresponds to the
final planned analysis.

Information Fraction The information fraction at each interim analysis. This is
equivalent to the proportion of the total sample sizeat a given look and will equal the
Information Fraction column from Step 3: Boundary Table.

Boundaries The Boundaries columns provide the efficacy and/or futility bound-
aries used for decision making about early stopping during the simulation. There can
be anywhere between 1-4 Boundaries columns depending on the inputs from Step 2:
Sequential Design Inputs.

Each Boundaries column will have a column title of the form “Boundaries (Scale) -
(Upper/Lower) Efficacy/Futility” where Scale refers to the statistical scale the boundary
is provided on, Upper/Lower are provided for a 2-sided designs to differentiate between
the upper and lower bounds and Efficacy/Futility refers to if the boundary is an efficacy
or futility bound.

The six primary types are:

1. Boundaries (Scale) - Efficacy: The 1-sided efficacy boundary beyond which the
trial would stop for efficacy. Only present if 1 or 2 Sided? = 1 and Efficacy
Bound Parameterization # Don’t Calculate at Step 2: Sequential Design
Inputs

2. Boundaries (Scale) - Futility: The 1-sided futility boundary beyond which the
trial would stop for futility. Only present if 1 or 2 Sided? = 1 and Futility
Bound Parameterization # Don’t Calculate at Step 2: Sequential Design
Inputs
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3. Boundaries (Scale) - Upper Efficacy: The 2-sided upper efficacy boundary
above which the trial would stop for efficacy. Only present if 1 or 2 Sided?
= 2 and Efficacy Bound Parameterization # Don’t Calculate at Step 2:
Sequential Design Inputs

4. Boundaries (Scale) - Lower Efficacy: The 2-sided lower efficacy boundary
below which the trial would stop for “efficacy” - assuming both directions are truly
considered “effective”!. Only present if 1 or 2 Sided? = 2 and Efficacy Bound
Parameterization # Don’t Calculate at Step 2: Sequential Design Inputs

5. Boundaries (Scale) - Upper Futility: The 2-sided upper futility boundary
where the trial will stop early for futility if the test statistic falls between the upper
and lower futility boundaries. Only present if 1 or 2 Sided? = 2 and Futility
Bound Parameterization # Don’t Calculate at Step 2: Sequential Design
Inputs

6. Boundaries (Scale) - Lower Futility: The 2-sided lower futility boundary where
the trial will stop early for futility if the test statistic falls between the upper and
lower futility boundaries. Only present if 1 or 2 Sided? = 2 and Futility Bound
Parameterization # Don’t Calculate at Step 2: Sequential Design Inputs

The statistical scale shown in (Scale) above depends on the choices in Efficacy Bound
Parameterization and Futility Bound Parameterization at Step 2: Sequential
Design Inputs for the Efficacy and Futility bounds respectively. The available scales
are Z-scale, p-value Scale, Score Scale and J-Scale (i.e. treatment effect e.g. mean
difference for Two Means Inequality scenario).

Note that the direction “beyond” which the test will stop for efficacy and/or futility
will depend on value in the final row for Boundaries (Scale) - Efficacy/Boundaries
(Scale) - Upper Efficacy or if Efficacy Bound Parameterization = Don’t Cal-
culate then Boundaries (Scale) - Futility/Boundaries (Scale) - Upper Futility.
See subsection 8.4.4 for a detailed breakdown for every scenario above.

Examples of the Boundaries table for a variety of scenarios is shown in Figure 8.21.
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Boundaries
1 0200000000 -4 876884949
2 0400000000 -3.357011194
3 0.600000000 -2.680279717
4 0.800000000 -2.269816770
5 1000000000 -2.031032169
Boundaries
0500000000 0.015502863 0152590667
2 1.000000000 0017405036 0017405036
Boundaries
0.684805068 -0.884805068
2 187 3.850034629 -3.850034629
3 280 7501168252 -7.501168262
Boundaries
279701911 -2.797019116 0214732221 0214732221
2 153 1352037033 -1.352037033 0420023635 -0420023635
3 230 0879220874 -0.879220874 0.566146695 -0.566146695
4 306 065215161 -0.6521516M 0652151611 -0652151611

Figure 8.21: Simulation Report Boundaries Table Examples

Number Stopping The Numbers Stopping table provides the number and percent-
age of the simulations stopped at each look where each table row will correspond to a
Look. The table will contain the following columns: Analysis/Look Number, (Up-
per/Lower) Efficacy, (Upper/Lower) Efficacy %, Futility, Futility %, Total,
Total %

Analysis/Look Number:  The look number (k) associated with each row of the
Boundary Table from Step 3: Boundary Table. The final Total row refers to the
sum of all cells in that column.

(Upper/Lower) Efficacy and (Upper/Lower) Efficacy % The Efficacy column(s)
provide the count of how many simulations Stopped for Efficacy at each analysis based
on the Efficacy Boundaries provided in the Boundaries table above. The Efficacy
value in the final Total row provides the total number of subjects who Stopped for
Efficacy in the simulation. If there are no Futility Boundaries then 1 - Total row
provides the number of simulations which Stopped for Futility at the final analysis.

286



8.5 Group Sequential Design Simulation Outputs

The Efficacy % column(s) provide the percentage of how many simulations Stopped for
Efficacy at each analysis based on the Efficacy Boundaries provided in the Boundar-
ies table above. The Efficacy value in the final Total row provides the total percentage
of subjects who Stopped for Efficacy in the simulation. This will equal the Average
Power in the Design Parameters table. If there are no Futility Boundaries then
1 - Total row the percentage of simulations which Stopped for Futility at the final
analysis.

If 1 or 2 Sided? = 1 at Step 2: Sequential Design Inputs then there will be one
column named Efficacy containing the efficacy counts per look and one column named
Efficacy % containing the efficacy percentages per look.

If 1 or 2 Sided? = 2 at Step 2: Sequential Design Inputs then there will be a Upper
Efficacy column containing the efficacy counts and a Lower Efficacy column containing
the efficacy counts for the Lower Efficacy Boundary. Similarly there will be a Upper
Efficacy % column and a Lower Efficacy % column containing the efficacy percentages
per look for the Upper Efficacy and Lower Efficacy boundaries respsectively.

If Efficacy Bound Parameterization = Don’t Calculate at Step 2: Sequential
Design Inputs then the Efficacy and Efficacy % columns will not be shown.

Note that the direction “beyond” which the test will stop for efficacy and/or futility
will depend on value in the final row for (Upper) Efficacy Boundaries (or if Efficacy
Bound Parameterization = Don’t Calculate then (Upper) Efficacy Boundaries).
See subsection 8.4.4 for a detailed breakdown for every scenario.

Futility and Futility % The Futility column provides the count of how many simula-
tions Stopped for Futility at each analysis based on the Futility Boundaries provided
in the Boundaries table above. The Futility value in the final Total row provides the
total number of subjects who Stopped for Futility in the simulation. If there are no
Efficacy Boundaries then 1 - Total row provides the number of simulations which
Stopped for Efficacy at the final analysis.

The Futility % column provides the percentage of how many simulations Stopped for
Futility at each analysis based on the Futility Boundaries provided in the Boundaries
table above. The Futility value in the final Total row provides the total percentage of
subjects who Stopped for Futility in the simulation. If there are no Efficacy Bound-
aries then 1 - Total row the percentage of simulations which Stopped for Efficacy at
the final analysis.

If Futility Bound Parameterization = Don’t Calculate at Step 2: Sequential
Design Inputs then the Futility and Futility % columns will not be shown.

Note that the direction “beyond” which the test will stop for efficacy and/or futility
will depend on value in the final row for (Upper) Efficacy Boundaries (or if Efficacy
Bound Parameterization = Don’t Calculate then (Upper) Efficacy Boundaries).
See subsection 8.4.4 for a detailed breakdown for every scenario.

Total and Total % The Total column provides the count of how many simulations
Stopped for Efficacy or Stopped for Futility at each analysis based on the Bound-
aries provided in the Boundaries table above. The Total value in the final Total row
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provides the total number of subjects who Stopped Overall in the simulation. The final
Total row will equal the Number of Simulations.

The Total column provides the percentage of how many simulations Stopped for Ef-
ficacy or Stopped for Futility at each analysis based on the Boundaries provided in
the Boundaries table above. The Total value in the final Total row provides the total
percentage of subjects who Stopped Overall in the simulation. The final Total row
will equal 100%.

Examples of the Number Stopped table for a variety of scenarios is provided in Figure 8.22

Number Stopping
0.040000000% 0.040000000%
2 968 9.680000000% 968 9.680000000%
3 3104 21.040000000% 3104 21.040000000%
4 an3 31.130000000% n3 31.130000000%
5 1649 16.490000000% 281 28.110000000%
Total 8838 §8.380000000% 10000 100.000000000%
Number Stopping
1712 17.120000000% 1712 17 120000000%
2 6519 £5.190000000% 6519 65.190000000%
3 1578 15.780000000% 1769 17.690000000%
Total 9809 98.090000000% 10000 100.000000000%

Number Stopping

4202 42.020000000% 5.380000000% 4740 47.400000000%
2 3467 428 34870000000%  4280000000% 3915 39.150000000%
3 1042 303 10.420000000% 3.030000000% 1345 13.450000000%
Total 8731 1269 87.310000000% 12.680000000% 10000 100.000000000%
Number Stopping

0.180000000% 0.180000000%

2 3 69 72 0.720000000% 72 0.720000000%
3 1 167 168 1680000000% 168 1680000000%
4 1 245 246 2460000000% 246 2 460000000%
5 2 215 27 3.170000000% 9496 94.960000000%
Total 8 813 821 £210000000% 10000 100.000000000%

Figure 8.22: Simulation Report Number Stopping Examples
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8.5.2 Rejection Plot

The Rejection Plot provides a visual summary of the decisions made at each analysis
about Stopping for Efficacy, Stopping for Futility or Continuing to the Next
Look.

The Rejection Plot can be found under the Plots header in the Workspace Bar on
the left side (section 8.3). An example Rejection Plot is shown in .

Workspace < R
i Rejection Plot

¥ Setup v
[El Reports ~

=l e . 10000

Simulation Report

X Plots A

:}: Rejection Plot

=

= Boundary Plot 3000
[ Tables A

[ Summary Data Per-Simulation
[ Per-Simulation Subject Data

6000

Count

Continue
M Futility
Efficacy

4000

2000

05 1 15 2 25 3 35
Look

Figure 8.23: Group Sequential Simulation Rejection Plot

The Rejection Plot provides a visual summary the count of how many simulations
stopped for either efficacy and futility and, for interim analyses, the number of simulations
which continued until the next look.

The Rejection Plot is a Bar Chart where the count of the number of simulations which
Stopped for Efficacy, Stopped for Futility or Continued (to next look) is plotted
on the Y-axis for each Look on the X-axis.

8.5.2.1 Look (X-axis)

The X-axis corresponds to the Look Number where the X-axis will range from 1 to
Number of Looks specified at Step 2: Sequential Design Inputs. Note that the
Looks will be equally spaced from each other in the Rejection Plot even if the looks
are not equally spaced in terms of sample size/information time.

Use Titles > X-axis Scale option from the Edit menu to change the X-axis Title
(show/hide, X-axis name, X-axis font). See subsubsection 8.5.2.5 for details.
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8.5.2.2 Count (Y-axis)

The Y-axis corresponds to the Count of how many subjects has the status Continue,
Efficacy or Futility at each Look.

Subjects who have the Efficacy or Futility status stop at that Look. Therefore the
height of Count at the next Look will equal the height of the current Look minus the
sum of the heights of the Efficacy and Futility sections. Therefore, in most Rejection
Plots the Count will reduce as Look increases representing the subjects who have
stopped already. The Count at Look 1 will equal the Number of Simulations set in
Step 4: Simulation Controls.

By default Continue is indicated by a cream color, Efficacy by blue and Futility by
red. Use Series from the Edit menu to change the color or name of any of the Continue,
Efficacy or Look series. See subsubsection 8.5.2.5 for details.

Use Titles > Y-axis Scale option from the Edit menu to change the Y-axis Title
(show /hide, Y-axis name, Y-axis font). See subsubsection 8.5.2.5 for details.

8.5.2.3 Legend

The Rejection Plot Legend provides an indication of the color for the Continue,
Efficacy and Futility series.

By default, the Legend is shown to the right of the boundary plot. To toggle whether
the Legend is shown, change the location of the Legend or change the Legend Border
use the the Legend option in the Edit menu . The colors in the plot and legend are
defined under the Series option in the Edit menu. See subsubsection 8.5.2.5 for details.

8.5.2.4 Tooltip

The Rejection Plot Tooltip provides the user information about the Count for either
the Continue, Efficacy or Futility at a given Look by placing the cursor over the
Count area of interest.

A Rejection Plot with the Tooltip active for the Futility Count at Look = 2 is
shown in Figure 8.24.
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Rejection Plot

10000 Look: 2
[ Futility : 6519
8000
6000
-
c
é Continue
W Futility
Efficacy
4000
2000
0
0.5 1

2
Look

2.5

Figure 8.24: Rejection Plot Tooltip

8.5.2.5 Editing and Saving

Options to edit, save or print the Rejection Plot are available from the right-click
context menu within the Rejection Plot. This menu is shown in Figure 8.25.
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Rejection Plot

10000

=1 Print
@ Print Preview
m Save As

Titles... »

8000

Series... ’
Gridlines... »

Legend..
6000

Count

Continue
M Futility
Efficacy

4000

2000

05 1 1.5 2 25 3 35
Look

Figure 8.25: Boundary Plot Toolbar

This menu provides options to edit the visual aspects of the plot such as the titles, legend
and color schemes while also providing options for printing and saving. This menu is
similar to Edit options available for other plots - section 1.9 for an overview.

The full set of dropdown menu options is as follows, where dropdown items with a » at
their right edge indicate a sub-menu which will open when that option is highlighted or
selected:

o Print: Open Print window for Rejection Plot

o Print Preview: Open Print Preview window for Rejection Plot

« Save As: Save Rejection Plot as .pdf or .jpeg file

o Titles »: Edit Main Title, X-axis Title and Y-axis Title of Rejection Plot

o Series »: Edit Color of Alpha Error and/or Beta Error series in Rejection
Plot

o Gridlines »: Add or remove gridlines from Rejection Plot
o Legend »: Edit Rejection Plot Legend

The Print, Print Preview and Save As options are available as per all other plots so
will not be discussed further.

A breakdown of the Titles, Series, Gridlines and Legend sub-menus is provided next.
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Titles The Titles menu allows the user to edit the Chart Title, X-axis Title and
Y-axis Title by choosing to show or hide that title, rename that title and change the
font of that title. The tabular summary of the Titles menu , where » indicate where
an option will open an additional sub-menu and = indicates where an option will open a
separate pop-out window, is as follows:

o Titles »
— Chart Title »

« Hide/Show Chart Title: Hide or show main Chart Title, name will de-
pend on whether Chart Title is currently shown in Error Spending
Plot - Default: Show

* Rename = : Opens Rename Title window where Chart Title can be
edited. Default: Rejection Plot

x Font = : Opens Update Title Font window for Chart Title where
can edit the Font (select desired font from dropdown), Font Size, Font
Type (Bold, [talics), Font Color (select from Color Panel or create
custom color in Colors window opened if select More Colors) Default:
Font: Segoe UI; Font Size: 21; Font Type: No Bold, No [talics; Font
Color: Black (Automatic)

— X-axis Title »

« Hide/Show Chart Title: Hide or show X-axis Title, name will depend
on whether X-axis Title is currently shown in Error Spending Plot -
Default: Show

* Rename = : Opens Rename Title window where X-axis Title can be
edited - Default: Look

x Font = : Opens Update Title Font window for X-axis Title where
can edit the Font (select desired font from dropdown), Font Size, Font
Type (Bold, [talics), Font Color (select from Color Panel or create
custom color in Colors window opened if select More Colors) - Default:
Font: Segoe Ul; Font Size: 16; Font Type: No Bold, No Italics; Font
Color: Black (Automatic)

— Y-axis Title »

« Hide/Show Chart Title: Hide or show Y-axis Title, name will depend
on whether Y-axis Title is currently shown in Error Spending Plot -
Default: Show

x Rename = : Opens Rename Title window where Y-axis Title can be
edited - Default: Count

*x Font = : Opens Update Title Font window for X-axis Title where can
edit the Font (select desired font from dropdown), Font Size, Font Type
(Bold, Italics), Font Color (select from Color Panel or create custom
color in Colors window opened if select More Colors) - Default: Font:
Segoe UI; Font Size: 16; Font Type: No Bold, No Italics; Font Color: Left
Y-axis: Blue unless Beta Error only then Red, Right Y-axis: Red
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Series The Series menu allows the user to edit the color and name of the series.
It will contain three sub-menus corresponding the three series: Continue, Efficacy,
Futility. Each sub-menu will contain the same two options: Rename, Color

Selecting Rename will open the Rename Series window where the user can the name
of the series which appears in the Legend. Select from Color Panel or create custom
color using More Colors.

Selecting Color will open the Select Series Color window where the user can edit color
for the selected error series. Select from Color Panel or create custom color using More
Colors. By default Continue will be cream, Efficacy will be blue and Futility will be
red.

Gridlines The Gridlines menu consists of two options: Show/Hide X-axis Grid-
lines and Show/Hide Y-axis Gridlines. The options will change between Show and
Hide depending on if that gridlines option is currently shown in the Error Spending
Plot . By default both the X-axis and Y-axis gridlines are not shown. When shown the
major gridlines will be shown at the numbered major ticks on the relevant axis and the
minor gridlines at the 4 unnumbered ticks between each major tick.

Legend The Legend menu allows the user to edit the Error Spending Plot Le-
gend including whether to show the legend, legend border color and the vertical and
horizontal position of the legend. The tabular summary of the Legend menu , where
» indicate where an option will open an additional sub-menu and = indicates where an
option will open a separate pop-out window, is as follows:

o Show/Hide Legend: Hide or show Legend, name will depend on whether Legend
is currently shown in Error Spending Plot - Default: Show

e Border Color = Opens Select Legend Border Color window where user can
edit color of border of the Legend. Select from Color Panel or create custom color
using More Colors - Default: Black

o Horizontal Position »: Choose the horizontal position of the plot and whether the
plot should be inside or outside the Error Spending Plot area. This sub-menu
has the following options: Left, Outside; Left, Inside; Center; Right, Outside; Right,
Inside - Default: Right, Outside

e Vertical Position »: Choose the vertical position of the plot and whether the plot
should be inside or outside the Error Spending Plot area. This sub-menu has
the following options: Top, Outside; Top, Inside; Center; Top, Outside; Top, Inside
- Default: Center

8.5.3 Boundary Plot

The Boundary Plot provides a visual and tabular summary of the group sequential
boundaries, which can be found in the Boundaries table in the Simulation Report,
and the associated exit and continuation regions at each look. It can be opened by
selecting the Boundary Plot option under the Plots header in the Navigation Bar
on the left (see section 8.3)
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The Boundary Plot allows the user to visually inspect the boundaries on multiple
statistical scales (Z-scale, p-value Scale, Score Scale, §-Scale) and also export these
plots to assist in the exploration and communcation of the simulated group sequential
design.

An example Boundary Plot is shown in Figure 8.26.

Workspace Edit.. v Boundary Scale... v E\l Save Plot
#* Setup e
_ Boundary Plot
Reports ~
[=] Simulation Report
4
X Plots ~
_%. Rejection Plot
- 2 /
/“C Boundary Plot //
[ Tables & —

Efficacy Bounds (Upper)
A Futility Bounds
Efficacy Bounds (Lower)

|: Summary Data Per-Simulation
E Per-Simulation Subject Data

Boundary (Z-scale)

0 0.1 02 03

Information Fraction

Look Efficacy Bound (Upper) Efficacy Bound (Lower) Futility Bound (Upper) Futility Bound (Lower)
1 419647240 -4.19647240 0.00000000 -0.00000000
2 2.83651085 -2.83651085 132195734 -1.32195734
3 2.26435161 -2.26435761 2.26435161 -2.26435161

Figure 8.26: Boundary Plot in Group Sequential Design Simulation Outputs

The Boundary Plot tab consists of three primary elements: the Boundary Plot
(middle), Boundary Table (bottom) and the Toolbar (top).

The Boundary Plot visually displayed the Efficacy Boundaries and/or Futility
Boundaries.

The Boundary Table provides a tabular summary of the Efficacy Boundaries and/or
Futility Boundaries.

The Toolbar allows the user to edit the plot, change the boundary parameterization scale
or save the Boundary Plot or Boundary Table.

However, the Boundary Plot in the Group Sequential Design Simulation Tool is
identical to the Boundary Plot within the GSTX series of Group Sequential Design
tables discussed in chapter 7. For a detailed breakdown of the Boundary Plot therefore
refer to subsubsection 7.3.5.1.

8.5.4 OQOutput Tables

The Output Tables are optional tables which provide access the underlying simulation
data on a summary and per-simulation basis. The Tables available are as follows:
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e Summary Data Per-Simulation
e Per-Simulation Subject Data

The options to include to these tables is provided in Step 4: Simulation Controls.
Refer to subsection 8.4.5 for details.

A summary of these Table options is provided next.

8.5.4.1 Summary Data Per-Simulation

The Summary Data Per-Simulation table provides the important summary statistic
outputs for each individual simulation.

In the Summary Data Per-Simulation table, each row corresponds to an individual
Look within an individual simulation.

When a simulation Stops for Efficacy or Stops for Futility (indicated by the Status
column) then no further Looks are assessed for that simulation since it is assumed that
simulated trial stopped early. If Status = Continue then further Looks are assessed.
As the Look at which a trial will stop is unknown a-priori, the number of Looks shown
per-simulation will range between 1 and the Number of Looks specified at Step 2:
Sequential Design Inputs.

The columns represent outcomes of interest at each look. There are some differences in
the columns provided depending on the simulation scenario. However, there are number
of columns which are in every Summary Data Per-Simulation table and these will be
summarized first. These columns and their definitions are as follows:

e Simulation ID: The unique indentifier for each simulation. Equals the order sim-
ulation was in simulation queue. Rows with the same Simulation ID indicates all
Looks that were conducted for that simulation

¢ Look: The Look number of the simulation associated with the Simulation ID in
the current row. This will vary between 1 and the Number of Simulations

o Status: The outcome status of the Look in the current row. Can equal Effic-
acy, Futility or Continue where Efficacy = Stopped for Efficacy, Futil-
ity = Stopped for Futility, Continue = Continued to next Look. For
Look Number = Number of Looks, Continue status cannot occur. Refer to
subsection 8.4.4 for details on how stopping rules are implemented

o Information: The (Fisher) Information achieve for the Look in the current row.
See subsubsection 7.2.1.1 for a technical overview of Information in the context
of Group Sequential Designs.

o Test Statistic: The standardised (Z) test statistic calculated based on the simu-
lated data at the current Look. Note this column is always the Z-statistic even if
the boundaries were specified on a different statistical scale in Step 2: Sequential
Design Inputs. For details on how the Test Statistic is calculated for different
simulation scenarios (including the effect of scenario specific Step 2: Sequential
Design Inputs fields) and how the test statistic is compared to the group sequen-
tial boundaries see section 8.7. For conversions from the Z-scale to other statistical
scales see subsubsection 7.2.1.1 and subsubsection 7.2.4.5.
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The remaining columns in the Summary Data Per-Simulation table will be design
specific inputs taken from the Design Parameters and Allocation Parameters in
Step 1: Simulation Inputs. See subsection 8.4.2 for details on the scenario specific
Design Parameters and Allocation Parameters inputs for all currently supported
scenarios.

For example for the Two Means Inequality scenario, the following fields will be provided:
Group 1 Sample Size, Group 2 Sample Size, Group 1 Mean, Group 2 Mean, Mean Differ-
ence, Group 1 Standard Deviation, Group 2 Standard Deviation

An example of the Summary Data Per-Simulation table is provided in Figure 8.27.

Workspace < Simulation ID | Look Status Group 1Sample Size Group 2 Sample Size Group 1 Mean Group 2 Mean Mean Difference s B

» 1 1 Efficacy 14 15 3.063 2173 0890 1.~ B
¥ Setup ~ 2 1 Efficacy 14 15 3.193 1.100 2,093 2
¥ Simulation Inputs 3 1 Efficacy 14 15 3.989 -0321 4310 2
£# Sequential Design Inputs 4 1 Efficacy 14 15 2931 079 2135 2
¥ Boundary Table 5 1 Efficacy 14 15 2861 0553 2308 2
a s Jati ’ Control 6 1 Efficacy 14 15 2361 1.943 0418 1

imulation Controls
7 1 Efficacy 14 15 1569 0204 1365 3.
[E Reports " 8 1 Efficacy 14 15 2829 1365 1464 4
[E] simulation Report 9 1 Efficacy 14 15 2976 0685 2291 2
10 1 Efficacy 14 15 3,565 0999 2.566 3
X Plots ~ 1 1 Efficacy 14 15 3.181 -0.300 3481 2
3 Rejection Plot 2 1 Efficacy 14 15 4023 0982 3.040 2
S —— 13 1 Efficacy 14 15 1808 2089 0281 2
’ 14 1 Efficacy 14 15 28% 1836 1.060 B
[ Tables " 15 1 Efficacy 14 15 3827 1.886 1941 2
E Summary Data Per-Simulation 16 1 Efficacy 14 15 3.710 1.084 2626 1
17 1 Efficacy 14 15 4307 1486 2821 2
[ Per-Simulation Subject Data =

18 1 Efficacy 14 15 2619 -0.065 2684 2
19 1 Efficacy 14 15 3,580 0090 3.490 2
20 1 Efficacy 14 15 2908 1173 1735 2
21 1 Efficacy 14 15 2961 1415 1.546 3.
2 1 Efficacy 14 15 2674 0529 2145 2
23 1 Efficacy 14 15 3448 0127 3321 1
2 1 Efficacy 14 15 2025 0753 1272 1
25 1 Efficacy 14 15 3.077 1.116 1961 1
26 1 Efficacy 14 15 3.088 1.298 1.790 i
27 1 Efficacy 14 15 5031 0469 4561 1
2 1 Efficacy 14 15 2734 2135 0599 2
29 1 Efficacy 14 15 1864 1708 0.156 2
30 1 Efficacy 14 15 4114 0252 3862 1
31 1 Efficacy 14 15 3.220 1.526 1.694 2
7 = === = = ;

Figure 8.27: Summary Data Per-Simulation Table

8.5.4.2 Per-Simulation Subject Data

The Per-Simulation Subject Data table provides the simulated outcomes for each
subject from a pre-specified number of simulations. The number of simulations is specified
by editing the (X) value in the Save subject-level data for (X) simulation runs field
in Step 4: Simulation Controls.

Each row correponds to a single simulated subject in the trial and each column is char-
acteristic about that simulated subject regarding which simulation they were generated
from, their simulated characteristics (e.g. group allocation) and outcome of interest.

The Per-Simulation Subject Data table will have the following fields:

e Simulation ID: The unique indentifier for each simulation. Equals the order sim-
ulation was in simulation queue.

e Subject ID: The unique indentifier for the simulated subject within the simulation
with Simulation ID in the current row. Equals the order simulation was in subject
simulation queue.

e Treatment ID: The treatment group the subject was assigned to. For Number
of Groups = 1 all subjects will have value of 1. For Number of Groups =
2, subjects will have value of 1 or 2 based on randomization algorithm selected
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in Step 1: Simulations Inputs under the Allocation Parameters section.
For Number of Groups > 2, subjects will have value up the number of groups
specified.

e Look: The Look before which the simulated subject was recruited. For example,
Look = 1 means the subject was recruited before the first look, Look = 2 means
subject was recruited after the first look but before second look etc. This will vary
between 1 and the Number of Simulations

e Response: The simulated response for the subject. This will depend on the design
scenario e.g. a normal variate for Means, a 0/1 binary variable for Proportion.
See subsection 8.7.1 for detail on the Data Generating Process for currently
supported scenarios.

An example of the Per-Simulation Subject Data table is provided in Figure 8.28.

Wo rkspace < Simulation ID Subject ID Treatment ID ook Response
! 2485 &
¥ Setup 2 2 3357
¥ Simulation Inputs 3 4747
$¥ Sequential Design Inputs 4 4.683
£ Boundary Table E 5242
%# Simulation Controls 5 2499
7 3375
[El Reports " 8 1502
[] simulation Report J 0.455
v 10 0.607
# Plots & 11 1373
X Rejection Plot 12 4079
X Boundary Plot 1 3.809
14 4669
[ Tables o} 15

-0.110
-1.505
3.565
5.920
0.860

[5] Summary Data Per-Simulation

17
E Per-Simulation Subject Data

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1 18
1

1 20
1 21
1 22
1 23
1 24
1 25
1

1

1

1

2

2

2

2458
2054
7.566
5.186
0454
26
27
28
29

-1313
5.140
-0.731
0.246
0252
2638

L
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1 2.802
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1 6.966

1
1
1
1
1
1
1
1
1
1
1
1
1
1
2
2
2
2
19 2
2
2
2
2
2
2
2
2
2
2
1
1
1

Figure 8.28: Per-Simulation Subject Data Table

8.6 Saving/Loading Group Sequential Design Simulation
Files

nQuery provides the file format of .nqgs to save an nQuery Group Sequential Design
Simulation Workspace. To save an nQuery Group Sequential Design Simulation
Workspace, select Save from the File Menu or select the Save icon & from the toolbar
or use the CTRL++S keyboard shortcut. This will open the Save Workspace window
which is shown in Figure 8.29.
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Save Workspace X

Please choose a name for the project:

Group Sequential Design Simulation Example

Project will be saved in sub-directory of:
ChUsers'\OO00Documents Browse

OK Cancel

Figure 8.29: Save Workspace Window

The Save Workspace window allows the user to specify the name of the .nqgs file in
the Please choose a name for the project: field and the location to save the .nqgs
file in the Project will be saved in sub-directory of: field. The user can also edit
the Project will be saved in sub-directory of: using the Browse button, which will
open the Browse for Folder window. To save the project, select the OK button.

When a project is saved, a folder with the Please choose a name for the project:
name will be present in the folder specified in the Project will be saved in sub-
directory of: field. This project folder will contain the .nqgs file alongside all tables
under the Tables header generated in the current simulation (all as .csv files).

After an nQuery Workspace is saved if a change is made to the workspace the user can
save over the prior save using the Save options (see above) or save a separate version using
Save As from the File menu.

To open a saved .nqgs file, select the file in Window Explorer or find the file from the Open
Menu which can be selected from the File Menu, the = toolbar icon or CTRL+O key-
board shortcut. Opening a .nqgs file works as for other nQuery file types (see subsection 1.7.5).

8.7 Group Sequential Design Simulation Technical
Background

This section provides technical information about the processes used to generate sim-
ulation, calculate test statistics, make decisions based on the simulated test statistics
compared to specified boundaries and the derivation for some outputs provided in the
simulation results. This section is focussed on the implementation of simulation for group
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sequential designs. If interested in knowing the statistical theory and technical background
for group sequential design, see chapter 7.

This section is broken up into the following domains:

o Data Generating Process: Statistical model for generating responses for all
supported group sequential design simulation scenarios

o Test Statistic Calculation: Formulae for calculating standardized test statistics
for all supported group sequential design scenarios

e Group Sequential Boundaries: Technical overview of group sequential boundary
decision process and details on converting between statistical scales

o Group Sequential Outputs: Calculations used for certain highlighted group se-
quential simulation results e.g. Power, Average Sample Size

8.7.1 Data Generating Process

The Data Generating Process specifies the statistical model that will generate sim-
ulations, the number of subjects to simulate per-simulations, the allocation process to
treatment groups and the total number of simulations overall.

As the Data Generating Process is dependent on the design scenario so an overview
is provided for all currently supported scenarios. The current scenarios available are:

o Two Means - seesubsubsection 8.7.1.1
» Two Proportions - subsubsection 8.7.1.2

The Data Generating Process for each scenario is provided next.

8.7.1.1 Two Means

The Two Means scenario refers to a trial design where there are two independent
groups where the response for each subject is simulated from the Normal Distribution.

Before describing the Data Generating Process, we will set out some definitions:
o Maximum Group 1 Sample Size: n;
o Maximum Group 2 Sample Size: no
e Group 1 Mean: 1
o Group 2 Mean: po
e Group 1 Standard Deviation: oy
e Group 2 Standard Deviation: o,

o Total Number of Looks: K

e Look Index: k

o Group 1 Sample Size at Look k: nqj
e Group 1 Sample Size at Look k: noy

o Information Time at Look k: t;, = (%)
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The Data Generating Process is as follows:

Assume that the subjects in Group 1 have a continuous response which can be drawn
from a Normal Distribution with a mean equal to p; and variance equal to o} and
that subjects in Group 2 responses can be drawn from a Normal Distribution with a

mean equal to py and variance equal to o3 . This is equivalent to:

Xy~ N(/Llagg)

X2 ~ N(:u% U%)

For simplicity!, nQuery will generate n; Normal variates from the N(u;,0?) for Group 1
and ny Normal variates from the N(uy,0%) from Group 2 in each simulation run.

We can simulate normal variates using a variety of methods. nQuery uses the Box-Muller
algorithm [Box and Muller, 1958] with random number generation via the quasi-random
Mersenne-Twister algorithm [Matsumoto and Nishimura, 1998].

This process is repeated until the specified number of simulations is reached. We will
define the simulated Normal data for Group 1 as xgj ) and for Group 2 as :céj ) where (7)
indicates the simulation index and where each a;gj )is of length n; and each :cgj )is of length
n2

We can then define the simulated data up to look k in simulation j as xﬁ} and ng) with
each defined as the first ny, variates in Group 1 and the first ng, variates in Group 2
respectively 2.

The per-look data cohorts (xﬁ), xgk)) can then be passed to the test statistic calculation
formulae described in subsubsection 8.7.2.1.

Randomization The above section assumed that n; and ny are known a-priori. This
is equivalent to the Fixed Allocation option in Step 1: Simulation Inputs where
the size of group 1 and group 2 is defined by the Group 1 Sample Size and Group 2
Sample Size fields.

The other option is Complete Randomization which is where allocation is based on
random allocation®. This is described below.

The random allocation for a given subject is simulated from the following Bernoulli
Distribution:

I Alternatively, the samples can be simulated up to each Look k sequentially and then conditionally stop
the simulation if a boundary is crossed. While this reduces the number of simulations required, it
provides minimal performance improvement for plausible trial conditions and number of simulations.
It should be noted that the post-stopping data can be valuable for communicating the estimate bias
in the treatment effect estimate after early stopping.

2This is equivalent to taking the first n; times t; variates and first no times ¢, variates respectively.

3Fixed Allocation and Complete Randomization represent extremes for the randomization process where
on one end the allocation is fixed at every pair to ensure the correct allocation and the other end
allocation is a random process which gives the specified allocation on average. In practice most trials
use a compromise option such as Block Randomization, where the allocation balance is achieved within
blocks of a specified size. For detail on different randomization schemes, see the Randomization List
chapter (chapter 6).
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A ~ Bernoulli(mg)

where 7R is the proportion of subjects assigned to group 1 based on the Sample Size
Ratio (R) specified at Step 1: Simulation Inputs. The formula for 7 is as follows:

- (11 8)
"=\1+R

As above for Fixed Allocation, nQuery will generate n; Normal variates from the
N(uy,0?) for Group 1 and ny Normal variates from the N(ug,03) from Group 2 in each
simulation run

For Complete Randomization, nQuery will generate n;+ns Bernoulli variates from
Bernoulli(mr) which are assigned to each subject, where the proportion of “successes”
should equal (1 - R)

The “successes” are assigned to Group 1 and the “failures” are assigned to Group
2. The sum of the number of “successes” becomes the updated value for the Group 1
Sample Size, we will designate this as the group 1 sample size in simulation with index
J as nl . Similarly, the sum of the “failures” becomes the Group 2 Sample Size, with
the group 2 sample size in simulation j being n(] . On average, ng ) = = np and n(]) = Ng
but due to random variation the sample size allocation can diverge from the originally

planned allocation.

on average.

For the interim analyses, it is assumed that the Bernoulli(mg) allocation process defined
the entry order to the simulated trial. Therefore, the interim timings are based on first
tr (n1 4+ ny) as per the Information Time (t;) values in the Boundary Table at Step
3.

The interim group 1 and group 2 sample sizes for simulation j are designated as nﬁ{j and
ngjk) Note that based on the random allocation sequence that the Sample Size Ratio
can vary over each of the looks.

Interm sample size values per-simulation are passed to the Test Statistic Calculation
(subsubsection 8.7.2.1) as above where ngk) and ngy ) replace ni,and ny, respectively if
using the Complete Randomization algorithm.

8.7.1.2 Two Proportions

The Two Proportions scenario refers to a trial design where there are two independent
groups where the response for each subject is simulated from the Bernoulli Distribu-
tion.

Before describing the Data Generating Process, we will set out some definitions:
o Maximum Group 1 Sample Size: n;
o Maximum Group 2 Sample Size: no
o Group 1 Proportion:
« Group 2 Proportion: 7y

e Total Number of Looks: K
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e Look Index: &
e Group 1 Sample Size at Look k: nqy
e Group 1 Sample Size at Look k: noy

« Information Time at Look k: t; = (%)

The Data Generating Process is as follows:

Assume that the subjects in Group 1 have a Bernoulli response (also known as a binary
response e.g. 0 or 1) which can be drawn from a Bernoulli Distribution with a success
proportion equal to m; and that subjects in Group 2 can be drawn from a Bernoulli
Distribution with a success proportion equal to ms. This is equivalent to:

X ~ Bernoulli(m)

Xy ~ Bernoulli(ms)

For simplicity, nQuery will generate n; Bernoulli variates from the Bernoulli(m;) distri-
bution for Group 1 and ny Bernoulli outcomes from the Bernoulli(my) dstribution for
Group 2 in each simulation run.

We can simulate Bernoulli variates using a variety of methods. nQuery uses the algorithm
from Kachitvichyanukul and Schmeiserwith [Kachitvichyanukul and Schmeiser, 1988] for
the Binomial distribution with Size set to 1, random number generation is via the quasi-
random Mersenne-Twister algorithm [Matsumoto and Nishimura, 1998].

This process is repeated until the specified number of simulations is reached. We will
define the simulated Bernoulli responses for Group 1 as argj ) and for Group 2 as :L"gj ) where
(7) indicates the simulation index and where each azgj ) is of length n; and each xgj ) is of
length no

We can then define the simulated data up to look k in simulation j as xﬁ) and mgk) with
each defined as the first nq, variates in Group 1 and the first ng, variates in Group 2
respectively

The per-look data cohorts (xﬁ), :Ugi))can then be passed to the test statistic calculation
formulae described in subsubsection 8.7.2.2.

Randomization The above section assumed that n; and ny, are known a-priori. This
is equivalent to the Fixed Allocation option in Step 1: Simulation Inputs where
the size of group 1 and group 2 is defined by the Group 1 Sample Size and Group 2
Sample Size fields.

The other option is Complete Randomization which is where allocation is based on
random allocation. This is described below.

The random allocation for a given subject is simulated from the following Bernoulli
Distribution:

A ~ Bernoulli(mg)
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where 7R is the proportion of subjects assigned to group 1 based on the Sample Size
Ratio (R) specified at Step 1: Simulation Inputs. The formula for 7 is as follows:

(5)
(Lt
BT \1+R

As above for Fixed Allocation, nQuery will generate n; Bernoulli variates from the
Bernoulli(m, ) distribution for Group 1 and ny Bernoulli outcomes from the Bernoulli(ms)
dstribution for Group 2 in each simulation run.

For Complete Randomization, nQuery will generate n;+ns Bernoulli variates from
Bernoulli(mr) which are assigned to each subject, where the proportion of “successes”

should equal ( ) on average.

1+R
The “successes” are assigned to Group 1 and the “failures” are assigned to Group
2. The sum of the number of “successes” becomes the updated value for the Group 1
Sample Size, we will designate this as the group 1 sample size in simulation with index
J as nl . Similarly, the sum of the “failures” becomes the Group 2 Sample Size, with
the group 2 sample size in simulation j being n¥’. On average, n\”) = n; and n¥ ) = ny
but due to random variation the sample size allocation can diverge from the originally

planned allocation.

For the interim analyses, it is assumed that the Bernoulli(rg) allocation process defined
the entry order to the simulated trial. Therefore, the interim timings are based on
tr (n1 + n2) as per the Information Time (t;) values in the Boundary Table at Step
3.

The interim group 1 and group 2 sample sizes for simulation j are designated as ng and

ngk Note that based on the random allocation sequence that the Sample Size Ratio
can vary over each of the looks.

Interm sample size values per-simulation are passed to the Test Statistic Calculation

(subsubsection 8.7.2.1) as above where ngjk and ns), ) replace ny,and ng, respectively if

using the Complete Randomization algorithm.

8.7.2 Test Statistic Calculation

The Test Statistic Calculation specifies the formula used to calculate the standardized
test statistic (i.e. Z-statistic) for each design scenario.

The Test Statistic Calculation is dependent on the scenario (including the scenario
specific options) so an overview is provided for all currently supported scenarios. The
current scenarios available are:

o Two Means - seesubsubsection 8.7.2.1
o Two Proportions - subsubsection 8.7.2.2

The Test Statistic Calculation for each scenario is provided next.

8.7.2.1 Two Means

The standardized test statistic for the mean difference is equal to the following:
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— _ 2 2

where X; — X, is the mean difference and SE = % + Z—; is the standard error?, based
on the per-group variances and sample sizes.

Recall that the n;, Normal data variates simulated for Group 1 up to look k for simulation

index j was defined as xgjk) and the ny, Normal data variates simulated for Group 2 up to
look k for simulation index j was defined as xgjk)

Then the standardized test statistic at look k in simulation 7 can be defined as:

() _ v ()
Z]Ej) _ lec — XQi
SE

where

nz, .
3 o

Ny

() _
2k

k

The calculation of the standard error will depend on the Standard Deviation Defin-
ition (chosen at Step 2: Sequential Design Inputs) where there are two primary
choices:

1. Between Known (assume variance is based on standard deviation values provided
for the Data Generating Process) or Unknown (variance is calculated based on
the interim simulated data) variance

2. Between Pooled (per-group variances replaced with pooled variance in SE formula)
and Unpooled (per-group variances used direclty in SE formula) variance

We will define the interim estimate for the variance as s? and this will be calculated for
the data up to look k in simulation j as:

B (0 - a0)’

2(4) _ 1
Slk ny, — 1
niy . AN 2
R ()
8;(1) _ 1
k ng, — 1

91
ni no

—1
4Note that ( i + U—g) is the (Fisher) Information
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Based on either o2 and o2 or si(j ) and sgff ) the Pooled variance under the Known and

Unknown scenarios can be calculated using the following formulae:
2 2
2 M, 01 + 12,09

Ny, + Ng,

2(7 2(y
20 _ (e — 1)t + (ng, —1)s5
K ni, + ng, — 2

For the four scenarios (Known + Pooled, Known + Unpooled, Unknown +
Pooled, Unknown + Unpooled) the standard error (SE) at look k in simulation

j is defined as follows:
SE,(;) = ,/—52 + 2 Known + Pooled
1 "2y

SE,Ej) =/ + -2 Known + Unpooled

ni no
) O ey
SE;" ==+ Unknown + Pooled
k k
G) 200 20
SEy” = |3+ = Unknown + Unpooled
k k

The standardized (Z-scale) test statistic (Z ,gj )) at look £ in simulation j is then compared
to the boundaries at look k to determine the outcome at that analysis. For each simulation,
the (Z,SJ )) will be compared sequentially (1,2...K — 1, K) until an early stop occurs or
the trial ends.

The counts for the outcome in each simulation are then used to calculate the simulated
exit probability and resulting summary statistics. This is covered in subsection 8.7.3.

8.7.2.2 Two Proportions
The standardized test statistic for the proportion difference is equal to the following:

T — T2

\/771(177r1) + mo(l—m2)

ni n2

7 —

where 7 — 7 is the proportion difference and SE = \/ mi-m) 4 “2(1;”2) is the (unpooled)

ni
standard error®, based on the per-group success proportions (my, ;) and sample sizes.

Recall that the n;, Bernoulli data variates simulated for Group 1 up to look % for simula-
533 and the ny, Bernoulli data variates simulated for Group
2 up to look k for simulation index j was defined as a:gjk)

tion index j was defined as z

Then the standardized test statistic at look k in simulation 7 can be defined as:

-1
®Note that (7”(1_7”) + ﬂQ(l_M)) is the (Fisher) Information

ny no
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%)) ()
70 — T T,
SE
where
ni,

S
Gy _ T

Tllk

na,
X

na

) —

k

The calculation of the standard error will depend on the Standard Deviation Defin-
ition (chosen at Step 2: Sequential Design Inputs) where the choice is between
Pooled (per-group success proportions replaced with the pooled success proportion in
SE formula) and Unpooled (per-group success proportions used direclty in SE for-
mula).

The pooled success proportion at look £ in simulation 7 can be defined as:

Ty,
ny, + Ng,

For the two scenarios of Pooled and Unpooled, the standard error (SE) at look k in
simulation 7 is defined as follows:

ni, ng,

Unpooled

The standardized (Z-scale) test statistic (Z ,ﬁj )> at look £ in simulation j is then compared
to the boundaries at look k to determine the outcome at that analysis. For each simulation,
the (Z,g] )) will be compared sequentially (1,2.../K — 1, K) until an early stop occurs or
the trial ends.

The counts for the outcome in each simulation are then used to calculate the simulated
exit probability and resulting summary statistics. This is covered in subsection 8.7.3.

8.7.3 Group Sequential Boundaries

In subsection 8.7.2 the calculation for the stamdardized test statistic (Z-statistic) was
described for each supported scenario for group sequential design simulation.

Recall that the standardized test statistic at look k in simulation run i is defined as Z, ,ﬁi).

For each group sequential design simulation the test statistics will be compared to the
available boundaries sequentially until either early stopping occurs or the final analysis.
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For the simulation results, we are interested in the count of how many simulations stopped
at each look k for efficacy and futility. We will define the count of how many simulations
stopped at look k for efficacy as Fj and the count of how many simulations stopped at
look k for futility as Fj. The count of the number of subjects who continue to the next
look k + 1 will be designated as C}.

At the the final look k a decision for efficacy (Ek) or futility (Fk) is required, therefore
Ck = 0.

The decision rules for all supported group sequential scenarios, depending on the presence
of efficacy and/or futility boundaries and whether a one-sided or two-sided test was used,
is covered next.

8.7.3.1 Boundary Decision Rules

The Boundary Decision Rules will depend on the following criteria:
1. Which boundaries are present
2. The direction of the test

For 1. Which boundaries are present, the following scenarios are possible based on
which of the efficacy or futility boundaries are present and whether the test is one-sided
or two-sided. The combination of these two factors provides the following six scenarios
with associated boundaries (with notation definition in brackets)®:

« Efficacy Only 1-sided: Efficacy Bound (ey)
o Futility Only 1-sided: Futility Bound ( fx)
» Efficacy and Futility 1-sided: Efficacy Bound (eg), Futility Bound (f%)

« Efficacy Only 2-sided: Upper Efficacy Bound (e(U)), Lower Efficacy Bound
(e(L)x)

o Futility Only 1-sided: Upper Futility Bound (f(U)x), Lower Futility Bound
(f (L))

» Efficacy and Futility 2-sided: Upper Efficacy Bound (e(U)y), Lower Efficacy
Bound (e(L)x), Upper Futility Bound (f(U)y), Lower Futility Bound (f (L))

For 2. The direction of the test, this will control the direction of the test and therefore
whether the exit or continuation area is above or below a given boundary. Direction
is based either on the sign of the bound at the final look K for designs with only one
boundary or on the relative positions of the bounds if there are multiple bounds. Where
multiple bounds are present, the direction condition will also indicate the consistency
condition where boundaries must be consistent across all looks e.g. Upper boundaries
cannot start above Lower boundaries and then switch to Upper < Lower at later looks.

A higher direction is equivalent to assuming that higher values for the treatment effect
0 (e.g. mean difference X; — X5 from subsubsection 8.7.2.1) are “better” or “worse”
respectively and vice-versa for the lower direction.

SNote that the notation here for the bounds differs from chapter 7 for the Group Sequential Design
tables where b = efficacy bounds and a = futility bounds - this was based on notation from Jennison
and Turnbull [Jennison and Turnbull, 1999]. Given the more specific scenario here, e = efficacy and
f = futility is used for clarity instead.
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8.7 Group Sequential Design Simulation Technical Background

A summary of the decision rules for the six boundary scenarios under the higher or lower
direction assumption is provided next.

Efficacy Only 1-sided: The boundaries present are the following:
« Efficacy Bounds (e)

€ =¢€1,62...€K_1,€EK

The direction is defined as:

lower e <0

{higher ex >0

If direction = higher, the stopping rules for the interim analyses (1,2..., K — 1) are

Z,gj) > e Stop(Ef ficacy)
Z,S,j) < e, Continue

and at the final analysis (K) the stopping rules are

Z[(g) > e Stop(Ef ficacy)
Z[(g) < e Stop(Futility)

If direction = lower, the stopping rules for the interim analysis (1,2..., K — 1) are

Z,gj) < ep Stop(Efficacy)
Z,gj) > e, Continue

and at the final analysis (K') the stopping rules are

Z[(g) <ex Stop(Efficacy)
Z9 > ey Stop(Futility)

Based on the above:

J A
By =) Stop(Efficacy),(g)

j=1
0 k<K
Fo=1J .
g > Stop(Futility)%) k=K
j=1

Futility Only 1-sided: The boundaries present are the following:
« Futility Bounds (f)
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f:flan---fK—lny

The direction is defined as:

higher fx >0
lower  fx <0

If direction = higher, the stopping rules for the interim analyses (1,2..., K — 1) are

Z,ﬁj) < fr Stop(Futility)
Z,gj) > fi Continue

and at the final analysis (K) the stopping rules are

Z}? < fx Stop(Futility)
Z}? > fx  Stop(Ef ficacy)

If direction = lower, the stopping rules for the interim analysis (1,2..., K — 1) are

Z,ij) > fr Stop(Futility)
Z,gj) < fr Continue

and at the final analysis (K) the stopping rules are
Zg) > fx  Stop(Futility)
Z}g) < fx Stop(Ef ficacy)
Based on the above:

J .
Fr=>_ Stop(Futility),(f)

j=1

0 k< K

E. =1 .
g > Stop(Efficacy)(I? k=K
j=1

Efficacy and Futility 1-sided: The boundaries present are the following:
» Efficacy Bounds (e)

€ =~¢€1,62...6K_1,€K

o Futility Bounds (f)
=l [k, fx

The direction is defined as:
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{higher ex > fr

lower e < f3

with exception of look K where ex = fi

If direction = higher, the stopping rules for the interim analyses (1,2..

Z,gj) > e Stop(E f ficacy)
Z,Ej) < fr Stop(Futility)

fr < Z,Ef') < e, Continue

and at the final analysis (K') the stopping rules are

Z[(g) > e Stop(Ef ficacy)
79 < ey Stop(Futility)

If direction = lower, the stopping rules for the interim analysis (1,2..

Z,gj) < ey Stop(E f ficacy)
Z,ﬁ” > fi Stop(Futility)

er < Z,gj) < fr Continue

and at the final analysis (K') the stopping rules are

Zg) <eg Stop(Efficacy)
Z[(g) > ex  Stop(Futility)

Based on the above:

J .
By =) Stop(Efficacy),(j)

Jj=1

J .
Frp=>_ Stop(Futility),(f)

J=1

Efficacy Only 2-sided: The boundaries present are the following:
o Upper Efficacy Bounds (e (U))

e(U)=e(U),e(U)y...eU)g,e(U)g
» Lower Efficacy Bounds (e (L))

The direction is defined as:
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higher e (U), > e (L),
lower e(U), <e(L)y

If direction = higher, the stopping rules for the interim analyses (1,2..., K — 1) are

Z,E,] >e(U), Stop(E f ficacy)

(
e(L), Stop(E f ficacy)
(L) <z <e(U), Continue

and at the final analysis (K) the stopping rules are

Z}g) >e(U)y Stop(E f ficacy)
Z}g) <e(L)y Stop(E f ficacy)
e(L), < Z}g) <e(U), Stop(Futility)
If direction = lower, the stopping rules for the interim analysis (1,2..., K — 1) are
Z,ij) <e(U), Stop(E f ficacy)
Z,E,]) > e (L), Stop(E f ficacy)

e(U), < Z,ij) <e(L), Continue

and at the final analysis (K) the stopping rules are

Zg) <e(U)g Stop(E f ficacy)
Z}g) >e (L) Stop(E f ficacy)

e(U)g < Z}g) <e(L), Stop(Futility)

It may be of interest to find the Upper Efficacy and Lower Efficacy exit counts separ-
ately. This is equivalent to designating the first condition in all the above Stop(E f ficacyy)
and the second condition as Stop(FE f ficacyy) but otherwise is unchanged.

Based on the above:

J A
Ey :Z Stop(Efficacy),(g)

j=1
0 k<K
=1 .
g > Stop(Futilz’ty)%) k=K
j=1

Futility Only 2-sided: The boundaries present are the following:
« Upper Futility Bounds (f (U))

f(U>:f(U)l7f(U)2"'f(U)Kfl’f(U)K
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» Lower Futility Bounds (f (L))
fL)y=r (L)1 f (L)Q o f (L)K—l o f (L)K

The direction is defined as:

higher f(U), > f (L)
lower — f(U), < f(L)g

If direction = higher, the stopping rules for the interim analyses (1,2..., K — 1) are

F(L), < zY < f(U), Stop(Futility)

Z,E;]j) > f(U), Continue
Z0) < (L), Continue

and at the final analysis (K) the stopping rules are

(D) <22 < f(U), Stop(Futility)

Zg) > f(U)g Stop(E f ficacy)
79 < f (L), Stop(E f ficacy)
If direction = lower, the stopping rules for the interim analysis (1,2..., K — 1) are

F), < Z9 < (L), Stop(Futility)

Z,ij:) < f(U), Continue
Z,(f) > f (L), Continue

and at the final analysis (K) the stopping rules are

F) e < 2% < f(L), Stop(Futility)

ZP < [(U)g Stop(Ef ficacy)
Z}? > f(L)g Stop(E f ficacy)

Based on the above:

J .
Fr =) Stop(Futility)?

J=1

0 k<K
E.=1J 4
F > Stop(Efficacy)%) k=K
j=1

Efficacy and Futility 2-sided: The boundaries present are the following:
« Upper Efficacy Bounds (e (U))
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e(U)=eU),,e(U)y...e(U)gy,eU)g
» Lower Efficacy Bounds (e (L))
e(L)=e(L)y,e(L)y-e(L)g y,e(l)g
« Upper Futility Bounds (f (U))
fU) = f(U)l’f(U)2"'f(U)K—17f(U)K
» Lower Futility Bounds (f (L))
fL)y=r (L)1 f (L)2 i (L)K—l f (L)K

The direction is defined as:

{m’gher e(U)y > f(U), > f (L), >e(L),
lower —e(U), < f(U), < [(L), <e(L),

with exception of look K where e (U); = f(U)x and e (L), = f (L)
If direction = higher, the stopping rules for the interim analyses (1,2..., K — 1) are

Zlgji) >e(U), Stop(E f ficacy)
Z,Ef) <e (L)k Stop(E f ficacy)

f(L), < fU), Stop(Futility)
f(0), < Z(J <e(U), Continue
e(L), < Z,gj < f(L), Continue

and at the final analysis (K) the stopping rules are

Z}ﬁ) >e(U)g Stop(E f ficacy)

Z}? <e(L)g Stop(E f ficacy)

(D) <29 < f(U), Stop(Futility)

If direction = lower, the stopping rules for the interim analysis (1,2..., K — 1) are

Z,(Cj) <e(U), Stop(E f ficacy)

Z,Ej) >e (L), Stop(E f ficacy)

FU), < ZO<f@M Stop(Futility)

e(U), < AL fU), Continue

f(L), < Z,gj) <e(L), Continue

and at the final analysis (K) the stopping rules are

Zg) <e(U)g Stop(E f ficacy)
Z[(?) >e (L), Stop(E f ficacy)

FU) <29 < f(L),, Stop(Futility)
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It may be of interest to find the Upper Efficacy and Lower Efficacy exit counts separ-
ately. This is equivalent to designating the first condition in all the above Stop(E f ficacyy)
and the second condition as Stop(E f ficacyy) but otherwise is unchanged.

Based on the above:

J .
Fy =Y Stop(Futility)?
=

J .
By =) Stop(Efficacy)%)

J=1

Summary: Based on the above, the algorithm should generate a series of counts for the
number of simulations which stopped at each look for the specified boundaries. We will
indicate these objects as the following for the efficacy (£) and futility (F') stopping counts
respectively:

E = E17E27 s EK—l;EK

F:Fl,FQ,...FK,hFK

8.7.3.2 Statistical Scale Conversions

nQuery provides four statistical scales that the boundaries can be parameterized on.
These are the Z-scale, p-value Scale, Score Scale and §-Scale.

As referenced above, the test statistic (subsection 8.7.2) and group sequential boundary
decisions (subsubsection 8.7.3.1) in nQuery are made the standardized test statistic scale
- this corresponds to the Z-scale. Within nQuery, when other scales are used they are
converted to the Z-scale and the algorithm is implemented as above. Further detail on
these scales is provided in subsubsection 7.2.1.1 and subsubsection 7.2.4.5

These conversions are provided next.

p-value Scale: The p-value Scale (p;) corresponds to setting the boundaries in terms
of the p-value. The p-values to be compared to the boundaries are presumed to come
from the appropriate unadjusted Z-test (e.g. Z-test for means, Chi-Squared Test for
proportions, Log-Rank Test for survival). This is a common boundary scale requested by
researchers.

The conversion to the Z-scale is as follows:

)

Zr = —¢(pr) 1— sided|Upper
Zr=v(pr)  Lower

where the first condition refers to the case of a one-sided analysis or, for a two-sided
analysis, where calculating the Upper Efficacy/Futility Bound. The second condition
is for the Lower Efficacy/Futility Bound for a two-sided analysis.
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As implied from these conditions, the p-value scale is always assumed to have direction
= higher. This means that if using the p-value boundary parameterization care should
be taken at Step 1: Simulation Inputs that the inputs are consistent with that for the
treatment effect (e.g. Mean Difference).

Score Scale: The Score Scale (Si) corresponds to setting the boundaries in terms
of the score statistic. Score statistisc (and other increment based statistics such as the
B-value) are widely used in the derivation of group sequential designs, though less used
in practice. The Score statistic based on the (Fisher) information (I) will equal 1.

The conversion to the Z-scale is as follows:

The Score Scale has the same directionality as the Z-scale.

0-Scale: The 6-scale corresponds to setting the boundaries in terms of the treatment
effect. The definition will depend on the endpoint of interest. For example, this could be
mean difference for the two-sample Z-test, the risk difference for the chi-squared test or
the log hazard ratio for the log-rank test. This is a common boundary scale requested by
researchers.

The conversion to the Z-scale is as follows:

Zy = /I

The 8-scale has the same directionality as the Z-scale.

8.7.3.3 t-statistic Adjusted Boundaries (Endpoint of Interest = Means)

In clinical trials, the t-test is the most popular test for comparing means. However,
the group sequential boundaries are calculated under the assumption of a (multvariate)
Z-distribution process (subsubsection 7.2.1.1 for details) which corresponds to using the
Z-test. While it is possible to construct exact boundaries for the t-test [Jennison and
Turnbull, 1999, Liu and Li, 2014, Rom and McTague, 2020], this adds significant complic-
ation compared to constructing under the multivariate Z-distribution as the multivaritate
t-distribution is significantly more complex.

However, Jennison and Turnbull [Jennison and Turnbull, 1999] showed that approxim-
ate t-test boundaries can be constructed based on the more commonly available Z-test
boundaries. Based on their work, they state these boundaries are “remarkably accurate'
for controlling the error rates at the desired level when using the t-test.

The Boundary Decision field uses these adjusted boundaries during simulation if t-
Distribution is selected. Note that the Boundary Table at Step 3: Boundary
Table will be the original Z-distribution boundaries with the adjustment occuring within
the simulation algorithm.

The method for generating these adjusted boundaries is as follows:
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df =N —2

where @ is the standard normal distribution cumulative distribution function (CDF),
Z(t)r are the t-distribution adjusted boundaries and Tcgl is the inverse CDF (quantile
function) for the central t-distribution.

Replace the boundaries in subsection 8.7.3 with these t-distribution adjusted boundaries
and proceed otherwise the same.

8.7.4 Group Sequential OQutputs

An overview of the statistics calculated in the Simulation Report is provided here. As
per subsubsection 8.7.3.1, the outcome of the group sequential simulation should be a
series of counts for how many simulations stopped at each look for efficacy and/or futility.

Efficacy (E) and futility (F') stopping counts objects contain the counts for each look k
as follows:

E= E17E27 . "EK—laEK

F:F17F27"'FK717FK

Assuming that J equals the total number of simulations ran then we can calculate the
percentage of trials which exited at each look for efficacy and futility as E(%) = 100(E/J)
and F(%) = 100(F'/J), where it assumed each element is divided by J.

The total % of subjects who stopped at a given look is therefore equal to T'(%) = E(%) +
F(%). Assuming pairwise addition, the T'(%) object will have the following sequence:
T(%)=T(%)1,T(%)a, ... T(%)k—1,T(%) k which will sum to 100%.

Based on the above we can calculate the power and average sample size (N ) as follows:

K
Power =Y E(%)

k=1

- ET(%)
N = N,

where Ny is the total sample size at look k.
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9 Group Sequential Designs
(Lan-DeMets Spending Function
Only Tables), Interim Monitoring &
Unblinded Sample Size Re-estimation

This chapter only provides information on the Group Sequential Design (Lan-DeMets
Spending Function Only) tables and their associated Interim Monitoring € Un-
blinded Sample Size Re-estimation tools.

For information on the Group Sequential Design (Spending Function, Haybittle-
Peto, Wang-Tsiatis, Unified Family, Custom Boundaries) series of tables and
the associated Group Sequential Simulator Tool, please refer to chapter 7.

For reference, the Lan-DeMets Spending Function Only tables are MTT12 (Two Means),
MTT4}0 (Two Poisson), MTT/2 (Two Negative Binomial), MTES2 (Two Means Non-
inferiority), MOT26 (One Mean), PTT12 (Two Proportions), POTS8 (One Proportion -
Alternative Variance), POT13 (One Proportion - Null Variance), STT12 (Two Survival -
Fized Follow-up, Constant Hazard), STT15 (Two Survival - Event-Driven, Constant Haz-
ard), STT23 (Two Survival - Event-Driven, Piecewise Survival, Accrual Rates), STT25
(Two Survival - Event-Driven, Piecewise Survival, Accrual %).

The associated Interim Monitoring € Unblinded Sample Size Re-estimation tables are
MTT25 (Two Means - linked with MTT12), PTT21 (Two Proportion - linked with PTT12)
and STT17 (Two Survival - linked with STT12, STT15, STT23, STT25)

The Spending Function, Haybittle-Peto, Wang-Tsiatis, Unified Family, Custom Bound-
aries tables are the GSTX series of tables including GSTO (Information-Based), GST1
(Two Means), GST2 (Two Proportions), GST3 (Two Survival - Event-Driven or Fized
Follow-up, Piecewise Survival, Accrual %)

0.1 Introduction

This chapter provides an overview of the spending function only group sequential designs
tables and associated interim monitoring and unblinded sample size re-estimation tool
available for the two arm means, proportions and survival group sequential designs.

This section will cover the statistical theory behind the Group Sequential Design
(Lan-DeMets Spending Function Only) series of tables and will give detailed de-
scription of how to design a group sequential trial in nQuery using these tables. It will
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also summarize the theory and user interface of the nQuery Adapt tool for Interim
Monitoring & Unblinded Sample Size re-estimation.

Note that much of theory and guidance here is also relevant for the Multi-arm Multi-Stages
(MAMS) Group Sequential Design tables (MGT6, PGT4).

These Group Sequential Design and Interim Monitoring € Unblinded Sample Size Re-
estimation features will only be available to users if an nQuery Advanced Pro license
s active. Active packages are displayed in the Packages section on the Home tab. To
purchase additional packages, see www. statsols. com.

9.2 Group Sequential Test Design

9.2.1 Background

Group sequential designs are an extension of fixed period designs in which data from the
trial is analyzed at one or more stages prior to the conclusion of the trial. The trial can
then be stopped early if there is strong evidence for or against the proposed treatment
being effective based on data up to that point. Group sequential designs are one of the
most widely used types of adaptive trial and provide the opportunity to stop a trial early
for efficacy (strong interim evidence against the null hypothesis) and/or futility (strong
interim evidence for the null hypothesis) and thus significantly reduce the economic and
ethical costs over the equivalent fixed period design.

Note: Group Sequential Design is currently only available for users with an nQuery Ad-
vanced Pro license except for the Group Sequential Design tables for Two Means (MTT12),
Two Proportions (PTT12) and Two Survival - Equal Followup (STT12) which are in
nQuery Advanced (Core). Active packages are displayed in the Packages section in the
Home tab. To purchase additional packages, see www. statsols. com.

9.2.2 Group Sequential Design Theory

In nQuery, the group sequential design tables’ power and sample size calculations are
performed using the Lan-DeMets alpha spending function approach [Demets and Lan,
1984, Demets and Lan, 1994|; for estimating boundary values. Building on the work of
Lan and DeMets; Pampallona, Tsiatis, and Kim [Pampallona et al., 1995, Pampallona
et al., 2001] later put forward the concept of using a beta spending approach to construct
boundaries for futility where the evidence for the null is strong. These boundary values
indicate the interim test values (test statistic, effect size, p-value) which would lead to
the trial stopping early based on interim data. Boundary values can be estimated in a
number of ways with nQuery providing bounds based on the O’Brien-Fleming [O’Brien
and Fleming, 1979], Pocock [Pocock, 1977], Hwang-Shih-DeCani [Hwang et al., 1990]
and Power Family spending functions. Each of these spending functions spend a certain
proportion of the alpha error (Type I/efficacy) and/or beta error (Type II/futility) at
each analysis or ‘look” and then make the needed adjustments to the sample size and
final errors to preserve the overall Type I and Type-2 errors. The “spent” alpha and
beta values used at each look are calculated based upon the test hypothesis, the spending
function chosen, the number of looks to be taken during the course of the study as well
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as the overall Type I and Type-2 error rates. For a full introduction to group sequential
methods, we recommend Group Sequential Methods Applications to Clinical Trials by
Jennison & Turnbull (2000) [Jennison and Turnbull, 1999].

9.2.2.1 Spending Functions

There are four spending functions available to the user in nQuery for the efficacy and
futility bounds. Note that nQuery also provides the option to manually input boundary
values. As standard all alpha spending functions have the properties that the error spent
at the start of the trial equals zero and the error spent at the final analysis equals the
original desired error level i.e. the desired test significance level for alpha spending, one
minus the power (as a proportion) for beta spending. Functionally the alpha and beta
spending functions are the same.

The spending functions for alpha spending are summarised in Table 9.1 where «(7) is the
cumulative alpha spent at the specified look, « is overall alpha error, 7 is the information
time (usually the sample size up to that look as a proportion of the total sample size ),
Z1.a/2 is the inverse standard normal cumulative distribution assessed at “1-a//2”, ® is the
standard normal cumulative distribution function, p is the Power Family parameter and
v is the Hwang-Shih-DeCani gamma parameter.

Table 9.1: Spending Functions

’ Spending Function \ Form ‘
O’Brien-Fleming | a(7) =2 < ( ))
Pocock a(r)=aln(1+ (e — 1 )T)
Power Family a(r) =ar?
Hwang-Shih-DeCani a(rt)=a %

Most spending functions spend less error at the earlier looks, with the O’Brien-Fleming
spending function being more conservative than the Pocock spending function (Power
Family /Hwang-Shih-DeCani will depend on their free parameter). This is usually a de-
sired characteristic as it means that the results of any interim analysis will only be con-
sidered significant (and thus ending the trial) at an early stage with an extreme result.
It also means that the final analysis will be more comparable in terms of sample size and
significance boundaries to an equivalent fixed term design.

9.2.2.2 Boundaries

The boundaries in nQuery represent the critical values at each look above or below which
the trial would end early. These boundaries are usually constructed using the alpha and
beta spending functions, though users are given the option of entering these manually.
For the spending function approach, nQuery will automatically generate boundaries for
the early rejection of the null hypothesis (if an efficacy alpha spending function is active),
early finding for the null hypothesis (if a futility beta spending function is active) or both
(if futility and efficacy are both active using a combination of both the alpha and beta
spending functions).
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Once these critical boundary statistics are generated, they can be compared during in-
terim monitoring to the interim test statistics to decide whether to end the trial early.
Essentially, if a test statistic crosses an efficacy boundary then it can be concluded that
the experimental treatment shows a statistically significant effect and the trial can be
stopped with rejection of the null hypothesis. If the test statistic crosses a futility bound-
ary then this indicates with high probability that an effect will not be found, that the
trial can be terminated by rejecting the alternative hypothesis. For futility bounds there
are two options; either to have the boundaries binding, or non-binding. With binding
boundaries, if the test statistic crosses the futility boundary, the test must be stopped,
otherwise the type-1 error may become inflated. The reason for this is that there is an
interaction between the efficacy and futility boundaries in their calculation that could
cause the efficacy boundary to shift. In the case of non-binding boundaries; the efficacy
boundaries are calculated as normal, that is, as if the futility boundaries did not exist.
This eliminates the danger of inflating the Type I error if the futility boundary is over-
ruled. The downside of the non-binding case is that it may increase the required sample
size relative to the binding case.

In nQuery, boundary values are given on the standardized scale (i.e. Z-statistic scale)
and will usually equal the treatment difference divided by its standard error. Examples
for two independent sample design case are given in Table 9.2.2.2.

Table 9.2: Two Sample Group Sequential Standardized Statistics

| Means | Proportions (Pooled) | Survival (Approx.) |

7=t | 7= 7 = R
1 1
4% +
LO L) )

For early stopping, we simply calculate the Z-statistic based on the current interim data
and stop early if it is above the “upper” bound or below the “lower” (2-sided) or “futility”
(1-sided) bound. Note that in nQuery; “upper”, “lower” and “futility” are defined relative
to the direction of the pre-specified effect size. For example, if the initial design assumes a
negative difference (u; > p9) then positive “upper” interim tests statistics would be those
in which the interim difference is also negative and vice-versa. Similarly, “lower” results
would be those in the opposite direction. Futility bounds can be above or below zero but
the same guidance applies for the Z-statistic calculation.

9.2.2.3 Calculating Power or Sample Size

To calculate the power or sample size, we can use the drift parameter. This is the standard-
ized Z-statistic defined above for the relevant test for the final look in the group sequential
design. Tt also equals A+/I, where Ais the treatment effect (e.g. mean difference) and I,
is the maximum total information of the group sequential design.

To calculate the sample size, nQuery calculates the value for the drift parameter based
on the values for the significance level, whether a one-sided or two-sided analysis is being
used, the power, the number of looks and the spending function. The drift parameter is
then set to equal to the standardized Z-statistic for the final look and via re-arrangement
or iterative search, the sample size can be found.
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To calculate the power, nQuery calculates the drift parameter by calculating the stand-
ardized Z-statistic based on the relevant information including the sample size. This drift
is used to reverse-calculate the power via algorithm [Jennison and Turnbull, 1999] using
the significance level, whether a one-sided or two-sided analysis is being used, the number
of looks and the spending function.

9.2.3 Group Sequential Design in nQuery

nQuery provides an intuitive interface to make planning a group sequential design and
finding the appropriate sample size or power easy. This section will outline the steps to
plan a group sequential trial in nQuery.

9.2.3.1 Background

In nQuery, the vast majority of user actions and interface options are the same as for
fixed term designs. This section will focus on the major additional issues associated with
group sequential design in nQuery. See previous chapters for information on the shared
table elements.

In nQuery, the inputs required for group sequential design can be split into two categories:
fixed term parameters, group sequential trial (GST) parameters. The fixed term para-
meters are those which would be required to calculate the sample size or power for the
equivalent fixed term design and thus will depend on the statistical test and data type.
The GST parameters are those required to define the group sequential design such as the
spending functions, number of interim looks etc. and will be effectively the same across
different designs and data types. We will cover how both of these are entered and how to
use nQuery for group sequential design in the following example.

9.2.3.2 Group Sequential Design Example

Main Table The main table is used to enter the fixed term parameters including the
significance level, effect size and power among others. These will be very similar or the
same as those for an equivalent fixed term design. In this example, the group sequential
design is for a two sample t-test and thus the effect size is characterised by the mean
difference and per-group standard deviations.
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Looks Side Table Name
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Figure 9.1: Two Means Group Sequential Design

The first thing we need to do is enter these fixed term design parameters.

As these

are effectively the same as for a fixed term design, please refer to previous chapters for
guidance on filling these values. Here we will assume a treatment difference of -1 and
per-group standard deviations of 2.5 for a 1-sided 5% significance test.

) |
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Figure 9.2: Example Fixed Term Parameters

We will leave the power and sample size empty for now as we want to define our group
sequential design before calculating the sample size. To do this we will need to use the

Looks side-table.
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Looks Side-table The Looks side-table will automatically open below the main table for
a specific column when any cell in the column is selected. It can also be manually opened
using the “Compute Effect Size” options from the toolbar or Assistants file menu. For more
details on what side-tables are and how they work in general, refer to subsection 1.7.4.
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@ Group Sequential Test of Two Means-1 Effect Size, &: 0.400000000

Figure 9.3: Looks Side-table

The Looks side-table can be split into two parts: the GST Parameters column (on the left)
and the Looks table (on the right). The GST Parameters column defines the important
features of the group sequential design. The Looks table will contain the important
characteristics of the complete group sequential design as well as allowing some more
complex study designs.

GST Parameters In the GST Parameters, there are 11 inputs settable to define the
group sequential design operating characteristics. These can be summarised as follows:

1. Number of Looks (> 2): Set the total number of looks in group sequential design.
As this is the total number of looks, the interim looks will equal this value minus
one.

2. Information Times (Equally Spaced, User Input): Set whether the interim looks
should be equally spaced or should be based on the user in-putted times (section 9.2.3.2)

3. Max Times (>0): Set the total maximum time. This will automatically re-scale
the Time row in the Looks table when set. Note this is disabled when Information
Times is set to User Input.

4. Efficacy Bounds (Spending Function, User Input, Don’t Calculate): Set how the
efficacy bounds will be calculated. Spending function will activate the Alpha Spend-
ing Function option, User Input will require editing the Upper Bound and Lower
Bound rows of the Looks table (section 9.2.3.2), Don’t Calculate will have no efficacy
bounds and will only be usable if Futility Bounds is not set to Don’t Calculate.
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10.

11.

. Alpha Spending Function (O’Brien-Fleming, Pocock, Power Family, Hwang-Shih-

DeCani): Set the spending function used to calculate the efficacy bounds. For the
Power Family and Hwang-Shih-DeCani options, the user will need to enter a value
for the parameter row below this.

. Power/HSD Parameter (>0 if Power Family, <3 if Hwang-Shih-DeCani): The free

parameter for the Power Family or Hwang-Shih-DeCani efficacy spending function.
Sometimes given the generic term of “Phi” in nQuery. See Table 9.1 for details.

Truncate Bounds (No, Yes): Set whether you want the efficacy bounds to be trun-
cated at a specific user-defined value. If Yes is selected the Truncate at row will be
active below.

. Truncate at (>1): If Truncate Bounds is set to Yes, this defines the value at which

the efficacy bounds are truncated. If an upper bound value in the Looks table is
higher than this value then it will be set to this value. For lower bounds, it will be
set to the minus version of this value.

. Futility Bounds (Non-binding, Binding, Don’t Calculate): Set how the futility

bounds will be calculated. Non-binding and binding will activate the Alpha Spend-
ing Function option, Don’t Calculate will have no futility bounds and will only be
usable if Efficacy Bounds is not set to Don’t Calculate. Non-binding allows futility
bound contravention without error inflation, while binding does not allow this.

Beta Spending Function (O’Brien-Fleming, Pocock, Power Family, Hwang-Shih-
DeCani): Set the spending function used to calculate the futility bounds. For the
Power Family and Hwang-Shih-DeCani options, the user will need to enter a value
for the parameter row below this.

Power /HSD Parameter (>0 if Power Family, <3 if Hwang-Shih-DeCani): The free
parameter for the Power Family or Hwang-Shih-DeCani futility spending function.
Sometimes given the generic term of “Phi” in nQuery. See Table 9.1 for details.

More detail on these are provided in the help cards and in subsection 9.2.2. In nQuery,
the default values are for 5 look design with an efficacy bound using an O’Brien Fleming
spending function. In this example, we will set these to have a two look equally spaced
design (i.e. one interim analysis at 50% of the total sample size), an O’Brien-Fleming
spending function for the efficacy bound and a Power Family spending function with a
parameter equal to 1 (which is similar to Pocock spending function) for the non-binding
futility bound.
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Figure 9.4: Example GST Parameters

Looks Table The Looks Table provides the information on the group sequential
bounds and number of other useful parameters and additional information that char-
acterises the complete group sequential design. In this table, each column corresponds to
that Look. In this example, column 1 is the single interim look and column 2 is the final
analysis. The Looks table contains the following rows:

1.

Time: The Time at which each interim analysis will occur. By default, this will be
the proportion of the total information at that look. The values in Time can be
changed using the Max Times option (where each of these will be multiplied by the
value in Max Times) or can be entered manually if Information Times is set to User
Input

Sample Size: The cumulative sample size required at each look. The final entry will
equal the calculated total sample size.

Lower Bound: The Lower Bound for efficacy below which we would end the trial
early. The bounds are on the standardized test statistic scale. This will only be used
for 2-sided designs with an active efficacy bound. These will be entered manually if
Efficacy Bounds is set to User Input.

. Upper Bound: The Upper Bound for efficacy above which we would end the trial

early. The bounds are on the standardized test statistic scale. This will be only used
with an active efficacy bound. These will be entered manually if Efficacy Bounds is
set to User Input.

Futility Bound: The Futility Bound below which we would end the trial early for
futility (can ignore if non-binding). The bounds are on the standardized test statistic
scale. This will only be used for 1-sided designs with an active futility bound.

. Nominal Alpha: This is the value of alpha (i.e. p-value) for these boundaries if they

were used in a single stand-alone test.
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7.

10.

11.

12.

13.

14.

15.

Incremental Alpha: This is the amount of alpha (type I error) that is spent at this
interim test since the last look. It is close to nominal alpha but differs slightly due
to being adjusted for multiple testing.

. Cumulative Alpha: This is total amount of alpha (type I error) that has been spent

up to and including this look.

. Exit Probability under H1: This is the percentage chance that the trial will stop,

given the specified alternative hypothesis in the main table is true. This is chance
for both the efficacy and futility bounds.

Cumulative Exit Probability under H1: This is the cumulative percentage chance
that the trial will stopped at this or any previous look, given the specified alternative
hypothesis in the main table is true. This is chance for both the efficacy and futility
bounds.

Nominal Beta: This is the value of beta for these boundaries if they were used in a
single stand-alone test.

Incremental Beta: This is the amount of beta error (type II error) that is spent at
this interim test since the last look. It is close to nominal beta but differs slightly
due to being adjusted for multiple testing.

Cumulative Beta: This is total amount of beta error (type II error) that has been
spent up to and including this look.

Exit Probability under HO: This is the percentage chance that the trial will stop,
given the specified null hypothesis (usually difference of zero) in the main table is
true. This is chance for both the efficacy and futility bounds.

Cumulative Exit Probability under HO: This is the cumulative percentage chance
that the trial will stopped at this or any previous look, given the specified null
hypothesis (usually difference of zero) in the main table is true. This is chance for
both the efficacy and futility bounds.

More information on these can be found in the table help cards when these rows are
selected or in subsection 9.2.2. Unless a User Input option is set, this table will be read-
only and will fill automatically once a power or sample size calculation occurs in the main
table. In this example, set power to 80% in the main table. This will give a sample size
of 87 in each group and following Looks table (Figure 9.5)

327



9.2 Group Sequential Test Design

Q nQuery Advanced =
File Edit View Assistants Plot Help
Emle=ElincGRBE !
Getting Started * | Group Sequential Test x| + =
MTT12-1/ GST Two Means L) He rox
2 3 4 5 6 7 8 e a
< >
Calculate the sample sizes v| I3 | Looks Side Table
Name
Loo rx
The looks side table is
[F5 Interim Monitoring & Sample Size Re-Estimation available below the main
GST Parameters 1 2 /| table. On the lefthand side
Number of Looks 2 Time 0500 1,000 the GST Parameters column
Information Times Equally Spaced Sample Size 87.000 174.000 allows you to define the group
Max Times 1.000 Lower bound -8.000 -8.000 sequential design. On the
Efficacy Bounds Spending Function Upper bound 2538 1,662 right-hand side, the Locks
Alpha Spending Function O'Brien-Fleming Futility bound 0582 1.662 table summarises the
Phi Nominal alpha 0006 0048 Structure of the group
Truncate Bounds No Incremental alpha 0006 0044 sequential design for the
Truncate At Cumulative alpha 0006 0050 specified inputs.
Futility Boundaries Nen-Binding Exit probability under H1 35008 64.992
Beta Spending Function Power Family Cumulative exit probability under H1 35.008 100.000 Selecta input or row in the
Phi 1.000 » | Nominal beta 0.280 0.048 above for further details on
Incremental beta 0100 0100 the definition and usage of
Cumulative beta 0100 0200 each term within the context
Exit probability under HO 72336 2raes of conducting an interim look.
Cumulative exit probability under HO 72536 100.000 ©
v
Looks-1 Help
@ Group Sequential Test of Two Means-1 | Power (%): 80.000000000

Figure 9.5: Example Looks Table

For practical purposes, the most important values are the Upper Bound, Futility Bound
and Nominal Alpha. These are the values we will compare the interim test statistics (or
p-values for nominal alpha) to decide whether to end the trial early or at the final analysis
whether to reject the null hypothesis. The additional information provides useful context
on the amount of error spent at each look and how likely the trial will end under the
specified alternative hypothesis (i.e. the effect size in main table) or the null hypothesis.

As mentioned previously, certain elements of the Looks table will have to be set manually
if Information Times or Efficacy Bounds are set to User Input. An example of these being
set manually is given in Figure 9.6.
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Figure 9.6: Custom Looks Table

9.3 Interim Monitoring and Unblinded Sample Size
Re-estimation

9.3.1 Background

With nQuery Adapt, users will have access to the interim monitoring and sample size
re-estimation tool. This tool will provide the opportunity to increase the sample size at
an interim analysis if the interim information suggests a “promising” result but which
is under-powered to find the current interim effect size if it were the true effect size. In
group sequential designs and other similar designs, access to the interim data provides
the opportunity to improve a study to better reflect the updated understanding of the
study. One way to improve a group sequential design would be to use the interim effect
size estimate not only to decide to whether to stop a trial early but to increase the sample
size if the interim effect size is promising. This optionality gives the trialist the chance
to power for a more optimistic effect size, thus reducing up-front costs, while still being
confident of being able to find for a smaller but clinically relevant effect size by increasing
sample size if needed.

Note: Interim Monitoring and Unblinded Sample Size Re-estimation is currently only
available for users with an nQuery Advanced Pro license. Active packages are displayed
in the Packages section in the Home tab. To purchase additional packages, see www.
statsols. com.

9.3.2 Unblinded Sample Size Re-estimation Theory

nQuery provides unblinded sample size re-estimation methods based on two main ap-
proaches: Chen-DeMets-Lan method [Chen et al., 2004] and Cui-Hung-Wang method
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[Cui et al., 1999]. The differences between this will be explored below but both of these
methods are based on using the conditional power to define whether a result is “promising”
and whether to increase and how much to increase the sample size.

9.3.2.1 Conditional Power

Conditional power is the probability that the trial will reject the null hypothesis at a
subsequent look given the current test statistic and the assumed parameter values, which
are usually assumed to equal their interim estimates. For “promising” trials where the
conditional power falls between a lower bound, a typical value would be 50%, and the
initial target power the sample size can be increased to make the conditional power equal
the target study power.

The conditional power is calculated by assuming a set of “true” values for the fixed term
parameters, the interim standardized test statistic and the proportion of information (i.e.
sample size) used at the interim analysis. The generalized formula for the conditional
power at look “k” for ending at look “k+1" is as follows [Jennison and Turnbull, 1999:

CcP (k‘) =¢ (Zk\/nzkﬂ\/erG(IkH]k))
\/[k+1—1k

where 7 is the interim standardized test statistic at time k, I is the information at time
k, zxy1is the target test statistic at look k+1, I, is the information at time k+1 and 6
is the “true” parameter value of interest

For unblinded sample size re-estimation, we will assume k is set to specified sample size
re-estimation look and k+1 is the final look. This means the conditional power in nQuery
is an approximation for the chance of rejecting the null at any subsequent look if k is
not the penultimate look but practically there will be a negligible difference between this
value and the “true” conditional power.

For unblinded sample size re-estimation, the information at a given look will equal the
reciprocal of the squared standard error based on the “true” parameter values (e.g. for
two means, the within-group standard deviations and sample sizes: [Z—? + %b and 6 is
the “true” parameter of interest (e.g. for two means, the mean difference). These “true”
parameters are assumptions made by the user. Two common suggestions would be set
these to either the interim estimates of these parameters or to set these to the assumed
“true” values from the original design. It will be discussed later but it should be noted
that the value of the interim test statistic, Z;, will be treated the same for the unweighted
(Wald) statistic and weighted (Cui-Hung-Wang) statistic.

9.3.2.2 Unblinded Sample Size Re-estimation Methods

Unblinded sample re-estimation increases the sample size in response to a “promising”
result (i.e. effect size) given the interim data. Note that sample size decreases are also
allowable but practically are greatly disfavoured by most sponsors and regulators. A
“promising” result is one which is clinically relevant but which the current sample size
is unlikely to be found significant given the current study design and trajectory. The
definition of “promising” is tied typically to conditional power, though alternative metrics
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such as Bayesian Predictive Power have been put forward. The sample size re-estimation
is tied to the conditional power (and corresponding effect sizes) falling within a range
defined as “promising”. This range is defined by the study design but a typical range
would be between 50% and the target power (e.g. 80% for our group sequential example).
If the conditional power is based on the interim analysis, we can increase the sample size
until the conditional power reaches the target level (typically the original target power
level).

Thus by increasing the sample size, this “promising” result can be adequately powered
for given the current available information to give the appropriate chance for finding
significance at the final analysis (or any subsequent). However by allowing the study
sample size to be changed based on the unblinded interim data there is the chance of
increasing the overall error rate or introducing bias into a study. Two strategies for
ensuring that the error rate is maintained will be discussed in this section: Chen-DeMets-
Lan and Cui-Hung-Wang. Note that these methods change the method for calculating
the standardized test statistics but that the group sequential bounds are unaffected and
can be used as for a classic group sequential design.

Chen-DeMets-Lan The Chen-DeMets-Lan method [Chen et al., 2004] is a method of
unblinded sample size re-estimation that requires minimal change from a group sequential
trial. This method works by setting out a number of criteria related to the allowable
conditions for increasing the sample size that ensures that the normal group sequential
methods (bounds, test statistics etc.) can be used while ensuring the overall error rate
is not inflated versus the original group sequential design. The two primary conditions
which are required to ensure no error inflation are:

1. Sample Size Re-estimation is at the penultimate look

2. The conditional power at the penultimate look must lie between 50% and the original
target power.

Chen-DeMets-Lan show that if these two conditions are met then the Type I error rate
after increasing the sample size until the conditional power equals the original target
power will not exceed the original target Type I error. For some conditions, the Type I
error rate is lower than the original target Type I error but the conservativeness is very
minor over this range. In addition, Gao, Ware and Mehta [Gao et al., 2008] and Mehta
and Pocock [Mehta and Pocock, 2011] extended the work of Chen-DeMets-Lan to derive
the exact lower bound for the conditional power which ensures Type I error control for
any given group sequential or equivalent fixed term analysis. In basic terms, this is done
by iteratively searching over the full range of conditional powers (and corresponding effect
sizes), calculating the required sample size increase for each conditional power and then
calculating the appropriate weighted test statistic (Cui-Hung-Wang) that ensures error
control. For the range where this weighted statistic is lower than the original critical
unweighted test statistic, the sample size can be increased while maintaining the Type I
erTor.

After the sample size increase occurs, the final analysis is conducted as if it were a standard
group sequential design and uses the pre-existing group sequential bound values and Wald
test statistic calculation (subsection 9.2.2).
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Cui-Hung-Wang The Cui-Hung-Wang method [Cui et al., 1999] is an extension of the
generalized adaptive design approach of Muller and Schaefer for the case of sample size
re-estimation. Under the Cui-Hung-Wang method, the user has full flexibility over which
look sample size increases can occur, how many sample size increases occur, how large the
sample size increase can be and the range of “promising” conditional powers allowable for
sample size increases. This robustness to in-study changes gives the greatest operational
flexibility possible regarding sample size. However, this method requires the usage of a
weighted test statistic which differs from the classic standardized test statistic used in
group sequential designs.

The Cui-Hung-Wang method uses a weighted test statistic based on the weighted combin-
ation of the incremental test statistics. Previously when discussing test statistics, we have
been referring to the cumulative test statistics which are based on all the interim data
up to that point. Incremental test statistics are those calculated based only on the data
between the last look and the current look. However, the cumulative and incremental test
statistics can be easily related for the traditional group sequential trial as follows:

7 Wi Zi+ w2 Za+ ...\ W1 L1+ W L,
Cumulative —
\/w1+w2+--~+wk71+wk

where 71 2 11 xare the respective incremental test statistics at each look and wy o x.1 xare
the weights for each test statistics. The weights must sum to one.

For the classic group sequential test statistic, the weights will equal the proportion of the
total sample size used for each incremental test statistic (e.g. for equally spaced 4 total
look design they would equal 0.25, 0.25, 0.25, 0.25). The Cui-Hung-Wang and Chen-
DeMets-Lan method differ in how these weights are affected by an increase in sample size
during the study. Note that for both statistics, the bounds for the classic group sequential
trial are used as before for accepting and rejecting the null hypothesis or for ending the
trial early for efficacy or futility.

For the Chen-DeMets-Lan method, the weights used in this calculation are
based on the actual (i.e. updated/increased) sample size for each incremental
test statistic. Practically, this means that if a sample size occurs at the penultimate
look, the weight placed on the final incremental test statistic will be increased so that
the weight for the final cohort of data is proportional to the increased number of subjects
between the penultimate and final look. Note that since the cumulative test statistic
is equivalent to this version of the weighted sum of incremental test statistics, we can
typically ignore the incremental tests statistics for practical purposes when using the
Chen-DeMets-Lan or classic group sequential methods.

For the Cui-Hung-Wang method, the weights used in this calculation are based
on the original proposed sample size for each incremental test statistic. This
means that if a sample size increase occurs, subjects which are recruited after the sample
size increase will be weighted less than subjects before the sample size re-estimation.
However, this formulation ensures that the Type I error is retained regardless of the
size of the sample size increase, when the sample size increase occurs and what range of
conditional powers are considered “promising”.

This robustness means that the Cui-Hung-Wang statistic provides a far greater level of
operational control over the sample size re-estimation procedure. However, this comes at
the cost of having to use a different test statistic than for the classic group sequential design
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and the down-weighting of subjects after the sample size increase. Note the weighting
issue is a source of debate and we refer to relevant papers for further details.

9.3.3 Unblinded Sample Size Re-estimation and Interim Monitoring
in nQuery

This section will show how to conduct an unblinded sample size re-estimation and interim
monitoring for a group sequential design in nQuery. We will cover two examples: one for
the Chen-DeMets-Lan method and one for the Cui-Hung-Wang method.

9.3.3.1 Opening the Interim Monitoring and Sample Size Re-estimation Table

To open the Interim Monitoring and Sample Size Re-estimation table, we first must
complete a group sequential design sample size or power calculation in a group sequential
table with this feature available (see www.statsols.com for details on which tables have
this feature in nQuery Adapt). In this section, we will take the completed example from
subsubsection 9.2.3.2.

In short, this was a group sequential design with fixed term parameters of a mean differ-
ence of -1, common within-group standard deviations of 2.5, a one-sided 5% significance
level and 80% power. The group sequential design was for a 2 look design (1 interim
analysis), the interim look at 50% of subjects analysed, O’Brien-Fleming efficacy bounds
and Power Family futility bounds with the Power Family parameter set to 1. Given this
the overall sample size required was 174 (87 per group).

To open the Interim Monitoring & Sample Size Re-estimation tool, we select the “Interim
Monitoring & Sample Size Re-estimation” button at the top of the Looks window. This
option will be greyed out if a sample size or power calculation has not been completed
in that column or if you do not have an nQuery Adapt license (see www.statsols.com
and section 5.2 for details on purchasing and activating nQuery Adapt). This button is
highlighted in Figure 9.7.
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Figure 9.7: Opening Interim Monitoring and Sample Size Re-estimation Table

9.3.3.2 Interim Monitoring and Sample Size Re-estimation Table Introduction

The interim monitoring and sample size re-estimation table provides an intuitive approach
for setting up a proposed sample size re-estimation and then allowing interim monitoring
with that sample size re-estimation in mind. The basic structure of the interim monitoring
and sample size re-estimation tables can be split into two main parts: the sample size
re-estimation rules column and the interim monitoring tool. We will refer to the former as
the “SSR Rules” and the latter as the “Monitoring Table” for short. We will summarise
each of these in the following section.

When first opened the table will look as per Figure 9.8 for a two means group sequential
design.
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